
 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

       User Manual 
 

 

 

 

 

DIRECTOR 6.20 

 

Configuration Software 

for ARTIST and PERFORMER 

Digital Matrix Intercom Systems 



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
© 2010 Riedel Communications GmbH & Co. KG & Co. KG. Alle Rechte vorbehalten. 

Dieses Handbuch ist urheberrechtlich geschützt. Das Kopieren, Vervielfältigen, Übersetzen oder Umsetzen in irgendein elektronisches Medium oder maschinell lesbare Form im Ganzen 

oder in Teilen ohne vorherige schriftliche Genehmigung von Riedel ist nicht gestattet. Riedel übernimmt keine Gewähr für die Richtigkeit des Inhalts dieses Handbuchs. Die Rechte an 

anderen in diesem Handbuch erwähnten Marken- und Produktnamen liegen bei ihren Inhabern und werden hiermit anerkannt. 

 

© 2010 Riedel Communications GmbH & Co. KG & Co. KG. All rights reserved. 

Under the copyright laws, this manual may not be copied, in whole or in part, without the written consent of Riedel. Every effort has been made to ensure that the information in this 

manual is accurate. Riedel is not responsible for printing or clerical errors. All trademarks are the property of their respective owners. 



 

DIRECTOR 6.20 Configuration Software, User Manual, Version 3.4          

 

  Page 3 

TABLE OF CONTENTS 
 

1 Hints reading this manual ............................................................................................................................... 12 

2 Preface.............................................................................................................................................................. 13 

3 New functions in Director 6.20 ....................................................................................................................... 15 

4 Glossary ............................................................................................................................................................ 16 

5 Artist Hardware Platform ................................................................................................................................ 18 

6 Director ............................................................................................................................................................. 21 

7 Getting started ................................................................................................................................................. 23 

7.1 What‟s needed? ....................................................................................................................................... 23 

7.2 PC Requirements ..................................................................................................................................... 23 

7.2.1 Network configuration ........................................................................................................................... 24 

7.2.2 Network IP addresses ............................................................................................................................ 25 

8 How To . . .......................................................................................................................................................... 26 

8.1 DIRECTOR Software - Layout ................................................................................................................... 26 

8.1.1 Basic layout ............................................................................................................................................. 26 

8.1.2 Navigation Bar and the Workspace .................................................................................................... 27 

8.1.3 Changing the view .................................................................................................................................. 28 

8.2 Creating a New Configuration ................................................................................................................. 29 

8.2.1 Create a new configuration .................................................................................................................. 29 

8.2.2 The Web and the Network .................................................................................................................... 29 

8.2.3 Labels for the Web and the Network .................................................................................................. 30 

8.3 Open a Configuration ............................................................................................................................... 31 

8.3.1 Open a file ............................................................................................................................................... 31 

8.3.2 Login as a predefined user ................................................................................................................... 32 

8.4 Login.......................................................................................................................................................... 33 

8.5 Add or Change Users ............................................................................................................................... 34 

8.6 Configure a “NET” ..................................................................................................................................... 35 

8.6.1 Adding / deleting and connecting nodes in a network .................................................................... 35 

8.6.2 Adding a new node ................................................................................................................................ 36 

8.6.3 Connecting multiple nodes ................................................................................................................... 37 

8.6.3.1 Manual connection ............................................................................................................................ 37 

8.6.3.2 Automatic connection using the magic wand tool ....................................................................... 37 

8.6.4 Labels for Net and Nodes ..................................................................................................................... 38 

8.6.5 Deleting nodes ........................................................................................................................................ 38 

8.6.6 Setting up multi-node systems ............................................................................................................ 39 

8.6.6.1 Setting the Net and Node addresses .............................................................................................. 39 

8.6.6.2 Defining a node as Ring Clock Master ........................................................................................... 40 

8.6.7 Merging separate configurations into a single configuration (Merge) .......................................... 44 

8.7 Hardware Configuration of a Node ......................................................................................................... 47 

8.7.1 Adding a new matrix card ..................................................................................................................... 48 



 

                                                                                                     DIRECTOR 6.20 Configuration Software, User Manual, Version 3.4 

 

Page 4 

8.7.1.1 Slot arrangement Artist 128, Artist 64, Artist 32, Artist M, Artist S .......................................... 48 

8.7.1.2 Artist 32, 64, 128 G2 - available Client cards ............................................................................... 49 

8.7.1.3 Artist M - available Client cards ....................................................................................................... 50 

8.7.1.4 Artist S - available Client cards ........................................................................................................ 50 

8.7.1.5 Performer 32-16, 32-80 - available Client cards .......................................................................... 51 

8.7.2 Adding a new port .................................................................................................................................. 52 

8.7.2.1 Add Expansion Panels ....................................................................................................................... 57 

8.7.2.2 Configuring a 2 channel panel ......................................................................................................... 59 

8.7.2.3 Configuring a 2 channel 4-wire port (AES only) ............................................................................. 60 

8.7.3 Adding a GPI Card .................................................................................................................................. 61 

8.8 Network Connection ................................................................................................................................ 62 

8.8.1 Setting the IP address of the local node in Director ......................................................................... 62 

8.8.2 Enabling and disabling network access ............................................................................................. 63 

8.8.3 Verifying a successful network connection ........................................................................................ 63 

8.8.4 Set up / Change the IP address in Artist nodes ................................................................................ 63 

8.9 Send a Configuration to Artist ................................................................................................................. 64 

8.10 Upload a Configuration from Artist ..................................................................................................... 67 

8.11 Saving a Configuration ........................................................................................................................ 68 

8.12 Configuration of Ports and Panels ...................................................................................................... 69 

8.12.1 Port name ................................................................................................................................................ 69 

8.12.1.1 Transferring port names from an Excel ® List ........................................................................... 71 

8.12.2 Key functions .......................................................................................................................................... 72 

8.12.3 Virtual port functions ............................................................................................................................. 73 

8.12.4 Panel GPI functions ............................................................................................................................... 74 

8.12.5 Panel Audio I/O ...................................................................................................................................... 74 

8.13 Navigation ............................................................................................................................................. 75 

8.13.1 Navigation via the Network Tab ........................................................................................................... 75 

8.13.2 Navigation via the Ports Tab ................................................................................................................ 76 

8.13.3 Port Short Lists ....................................................................................................................................... 77 

8.13.4 Control panel Workspace...................................................................................................................... 79 

8.13.5 Key assignment ...................................................................................................................................... 79 

8.13.6 Right mouse click menus ..................................................................................................................... 80 

8.13.7 Assigning a function to a key ............................................................................................................... 80 

8.13.8 Drag & Drop programming ................................................................................................................... 81 

8.13.9 Copying and moving keys ..................................................................................................................... 82 

8.13.10 Multiple assignments on a single key ............................................................................................ 83 

8.13.11 Assigning Virtual Functions .............................................................................................................. 83 

8.13.12 Assigning a Virtual Function ............................................................................................................. 84 

8.13.13 Enable Auto Reverse Talk option .................................................................................................... 85 

8.13.14 Panel GPI ............................................................................................................................................. 86 

8.14 Panel Audio Patch................................................................................................................................ 87 

8.14.1 Example: Audio Patch „Cough„ or „Mic-Mute„ ..................................................................................... 89 

8.14.2 Audio Patch “Headset” for 3000 series control panels ................................................................... 91 

8.14.3 Audio Patch parameters ....................................................................................................................... 92 

8.14.3.1 Audio Patch Mic Pre-amp ............................................................................................................. 93 

8.14.3.2 Audio Patch Panel Mic / Headset Switch .................................................................................. 93 



 

DIRECTOR 6.20 Configuration Software, User Manual, Version 3.4          

 

  Page 5 

8.14.3.3 Audio Patch Amplifier ................................................................................................................... 94 

8.14.3.4 Audio Patch Bandpass .................................................................................................................. 94 

8.14.3.5 Audio Patch Compressor/Limiter ............................................................................................... 95 

8.14.3.6 Audio Patch Crosspoints ............................................................................................................... 96 

8.15 Copy Panels and Apply Default Parameters ...................................................................................... 97 

8.15.1 Copy panel ............................................................................................................................................... 97 

8.15.2 Apply defaults to all existing objects .................................................................................................. 99 

8.16 Configuration of typical intercom functions..................................................................................... 101 

8.16.1 Interrupted Foldback (IFB) .................................................................................................................. 101 

8.16.1.1 Method 1: DIM Crosspoint On Call ............................................................................................ 102 

8.16.1.2 Method 2: DIM Crosspoint triggered by priorities ................................................................... 104 

8.16.1.3 Method 3: Using the IFB tables ................................................................................................. 106 

8.16.1.4 IFB Table: Online View ................................................................................................................. 111 

8.16.2 ISO (Isolated Calls) ............................................................................................................................... 113 

8.17 Programming GPIs ............................................................................................................................. 114 

8.17.1 Navigation ............................................................................................................................................. 114 

8.17.2 Assigning functions to a GPI .............................................................................................................. 115 

8.18 Create and Manage Groups and Conferences ................................................................................. 118 

8.18.1 Groups + Confs - tab ............................................................................................................................ 118 

8.18.2 Adding members to a group ............................................................................................................... 120 

8.18.3 Adding members to a conference ..................................................................................................... 121 

8.19 Configuring  “Edit Conference” Function .......................................................................................... 123 

8.19.1 Edit Conference .................................................................................................................................... 123 

8.19.2 Operating the Edit Conference function ........................................................................................... 125 

8.20 Configuration and Operating the „Edit IFB“– Function ................................................................... 126 

8.20.1 Configuration ........................................................................................................................................ 126 

8.20.2 Operating the „Edit IFB“- Function ..................................................................................................... 128 

8.21 Creating and managing Scroll Lists .................................................................................................. 130 

8.21.1 Adding a new Scroll List ...................................................................................................................... 130 

8.21.2 Editing Scroll List entries and functions ........................................................................................... 131 

8.21.3 Assigning a Scroll List to a control panel ......................................................................................... 133 

8.21.4 Scroll Lists – operation from a panel ................................................................................................ 134 

8.21.4.1 Alphabetical Search .................................................................................................................... 134 

8.21.4.2 Selection via a keypad ................................................................................................................ 135 

8.21.4.3 Selection by function type .......................................................................................................... 135 

8.22 Logic Functions .................................................................................................................................. 136 

8.22.1 Logic workspace ................................................................................................................................... 136 

8.22.2 Logic Gates ............................................................................................................................................ 138 

8.22.3 Building a logic function ...................................................................................................................... 139 

8.22.4 Assigning actions to a logic function ................................................................................................ 141 

8.22.5 Creating a macro .................................................................................................................................. 142 

8.23 Log System Activity ............................................................................................................................ 143 

8.23.1 Log settings ........................................................................................................................................... 143 

8.24 Node and Client logging .................................................................................................................... 145 



 

                                                                                                     DIRECTOR 6.20 Configuration Software, User Manual, Version 3.4 

 

Page 6 

8.25 Resolving Configuration Errors ......................................................................................................... 146 

8.26 Monitor „Live State„ ............................................................................................................................ 147 

8.27 Remote Control a Panel .................................................................................................................... 149 

8.28 Crosspoint View .................................................................................................................................. 152 

8.29 Software Updates ............................................................................................................................... 157 

8.29.1 Before beginning the update: ............................................................................................................. 158 

8.29.2 Director update ..................................................................................................................................... 159 

8.29.3 Firmware update .................................................................................................................................. 159 

8.29.3.1 Node Update ................................................................................................................................. 160 

8.29.3.2 Client Update ................................................................................................................................ 161 

9 Functions and features in detail ................................................................................................................... 162 

9.1 Menu Bar ................................................................................................................................................ 162 

9.1.1 File .......................................................................................................................................................... 162 

9.1.2 Edit.......................................................................................................................................................... 164 

9.1.2.1 Menu Bar - edit commands ............................................................................................................ 164 

9.1.2.2 Special interfaces ............................................................................................................................ 164 

9.1.2.3 Marker definitions ............................................................................................................................ 165 

9.1.2.4 Copy Panel ........................................................................................................................................ 165 

9.1.3 View ........................................................................................................................................................ 166 

9.1.4 Settings .................................................................................................................................................. 167 

9.1.4.1 IP-Address of local Node ................................................................................................................. 167 

9.1.4.2 Options - Logging ............................................................................................................................. 168 

9.1.4.3 Options - Partial Files ...................................................................................................................... 169 

9.1.4.4 Options - Autosave ........................................................................................................................... 170 

9.1.4.5 Options - Miscellaneous .................................................................................................................. 171 

9.1.4.6 Colors ................................................................................................................................................. 172 

9.1.5 Extras ..................................................................................................................................................... 172 

9.1.5.1 Set System-Time on all nodes ....................................................................................................... 173 

9.1.5.2 Reset all nodes ................................................................................................................................. 173 

9.1.5.3 Reset Tree … ..................................................................................................................................... 174 

9.1.5.4 Assign new Configuration ID .......................................................................................................... 174 

9.1.5.5 Register special features … ............................................................................................................ 175 

9.1.6 Help ........................................................................................................................................................ 176 

9.2 Toolbar .................................................................................................................................................... 177 

9.3 Navigation Bar ........................................................................................................................................ 178 

9.4 Workspace .............................................................................................................................................. 179 

9.5 Update Bar .............................................................................................................................................. 180 

9.6 Status Bar ............................................................................................................................................... 181 

9.7 Online View ............................................................................................................................................. 182 

9.7.1 Node properties .................................................................................................................................... 182 

9.7.2 Write log data ....................................................................................................................................... 183 

9.7.3 Update firmware................................................................................................................................... 183 

9.8 Net Properties ........................................................................................................................................ 184 



 

DIRECTOR 6.20 Configuration Software, User Manual, Version 3.4          

 

  Page 7 

9.8.1 General .................................................................................................................................................. 184 

9.8.2 Port Defaults 1 ..................................................................................................................................... 185 

9.8.3 Port Defaults 2 ..................................................................................................................................... 186 

9.8.4 Port Settings ......................................................................................................................................... 187 

9.8.5 Key Defaults .......................................................................................................................................... 188 

9.8.6 Call Defaults .......................................................................................................................................... 189 

9.8.7 Marker Definition ................................................................................................................................. 190 

9.8.7.1 Edit Marker ........................................................................................................................................ 191 

9.8.8 Rights ..................................................................................................................................................... 192 

9.9 Node - Properties ................................................................................................................................... 193 

9.9.1 General .................................................................................................................................................. 193 

9.9.2 Error mask ............................................................................................................................................. 194 

9.9.2.1 ALARMS ............................................................................................................................................. 194 

9.9.3 Relay 1 mask ........................................................................................................................................ 195 

9.9.4 Relay 2 mask ........................................................................................................................................ 196 

9.9.5 Rights ..................................................................................................................................................... 196 

9.10 MADI – Client Card Properties .......................................................................................................... 197 

9.11 VoIP ..................................................................................................................................................... 199 

9.11.1 VoIP - Client card properties ............................................................................................................... 200 

9.11.1.1 VoIP - DNS ..................................................................................................................................... 201 

9.11.1.2 VoIP - SIP port ............................................................................................................................... 201 

9.11.1.3 VoIP - QoS ...................................................................................................................................... 202 

9.11.2 Creating VoIP Ports .............................................................................................................................. 202 

9.11.3 Bandwidth calculation ......................................................................................................................... 204 

9.11.3.1 Audio bitrates required by the codec‟s ..................................................................................... 205 

9.11.3.2 UDP Protocol ................................................................................................................................ 205 

9.11.3.3 IP Protocol ..................................................................................................................................... 206 

9.11.3.4 Ethernet Protocol ......................................................................................................................... 206 

9.11.3.5 Jitter ............................................................................................................................................... 207 

9.11.3.6 Calculation example for a VoIP SIP-Port: ................................................................................. 207 

9.11.4 Distribute a panel / 4-wire with CONNECT IPx2 / x8 ...................................................................... 208 

9.11.4.1 Configuration of the CONNECT IPx2 / x8 ................................................................................. 208 

9.11.4.2 Configuration of the VoIP-Ports in Director .............................................................................. 211 

9.11.5 Softpanel VCP-1004/ VCP-1012 ....................................................................................................... 212 

9.11.5.1 Installation of the VCP-1004/VCP-1012 Softpanel ............................................................... 212 

9.11.5.2 Setup VCP-1004/VCP-1012 ....................................................................................................... 213 

9.11.5.3 Configuration VCP-10xx in Director ........................................................................................... 215 

9.11.5.4 Operate VCP-10xx on the PC ...................................................................................................... 216 

9.11.6 SIP - Telephony (new in version 6.20) ............................................................................................... 218 

9.11.6.1 SIP-Phone Basic setup ................................................................................................................ 218 

9.11.6.2 Creating of PoolPorts .................................................................................................................. 219 

9.11.6.3 Configuration of the PoolPorts .................................................................................................. 221 

9.11.7 VoIP statistics ....................................................................................................................................... 223 

9.12 Panel - Properties ............................................................................................................................... 224 

9.12.1 General .................................................................................................................................................. 224 

9.12.2 Details 1 ................................................................................................................................................ 225 

9.12.2.1 Monitoring Function .................................................................................................................... 226 



 

                                                                                                     DIRECTOR 6.20 Configuration Software, User Manual, Version 3.4 

 

Page 8 

9.12.3 Details 2 ................................................................................................................................................ 228 

9.12.4 GPI .......................................................................................................................................................... 229 

9.12.5 Virtual Keys ........................................................................................................................................... 230 

9.12.6 Usage ..................................................................................................................................................... 231 

9.12.7 Rights ..................................................................................................................................................... 231 

9.13 4-wire Properties ................................................................................................................................ 232 

9.13.1 General .................................................................................................................................................. 232 

9.13.2 Details 1 ................................................................................................................................................ 233 

9.13.3 Details 2 ................................................................................................................................................ 234 

9.13.4 Gain ........................................................................................................................................................ 235 

9.13.5 Beep ....................................................................................................................................................... 236 

9.13.6 Virtual Keys ........................................................................................................................................... 237 

9.13.7 Usage ..................................................................................................................................................... 238 

9.13.8 Rights ..................................................................................................................................................... 238 

9.14 Key Properties .................................................................................................................................... 239 

9.14.1 Key Modes: ............................................................................................................................................ 240 

9.14.2 Rights ..................................................................................................................................................... 240 

9.15 Virtual Function Properties ................................................................................................................ 241 

9.15.1 Rights ..................................................................................................................................................... 241 

9.16 Overview of Functions (Commands) ................................................................................................. 242 

9.16.1 Call to Port ............................................................................................................................................. 243 

9.16.1.1 Autolisten ...................................................................................................................................... 244 

9.16.2 Call to Conference ................................................................................................................................ 245 

9.16.3 Call to Group ......................................................................................................................................... 246 

9.16.4 Call to IFB .............................................................................................................................................. 247 

9.16.5 Listen to Port......................................................................................................................................... 248 

9.16.6 Route Audio .......................................................................................................................................... 249 

9.16.7 Switch GPI Out ...................................................................................................................................... 250 

9.16.8 Select Audiopatch ................................................................................................................................ 251 

9.16.9 Control Audiopatch .............................................................................................................................. 252 

9.16.10 Remote Key ...................................................................................................................................... 254 

9.16.11 Reply .................................................................................................................................................. 255 

9.16.12 Edit Conference ................................................................................................................................ 256 

9.16.13 Edit IFB ............................................................................................................................................... 256 

9.16.14 Dim Panel Speaker .......................................................................................................................... 257 

9.16.15 Dim XP Level ..................................................................................................................................... 258 

9.16.16 Beep Panel ........................................................................................................................................ 259 

9.16.17 Telephone Dial Keypad / Display .................................................................................................. 260 

9.16.18 Telephone Dial / Hang up ............................................................................................................... 261 

9.16.19 Logic ................................................................................................................................................... 262 

9.16.20 Kill Partyline Mic .............................................................................................................................. 263 

9.16.21 Autolisten Off .................................................................................................................................... 264 

9.16.22 Set Input/Output Gain ..................................................................................................................... 265 

9.16.23 Sidetone ............................................................................................................................................ 267 

9.16.24 Send String ........................................................................................................................................ 268 

9.17 Group Properties ................................................................................................................................ 269 

9.17.1 Group “General” tab ............................................................................................................................. 269 



 

DIRECTOR 6.20 Configuration Software, User Manual, Version 3.4          

 

  Page 9 

9.17.2 Group “Members” tab .......................................................................................................................... 270 

9.17.3 Group “Usage” tab ................................................................................................................................ 271 

9.17.4 Group “Rights” tab ............................................................................................................................... 272 

9.18 Conference Properties ....................................................................................................................... 273 

9.18.1 Conference “General” tab ................................................................................................................... 273 

9.18.2 Conference “Usage” tab ...................................................................................................................... 274 

9.18.3 Conference “Rights” tab ...................................................................................................................... 274 

9.19 Scroll List Properties .......................................................................................................................... 275 

9.19.1 Scroll List “General” tab ...................................................................................................................... 275 

9.19.2 Scroll List “Usage” tab ......................................................................................................................... 277 

9.19.3 Scroll List “Rights” tab ......................................................................................................................... 277 

9.20 GPI In Properties ................................................................................................................................ 278 

9.20.1 GPI In “General” tab ............................................................................................................................. 278 

9.20.2 GPI In “Rights” tab ............................................................................................................................... 279 

9.21 GPI Out - Properties ........................................................................................................................... 280 

9.21.1 GPI Out “General" tab .......................................................................................................................... 280 

9.21.2 GPI Out “Usage” tab ............................................................................................................................. 281 

9.21.3 GPI Out “Rights” tab ............................................................................................................................ 281 

9.22 User Rights ......................................................................................................................................... 282 

9.22.1 User “General” tab ............................................................................................................................... 282 

9.22.2 User “Usage” tab .................................................................................................................................. 286 

9.23 Setting up CONNECT Codecs and Remote Panels .......................................................................... 287 

9.23.1 Adding a codec to the configuration ................................................................................................. 288 

9.23.2 General tab............................................................................................................................................ 289 

9.23.3 Details tab ............................................................................................................................................. 290 

9.23.4 Port Pool tab ......................................................................................................................................... 291 

9.23.5 Telephone Number tab........................................................................................................................ 293 

9.23.6 Rights tab .............................................................................................................................................. 294 

9.23.7 Pool Panel – 4-wire properties ........................................................................................................... 295 

9.23.8 Pool Panel – Panel properties ........................................................................................................... 296 

9.23.9 Setting up a panel to use a CONNECT/SIP codec ........................................................................... 297 

9.23.9.1 Dialling a connection with a fixed number .............................................................................. 297 

9.23.9.2 Manually dialing a telephone number without a built-in keypad ......................................... 298 

9.23.9.3 Manually dialling a telephone number with a built-in keypad ............................................. 301 

9.23.10 Setting up a Remote Panel using CONNECT DUO ...................................................................... 302 

10 System Parameters ................................................................................................................................... 304 

10.1 Default Settings ................................................................................................................................. 304 

10.2 Specifications / System Limits ......................................................................................................... 306 

11 Special features (software add-ons) ......................................................................................................... 308 

11.1 Unlocking Software Add-ons ............................................................................................................. 308 

11.1.1 Manual activation key ......................................................................................................................... 308 

11.1.2 USB DONGLE ......................................................................................................................................... 309 

12 Partial Files ................................................................................................................................................. 310 



 

                                                                                                     DIRECTOR 6.20 Configuration Software, User Manual, Version 3.4 

 

Page 10 

12.1 Purpose ............................................................................................................................................... 310 

12.2 Creating Partial Files ......................................................................................................................... 310 

12.3 Downloading a Partial Configuration file ......................................................................................... 312 

12.4 Opening Partial Files .......................................................................................................................... 313 

12.4.1 XY-Matrix ................................................................................................................................................ 315 

12.4.2 Partial Files Trigger .............................................................................................................................. 319 

13 Master Control Room (MCR) ..................................................................................................................... 323 

13.1 Adding the MCR ................................................................................................................................. 324 

13.2 Creating MCR Conferences ............................................................................................................... 324 

13.3 Configuring the MCR .......................................................................................................................... 325 

13.3.1 Creating MCR members ...................................................................................................................... 326 

13.3.1.1 Using 4-wires in multiple conferences ..................................................................................... 328 

13.3.2 MCR setup – layouts ............................................................................................................................ 330 

13.3.3 Monitoring set up ................................................................................................................................. 333 

13.3.4 Creating MCR presets .......................................................................................................................... 336 

13.3.5 Other settings (Misc) ............................................................................................................................ 337 

13.4 Using the MCR .................................................................................................................................... 339 

13.4.1 MCR – overview .................................................................................................................................... 340 

13.4.2 Assigning members to a conference ................................................................................................ 341 

13.4.3 Using presets ........................................................................................................................................ 343 

13.4.4 Removing a member from a conference ......................................................................................... 344 

13.4.5 Using an alias name ............................................................................................................................ 345 

13.4.6 Changing a 4-wire I/O gain level ....................................................................................................... 347 

13.4.7 Using the Monitor function ................................................................................................................. 348 

13.4.8 Undo changes ....................................................................................................................................... 349 

13.4.9 Display of time controlled conferences ............................................................................................ 351 

13.5 Setting Up and Using the MCR Interface from a Control Panel...................................................... 353 

13.5.1 Setting up the MCR and panels ......................................................................................................... 353 

13.5.2 Using the MCR from a control panel ................................................................................................. 355 

14 Events / Scheduler ..................................................................................................................................... 357 

14.1 Adding the Events / Scheduler add-On ............................................................................................ 357 

14.2 Creating events .................................................................................................................................. 358 

14.2.1 Event Properties ................................................................................................................................... 358 

14.2.2 Event: MCR Conference ....................................................................................................................... 360 

14.2.3 Event: Call to Conference .................................................................................................................... 361 

14.2.4 Event: Call to Group ............................................................................................................................. 363 

14.2.5 Event: Port to Port ................................................................................................................................ 364 

14.2.6 Event: Call to Port ................................................................................................................................. 365 

14.2.7 Event: Listen to Port ............................................................................................................................. 366 

14.2.8 Event: Logic Source .............................................................................................................................. 367 

14.2.9 Configuration using Drag & Drop....................................................................................................... 368 

14.3 Starting and Stopping Events ............................................................................................................ 370 

14.4 Scheduler ............................................................................................................................................ 372 



 

DIRECTOR 6.20 Configuration Software, User Manual, Version 3.4          

 

  Page 11 

14.4.1 Activating Director for the Scheduler ................................................................................................ 372 

14.4.2 Configuring the Scheduler .................................................................................................................. 373 

15 Audio Video Router .................................................................................................................................... 376 

15.1 General................................................................................................................................................ 376 

15.2 DMX Driver .......................................................................................................................................... 376 

15.3 Adding the Audio/Video Router (AVR) to Director ........................................................................... 377 

15.4 Connecting Director to the DMX Driver ............................................................................................ 378 

15.5 AVR Configuration .............................................................................................................................. 379 

15.5.1 Router-IF objects .................................................................................................................................. 379 

15.5.2 Router-IF source ................................................................................................................................... 380 

15.5.3 Router-IF destination ........................................................................................................................... 381 

15.5.4 Router-IF ext. Lines .............................................................................................................................. 383 

15.5.5 Router-IF external Lines Defaults ...................................................................................................... 385 

15.5.6 Testing the AVR .................................................................................................................................... 386 

16 Trunking ...................................................................................................................................................... 388 

16.1 Requirements ..................................................................................................................................... 388 

16.2 Setup in Director ................................................................................................................................ 390 

16.2.1 General .................................................................................................................................................. 390 

16.2.2 Preparing the Artist systems .............................................................................................................. 390 

16.2.3 Preparing the configuration................................................................................................................ 391 

16.2.4 Defining trunklines ............................................................................................................................... 392 

16.2.5 Preparing individual ports for trunking ............................................................................................. 393 

16.2.6 Preparing groups and conferences for trunking ............................................................................. 394 

16.3 Trunk Navigator Software .................................................................................................................. 395 

16.3.1 Changing the background image ...................................................................................................... 396 

16.3.2 Connecting Trunk Navigator to an Artist system ............................................................................ 397 

16.3.3 Setting up trunklines ........................................................................................................................... 399 

16.3.4 Trunk Navigator details ....................................................................................................................... 402 

16.3.5 Protection mode of the Trunk Navigator .......................................................................................... 404 

16.4 Configuring Trunking Calls in Director .............................................................................................. 406 

16.4.1 Trunking: Call to Port ........................................................................................................................... 406 

16.4.2 Trunking: Listen to Port ....................................................................................................................... 408 

16.4.3 Trunking: Call to Group / Call to Conference ................................................................................... 409 

16.4.4 Trunking: Changing portnames .......................................................................................................... 410 

16.4.5 Offline configuration of Trunkcalls (new in Director 6.20) ............................................................ 411 

16.4.6 Trunking priorities ................................................................................................................................ 414 

16.5 Displaying trunking calls ................................................................................................................... 415 

17 Troubleshooting .......................................................................................................................................... 417 

18 Table of figures ........................................................................................................................................... 419 

19 Notes ........................................................................................................................................................... 435 

20 Service ........................................................................................................................................................ 438 



   

                                                                                                     DIRECTOR 6.20 Configuration Software, User Manual, Version 3.4 

 

 

Page 12 

1 HINTS READING THIS MANUAL 

To read this manual comfortable on a PC,  Adobe Acrobat Reader® Version 9 is required. 

You can download it from here. 

To always show the directory of this document on the left side of the reader, click on  . 

To use the links inside the document comfortable with a “Previous view „ and „Next view„ -

button, you first have to activate this functionality in the Acrobat Reader®. 

Open „Tools“ in the Acrobat Reader® and then „Customize Toolbars”. 

 

 

Activate the tools „ “ and „“  

Now you can use these buttons to jump to the last position in the document, before you 

jumped to a link. 

  

Figure 1: Adobe Acrobat Reader® - Settings 

http://get.adobe.com/de/reader/download/
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2 PREFACE 

The purpose of this document is to introduce and explain how to use the Director Software 

for the Artist system. The document is divided into four main parts including a general 

description of the Artist system, its capabilities and typical applications, followed by an 

introduction to the Director Software, its make up, purpose and functions. The first part gets 

you started and provides all of the necessary information to enable the software to be set 

up and used. The following sections provide typical examples of how to program and control 

the Artist system with the appropriate level of detail to quickly and effectively achieve what 

is required. The last part is a troubleshooting guide to assist with any problems that you 

might encounter getting started, programming and running the software.  

NOTICE 

This manual, as well as the software and any examples contained herein are provided “as 

is” and are subject to change without notice. The content of this manual is furnished for 

informational use only and should not be construed as a commitment by Riedel 

Communications GmbH & Co. KG & Co. KG or its suppliers. Riedel Communications GmbH 

& Co. KG & Co. KG gives no warranty of any kind with regard to this manual or the software, 

including, but not limited to, the implied warranties of merchantability and fitness for a 

particular purpose. Riedel Communications GmbH & Co. KG & Co. KG shall not be liable for 

any errors, inaccuracies or for incidental or consequential damages in connection with the 

furnishing, performance or use of this manual, the software or the examples herein. Riedel 

Communications GmbH & Co. KG & Co. KG reserves all patent, proprietary design, title and 

intellectual property rights contained herein, including, but not limited to, any images, text, 

photographs incorporated into the manual or software.  

 

© 2010 Copyright Riedel Communications GmbH & Co. KG.  

All rights reserved. Reproduction, adaptation, or translation of this manual in whole or in 

part is prohibited without prior written permission of Riedel GmbH, except as allowed under 

the copyright laws. 

Microsoft® and Windows® are registered trademarks of Microsoft Corporation. Adobe® is a 

registered trademark of Adobe Systems Incorporated. Apple and Mac are registered 

trademarks of Apple Computer, Inc. Pentium® is a registered trademark of Intel 

Corporation. All other trademarks are the property of their respective owner. 
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3 NEW FUNCTIONS IN DIRECTOR 6.20 

 Support of the new 1100 panel series and the ACROBAT WB-2 beltpack  

 Support of the new virtual panel VCP-1012 

 IFB-Table: Possibility to use groups in the IFB-table 

 VoIP card: Support of SIP telephony  

 Trunking: „Listen to“ Trunkport is now possible 

 Trunking: Offline-configuration of trunkcalls is now possible 



   

                                                                                                     DIRECTOR 6.20 Configuration Software, User Manual, Version 3.4 

 

 

Page 16 

4 GLOSSARY 

Bay                  Slot for CPU-, Client- and GPI cards in the Artist mainframe 

Crosspoint The virtual intersection in the matrix where sources are mixed and routed to 

a destination 

Destination Matrix output, for example a control panel or 4-wire output 

DNS                    DNS (Domain Name System) allows to access a network member by a 

unique name instead entering the IP address. Therefore a DNS-server in the 

network is needed. The DNS-Name and the IP address of the device are 

stored in the DNS-Server. 

DSP Digital Signal Processor, a very fast processor designed for digital audio  

processing 

GPI General Purpose Interface (Input/Output), an interface for electrical signals 

(contact closures, relays) that can be used to trigger an event in the system 

or send a signal to an external device 

Ethernet 10BaseT Ethernet Network port, 10Mbit, half-duplex 

IFB Interruptible Foldback.  A particular audio signal (ex. program audio) sent to 

a port is dimmed or muted if the port receives a call from another source 

ISDN Integrated Services Digital Network, a standard digital telephone service 

ISO Isolated call, a private, point-to-point communication between a source and  

destination where all other calls to that destination are muted or dimmed  

Matrix The digital signal processing platform comprising of one or more frames. See  

Node and Net 

Net The complete local matrix that is made up of either a single node or multiple 

nodes connected by fiber 

Node A single mainframe that provides audio connections, general-purpose  

input/output interfaces and fiber links. 

Panel The device that allows end users to route audio and send other commands to 

the intercom system.  Panels are connected to digital client cards.  

PortPool A group of destinations that have the same physical connection on the 

system.  Used for remote destinations such as ISDN panels and 4-wires. 

PC Personal Computer 

PSTN Public Service Telephone Network, the standard analogue telephone service 

Port                 Analogue or digital interface on the matrix for the connection of panels or 4-

wires 
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Source Audio source, for example a panel or a 4-wire input 

TCP/IP Transmission Control Protocol/Internet Protocol, standard network protocol 

that is the basis for the internet   

UHF Ultra High Frequency – section of the radio spectrum that is used for, among 

other things, many two-way radios (403 – 470MHz)   

VHF Very High Frequency - section of the radio spectrum that is used for, among 

other things, many two-way radios (30 – 300MHz) 

Vox Voice Operated Switch.  Triggered when an incoming audio signal exceeds a 

set threshold, causing an event in the matrix without a key press 

Web Artist System Network 
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5 ARTIST HARDWARE PLATFORM 

Artist is a powerful digital matrix platform for the transmission and distribution of analogue 

and digital audio and data signals. As a multimedia platform, Artist systems provide a new 

concept of intercom and talkback technology, completely changing the general perspective 

of system design for applications in broadcast, theatres, event centres and security 

systems. The decentralized system architecture supported by high bandwidth optical fibber 

interconnectivity, high-speed digital signal processing and industry standard interfaces 

enable the Artist to offer state of the art communication solutions.  

Decentralized matrix structure 

Artist systems provide a distributed real-time, broadcast quality audio matrix comprising of 

either a single mainframe or multiple frames, serving both small and larger applications. 

Each frame can act entirely independently or as a node within a network forming a large, 

distributed matrix that is interconnected by a dual optical fibber ring. 

 

 

Figure: Artist‟s redundant dual ring topology 
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Interfacing and connectivity 

Artist systems offer a wide range of different connections and interfaces to quickly and 

easily adapt to local requirements.   

For example:  

 

 

Figure 2: Artist - Interfacing and connectivity 

 

The analogue four-wire and digital audio interfaces enable audio signals to be distributed, 

mixed and routed through the matrix as required. The broadcast quality audio distribution 

capability meets the demands of most professional environments. The integration of radio 

base stations provides access to wireless communications. 2/4-Wire interfacing provides 

access to traditional analogue two-wire party line intercom systems. 

Connection and use of the public telecommunication services, both analogue and digital, 

are achieved using codec interfaces, allowing intelligent trunking as well as the making of 

and receiving calls from any PSTN, ISDN or mobile phone.  
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Artist system overview 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure: Example of an Artist system installation 

System Features 

 

Point-to-point calls, group calls, conferences, party lines and call priorities are supported as 

standard.  Freely programmable panel keys with different names, signalizations, and key 

modes are offered to support today‟s various intercom, interphone, talkback and address 

standards.  

System set-up, monitoring and remote control are achieved using the Director Windows® 

based software. Single or multiple PCs have access to the Artist Mainframe using an 

existing 10BaseT Ethernet Network. 
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6 DIRECTOR 

Access, set-up and control of any aspect of an Artist system is handled using the Windows® 

based Director configuration software. The software has been designed to offer quick 

access to important features and give a general overview of what‟s going on in the system 

through its intuitive graphic user interface. Director provides the basic functions, look and 

feel associated with most Windows® software products, so that the navigation, location and 

operation of the standard features are familiar. 

Networking 

A single or multiple PCs (up to 4 per node) can be used to control and monitor an entire 

intercom system.  PCs connect to the Artist system via a standard Ethernet port, which 

enables all PCs to access and show the online configuration simultaneously, as well as 

make configuration changes, if allowed.  Moreover, if a fiber ring is used it is possible to 

activate a transparent 10BaseT hub function in order to send additional Ethernet packets 

over the fiber to network the connected PCs.  This function can only be used if the PCs are 

not already members of an existing in-house network. 

 

Figure 3: Artist Dual Ring Network with multiple PCs connected 
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User Management 

Extensive rights management allows the creation of user groups with various access rights 

to the system.  Different levels of user rights can be established to prevent unauthorized 

system changes. 

 

Send Configuration to Artist / Load from Artist 

All information pertaining to the set-up and operation of the system is contained in the form 

of configuration data files that are shared and held by all nodes and PCs on the network. 

The configuration files can be completely uploaded or downloaded between the PCs and the 

matrices for storage, editing or to load new setups. Partial changes to configurations can be 

uploaded or downloaded automatically to handle regularly recurring changes such as the 

switching of productions between various studios. 

Remote Control 

The software not only allows the control panels and keys to be programmed with nearly all 

imaginable functions, it also allows keys to be controlled remotely.   

All functions which can be configured in the software, such as GPIs, logic functions, 

conference calls, etc, can also be controlled remotely via Director.  Even all of the volume 

controls on panels can be changed from a PC using the Remote Control function.  This 

provides a quick and easy way to test configurations or to find and correct user errors 

without having to leave your desk. 
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7 GETTING STARTED 

The DIRECTOR configuration software can be set up very quickly and easily.  The next 

chapter describes how to connect your configuration PC to the system.   

7.1 What‟s needed? 

The following items are required to establish a connection with an Artist network:  

 PC workstation (Windows XP®, Windows Vista® or Windows 7®) 

 LAN connection 

 Director software 

 Artist system 

 Director Software Manual 

 

Details regarding each of these items, including how to set them up, will be described below 

to ensure a successful connection to the system.   

7.2 PC Requirements 

The minimum PC requirements to optimally run Director are the following: 

 Minimum 500MHz Pentium Processor 

 500MB of free space on the hard drive  

 512 MB RAM 

 A monitor with a resolution of at least 1,024 x 768 capable of displaying 256 colours 

(Recommended: 1,280 x 1,024 or 1,400 x 1,050 with 16 bit colour) 

 Mouse or other pointing device 

 XP®, Vista® or Windows 7® operating system 

 10BaseT Ethernet network adapter (LAN connection) 

 The 10BaseT Ethernet network adapter card must support TCP/IP protocol and a 

bandwidth of 10 Mbit half-duplex or auto detection.   
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7.2.1 Network configuration 

There are different ways in which PCs can be connected together and connected to other 

equipment. An Ethernet network, which is the most widely used network method, is 

required for connecting Artist systems to PCs, hence the need for a Network Adapter card.  

Network cabling and adaptors 

The Artist system requires a standard 10BaseT network cable with CAT5 connectors.  

Depending on whether the PC is connected directly to the Artist or connected over a switch 

or hub determines whether a 1:1 or crossover twisted pair cable is required (more 

information and pin-outs are available in the installation guide).     

 A network hub/switch allows multiple PCs to access the same network, which may be 

required for either single or multi-node systems  

 If a single PC is to be connected to a single Artist node a network hub is not required.  In 

this case, a PC can be connected directly to the Artist using a crossover cable.  However, 

if the system is equipped with redundant CPUs we recommend using a hub/switch in 

order to ensure a working connection to the system in the case of a CPU switch-over. 

 

 

Figure 4: Network - Networking 2 nodes 

 

Note: If the PC is already part of a network you should consult your Network Administrator 

before continuing with this installation. The PC requires a fixed IP address. 
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7.2.2 Network IP addresses 

Each Artist mainframe is delivered with a factory set IP Address of 192.168.42.100, where 

192.168.42 is referred to as the “Net ID” and 100 is the “Host ID.” The complete IP address 

can of course be changed at any time to connect the Artist with a pre-existing network.   

The following is required for a direct connection between an Artist and a PC using a 

crossover cable or a switch/hub: 

The Net-ID of the PC‟s IP address should be set the same net ID as that of the Artist 

mainframe (default: 192.168.42), but with a different host ID (100 and 101 are reserved for 

use by Artist).  For example, the PC could use the IP address 192.168.42.10. 

Attention: If the Artist and the PC are connected via a DHCP server, such as a router, the IP 

addresses of the system and the Artist can be different.  In this case, the corresponding 

routing must be handled by the router.  If this applies, contact your network administrator. 

Further IP settings for Artist can be found in the chapter 8.8.4 Set up / Change the IP 

address in Artist nodes 

One should always chose an even numbered IP address for Artist since the next odd 

numbered IP address is automatically used by the second CPU in the mainframe.  For 

example: 

1. CPU: 192.168.42.100  

2.  CPU 192.168.42.101 (automatically) 

It is recommended to test pre-existing networks with standard port scanners or ping tools in 

order to find possible repeated IP address and other problems.  This should be done before 

connecting the Artist to the network to avoid possible IP address conflicts and collisions. 
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8 HOW TO . . . 

This part of the document provides step-by-step details on how to configure and program all 

of the functions and settings in the Director Software package. Each section describes a 

function and the requirements needed to configure it.   

 

8.1 DIRECTOR Software - Layout 

8.1.1 Basic layout 

Director is divided into two main sections: the Navigation Bar and the Workspace. In 

addition, there is also a toolbar containing the standard Windows functions and special 

software tools, as well as a status bar showing the details of the system‟s status.  

 

Figure 5: Director - layout 
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8.1.2 Navigation Bar and the Workspace  

The Navigation Bar is made up of a series of tabs, each one corresponding to a category of 

functions that can be programmed in the Workspace.  Each tab is labelled with a name and 

a symbol.  Some of the tabs may require a different window arrangement for optimal 

viewing. 

The positioning of the Navigation Bar and the Workspace can be changed with the  

button or by pressing <F10> in order to more easily view and edit all required functions.  In 

that case, the Navigation Bar and Workspace are displayed one below the other as in the 

figure below. 

 

Figure 6: Director - Navigation Bar docked on top 

 

A side-by-side view can be restored by pressing the  button or the <F9> key.  

The window size of both areas can also be manually adjusted to show all available 

information. 
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8.1.3 Changing the view 

The appearance of Director can be changed in the “View” menu. The menu allows the 

various toolbars to be shown or hidden. 

 

Standard Toolbar Windows function buttons and toolbars 

Status Bar Director Status Bar 

Artist - Online View Online Monitoring and Status Tool  

Config Transfer Toolbar Director Download/Upload Bar  

Navigation Bar Director Navigation Bar 

Figure 7: Table - Director „View” functions 

 

Click on the menu “View” to display or hide the corresponding toolbars.  A checkmark  will 

be shown when the toolbar is active. 

It is also possible to move the Workspace and Navigation Bar to other positions. To do so, 

place the mouse pointer at the end of the bar or window, and reposition the window while 

holding down the left mouse key.  In addition, the Navigation Bar and Workspace can be 

detached and unlocked with a double click on the outside of the bar or window. It is  also 

possible to move the Workspace or Navigation Bar outside of Director, for example to a 

second monitor.  

A double click on the detached window will return it to its standard position. 

 

Figure 8: Director - Repositioned Navigation Bar and Update Button 
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8.2 Creating a New Configuration 

A new configuration is required when the system is being used for the first time.  If a new 

configuration is being created, an empty workspace opens based on the default settings for 

all functions and parameters. 

8.2.1 Create a new configuration 

In order to start a new configuration, select “New” from the “File”- menu or press the  

button in the toolbar.      

8.2.2 The Web and the Network 

The Web and the Network are two hierarchical layers describing the architecture of the 

complete system. The top layer called Web is used to trunk different systems to each other.  

The WEB consists of a NET, which is the second layer of the system.  A WEB may contain a 

maximum of one NET.   

 

 

Figure 9: Director - New workspace 
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8.2.3 Labels for the Web and the Network 

To provide the Web and Net with suitable names, right mouse click either on the Workspace 

or on the Web or Net label in the Navigation Bar. This will display the corresponding 

properties window. 

Alternatively, you may click on the Web or Net and press the <F2> key to change the name 

directly. 

The default Web name is “Untitled ARTIST Configuration” and the default Net name is  

“Net #1”. 

 

Figure 10: Web properties window 

 

 

Figure 11: Net properties window 

 

The default settings in the Net properties window can be changed to apply the defaults 

globally.  Details are found in 9.8 Net Properties.   

Change the name of the Web or Net 

in the General tab. The name can be 

up to 32 characters long and is only 

used in Director. The name entered 

will be displayed in the Navigation 

Bar and Workspace.  
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8.3 Open a Configuration 

Accessing a pre-existing configuration file requires the file to be located and opened. 

8.3.1 Open a file 

When a previously saved configuration is opened, all of its settings and configured functions 

are available in Director.  The opened configuration can now be edited and saved to the 

Artist system.   

A configuration is opened by selecting Open from “File”- menu or by using the  button in 

the Toolbar. 

 

 

Figure 12: Director - Selecting a configuration file 

 

 

To load the current configuration from an Artist system to a PC, please see chapter 8.10 

Upload a Configuration from Artist. 

 The file selection window will open in 

order to load a pre-existing 

configuration file ending in “*.Art. “  

 First, choose the drive and next 

choose the corresponding folder in 

which the *.Art files are stored.  

 Choose the desired file with a 

double-click or press the “Open“ 

button. 
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8.3.2 Login as a predefined user 

The Navigation Bar and the Workspace display the details of the opened configuration.  The 

User Login window will be displayed and the user must login before proceeding.  Even if no 

password is required, one must still login by pressing the    button.  For details, 

see: 8.4 Login 

 

Figure 13: Director - User Login after opening a pre-existing configuration 

 

If the configuration is opened and there are no errors reported, the configuration can be 

sent to the Artist system.  Details are found in chapter: 8.9 Send a Configuration to Artist 
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8.4 Login 

The User Login is a system security mechanism which ensures that only those users who 

have the required rights can make changes to the system.  The software always opens with 

the default user “Admin” selected, which has so-called “super user” rights.  That means that 

this user is allowed to create new users and define their user rights. 

Note: The default user is “Admin.”  No password is initially set for this user.  We therefore 

strongly recommend that the system administrator sets up a password at the first 

opportunity. 

Every time that a new configuration is opened, either from a file or directly from Artist, the 

login window is displayed. 

 

Figure 14: Director - User login window 

 

The user login window can also be opened to switch to another pre-defined user.  To open 

the user login window either:  

 Select the User Login option in the File menu  

 Press the User Login Button  in the toolbar 

 Read out the configuration from the system 

 

The current user that is logged onto the system is shown in the Status Bar at the bottom of 

the Director window. 

 

Figure 15: Director - Statusbar 

 

Note: If the user name is not available or access to the configuration data cannot be 

obtained, then the user „Admin„ must log in and either create a new user or change the 

access rights of the existing user. 

In order to gain access to the configuration and all 

of its functions, users must login with their 

predefined name and password. 
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8.5 Add or Change Users 

The table in the “Users” tab lists all of the users and their assigned access rights. 

Note: The default user is “Admin”, who possesses the so-called super user rights.  This 

means that this user is allowed to change all functions and setting in the configuration as 

well as create new users. 

In the tab “Users” new users can be created or existing uses can be edited. 

   

 

Figure 16: Director - Navigation Bar Users tab 

 

 

 

Figure 17: Director - User Properties window 

 

 The button “Add” creates a new user. 

 The button “Edit” edits current users. 

 A user can be named in their 

properties window 

 A distinct password can be given to 

each user.  This password must be 

entered the same twice or it will not 

be accepted. 

 

 

 

 

 

 

 

 In the field “Permissions” users can 

be given the following basic user 

rights: (Active rights are signaled by 

a  checkmark.) 

 

 Allow Save to Artist (overwrite) 

 Allow Save Changes to Artist (merge) 

 Allow Save Configuration to Disk 

 Allow Open File from Disk 

 Restrict Properties for AV-Router  

(if installed) 

 Schedule Manager 

(if installed) 

 User Account Manager 

 Allow System-Resets 

 Enable Partial Files 

(if installed) 
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8.6 Configure a “NET” 

After a new configuration has been created (see 8.2 Creating a New Configuration), the next 

step is to define the individual components of the Net. 

Note: The Net is an element of the Web and is comprised of one or more nodes that 

together form a matrix. The Net must contain at least one Node that provides the audio and 

control interfaces. In a multiple node system the individual nodes are connected over fiber 

and form a ring. 

8.6.1 Adding / deleting and connecting nodes in a network 

Double clicking on the Net#1 label in the Navigation Bar opens the Net Workspace where 

new nodes can be added. If Net#1 cannot be seen in the Navigation Bar, click on the plus 

sign (+) to expand the Web tree. 

 

Figure 18: Director - Net Workspace without any nodes 
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8.6.2 Adding a new node 

To add a new node click on the button  in the workspace that 

corresponds to the type of node being used.  Holding the mouse over the different node 

types will show what mainframe each node type corresponds to. Using the left mouse key, 

click on the chosen node type and then point the mouse anywhere on the Workspace.  The 

mouse pointer will change to small cross lines. Click again anywhere that is empty in order 

to “place” the node in that location.  On the Workspace there is now a rectangle that 

represents the node.  At the same time, a tree menu structure will appear under NET#1 in 

the Navigation Bar.  Clicking on the “+” displays the new node that has been added under 

NET#1.  Repeat the steps above until all of the nodes in your system have been added. 

 

Figure 19: Director - Net containing nodes without links 

 

The nodes in the Workspace can be moved around by clicking the  button and then 

selecting the node that you wish to move.  The “+” and “-“ buttons increase or decrease the 

display size of the nodes.    

 Active nodes which are detected by Director during online operation are green. 

 Nodes that are red are not detected to be online, or Director is in offline mode and is 

not connected to any system. 
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8.6.3 Connecting multiple nodes 

Multiple nodes must be connected with one another. Each node must have both an input 

(upstream) and output (downstream) connection. 

8.6.3.1 Manual connection 

The connections are added to the worksheet by selecting the fiber Link  button. 

 

 

Figure 20: Director - Connecting nodes 

 

 

8.6.3.2 Automatic connection using the magic wand tool 

Alternatively, with the magic wand button  you can automatically connect all of the nodes 

with one another independent of their assigned IDs. If this button is pressed, all of the 

nodes on the workspace will be connected with each other beginning with the node with the 

smallest ID and connecting them in order by ID number. 

Upstream Downstream 

Fiber  

Upstream Downstream 

Fiber  

Upstream Downstream Fiber 

back to 

smallest 

ID 
Node with smallest ID Node xx Node with highest ID 

 

Note: This automatically generated connection order might not reflect your actual physical 

fiber cabling 

 The pointer will initially display a 

white-on-black „From„ label when 

positioned over the worksheet (1).  

 Move the pointer to the right side of 

a node (2).  The “From” label 

changes to a green background.  If 

you now click with the mouse a 

connection line representing a fiber 

link will attach to the node.  

 The label near the mouse pointer 

changes to a black background (3).  

Pull the line to the left side of the 

next node. The “To” label will 

become green as soon as it is placed 

above the correct area of the next 

node (4).  Click once to establish the 

connection between the two nodes. 

 The connecting lines (5) can be 

moved around as necessary by 

clicking on them. 
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Figure 21: Director - Net with 3 networked nodes 

 

Once the Net has been configured the next stage is to configure each of the Nodes that 

comprise the Net. See 8.7 Hardware Configuration of a Node. 

8.6.4 Labels for Net and Nodes 

It is possible to give the net and nodes meaningful names. Right mouse click in the 

Navigation Bar on the net or node and choose “Properties”.  The window that opens has a 

space to change the names. 

Alternatively, by selecting a net or node and pressing the <F2> key one can change the long 

names directly.   

 

Figure 22: Director - Node Properties window 

8.6.5 Deleting nodes  

Before deleting a node it is recommended that you save the current configuration to the 

hard disk.  For details see: 8.11 Saving a Configuration 

 

Figure 23: Director - Edit Node pop-up 

 

Attention: If a node is deleted, all fiber connections to the node and everything configured in 

the node is completely erased.   

Enter a name for the Net or Node on 

the General Tab. You can use up to 

32 characters.  This Long Name will 

only be displayed in Director.  The 

name appears in the Navigation Bar 

and Workspace.    

The Node is selected using the pointer  

button. A right mouse click then displays 

the Delete Node and Properties options. 

Clicking “Delete Node” deletes the node. 
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8.6.6 Setting up multi-node systems 

Before connecting multiple nodes in a fiber ring, the configuration and the settings of each 

node must be checked and adjusted, if necessary. Wait until all of the nodes have been 

configured correctly before physically connecting them with fiber. Connect the PC (Director) 

to each node individually, for example by entering their individual IP addresses in Director, 

assuming the nodes are connected on a PC network. If there is no IP network, connect the 

PC to each node directly with a crossover Ethernet cable in order to change their settings 

one after another. 

 

8.6.6.1 Setting the Net and Node addresses 

Each node in a fiber ring must be assigned a unique node address. 

Node ID Address Range 2, ……… ,99 

 

Note: Node IDs “0” and “1” are reserved and cannot be used for normal operation. 

 

Artist S  

Artist S Mainframes have front panel accessible switches and LED displays to adjust and 

view the current Node and Net IDs. Remove the left most of the four foam covers on the 

front panel. Hidden underneath are three HEX and two push-button switches to make the 

necessary Net and Node ID adjustments.  Set the desired node address with SW1 (right) and 

SW2 (middle).  For example, if you set SW2=3 and SW1=1 you get node address 31, which 

will be shown in the display.  The SW3 switch must always stay on address 1.  The newly set 

address blinks in the display.  This means that the new address has not yet been accepted 

by the system.  Give the key on the right a short press to confirm the selection.  

 

Figure 24: Artist S - Net and Node ID 

 

After an address change, a node must be reset. A node reset can be accomplished by 

pressing both keys at the same time. Hold both keys pressed for approximately 10 seconds 

until the countdown in the display reaches 0. 

Attention: In order to receive a new node address the node must also be restarted by a 

power reset. Otherwise the node will not be visible in Director. 
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Artist 32, 64, 128, M 

Select the Network On  button from the Director Menu Bar to enable access to the fiber 

network (See: 8.8.2 Enabling and disabling network access)  

Node addresses can be changed in the Online View.  Click on the  button or open the 

“Online View” window via “View->Artist Online View.” 

 

Figure 25: Director - Online View 

 

 

Figure 26: Director - Online View - Set Node Properties window 

 

 

 

 

8.6.6.2 Defining a node as Ring Clock Master 

It is necessary to set A SINGLE node of an Artist system to be the so-called “Ring Clock 

Master.” The Ring Clock Master provides the system clock that synchronizes all nodes 

connected over a fiber network. To set a node as Ring Clock Master, click the checkbox “Set 

Ring Clock Master to” in the “Online View” -> “Node Properties” and click the checkbox 

“Enabled.”  

 Open the Online View window 

 Select with a mouse click the node that 

you wish to change under “ARTIST Nodes 

detected”.  Then press the  

button.   

 Click on the checkbox “Set Node 

Address”. 

 Change the node address.  The Net ID 

should remain unchanged and set on 1. 

 Pressing the button “Send changes and 

reset the node” will implement the 

changes. The node automatically 

undergoes a reset. 
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If a sync-module is installed in your node, you can choose “Set Synchronize to External 

Clock” to synchronize the node, as well as the complete fiber ring, to the system clock of an 

external devise, such as a digital mixing console.   

If you only have a single node, it should still be defined as the Ring Clock Master. After this 

change is made the node will reset itself. 

 

Checking the node IDs in the configuration 

Add new nodes and fiber connections to your network (See: 8.6.1 Adding / deleting and 

connecting nodes in a network). The configuration should mirror your actual hardware 

installation.  Set the Node ID properties in the Director configuration according to the 

hardware Node ID pre-set during Step 1.  

 

Figure 27: Director - Edit Node Pop-Up 

 

 

Figure 28: Director - Node Properties window 

 

Should it become necessary to change the node type without deleting its configuration (for 

example when a node is replaced by a larger frame due to expansion), this is also possible 

using this pop-up window.  

Choose a node using the pointer button 

 . Use a right mouse click to display 

the Edit Node pop-up window. Choose 

“Properties” to display the window with 

the node properties. 

Adjust the node addresses to reflect 

your hardware configuration. 
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Figure 29: Director - Change node type to … 

 

 

 

Connecting the fiber cabling 

 

 Connect all fiber cables between the frames, according to your configuration 

Note: Do not accidentally switch the Rx & Tx on the fiber.  Details are found in the 

Installation Guide.  

 

Step 4:  Check the fiber network 

Press the Network button from the Director Menu Bar to enable access to the fiber 

network. 

Online View 

If you have successfully connected to the system and the fiber cabling is correct, all current 

nodes which are accessible should appear as entries in the “Online View” window, which is 

opened using the  button.  

 

Figure 30: Director - Online View window 
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Net Workspace 

When you connect to the system by clicking the  button, and all addresses are set 

correctly, all of the available connected nodes should be green.  

 

 

 

 

 

 

 

 

The following example with an Artist 32, an Artist 64 and an Artist 128 shows that the Artist 

32 only has its redundant CPU active, the Artist 64 is functioning normally, and the Artist 

128 is either not turned on or has a node address that does not match the configuration.  

 

 

Figure 31: Director - 3 Node System: 1x CPU online, 2x CPUs online, Offline 

If an Artist frame only has a single CPU installed but two CPUs in the 

configuration, or if the second CPU is not functioning properly, half of 

the node will appear green and half red.  The left side shows the CPU in 

Slot A while the right side shows the status of the CPU in Slot B. 

When redundant CPUs are installed and working correctly the node 

will appear completely green.  This also happens if there is only one 

CPU defined in the Director configuration. 

Artist S offline Node; the Artist S does not support a redundant CPU so 

it will always be either fully green or fully red. 
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8.6.7 Merging separate configurations into a single configuration (Merge) 

A truly unique feature of Director and Artist systems is the possibility to import 

configurations.  This means that two or more configurations from different systems can be 

combined into a single large configuration, for example to directly connect Artist systems 

from two outside broadcast vehicles for a large production.  In this case, both trucks would 

be networked over fiber and would have the ability to combine their systems into a single 

large matrix without having to pull large numbers of audio cables between them.  

 

If several Artist systems are to be combined, the same steps are involved as in the creation 

of a new configuration with several nodes.  This means that the node addresses of all of the 

nodes must be unique.  In addition, only one frame is allowed to serve as Ring Clock 

Master.  The node addresses and Ring Clock Master settings must be adjusted before 

physically connecting the nodes via fiber.  (See Step 1: 8.6.6.1 Setting the net and node 

addresses in the previous chapter).  

Should two identical configurations need to be combined (for example, two identical 

broadcasting trucks), it is imperative that one of the configurations receives a new 

“Configuration ID.”  Be aware that existing Partial Files will no longer work with the 

configuration after this change.  To change the Configuration ID, click on “Extras” -> “Assign 

new Configuration ID.”  The configuration then receives a new unique internal ID.  Save the 

configuration under a new name.  Afterwards, the two configuration files can be combined 

without any problems. 

 

 

    

 

Figure 32: Director - Assign new Configuration ID 
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Step 2: Prepare the new nodes for merging 

Be sure to save the original configuration files of the individuals systems.  As soon as all of 

the nodes have been assigned a unique ID, a new merged configuration can be created.  

Open the original configuration from the hard drive.  The configuration of the second 

system, which should also be available on the hard drive or a USB stick, can then be 

imported using File -> Import.  

 

Figure 33: Director - File / Import 

 

Likewise, it is possible to import the configuration of the other system directly from Artist.  

To do so, connect Director with the IP address that corresponds to the second system (if you 

have a direct connection between the PC and Artist you must move the cable to the second 

system).  Once there is a working connection, you can use the function “File -> Import from 

Artist” to directly import the second configuration into the original configuration.   

 

Figure 34: Director - File / Import from Artist 
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Regardless of the method you choose, after a successful import a window will appear in 

which you can give a prefix to the names in the imported configuration. This name prefix 

will be added to the beginning of the name of every imported object in the system. This will 

differentiate the imported objects from those contained in the original file and prevent port 

names from being repeated. This prefix should be as short as possible.   

 

Figure 35: Director - Configuration Import window 

 

You can now change the node and port names in the new merged configuration as you like, 

and also add new functions, conferences, calls, etc. between the two systems. 

 

 

Step 3: Connect the fiber cabling 

Connect all your fiber-cables according to your configuration. 

If the cabling and the node addresses are correct, you should be able to see the new nodes 

in the Online View . Send the complete configuration with the  button to the newly 

connected system.  Finally, reset all nodes via “Extras ->Reset all Nodes.”  

A merged system created in this way can be used and programmed as you like without any 

restrictions or bottlenecks between the two individual systems. 
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8.7 Hardware Configuration of a Node 

A node is comprised of a set of audio and control interfaces, as well as fiber connectors to 

link to other frames.  Each node consists of a mainframe where cards with various interface 

capabilities are placed. These client cards provide ports for panels, 4-wires etc. The CPU 

manages the system and provides the connection to both the computer network and the 

fiber ring. GPI cards offer the ability to send and receive contact closures. For more details 

on the individual cards please refer to the Artist Hardware Manual. 

Each node is populated with cards according to your requirements.  The cards in the 

mainframe determine the number and type of available ports in the node.  It must be 

decided in advance how many panels and 4-wire ports are needed in the system.  In order 

to program a hardware layout in Director, double click on a node in the Network tab of the 

Navigation Bar.  Click on the plus signs (+) to expand the Web tree if no Nodes are shown.   

After double clicking on a node the corresponding hardware configuration table is shown in 

the Workspace.  

 

Figure 36: Unassigned Node Configuration Tables for Artist 128 and Performer 32-16 mainframes 

 

To add a new card to the configuration, either right mouse click on a bay or click with the 

left mouse key on the   symbol. 
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8.7.1 Adding a new matrix card 

8.7.1.1 Slot arrangement Artist 128, Artist 64, Artist 32, Artist M, Artist S 

The configuration table corresponds to the bay locations in the various mainframe types:  

 

Figure 37: Artist M / 128 bay numbering, front view  

 

 

Figure 38: Artist 64 bay numbering, front view  

 

 

Figure 39: Artist 32 bay numbering, front view  

 

 

Figure 40: Artist S bay numbering, front view  
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8.7.1.2 Artist 32, 64, 128 G2 - available Client cards 

 

 

 

 

 

 

Figure 41: Node configuration - available card types Artist 32, 64,128 

Bay A 

(Artist 32, 64, 128) 

Bays 1 to 4/8/16 

(Artist 32, 64, 128) 

 

Bays X and Y 

(only Artist 128) 

 

PSU 1 and PSU 2 

(Artist 32, 64, 128) 

 

Bay B 

(Artist 32, 64, 128) 
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8.7.1.3 Artist M - available Client cards 

 

 

 

 

 

Figure 42: Node configuration - available card types Artist M 

  

Attention: In Artist M configurations, the PSUs should be set to “unused,” because Artist M 

does not support any PSU monitoring.  If this is not done, you will receive constant error 

messages.  

 

 

8.7.1.4 Artist S - available Client cards 

 

 

 

 

Figure 43: Node configuration - available card types Artist S 

 

Bay A and B 

(only Artist M) 

Bays 1 to 16 

(only Artist M) 

 

Bays X and Y 

(only Artist M) 

 PSU 1 and PSU 2 

(only Artist M) 

 

Bay A 

(only Artist S) 

Bays 1 to 4 

(only Artist S) 

 

Bay X 

(only Artist S) 
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8.7.1.5 Performer 32-16, 32-80 - available Client cards 

 

 

 

 

 

 

Figure 44: Node configuration - available card types Performer 32-16, 32-80 

 

 

As soon as a new client card is added, its 8 available ports are automatically displayed. 

 

Figure 45: Node configuration - Client Cards selection 

Bay A  

( Performer 32-16/80) 

Bays 1 to 4 

(Performer 32-16/80) 

 

Bays 5 to 8 

(only Performer 32-80) 

 
PSU 1 and PSU 2 

(Performer 32-16/80) 

 

Bay B  

(Performer 32-16/80) 
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8.7.2 Adding a new port 

In the Node Configuration Table, right click on any port marked “<unused>” or open a list of 

available port types by clicking on the   symbol.  Different port types can be selected 

depending on the kind of client cards that are installed and configured. Port types are 

organized by series. 

 

Figure 46: Node configuration - Choosing a new port type 

 

 

Figure 47: Node configuration - Port type 1000 series 

 

 RCP-1012E 

 RCP-1028E 

 DCP-1016E 

Figure 48: Port types 1000 series 

  

                                         

Note: If under “Settings“ -> “Options“ -> “Miscellaneous“ the function “Show legacy Panels” 

is activated, the older “B-series” panels of the 1000 panel series will also be displayed. 
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Figure 49: Node configuration - Port type 1100 series 

 

 RCP-1112 

 RCP-1128 

 DCP-1116 

Figure 50: Port types 1100 series 

   

 

 

Figure 51: Node configuration - Port type 2000 series 

 

 RCP-2016 / RCP-2116 

 DCP-2016 / DCP-2116 

Figure 52: Port types 2000 series 
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Figure 53: Node configuration - Port type 3000 series 

 

 RCP-3016 

 DCP-3016 

Figure 54: Port types 3000 series 

 

  

 

Figure 55: Node configuration - Port type 5000 series 

 

 DCP-5008           DCP-5108 

Figure 56: Port types 5000 series 

  

  

 

Figure 57: Node configuration - Port type 4-Wire 
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    4-Wire 

     4-Wire Split 

Figure 58: Port types 4-Wire 

 

 

 

 

Figure 59: Node configuration - Port type Miscellaneous 

 

 

 DBM-1004 

 Telephone Codec 

 RIF-1032 

 RIF-2064 

 C3 –Beltpack 
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 Aurus Panel 

Figure 60: Port types Miscellaneous 

 

By using a VoIP - Client card with minimum version 6.20, it is now possible to use also the 

software panels VCP-1004, VCP-1012 or a SIP-telephony connection. Details see 9.11.4 

Softpanel VCP-1004/ VCP-1012 und 9.11.5 SIP-Telephony (new in version 6.20) 

 

Figure 61: Node configuration - Port type Miscellaneous - VoIP card 

 

 VCP-1004 

 VCP-1012 

 SIP-Phone 

Figure 62: Port types Miscellaneous - VoIP card 

 

By using a MADI Client card with minimum version 6.20, it is now possible to select an 

ACROBAT - WB2 Beltpack as port type. The minimum requirements to connect a ACROBAT 

system is an ACROBAT Cell Controller CC60 or CC120, equipped with a MADI Interface. The 

keys of the WB-2 can be programmed with any function like any other panel. 

 

 
Figure 63: Node configuration - Port type Miscellaneous - MADI card 
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 WB-2 

Figure 64: Port types Miscellaneous - MADI card 

 

 

8.7.2.1 Add Expansion Panels 

If a panel should also have one or more expansion panels, add them in the panel‟s 

“Expansions” list.  Choose the expansion panel type and address. Addresses that have 

already been used will not be displayed. To add additional expansion panels, repeat these 

steps. 

 

Figure 65: Node configuration - Configuration table Expansions 

 

Available Expansions, dependent on the selected base-unit:  

1000 Series: 

 ECP-1016 

 ECP1012-PT 
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 DCP-1016 ES            DEM-1006 

Figure 66: Expansion variation 1000 series 

 

 

1100 Series: 

 ECP-1116 

Figure 67: Expansion variation 1100 series 

 

 

2000 Series: 

 ECP-2016 

 ECP-2016 PT 

 DCP-2016 ES 

Figure 68: Expansion variation 2000 series 

 

 

3000 Series: 

 ECP-3016 

 DCP-3016 ES 

Figure 69: Expansion variation 3000 series 
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8.7.2.2 Configuring a 2 channel panel 

The digital ports of the Artist system always use an AES audio format. However, only a 

single channel mono AES signal is normally sent to each port.  Nevertheless, it is possible to 

send 2 full-duplex audio channels to a panel. This can be valuable for certain applications 

that make use of the audio patches and the analogue I/Os on the panel.  Thus, it is possible 

to send an additional audio channel, such as program audio, directly to the panel without 

interfering with the intercom communication.    

In this case, the mono signal from the next port is internally routed to the second channel of 

the previous port.  

 

Figure 70: Communication with 1 AES channel between Artist and a panel 

 

 

Figure 71: Communication with 2 AES channels between Artist and panel 

 

Odd numbered ports must always be used when connecting 2 channel ports 

(CAT5/AES/COAX).  The next even numbered port must always remain unused. 

Place a panel on an odd numbered port of a client card. Check that the next port is not 

already being used. Open the “Properties” of the panel with a double click on the panel. On 

the “General” tab, activate the option “Use 2nd audio channel.” 

 

Figure 72: Activating the second audio channel 
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The next port will be automatically blocked in the node Configuration Table.   

 

Figure 73: Node configuration - second audio channel 

 

The second channel can now be used in the configuration. 

Attention: When a port is defined for use as a “CONNECT SOLO/DUO” or a “C3 Beltpack,” 

the port will automatically be set in 2 channel mode if the hardware configuration allows it - 

that is, when the port is an odd numbered port and the next port is not being used. 

 

8.7.2.3 Configuring a 2 channel 4-wire port (AES only) 

To create a 2 channel 4-wire port (AES only!), you should proceed exactly as with a 2 

channel control panel.  In this case, the 1st and 2nd audio channels of the port will have the 

same name and can only be routed together. 

However, since a digital 4-wire port is normally connected to a mixing console or a similar 

device, it makes sense for each channel to use a separate name. Then the two channels 

can be configured and routed independently from one another. 

In the node configuration add a digital 4-Wire or 4-Wire Split just like you would for an 

analogue 4-wire. The system automatically recognizes that the following port should be 

used as the second audio channel for the preceding port. 

 

Figure 74: Node configuration - Configuring a 2-channel AES 4-wire 

 

Attention: The 2 channel AES port must be connected to an odd numbered port.  The 

following port must remain unused. 
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8.7.3 Adding a GPI Card 

When a GPI card is selected, the available 16 GPI and 16 GPOs are automatically displayed.  

To define the contact mode, either right mouse click on the “<unused>” field or click on the  

 symbol.  Inputs and outputs offer their corresponding functions. 

    

 

Figure 75: Node configuration - Configuration of a GPI card 

The 16 GPI inputs can be 

treated as normal levels or 

can be inverted, for example, 

in the case of incorrect wiring 

or inverted voltages. 

 

The 16 GPI outputs can be 

defined as either “normally 

closed” or “normally open,” 

depending on the 

requirements of the external 

circuit.  
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8.8 Network Connection 

Artist systems can be configured and monitored with the Director software.  A configuration 

can be worked with either online or offline.  It is possible to create an entire configuration 

without being physically connected to a system.  However, to later use such a setup requires 

a network connection between the configuration PC and at least one node of an Artist 

system.  As soon as Director is connected with an Artist system it is possible to send a 

configuration to the system, read out a configuration from Artist to the PC, as well as 

monitor the system in real time. 

A functioning Ethernet connection is required for online operation.  For details on cabling 

and basic set up, see: 7.2.1 Network configuration. 

8.8.1 Setting the IP address of the local node in Director 

In order to connect to an Artist network, the IP address of the node to which Director is 

connected must be known. If the IP address has not been manually changed, it is the 

factory default address of 192.168.42.100. Check to make sure that you are connected to 

the active CPU of the node via a CAT5 cable (depending on whether the connection is direct 

or over a hub, a 1:1 or at crossover cable must be used, respectively). Director can only be 

connected to one node at a time. However, through this node Director has access to all 

other nodes that are connected via fiber and can also access the complete system 

configuration.  

Note: Up to 4 Director PCs can be connected to a node at the same time. 

 

 

Figure 76: Network - IP Address of local Node 

 

 

If you are running your system with a redundant CPU, it is best to connect to both CPUs over 

a switch or hub.  Click the checkbox “This is an Artist M/32/64/128 node with a redundant 

node controller card.” If the IP address of the first CPU is unavailable because the card has 

failed or has been removed, Director will automatically look for the redundant CPU at the 

next highest IP address.  

Note: The IP address of the redundant CPU card cannot be changed.  The system 

automatically uses the IP address of the first CPU card +1  for the IP address of the 

redundant CPU. 

Next, you must enter the IP address of the 

node that you wish to connect to.   

In the “Settings” menu, choose “IP Address 

of local Node.” Enter the IP address of the 

node in the first field. 
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8.8.2 Enabling and disabling network access 

 

 

Figure 77: Director - Toolbar 

 

The Director Toolbar has a dedicated Network On/Off button  to connect and disconnect 

Director from the Artist system. Clicking the button will attempt to connect Director to the 

system. A successful connection will be shown in the Status Bar. See the next chapter for 

details. 

To disconnect Director from the Artist node, click the Network On/Off button again. The 

Status Bar still show that there is no longer a connection. 

The Status Bar on the bottom of the Director window shows the connection status.   

 

Figure 78: Director - Status bar, network not connected 

 

 

8.8.3 Verifying a successful network connection 

When a successful connection has been established it is reflected in the Status Bar as in 

the figure below.  The blue Connect indicator shows that a connection has been established.  

The green Rx and Tx indicators show that Ethernet packets are being sent and received.  

The current bandwidth used is displayed in the red Network Traffic field. The yellow area 

gives information on the number of nodes Director has found, including any nodes that are 

connected over fiber.  The yellow background also indicates that the connected system 

already has a valid configuration. 

 

Figure 79: Director - Status bar, Artist connected 

 

 

 

8.8.4 Set up / Change the IP address in Artist nodes 

The IP address of a node can be changed via Director. To do so, Director must be online with 

the system. The changes can be carried out in the “Online View,” which can be opened by 

clicking on the   button. Next select the node you wish to change and click on the 

  button. 

Attention: Only change the IP address of a node if necessary.  Errors made while entering an 

IP address will result in the node not being found by Director. If this occurs, use a port 

scanner or reset the CPU to the default factory settings in order to gain access to the 

system. 
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Figure 80: Online View - Set Node Properties 

 

If you change the IP address of the node that you are connected to, you must also change 

the IP address in Director in order for that Director to re-establish a connection to the node.  

See: 8.8.1 Setting the IP address of the local node in Director 

 

 

 

8.9 Send a Configuration to Artist 

 

 

Figure 81: Configuration change - Download a configuration 

Open the Online View window  . 

In the Online View select the node you wish to 

change, and open the Node Properties window 

with the  button.  

Click the corresponding check box  to set a 

new address.  

Change the IP address and the Subnet Mask 

and Gateway, if necessary. For details, see 

your network administrator. 

To confirm the changes, click the 

 button. The node will 

automatically reset. 

Director can be used to program systems and 

generate configuration data files independently of 

being connected to a system. The majority of the 

configuration can be prepared offline and checked 

for configuration errors prior to sending it to a 

system.  

A completed configuration without errors can only 

be sent to an Artist system when Director is 

successfully connected to the system. 
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The following methods will send an entire configuration to the Artist system and will replace 

the existing configuration! 

 Click on the  button in the Director Toolbar to send the entire configuration from 

the PC to the Artist system. 

or 

 In the menu “File,” select “Save to Artist (Override) to send the configuration to the 

system. 

NOTE: If several PCs are connected with the same Artist system at the same time, or when 

using special features such as MCR, AV-Router or Events, it is strongly advised not to use 

the “Override” button , because this will overwrite any changes that were made by 

other PCs or special features.  Instead, only use the “Transfer Changes” button . The 

“Override” button should only be used to send an entire new configuration to the system.  

 

 

If you cannot press the  button because it is greyed out, or if after pressing it you 

receive an error message, the following issues may be causing the problem:  

 there are errors in the configuration  

 the connection to the system has not been successfully established 

 the user has insufficient rights to send a complete configuration to the system 

 another PC is downloading a configuration at the same time.  The system is therefore 

unavailable for further downloads for a short period. 

A progress window will display during the download to the system. This window will 

automatically close after a successful download. The configuration that was sent will be 

active immediately.    

 

Figure 82: Configuration change - Update successfully 

 

Note: The display of this window can be deactivated under “Settings” -> “Options” -> 

“Miscellaneous” -> “Do not show configuration transfer dialog for short, successful 

updates”.  If the window has been deactivated, it will only appear in the case of an update 

error. 
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The following methods will make changes to a configuration in the Artist system. The 

current configuration in the system will be modified! 

 Click on the  button in the Director Tool Bar to send configuration changes to the 

system.  Only changes to the current configuration will be sent. 

or 

 In the “File” menu, select the option “Save to Artist (Merge)” to send the configuration 

changes. 

 

If the  button cannot be pressed because it is greyed out, or if after pressing it you 

receive an error message, the following issues may be causing the problem:  

 there are errors in the configuration  

 the connection to the system has not been successfully established 

 the user has insufficient rights to send a configuration change to the system 

A progress window displays during the download to the system.  This window will 

automatically close after a successful download.  The configuration changes that were sent 

will be active immediately.    
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8.10 Upload a Configuration from Artist 

 

 

Figure 83: Configuration change - Upload a configuration to a PC 

 

There are two different ways to upload the current Artist configuration to a PC.  If you open 

a configuration from the system, any other configuration open in Director will be closed.  

You will be asked whether or not you want to save the open configuration.  

 Click on the   button to load the Artist configuration to the PC 

 From the File menu, select “Open from Artist...“ to load the Artist configuration to the 

PC 

 

If after attempting to load a configuration from the Artist to the PC you receive an error 

message, it may be for one of the following reasons: 

 The Ethernet connection is not yet established  

 The software version of the Artist system is not compatible with your Director version 

After the configuration has been successfully loaded onto your PC you must login with your 

user name and password (if any).  See chapter 8.4 Login 

The uploaded configuration can now be opened, edited and saved onto the PC. See: 8.11 

Saving a Configuration 

The complete configuration of an Artist ring can 

be read with the Director software by any PC 

connected via Ethernet to a node. This 

configuration can then be edited and saved 

locally on the PC.   
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8.11 Saving a Configuration 

A configuration file can be saved to a disk or network drive after it has been created or after 

it has been uploaded from the system. A file can be saved at any time during the 

configuration process, irrespective of any unresolved configuration errors or it being 

incomplete. 

For the purpose of saving the configuration data the Director toolbar has a dedicated  

button and the menu bar “File” has a “Save” option. Clicking the button or selecting the 

“Save” option will save the configuration data to the previously used *.Art filename. 

If the configuration is untitled, the “Save As …” window will open. Alternatively, “Save As …” 

can be selected directly from the toolbar file option in order to save the configuration under 

a new *.Art filename. 

 

 

Figure 84: Configuration change - “Save As” window 

 

 

Figure 85: Configuration change - Save Changes prompt 

 

 

If you make changes in a previously saved configuration, an “*” appears on the window 

label after the name of the configuration. This means that changes have been made that 

have not yet been saved.   

 

Figure 86: Director - modified and unsaved configuration 

Assign a meaningful file name and 

click on “Save“ to save the file in 

the desired directory.   
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8.12 Configuration of Ports and Panels 

The term “Port” refers to any device that can be connected to a matrix port. This can include 

control panels, 4-wires, 2-wire I/Os, digital beltpacks or telephone codec‟s. Simplex and 

duplex audio connections, groups, conferences, etc. can be freely configured between ports 

in order to achieve the desired functionality.   

Control panels can also be used for other functions such as: 

 Activating central and local GPOs 

 Connecting and using auxiliary audio sources and outputs 

 Source assignment and routing operations 

 Destination status and audio monitoring 

 IFB sources and destination switching 

 Panel re-programming 

 Additional functions 

 

8.12.1 Port name 

As soon as a port is created Director automatically assigns it a unique system name. Both a 

distinct Long Name (a unique description used in Director) and a distinct Local Name 

(Display text) are created (For example, Long Name: “4Wire #019-Rack 2-Net #1“, Local: “4-

W. #19“). 

In order to change the name, open the properties of the port. Right click on the port in the 

network list or port list and choose “Properties.” You may also double click in the workspace 

on the port to reach the properties. 

 

Figure 87: Opening the properties of a port, variant 1 
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or       or                 

Figure 88: Opening the properties of a port, variant 2+3 

 

 

Both, the long name and display name can be changed in the “Properties” window.  

 

Figure 89: Properties window of a port 

 

 

The “Alias” is a temporary name. With this feature the “Local” name can be temporarily 

overridden, for example, to display a colleague‟s first name without having to change the 

actual local name. As soon as your changes have been confirmed with  or  

the new name of the port will be changed in the entire configuration. 
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8.12.1.1 Transferring port names from an Excel ® List  

As of software Version 5.91, it is possible to import a predefined list of all long names and 

local names from an Excel® spreadsheet. To do so, it is necessary that the order of the 

names in the Excel® spreadsheet matches the order of the ports in the configuration. 

First, create a new table in Excel®. We recommend one column for long names and a 

second column for local names. Next, copy the marked names into the Windows clipboard  

(  +  ) 

    ->        - >    +  

Figure 90: Excel® list with port names in the correct order 

 

Open the port list in Director. Select the port from which you would like to begin importing 

names. Right mouse click on the first port that should be renamed and choose “Paste „Long 

names‟ from Clipboard.” All of the long names following this port will be renamed according 

to the names from the Excel® spreadsheet. 

   ->    

Figure 91: Importing names from an Excel® spreadsheet into Director 
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The same process can be used for the “Local” names. Select and copy the entries from 

Excel® and paste them into the desired location in the “Local 8-Character” column by using 

a right mouse click and the “Paste ´Local Labels´ from Clipboard” command. 

    ->    

Figure 92: Pasting local display names from an Excel® spreadsheet 

 

8.12.2 Key functions 

Every key on a panel can be allocated one or more functions. Currently, up to 32 functions 

can be configured per key, which will all be activated at the same time when the key is 

pressed. The following list contains descriptions of the individual functions.  

Call to Port Point-to-point call between two ports 

Call to Conference 
Multipoint-to-multipoint call.  Speak to a conference, listen to a 

conference 

Call to Group 
Point-to-multipoint call.  Talk from a port to several others at the same 

time.  Functions only from the source to destination 

Call to IFB 
Enables a call to a pre-defined port from the IFB table with IFB 

functionality 

Listen to Port Listen to an audio source (control panel, 4-wire, etc.) 

Route Audio 
Routes audio directly from a source in the system to a destination.  In 

addition, the crosspoint level can be adjusted (from a panel) 

Switch GPI Out Activates a local or central GPI out 

Select Audiopatch 
Loads pre-defined audio settings to a particular control panel in the 

system 

Control Audiopatch Controlling any element of any Audiopatch  
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Remote Key 
Remote control of control panel keys, option to lock keys, and the 

activation of the signalization markers of a particular key 

Reply Automatic reply key for point-to-point calls 

Edit Conference Change conference members of a selected conference on a panel 

Edit IFB Change IFB assignment on a panel 

Dim Panel Speaker Dims the loudspeaker of a selected panel by a specified amount 

Dim XP Level Dims the level of a selected crosspoint by a specified amount 

Beep Panel Triggers an audible call signal at the selected panel 

Telephone Dial Keypad / 

Display 
Keypad functions for dial-up and display phone numbers 

Telephone Dial  

/ Hang up 
Initiates the dial-up, hook control of a selected codec port 

Logic Triggers a pre-defined logic source 

Kill Partyline Mic 
Deactivates all partyline microphones in a selected partyline. (The 

partyline must be programmed as a member of a conference.) 

Auto Listen Off Deactivates a selected auto listen call 

Set Input/Output Gain 
Allows Input/Output Gain control of 4-wires, split 4-wires and digital 

partyline ports from a panel (only available on the 1000 series panels) 

Sidetone 
Activates the Sidetone function on a panel and offers sidetone level 

control 

Send String 
Sends a 256 character string to the RRCS interface for communication 

with higher ordered systems (special feature) 

Figure 93: Table - Key functions 

 

 

8.12.3 Virtual port functions 

All ports have three so-called Virtual Functions. The Virtual Functions activate certain 

commands without the need to press a key. 4-wire and 2-wire ports only have Virtual 

Functions. Most of the functions in the list above can also be programmed on a Virtual 

Function. However, functions which require a key for operation, such as those that need a 

volume control, are not available. Up to 32 functions can be programmed on a Virtual 

Function.   

Always 
As the name implies, the assigned functions are always active as soon as the 

port is connected to the matrix 

Vox 
The assigned functions are activated when the input audio signal of the 

port is above a specified level 

On Call The assigned actions are activated when the port receives a call 

Figure 94: Table - Virtual port functions 
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8.12.4 Panel GPI functions 

All 1000 and 2100 series control panels are fitted with three GPI inputs and three GPI 

outputs. The same commands that can be programmed on Virtual Functions can also be 

programmed on each GPI. The GPIs of the individual panels are available for use throughout 

the entire system and work the same as GPIs on a GPIO card in the mainframe. 

 

8.12.5 Panel Audio I/O 

All 1000 and 2100 series panels are also equipped with auxiliary audio inputs and outputs 

for applications such as external microphones, loudspeakers, a second headset connection 

etc. In addition, two AUX I/Os can be freely programmed in the “Audio Patches.”  See: 8.13 

Panel Audio Patch 

                          

Figure 95: Panel audio patch 
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8.13 Navigation 

 

8.13.1 Navigation via the Network Tab 

To open a port, double click on the port name shown in Network Tab of the Navigation Bar. 

Click on the “+” sign next to a node to expand the navigation tree if no ports are shown. 

After the double click, the selected port is displayed in the Workspace. If the port is a 

control panel, it will look like it does in real life. A total of two ports can be displayed in the 

Workspace at the same time. 

 

Figure 96: Navigation - Network with an open panel in the workspace 

 

A port can also be opened in the Workspace by right mouse clicking on the port name in the 

node configuration table and selecting the edit port option.  
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8.13.2 Navigation via the Ports Tab  

A double click on a port in the “Ports” tab of the Navigation bar will also open the port in the 

Workspace. The ports tab displays a list of all the ports in the entire system, sorted by 

name. If Director is connected to an Artist system the status of the individual ports will also 

be indicated by colour. A green background means that the port has a device connected to 

it that has booted correctly and is available for use. A red background means either that 

nothing is connected to the port or that the device has not booted.    

 

Figure 97: Navigation - Port tab with workspace 

 

 

The port list can be sorted by other criteria, such as port type, number, etc, by clicking the 

label of one of the columns. An arrow with a “1” next to it shows which criteria the list is 

sorted by and in what direction. 

 

 

The list can be sorted by more than one criterion by clicking on a column while holding 

down the <Ctrl> key. All of the criteria can be chosen and the order of sorting is shown by 

the numbers that appear on the column. 
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In addition, you can search for specific port names using a * filter.  A yellow background 

indicates that a filter is active. Names that match the Long Name or Local 8 Character 

name of the filter will be displayed.  

 

Figure 98: Navigation - Active filter 

 

 

8.13.3 Port Short Lists 

In order to have a better overview of large systems, there is the possibility to create port 

short lists. Groups of ports can be made and opened in the port list with a mouse click. In 

addition, user rights can be assigned to the individual lists to limit the access of specific 

users to certain ports. 

To manage port lists, click the  button in the port list view. 

 
Figure 99: Navigation - Port Shortlist Management 

 

Ports can be added or renamed by clicking on the  button on the left side of the port 

short list window. 
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To add individual members to a list, first select a list from the left side of the window. Then 

click the   button on the right side of the window to select ports to add to the list.  

You can also add port members using Drag and Drop from the network or port view by 

dragging them directly into the port short list window.  

 
Figure 100: Navigation - Assigning members to a short list 

 

 

 

 

The predefined short lists can be later selected in the “Ports” tab of the Navigation Bar.  

 
Figure 101: Navigation - Selecting a short list in the port view 
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8.13.4 Control panel Workspace  

The workspace for programming ports and control panels, normally located on the right side 

of Director, offers several tabs for configuration and monitoring. 

 

Configuration Configuration mode for assigning and editing functions 

Live State Monitoring the port in real-time (only available in Online Mode) 

Remote Control 
Monitoring and remote control of a port via Director (only available in Online 

Mode) 

Audio Patches 
Programming of the audio settings of the port.  Only available for control 

panels. 

Figure 102: Table - Panels workspace functions 

8.13.5 Key assignment 

There are different ways to program commands on control panels and Virtual Functions. A 

precondition for adding functions is that the “Configuration” tab has been selected, as 

described above. The Navigation Bar and Workspace can be adjusted so that one or more 

panels plus expansion panels are visible.  The  and  buttons can be used to adjust this 

view.  See: 8.1 DIRECTOR Software - Layout 

 

Figure 103: Navigation - Navigation Bar docked to the top of the window 
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All panels (except for the 3000 series and RIF panels) have 2 pages of keys: a main page 

and a shift page. Both of the pages offer the same number of keys, according to panel type.  

The shift page can be reached by clicking with the mouse on the “Shift” button located on 

the panel diagram or by pressing  on your keyboard.  

8.13.6 Right mouse click menus 

A menu for editing key functions and properties appears when you right mouse click on a 

control panel key. The following menu items are available: 

Add Function Adds a new command to a key (maximum of 32 functions per key) 

Edit Function Allows the editing of previously added commands on a key 

Delete Function Deletes one or all of the commands on a key 

Properties 
Opens the key‟s properties to change options such as key mode.  

See: 9.14 Key Properties 

Figure 104: Table - Right click functions 

 

Note: The Edit and Delete functions are only shown if there is at least one command 

programmed on the key. 

 

8.13.7 Assigning a function to a key 

 

 

Figure 105: Add function - 1000 series control panel key functions 

 Right mouse click on the key and choose 

the function to program under “Add 

Function.” 

 As soon as a function has been assigned to 

a key it also appears as a new tab in the 

key‟s Properties.  In the following example, 

a “Call to Port” command has been 

selected. 
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Figure 106: Add function - Control panel key, Call to Port destination 

 

Reciprocal or return routes between sources and destinations are not made automatically 

and must be manually assigned.  An exception is the Auto Reverse Talk Option, available for 

4-wires.  See: 9.1.4 Settings >Options, Miscellaneous, > Enable Auto Reverse Talk option. 

 

8.13.8 Drag & Drop programming 

Another, more efficient method of programming keys and virtual functions is offered by 

Window‟s® Drag & Drop function.  First, double click on a port to open it in Director‟s 

Workspace.  Ports, conferences, GPIs and logic sources can be dragged directly to keys 

using Drag & Drop from the Navigation Bar.  Open the corresponding tab in the Navigation 

Bar.  Click on a port or function and hold down the mouse key.  Now pull the pointer to the 

key that should be programmed and release button on the mouse.    

 

Figure 107: Add function - Panel Drag and Drop  

Programming 

Under “Destination” choose the 

port in the system that should be 

called. 

 Drag & Drop a control panel, 4-wire or 2-

wire Out automatically programs a “Call 

to Port” function to that port 

 Drag & Drop a 2-wire In automatically 

programs a “Listen to Port” function to 

that port 

 Drag & Drop a group adds a “Call to 

Group” command 

 Drag & Drop a conference adds a “Call 

to Conference” function 

 Drag & Drop a GPI Out adds a “Switch 

GPI Out” command 

 Drag & Drop  logic source adds a “Logic” 

command 
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Figure 108: Add function - View of destination panel 

 

 

8.13.9 Copying and moving keys 

 

 

Figure 109: Add function - Key assignments on the destination 

 panel 

 All commands and properties of a 

key can be easily copied to a key 

of another port via Drag & Drop 

 All of the keys on the shift page of 

a panel can be copied by >Drag, -

>press <F3>, -> Drop  

 To move a key, simply Drag & 

Drop it elsewhere on the same 

page 

 Other ports can be shown in either 

the source or destination position 

by manually selecting the port 

from the drop-down lists.  You can 

also open ports by Drag & Drop 

from the Navigation Bar to a drop-

down list. 

 The drop-down list can also be 

used as the source for other Drag 

& Drop actions 
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8.13.10 Multiple assignments on a single key 

All keys, Virtual Functions and GPIs can be assigned multiple functions that are activated 

together.  Additional functions can be added via Drag & Drop or the “Add Function” menu. A 

maximum of 32 functions can be programmed to a key/Virtual Function/GPI. All of the 

functions programmed on a key can be viewed, edited or deleted with a right mouse click. 

 

Figure 110: Add function - Tooltip window showing all programmed functions 

 

 

Figure 111: Naming - “Define automatically” setting 

 

8.13.11 Assigning Virtual Functions 

There are different ways to assign functions to Virtual Keys. A prerequisite is that the port 

has been opened in the Workspace. 

All port types have the same Virtual Functions. 2-wire and 4-wire ports have only Virtual 

Functions in lieu of keys. 

Always 
As the name implies, the assigned functions are always active as soon as 

the port has been recognized by the system 

Vox 
The functions configured are activated as soon as the incoming audio 

exceeds a pre-defined level 

On Call 
The functions configured are activated as soon as the port is called by 

another port in the system 

Figure 112: Table - Virtual functions - function description 

 

Assigning Virtual Functions with a right mouse click menu: 

A right mouse click on a Virtual Function opens a menu with the following entries: 

Add Function Adds a new command to the Virtual Function (max. 32) 

Edit Function Allows existing commands to be edited 

Delete Function Deletes one or all of the commands on the Virtual Function 

To get an overview of all of the 

functions and properties of a key or 

Virtual Function, simply position the 

mouse pointer over the key.  A tool-

tip window will automatically be 

displayed with a list of all functions 

and properties on the key. 
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 Drag & Drop a control panel, 4-

wire or 2-wire Out automatically 

programs a “Call to Port” function  

 Drag & Drop a 2-wire it 

automatically programs a “Listen 

to Port” function to that port 

 Drag & Drop a group adds a “Call 

to Group” command 

 Drag & Drop a conference adds a 

“Call to Conference” function 

 Drag & Drop a GPI Out adds a 

“Switch GPI Out” command 

 Drag & Drop  logic source adds a 

“Logic” command 

 

Properties 
Opens the properties of the commands on the Virtual Function.  See: 9.15 

Virtual Function Properties 

Figure 113: Table - Virtual functions - right click menu overview 

 

Note: The Edit and Delete functions will only be shown if at least one command has already 

been programmed on the Virtual Function.  

 

8.13.12 Assigning a Virtual Function 

 

Figure 114: Add function - Adding a command to a virtual function 

 

Drag & Drop Programming 

Another way to program Virtual Functions is with Drag & Drop. Call to Ports, Groups, 

Conferences and GPIs can be dragged to a Virtual Function. Open the corresponding tab in 

the Navigation Bar, select a function, hold down the left mouse key and drag the function 

onto the Virtual Function you wish to program in the Workspace. 

 

Figure 115: Add function - Virtual Function Drag and Drop  

Programming 

 

If a destination panel is dragged to a source panel via 

Drag & Drop, the destination panel automatically 

opens below in the Workspace. This allows the quick 

configuration of a returning call command, if 

necessary. 

Right mouse click on the Virtual 

Function and choose the function to 

program under “Add Function.” 

 

As soon as a function has been 

assigned to a key it also appears as a 

new tab in the key‟s Properties.   
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8.13.13 Enable Auto Reverse Talk option 

A very useful tool allows a reverse call from a 4-wire to be automatically programmed as 

soon as the 4-wire port is added as a “Call to Port” destination elsewhere. When this 

function is active, a call is automatically programmed to the source panel on the VOX 

function of the 4-wire. The call is then automatically deleted as soon as the call to the 4-wire 

from the source port is deleted.     

 

Figure 116: Settings - Options - Miscellaneous - Auto Reverse Talk for 4-Wires 

 

 

Figure 117: Example Auto Reverse Talk for a 4-Wire 

 

Auto Reverse Talk for 4-Wires 

 Select “Settings” -> “Options” from 

the menu in Director.  The Option 

window will open. 

 Select the tab “Miscellaneous” 

 Checking the box next to “Auto 

Reverse Talk for 4-Wires” will 

activate the function  

 The activation of this tool only 

works with the copy of Director on 

the local PC.  It is not a part of the 

configuration. 

 If ”Auto Reverse Talk” is active, 

Director automatically adds on the 

VOX function of the 4-wire called 

the corresponding reverse call to 

the source panel. 

 If the “Call to” the 4-wire is deleted 

from the source panel, the reverse 

call will automatically be deleted 

from the 4-wire‟s VOX function. 

 This function is only available for 4-

wires.  Reverse routes between 

panels must be programmed 

manually. 
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8.13.14 Panel GPI 

The GPI Input and Outputs of a panel can be accessed by opening the panel properties.  (In 

the Workspace, right click on the gray area around the panel and choose the GPIO tab). The 

GPIOs can also be opened by right clicking on one of the GPIOs and choosing “Define GPIO.”  

This window allows GPIOs to be made available for use in programming, defined and 

named.  

 

Figure 118: Panel GPIO - Panel Properties GPI tab 

 

Once the GPIOs are defined, functions can be added to the individual inputs and outputs.  

The process of configuring the GPIOs is identical to configuring keys or Virtual Functions.   

Up to 32 functions can be added per GPIO either with a right mouse click and selecting “Add 

Function,” or by using Drag & Drop.  

As soon as the functions of the panel GPIOs are defined they will automatically appear in 

the list of GPIs found in the Navigation Bar (GPIO tab). The panel GPIOs can be used 

throughout the system. For example, a local GPI input from a panel can activate a function 

anywhere in the system, and anyone in the system can activate the local GPI outputs.    

 

Figure 119: Panel GPIO - Add functions 

The opto-isolated inputs can be 

inverted, if required. 

The GPI outputs can be set either 

as: 

 normally closed  

or 

 normally open 

depending on your interfacing 

requirements.  For more 

information, including pin-outs, 

please refer to the Artist 

Installation Guide. 



 

DIRECTOR 6.20 Configuration Software, User Manual, Version 3.4          

 

  Page 87 

8.14 Panel Audio Patch 

An Audio Patch is a local 6x6 DSP matrix located inside a panel. This matrix allows all of the 

panel‟s inputs and outputs to be freely programmed and adjusted. For example, Audio 

Patch presets can be used to activate different routing configurations or amp settings with a 

key press.  

Inputs 

Panel Mic Front panel microphone 

Headset A Front and rear panel Headset A microphone input (XLR, D-SUB) 

External Mic* External microphone (via D-Sub connector on rear) 

Headset B* Microphone input for Headset B (via D-Sub connector on rear) 

Audio In A* Analogue audio input 1 (D-Sub connector on rear) 

Audio In B* Analogue audio input 2 (D-Sub connector on rear) 

Matrix CH.1 First digital audio channel from the matrix 

Matrix CH.2 Second digital audio channel from the matrix 

Figure 120: Table - Panel Audiopatch - Inputs 

 

Outputs 

Speaker Integrated loudspeaker 

Headset A Front and rear output for Headset A (XLR, D-SUB) 

External Out* Active, external loudspeaker connection (D-Sub, rear) 

Headset B* Output for Headset B (D-Sub, rear) 

Audio Out A* Analogue audio output 1 (D-sub, rear) 

Audio Out B* Analogue audio output 2 (D-sub, rear) 

Matrix CH.1 First digital audio channel to the matrix 

Matrix CH.2 Second digital audio channel to the matrix 

Figure 121: Table - Panel Audiopatch - Outputs 

 

* only available on 1000 and 2100 series panels  

An Audio Patch stores all of the limiter, compressor and bandpass filter settings for the 

individual analogue audio I/Os. 

Any number of Audio Patches can be created for a control panel, but only one Audio Patch 

can be active at any given time. These predefined audio settings can be activated by anyone 

in the system through a key press, VOX function or logic source. 

The Audio Patches can be accessed via the panel workspace.  Choose the  

tab. 
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The Audio Patches tab displays the internal audio matrix of the panel for programming.  

There are always at least two Sub-Patches, the Speaker and Headset Patch.  The “HS” key 

on the front of the panel switches between the two Sub-Patches. If the panel is being used 

in 2-channel mode, the source and destination of the second matrix channel will be 

available. 

 

Figure 122: Panel Audiopatch - default Audio Patches 

 

The sources (inputs) are displayed on the left side (Y axis) and the destinations (outputs) are 

shown on the bottom (X axis).  All Audio Patch elements that can be changed are displayed 

in colour.  The colours have the following meanings:   

  = off 

 = active 

 

The “Default Speaker Mode” Audio Patch, for example, shows that the microphone pre-amp 

is active while the headset microphone is turned off. The crosspoint from the panel 

microphone to the 1st Artist AES channel is open so that the audio is routed to the matrix.  A 

crosspoint is also active from the 1st AES channel of the matrix to the loudspeaker while the 

headset output is muted. This set-up enables standard intercom functionality.    
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8.14.1 Example: Audio Patch „Cough„ or „Mic-Mute„ 

Audio Patches are used to define a panel‟s basic audio settings as well as other temporary 

audio presets for special applications. These special presets can be activated using the 

“9.16.9 Select Audiopatch” command. 

A so-called “cough key,” which temporarily turns off the microphone, can be programmed 

using a new Audio Patch. The crosspoint from the microphone to the matrix is turned off 

while the input from the matrix to the loudspeaker remains open. It is recommended to 

modify the new Audio Patch to shut off the microphone in both speaker and headset mode 

since one never knows which microphone the panel user will choose.   

 

Figure 123: Panel Audiopatch - Add Audio Patch 

 

 

 

 Press the  button to display the “Add Audiopatch“ window 

 Select an Audio Patch in “Copy Settings” to choose an existing Audio Patch from which 

to copy the initial settings for the new Audio Patch  

 Enter a name for the new patch.  In this example, the name is Mic Mute. 
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Figure 124: Panel Audiopatch - Audio Patch “Mic mute” 

 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 In the “Audiopatches” list select the new “Mic Mute” patch. 

 Select the crosspoint from the microphone to Matrix Ch. 1 with a mouse click 

 Change the crosspoint from active (green) to mute (red) by unchecking the box  
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8.14.2 Audio Patch “Headset” for 3000 series control panels 

Since a 3000 series panel does not have a dedicated headset button, switching to headset 

mode must be manually configured to a key. 

 

Figure 125: RCP3016 panel 

 

Again, the default Audio Patch can be used as the basis for the headset mode. Since this 

type of panel has no “HS” key the headset mode of the standard Audio Patch has no effect.  

This means that the speaker mode of the new Audio Patch must be rerouted for headset 

use.   

Attention: The “Default (Headset Mode)” Audio Patch does not function in the 3000 series 

panels. 

 

Figure 126: Panel Audiopatch - RCP3016 panel - Audio-Patch “Headset Mode” 

 

This new Audio Patch can then be activated via a panel key (Latching, No Dim) with the  

“9.16.9 Select Audiopatch” command. 

 

Figure 127: RCP3016 panel - Headset switching via “Select Audiopatch” function 
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8.14.3 Audio Patch parameters 

The following audio parameters can be set in an Audio Patch: 

 Mic pre-amp 

 Speaker / headset switch 

 Amp 

 Bandpass filter 

 Limiter / compressor 

 Crosspoint activation/deactivation, crosspoint level control 

 

Click on the corresponding symbol in the matrix to change one of these parameters. The 

selected element will be highlighted and its parameters will be displayed under the list of 

Audio Patches. To change a setting, move the level indicator or click on the parameter value 

desired. 

 

Figure 128: Panel Audiopatch - Audiopatch options 
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8.14.3.1 Audio Patch Mic Pre-amp 

If the mic pre-amp of the “external mic” or a headset input is selected, the gain level can be 

changed. You can set the pre-amp to 0 dB for electret microphones (default) or +20 dB for 

dynamic mikes. The panel mic is always set to electret. 

 

Figure 129: Panel Audiopatch -  pre-amp options 

 

 

 

8.14.3.2 Audio Patch Panel Mic / Headset Switch 

The setting of the panel mic / headset switch can be manually changed. This is useful if, for 

example, a panel should only be used in headset mode. Pressing the HS key will then result 

in no change in panel settings. To change the switch, first select it in the Audio Patch and 

then change the settings in the box on the right side of the screen.   

 

Figure 130: Panel Audiopatch -  Mic / Headset switch 
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8.14.3.3 Audio Patch Amplifier 

There is an amplifier element for analogue I/Os that can be adjusted from 0 dB to +18.5 dB 

in 0.5 dB steps.  

 

Figure 131: Panel Audiopatch - amplifier 

 

If the function “ ” is activated, the amplifier can later be adjusted from 

a control panel key (available only on the 1000 and 2100 series panels). The amplifier 

symbol will be then turn blue , signalling that the amplifier is now available system-wide 

for control with the “Control Audiopatch” function.  See:  9.16.10 Control Audio Patch. 

 

8.14.3.4 Audio Patch Bandpass 

The high and low bandpass filters in every I/O can be used to cut certain frequencies in 

noisy environments.   

High-Pass Filter  off, 40Hz to 240Hz on a logarithmic scale (default is off) 

Low-Pass Filter  off, 1kHz to 16kHz on a logarithmic scale (default is off) 

Figure 132: Table - Audiopatch - Bandpass filter 

 

 

 

 

Figure 133: Panel Audiopatch - bandpass options 
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8.14.3.5 Audio Patch Compressor/Limiter 

A fully featured compressor/limiter is available for the panel Mic In and Speaker. They can 

be used to improve speech quality, for example if the distance between the user and 

microphone is very far. 

 

Compressor parameters 

Threshold -48dB to 12dB in 3dB steps 

Ratio 1:1 to 8:1 in an arithmetic progression 

Attack 100ms to 100s in an arithmetic progression 

Release 10ms to 1s in a logarithmic progression 

Figure 134: Table - Panel Audiopatch - Compressor parameters 

 

Limiter parameters 

Out-Level -33dB to 12dB in 3dB steps 

Threshold 12dB to 0dB in 3 dB steps 

Attack 100ms to 100s in an arithmetic progression 

Release 10ms to 1s in a logarithmic progression 

Figure 135: Table - Panel Audiopatch - Limiter parameters 

 

 

 

Figure 136: Panel Audiopatch - compressor/limiter input/output 
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8.14.3.6 Audio Patch Crosspoints 

For every audio in and out there is a corresponding crosspoint that enables any source to be 

routed to any destination. The individual crosspoints can be activated or muted by selecting 

the crosspoint and changing the  checkbox. In addition, the crosspoint gain can be 

adjusted from -60 dB to +12 dB in 1 dB steps (default is 0 dB).  

 

Figure 137: Panel Audiopatch - crosspoint options 

 

If the function “ ” is activated, the gain can later be adjusted from a 

control panel key (available only on the 1000 and 2100 series panels).  The crosspoint 

symbol will be then turn blue , signalling that the gain is now available system wide for 

control with the “Control Audiopatch” function.  See:  7.16.10 Control Audio Patch. 

  = off 

 = active 

  = adjustable by command 

 

Attention: Crosspoints that are set to “Adjust from command” are permanently opened 

(active) in the entire panels Audio Patches, regardless of which Audio Patch is currently 

selected.  This means that the ability to switch a crosspoint via “Select Audiopatch” with the 

additional capability to adjust it via “Control Audiopatch” is not possible at this time.  
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8.15 Copy Panels and Apply Default Parameters 

The “Edit” menu offers two very useful functions: The ability to copy an already configured 

panel, and the ability to change default settings system wide. 

8.15.1 Copy panel 

The “Copy Panel” command allows quick and easy copying of all panel key functions and 

audio settings to other panels of the same panel type. The command can be accessed by 

selecting “Copy Panel” from the edit drop down menu.  

 

Figure 138: Copy Panel - Edit> Copy Panel 

 

The “Copy Panel” function can also be found in the properties menu of a panel.  

 

Figure 139: Copy Panel - Panel > Copy Panel 

 

If you open the copy panel function via the panel properties, the selected panel will 

automatically be added as the source panel which can be copied to one or more additional 

panels. If you open the function using the “Edit” menu, you must manually select the source 

panel from the source panel list.   



   

                                                                                                     DIRECTOR 6.20 Configuration Software, User Manual, Version 3.4 

 

 

Page 98 

                           

Figure 140: Copy Panel window 

 

 

Figure 141: Copy Panel window - Add Panel 

 

You can choose to copy the entire panel, including all key functions, properties, commands 

and Audio Patches. Or, by clicking the “Copy Audiopatches only,” you can copy just the audio 

settings and Audio Patches of a panel without changing the key functions of the destination 

panel. 

Clicking the  button opens a window asking you to confirm before the 

destination panels will be changed.  

 

Figure 142: Copy Panel - confirmation 

 

Note: Copying an entire panel will overwrite all existing key commands/properties at the 

destination panel.  If you have special functions on the source panel, such as Remote Key 

commands, they will also be copied one-to-one to the destination panel.  After the copying 

procedure some key commands on the destination panel may have to be manually 

adjusted in order to function correctly.  
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8.15.2 Apply defaults to all existing objects 

The “Apply defaults to all existing objects” command can be used to apply specific settings 

from the default settings in the Net properties to all existing ports. First, you must adjust the 

parameters you wish to change in the Net properties.   

 

Figure 143: Apply defaults - Net Properties 

 

 

Figure 144: Apply defaults - Net Properties - General tab 

 

Note: If items are changed in the Net Properties, the changes will only affect newly created 

ports.  Already existing ports will not be changed. Only by using the command “Apply 

defaults to configuration objects…” can these changes be transferred to all of the existing 

ports in the system. 

 

 

Figure 145: Apply defaults - Edit - Apply defaults to configuration objects … 

 

Open the Network Tab in the Navigation Bar, 

right mouse click on the “Net” and select 

“Properties.” 

Change the parameters that you wish to later 

copy to all ports or panels in the system. 
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The “Apply defaults to all existing objects” allows the parameters to be selected that should 

be transferred to all existing ports. 

The “Apply defaults…” window is divided into four areas: Panel Defaults, Call Defaults, Key 

Defaults and Audio Patch Defaults. 

 

Figure 146: Apply defaults - Apply defaults to configuration objects window 

 

The parameters that should be changed on all panels are selected with a checkmark .  

Clicking the OK button will overwrite these parameters in all ports of the system with the 

values in the Net properties. 

If you choose a panel in the “Audio Patch Defaults to apply” field the audio settings of this 

panel will overwrite the settings of all other panels in the Net. 

Attention: Individual port settings will be overwritten by this command.  
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8.16 Configuration of typical intercom functions 

 

8.16.1 Interrupted Foldback (IFB) 

IFB is a typical intercom function that is used frequently.  A source is permanently routed to 

a particular destination. If someone makes a call to this destination the permanently routed 

source is either muted or dimmed.  The dim level is adjustable.  The typical dimming range 

is from -15 dB to -30 dB. After the call to the destination is over the permanently routed 

source returns to its normal volume level. This application is used, for example, if a director 

wants to speak with the talent over an earpiece that normally receives program audio or an 

N-1.   

An additional option or requirement is the ability to listen to the talent‟s return feed, 

normally their microphone output, on a control panel.  The volume control next to the call 

key then allows the incoming volume level of the talent to be adjusted. If the volume control 

is pressed the incoming audio is either muted or re-activated. 

 

If you intend to adjust the volume level of the talent‟s return feed it is advisable to use a 4-

wire port for the talent.  The 4-wire‟s output will feed the talent‟s earpiece.  The output will 

also be used for the permanent program audio or similarly as an IFB output.  The 4-wire 

input will be used for the talent‟s microphone, which can also be connected to the 4-wire 

port of the Artist over an audio mixer.  This setup allows IFB functions to be programmed 

quickly and easily.   

 

There are three different ways to program an IFB (Interrupted Foldback).  The end results 

are the same, but the programming approaches are different. 

We recommend Method 3 (Using the IFB table), since it offers the most flexibility.   
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8.16.1.1 Method 1: DIM Crosspoint On Call 

One way to program an IFB is to use the “Dim XP Level” function in conjunction with a 4-wire 

port‟s “On Call” Virtual Function. The right side of the diagram below summarizes the 

necessary steps.   

 

Figure 147: IFB - configure IFB with DIM XP on call 

 

Step 1 

 

Figure 148: IFB - Adding the listen source 

 

 

Figure 149: IFB - Select the listen source port 

 First, select the 4-Wire or split 

4-Wire destination (output) 

port by double clicking on the 

entry in the “Ports” tab in the 

Navigation Bar. 

 Right mouse-click on the 

Virtual function “Always” and 

select “Listen to Port” from the 

“Add Function” drop-down 

menu. 

 In the properties window of the 

listen function, choose the IFB 

source port that the 4-wire 

should always hear. 

 Confirm with “OK” 
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Step 2 

 

Figure 150: IFB - Adding Dim XP Level 

 

 

Figure 151: IFB - Setting the XP Dim Level 

 

Step 3 

The IFB function is now setup correctly.  Simply drag and drop the talent‟s port to a panel 

key or 4-wire Vox function for everyone who should be able to speak to the talent.  Calling 

the talent will activate the “Dim XP Level” function. The talent‟s return feed must be 

configured separately (like every 4-wire).  If you activated the “Auto Reverse Talk for 4-Wire” 

option in Director, the return will be automatically programmed. This setup enables the 

return communication of the talent to be heard on the panel with the ability to adjust the 

volume. 

 Right mouse click on the 4-wire‟s Virtual 

Function “On Call” and select “Dim XP 

Level” from the “Add Function” menu 

 

 In the properties window of 

Dim XP under Source select 

the 4-wire of the IFB signal 

(PGM, N-1,..).  For the 

Destination select the talent‟s 

port. 

 Set the desired dim level, by 

which the IFB signal should be 

dimmed when the talent 

receives a call. 
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8.16.1.2 Method 2: DIM Crosspoint triggered by priorities 

Another way to program an IFB is to use the various call and listen priorities. A higher 

priority will dim a lower priority. The “Dim Level” is set in the Net properties window. This 

means that all IFBs programmed this way will have the same dim level. The diagram below 

summarizes this method of creating IFBs. 

 

Figure 152: IFB - configure IFBs with priorities 

 

Step 1 

 

Figure 153: IFB - Adding the listen source 

 

 First, select the 4-Wire or split 4-Wire 

destination (output) port, by double clicking 

on an entry in the “Ports” tab on the 

Navigation Bar. 

 Right mouse-click on the Virtual Function 

“Always” and select “Listen to Port” from 

the “Add Function” drop-down menu. 

 In the properties window of the listen 

function choose the IFB source port that 

the 4-wire should always hear. 
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Figure 154: IFB - Select the priority of the listen command 

 

Step 2 

 

Figure 155: IFB - Opening the Net Properties 

 

 

Figure 156: IFB - Net Properties - Port Settings 

 

Step 3 

The IFB is now setup correctly. Simply drag and drop the talent‟s port to a panel key or 4-

wire Vox function for everyone who should be able to speak to the talent. Make sure that 

the listen command on the IFB port is set to “Below Standard” priority. The “DIM” command 

will be activated by a “Call to Port” with a higher priority (standard).  The talent‟s return feed 

must be configured separately (like every 4-wire). If you activated the “Auto Reverse Talk for 

4-Wire” option in Director, the return will be automatically programmed. This setup enables 

the return communication of the talent to be heard on the panel with the ability to adjust 

the volume. 

 Right mouse click on the “Net” 

and choose “Net Properties.” 

 Select the “Port Settings” tab in 

the “Net Properties” window. 

 If necessary, change the dim level 

for the individual priority levels. 

 For example, if you set “Standard” 

to -12 dB, any crosspoint to a 

destination with “Below Standard” 

will be dimmed by -12 dB as soon 

it is called by a call that has the 

Standard priority. 

 The priorities “High”, “Paging” and 

“Emergency” work the same way.  

Lower priorities will be dimmed by 

the value set in this window. 

Set the priority level for this 

function. Normally, “Below 

Standard”  is chosen since the 

rest of the commands in the 

system usually have the priority 

“Standard.” 
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8.16.1.3 Method 3: Using the IFB tables 

As of Director version 5.90, a new method has been included for quickly and easily creating, 

editing and seeing an overview of IFBs. In the so-called IFB table, new IFBs can be quickly 

created and existing IFBs can be edited directly. 

Click on the  button in the toolbar to open the IFB table. 

 

Figure 157: IFB table - Empty IFB table 

 

Click the  button to create a new IFB. The number you enter in the field next to 

the add button  determines where the numbering of the IFBs starts. Create 

the desired number of IFBs by pressing the   button repeatedly. 

 

Figure 158: IFB table - new IFB entries 

 

The columns “Input,” “Mix Minus,” and “Output” can be renamed. Right mouse click on the 

column and choose “Rename.” 

  

Figure 159: IFB table - Renaming the IFB columns 

 

To rename individual IFBs, select the entry you wish to rename and double click on the 

name in order to change it. You may also rename the selected IFB by pressing the <F2> 

key.  The name can also be changed by right mouse clicking on the name and selecting the 

function “Edit Name”. The name can be up to 32 characters long. Confirm the new name 

with the <Enter> key. 
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To delete an entire IFB entry, select the row you wish to delete and click the 

 button or press <Delete> on the keyboard. 

The selection of several IFBs at once is possible with the <Ctrl> or <Shift> keys. 

You can now assign ports or groups to the individual IFBs. For every IFB there is the 

possibility to assign an “Input,” a “Mix Minus” and an “Output.”  

Input (Name changeable) 

Routes the selected sources to the ports that have the IFB assigned. 

For example, if a talent is selected as an input, their microphone can  

be heard by everyone who has this IFB. 

The input is not necessary for normal IFB functions. 

Mix Minus (Name changeable) 

Describes the input source that should be dimmed when the output is 

called.  For example, a program audio source that should always be 

heard as long as the talent is not called. 

Output (Name changeable) 
Describes the destination of the IFB.  For example, the talent‟s 

earpiece. 

Figure 160: Table - IFB table - column meaning 

 

Select the desired ports or groups to assign. Double click on the respective field and select a 

port/group from the drop down list. 

You can sort the list by ports or groups. By using the filter you can search for a specific 

port/group. The Director is storing the last view per column. 

 

Figure 161: IFB table - selection ports/groups 

 

For example, choose a program source for the “Mix Minus.”   

 

Figure 162: IFB table - Selecting the Mix Minus source 
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Select the desired output from the port list. You can select the output using Drag & Drop 

directly from the network tab or port list. 

 

Figure 163: IFB table - assignments by Drag & Drop 

 

The contents of selected rows can be deleted by clicking the  button. 

If desired, you can also drag the talent to the “Input”. This will result in all ports using this 

IFB hearing the audio feed from the talent directly. 

As needed, you can also set the “Dim Level” for the IFBs. This determines how many dB`s 

the “Mix Minus” is dimmed by when someone calls this IFB. Double click on this field and 

choose the desired dim level. You can also change the dim value using the <+> and <-> 

keys.   

 

Figure 164: IFB table - Setting the dim level 

 

In the “Number” column you can assign each IFB a number in order to sort the IFB table by 

number. 

Enter a key label for each IFB. Double click on the field “Key Label” and enter a name with a 

maximum of 8 characters. Confirm the name with the <Enter> key. The name can also be 

changed by pressing the <F2> key or with a right mouse click and selecting “Edit Key 

Label”. As soon as the name is changed in the table it will also be changed on all keys that 

have been assigned the IFB.  
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The newly created IFBs can now be distributed throughout the system. 

Add the new function “Call to IFB” to a key or Virtual Function using a right mouse click and 

“Add Function”. Choose the desired IFB from the list. 

    >      

Figure 165: IFB table - Adding a “Call to IFB” function 

 

You can also put IFB´s from the IFB table directly to keys or virtual functions using 

drag&drop. 

 

Figure 166: IFB table - Drag & Drop an IFB 
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In the columns “Input Gain” and “Output Gain” you can directly set the gain level of the input 

and output ports. Double click on the gain you wish to set and choose a level between -18 

dB and +18 dB. 

 

Figure 167: IFB table - Setting the gain 

 

There are also several submenus in the IFB table to help in editing IFBs and locating 

programming errors. 

If you right click on an IFB in the IFB table you can select “Usage selected IFB(s)”. This 

displays a list of all locations that can currently call this IFB. 

 

Figure 168: IFB table - Usage selected IFB(s)  

 

 

A right mouse click on a port offers the possibility to go directly to its properties or find its 

location in the various views in the configuration. 

 

Figure 169: IFB table - Properties of an IFB port 
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8.16.1.4 IFB Table: Online View 

If Director is online with the system the status of every IFB element will be shown. It is 

displayed whether or not each element already exists in the online configuration. 

             : a new IFB was created, but have not yet been sent to the system 

  : the element has been changed, but the changes have not yet been sent to the 

system 

  : the element is available in the online configuration 

 

Click the  key or press <F5> to send changes in the IFB table to the system. 

 

Figure 170: IFB table -Online view 

  

In online mode, the current audio level of the crosspoint Mix Minus -> Output is displayed 

graphically in the “Online XP” column.  

You can directly adjust this crosspoint level in the system in real-time. Double click on the 

XP level you wish to change and adjust it with the control. 

       

Figure 171: IFB table - Online XP level adjust 

    

The level can also be adjusted with the “+” and “–“ keys of your keyboard. An update with 

<F5> is not necessary.  

 

Attention: When you are using a group as in/output or Mix minus the gain-setting is not 

available.  
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If you have assigned an input port this will be displayed and heard on the control panel. In 

our example, the volume of the talent‟s microphone can be adjusted via the corresponding 

encoder. 

 

                                   

Figure 172: IFB table - IFB Crosspoint View input and no active “Call to IFB” 

 

 

 

As soon as the “Call to IFB” key is pressed, you can speak to the talent and the “Mix Minus” 

will be dimmed the set level. 

This can be recognized in the Crosspoint View  as follows:                                             

 

                                     

Figure 173: IFB table - Crosspoint View with an active IFB 
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8.16.2 ISO (Isolated Calls) 

The ISO (Isolate Call) is a special intercom function. If an isolated call is made, all other 

audio paths (call, listen, route) to the destination are muted. This is used to create a secure 

connection where the called port can only hear the ISO caller, without being distracted by 

other audio sources. In addition, the microphone at the ISO call destination is activated and 

automatically routed to the source of the call.  The person called can answer without having 

to press a key. 

No special function is needed to create an ISO call. ISO calls can be activated simply by 

clicking the “Isolate” checkbox found on the “Call to Port“ function. 

 

Activating the ISO function 

 

Figure 174: ISO - Activating the ISO function 

 

 

Figure 175: ISO - Isolate options 

 

 

 

Open the properties of a “Call to Port” on a 

key. 

Selecting “Isolate” with a . It activates the 

ISO function for this call.  As soon as this 

option has been activated, the “Isolate Self” 

box can be selected. 

Isolate: 

 Only the destination will be 

isolated from all other audio 

paths.  The microphone of 

the destination will be 

automatically routed to the 

source.   

Isolate self: 

 Both the called destination 

and the originating source 

will be isolated from all other 

audio paths.  Both 

microphones will be 

automatically opened. 
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8.17 Programming GPIs 

The General Purpose Interfaces (Input/Output) can be used to control internal and external 

system events, as well as interpreting external information for use in the system. The GPIs 

can be programmed so that they can be used just like control panel keys or Virtual 

Functions.   

The GPI In and Out default states have to be defined for both the internal GPI cards in the 

mainframe (see: 8.7.3 Adding a GPI card) as well as for GPIs in control panels (see: 8.12.18 

Panel GPI). The opto-isolated inputs can be set as either normal or inverted, in case of 

incorrect wiring or inverted voltage. The solid-state relays outputs can be set as either 

normally closed or normally open, depending on the requirements of the external devices. 

For further information on pin outs and other technical details, please see the installation 

manual. 

8.17.1 Navigation 

The details of all GPIs in the system, both central and panel GPIs, are available in the GPIO 

list. The GPI tab is best viewed with the Navigation bar docked on the top, either by clicking 

the Toolbar button  or pressing  <F10> on the keyboard.  

 

Figure 176: GPIO - Navigation Bar GPI tab 

 

All of the columns can be adjusted to display the names and other information more clearly.  

Move the mouse pointer to the line between columns until it changes to a , then hold 

down the left mouse button and adjust the column widths. 

All entries in the GPIO list are sorted alphanumerically by column. In order to sort by another 

column, simply click on the column label. Another click on the same column changes the 

sorting from ascending to descending. Clicking on other column while holding down the 

<Ctrl> key allows sorting by more than one criterion. To edit the individual GPIs, double click 

on the row or right mouse click and choose “Properties,” to open the properties of the GPI in 

a separate window for editing.  For details, see: 9.20 GPI Properties. 
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8.17.2 Assigning functions to a GPI 

To configure a GPI, right mouse click on the GPI to be programmed and select the desired 

function. 

Add Function Adds a new function to the GPI (maximum 32) 

Edit Function Changes an already existing function 

Delete Function Deletes an existing function 

Locate in Node config* Opens the hardware setup of the node and highlights the GPI 

Properties Displays the GPI‟s properties 

Figure 177: Table - GPIO - right click menu 

 
* available only for central GPIOs 

Note: If the GPI does not yet have any functions programmed to it, only the  “Add Function” 

command will be displayed. Edit and Delete functions are not available. 

 

Figure 178: GPIO - GPI functions 

 

GPI Functions 

Call to Port* Point-to-point call between two port 

Call to Conference* Multipoint-to-multipoint call.  Talk or listen to a conference (partyline) 

Call to Group* 
Point-to-multipoint call.  From one port talk to several at the same time.  

Operates only from the source to the destination 

Listen to Port* Listen to an audio source (control panel, 4-wire, etc.) 

Route Audio 
Routes audio directly from a source to a destination.  In addition, the 

crosspoint level can be adjusted (only at panels). 

Switch GPI Out Activates a local or central GPI output 

Select Audiopatch Loads predefined audio settings to a particular panel in the system 

Remote Key 
Remote control of control panel keys, lock keys or activation of key 

signalization  

Reply* Automatic call-back function for point-to-point calls 
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Dim Panel Speaker Dims the loudspeaker of a selected panel 

Dim XP Level Dims a particular crosspoint in the system 

Beep Panel Triggers an audible call signal at the selected panel 

Dial / Hangup Enables the dialing and hook control for a telephone number 

Logic Triggers a predefined logic input 

Send String* Sends a data command to higher ordered systems 

* only available for panel GPIs 

Figure 179: Table - GPIO functions 
 

All functions work the same way as if they were programmed on a panel key or Virtual 

Function. Up to 32 functions can be triggered at the same time by a single GPI. All GPIOs, 

regardless of location, can be made available to any user in the system. 

As soon as a GPI has been assigned a new function, the properties window opens to the tab 

of the corresponding function so that necessary details can be defined.  

 

Assigning a new function to a GPI 

Example: Assigning a “Dim Speaker” function to a GPI 

 

Figure 180: GPIO - Dim Speaker tab 

 

Right mouse click on the GPI and 

select “Add Function.” 

Select the function “Dim Panel 

Speaker.” 

Choose the control panel where 

the loudspeaker should be 

dimmed.  Either select the panel 

from the list or drag it to the 

destination field from the network 

list or port list using Drag & Drop.   
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Figure 181: GPIO - Dim Speaker - level options 

 

The 1000 and 2100 series control panels each have 3 GPI inputs and outputs that can be 

used just like a panel key, or alternatively can be triggered by other users in the system (see 

8.12.18 Panel GPI). 

 

A panel GPI can be used for functions that have nothing to do with the panel itself, such as 

closing a PTT contact to trigger the transmission of a radio interface. Therefore it is not 

necessary to always create a separate, often long, connection to a central GPI card.  

Instead, you can simply use the GPI contact on the panel that is closest to the radio 

interface. This can greatly reduce cabling costs and hassles.   
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8.18 Create and Manage Groups and Conferences 

Definition of a Group 

A group consists of a number of members that are addressed in a point-to-multipoint 

fashion. A single source talks to multiple destinations with one key press. However, the 

return route of a group call is always a point-to-point connection.  This means that when a 

group member answers, only the port that initiated the group call will hear the reply. This 

function is normally used to send a message to a number of people at the same time. 

Definition of a Conference 

A conference is made up of a number of ports which every member can hear. It is a 

multipoint-to-multipoint call similar in function to a conference room where anyone in the 

room can contribute at anytime. However, it is possible in Artist to block certain members 

from speaking into the conference. These members are then only allowed to hear the 

discussion.  The signalization on the conference key becomes active as soon as anyone 

speaks into the conference. For example, conferences are often used during rehearsals or 

planning exercises if it is necessary that various members should be listening at the same 

time. 

 

 

8.18.1 Groups + Confs - tab 

The details of groups and conferences are displayed in the  tab.  There is no 

separate workspace for groups and conferences. The following information can be found in 

the table on this tab: 

Long Name 
Displays the long name of the conference or group (up to 32 characters 

long, only displayed in Director) 

Type Shows whether an item is a group or conference 

GPIO OUT 
Shows which GPI output is activated, if desired, when the group or 

conference is active 

Alias / Display 8 Shows the display names or the assigned alias names 

Membercount Displays the number of members in the group or conference 

Figure 182: Table - Groups+Confs - tab column function 

 

 

Figure 183: Groups + Confs - tab 

DynaConf 

Director always includes a conference 

with 0 members.  This DynaConf is 

used internally for the “Edit 

Conference” function and cannot be 

used for normal configuration 

purposes. 

The “Edit Conference” function allows 

members to be dynamically added or 

removed from a conference using a 

control panel.  
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Figure 184: Groups + Confs - Creating groups and conferences 

 

 

Figure 185: Groups + Confs - Group properties 

 

 

Figure 186: Groups + Confs - Conference properties 

  

A GPI contact that is switched as soon as the group or conference is active can be assigned 

to a group or conference. 

In order to delete a group or conference, select the group or conference you wish to delete 

and click the  button.  

Note: Director does not ask for confirmation before deleting a group or a conference. Be 

sure you have selected the correct item from the list before deleting it. 

Creating a new group or conference 

To add a new group or conference click on either the “Add Group…” or “Add Conf…” buttons.  

This will display the properties window of the new group or conference. 

See 9.18 Conference Properties 

See 9.17 Group Properties  
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8.18.2 Adding members to a group 

Open the properties of the group by selecting the group and clicking the  button 

or simply double click on the group you wish to open. Once the group properties are 

displayed, select the “Members” tab. New group members can be added by clicking on the 

 button and choosing group members from the drop down list that appears. 

Alternatively, you can simply drag new members from the network or port lists into the 

member‟s window using drag & drop. 

 

Attention: Using drag & drop will always use the 1st audio channel of a panel. If you wish to 

add the 2nd audio channel of a panel to a group, you must add this port using the  

button and activate the “2nd Channel” option.    

 

Figure 187: Groups - adding members 

 

 

Figure 188: Groups - Properties of the members tab 

 

Attention: Director does not ask for confirmation before deleting a group member. Be sure 

you have selected the correct member from the list before deleting it. 

The member list shows all group 

members with information on port type, 

name and which audio channel is being 

used. 

To delete a member from the group, 

select the member you wish to delete 

and press the  button. 
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8.18.3 Adding members to a conference 

New members are automatically added to a conference as soon as the conference is added 

to a port using the “Call to Conference” - command. The “Call to Conference” function has 

two sides to it.  Separate “talk” and “listen” functions allows members to be individually 

assigned whether they should hear the conference or should also be allowed to talk into it.  

Control panels can be added to a conference by programming the “Call to Conference” 

function to one or more panel keys or to one of the Virtual Functions on the panel. 4-wires 

can only be assigned to a conference by programming it on a Virtual Function. It is also 

possible to assign members to conferences dynamically from a panel if the “Edit 

Conference” function is used. The following example shows how a control panel or 4-wire is 

assigned to a conference. 

 

Assigning a panel to a conference 

 

 
Figure 189: Conference - Assigning a conference to a panel key 

 

 

Figure 190: Conference - Key properties - Conference tab 

Right mouse click on a panel key and 

choose “Add Function” -> “Call to 

Conference”.  The properties of the 

key will automatically open to a new 

tab with the conference function. 

Alternatively, you can drag a 

conference to a key from the 

“Groups+ Confs” list using Drag & 

Drop. 

In this case, the “Call to Conference” 

function will always be automatically 

configured for both “talk” and “listen.”  

To later change the properties of the 

conference call, right mouse click on 

the key and choose the “Conference” 

tab. 
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Assigning a 4-wire port to a conference 

 

 

Figure 191: Conference - Assign a Conference  

to a 4-Wire 

 

 

 

Figure 192: Conference - Virtual Function properties - Conference tab 

 

 

 

 

 

 

 

 

 

 

 

 

Right mouse click on a Virtual Function and 

choose “Add Function” -> “Call to Conference”.  

The properties of the Virtual Function will 

automatically open to a new tab with the 

conference function. 

Alternatively, you can drag a conference to a 

Virtual Function from the “Groups+ Confs” list 

using Drag & Drop. 

In this case, the “Call to Conference” function will 

always be automatically configured for both 

“talk” and “listen.”  

To later change the properties of the conference 

call, right mouse click on the Virtual Function and 

choose the “Conference” tab. 

 

Choose a conference from the list 

of conference destinations. 

The “talk” privilege allows this 

member to speak into the 

conference. 

The “listen” privilege allows this 

member to listen to the 

conference. 

Select the talk and listen 

privileges as required. 
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8.19 Configuring  “Edit Conference” Function 

The “Edit Conference”- Function allows users to modify conference members on a panel. 

8.19.1 Edit Conference 

1. Make sure that a PC is connected to the Artist system. “Edit Conference” requires that 

the Director software is running, since Director handles all edit conference requests.  

One copy of the Director software must be defined for this purpose. In Director select 

“Settings” ->”Options” -> “Miscellaneous”. Click the option “Handle EditConf Requests.” 

         

        Figure 193: Edit conf - Activating the Edit Conference function 

 

       Note: Only one copy of Director in the network should have this option activated 

 

2. Create conferences, as described above, that you would later like to edit. 

3. Add a “Call to Conference” function to ports (keys or Virtual Functions) with the 

conference that should later be edited. The quickest way to do this is to drag the 

conference from the list using Drag & Drop. 

4. Choose one or more panels that should later have the ability to edit conferences.  

(NOTE: This function is only possible on 1000 series panels.)  With a right mouse click 

open the properties of the conference key and select the “Conference” tab. Select the 

check box next to “Use this command to select the destination conference during an 

Edit Conference operation”. 

The system now knows that this conference is allowed to be changed from the panel. 
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Figure 194: Edit conf - Key properties - Conference tab - properties for Edit Conference 

 

5. In addition, the panels that will be used to make conference assignments need a “Call 

to Port” command to each member that should be available for dynamic conferences.  

Drag the members from the network or port lists to panel keys using Drag & Drop. 

6. Add the “Edit Conference” function to an empty key by selecting it from the “Add 

Function” menu. The key will now display “EditConf”. To allow one-handed operation of 

the function, open the properties of the key and set the key mode to Latching with a 

timeout of around 3 seconds. Deselect the “Dim Panel Speaker” option. The “Edit 

Conference” tab contains no options to change. 

7. Finally, on all of the ports that should be able to be dynamically selected for 

conferences, the properties of the “Call to Conference” command need to be adjusted.  

One after another, open each of the corresponding ports, right mouse click on the “Call 

to Conference” key or Virtual Function and choose the “Conference” tab. Click the 

checkbox next to the option “The destination conference on this command can be 

changed by Edit conference”. 

         

        Figure 195: Edit Conf - The destination conference on this command … 
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8.19.2 Operating the Edit Conference function 

 

With this configuration it is now possible to dynamically assign members to the enabled 

conferences from a panel.  In order to do so, press the “EditConf” key. 

 

Figure 196: Edit conf - Activating the Edit Conference function 

 

Conferences that can be edited begin to blink. Press the conference that you would like to 

edit. Now all possible members that are available light up. Red LEDs above a name indicate 

that the port is not currently a member of the conference. Greed LEDs mean that the 

member is already assigned to the conference. Members can be added or removed from 

the conference by pressing their corresponding keys on the panel. You can also assign 

whether the member should be able to talk or listen. If you press the left side of the key, the 

member will be assigned the listen option (L). Pressing the right side of the key will assign 

the talk option (T). 

 

Figure 197: Edit conf - Selecting the conference to edit 

 

After you have made all of the changes you wish to make, press “Yes” in the EditConf key.  

Director will then send the updated configuration to the system. The newly edited 

conference will now be available.  

 

Figure 198: Edit conf - Adding and deleting members 

 

It is also possible to remove members from a conference with this function. As before, press 

the “EditConf” key, select a conference, and press the key of the member to be removed as 

often as needed until “Remove” is displayed.  Press “Yes” to confirm.  

The display on the conference key of the removed member changes to “DynaConf”. This key 

is thus reserved with a placeholder for when the member is again added to the conference. 
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8.20 Configuration and Operating the „Edit IFB“– Function  

With the „Edit IFB“- Function it is possible to modify IFBs apart from the IFB-Table also on 

standard panels. All changes are directly adopted to the IFB assignment and to the system.  

For editing IFB on panels, you can only use 4-wires and 4-wires split Inputs as Mix Minus 

sources.  

To use the “Edit IFB”- Function on panels it is not necessary to have a Director-PC connected 

to the system. 

8.20.1 Configuration 

Create an IFB-Table in your Director-configuration.  8.15.1.3 Using the IFB-Tables. 

Because with the “Edit IFB“- Function you can only assign or modify „Mix Minus“ sources to 

predefined IFBs, make sure you have already created some IFBs with outputs assigned in 

the IFB-Table.  

 

Figure 199: Edit IFB - IFB-Table with predefined outputs 

 

Also the „Dim Levels“ and „Gain“- Settings need to be prepared in the IFB-Table. 

Open the panel you want to edit IFBs (works only on 1000- , or 2000 series) and create the 

“Edit IFB”- function on an empty key. There are no further settings needed to use this 

function. 

    ->       

Figure 200: Edit IFB - Add function „Edit IFB“ 
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Now open the IFB-Table by pressing the  -Button.  

Drag&drop the predefined IFBs you want to use on the panel to different empty keys of your 

panel. 

 

Figure 201: Edit IFB - Drag&Drop IFBs 

 

Following drag&drop the „Mix Minus“- sources you want to use to different empty keys. Only 

4-wire or 4-wire split ports can be used with the “Edit IFB”- Function afterwards. 

 

 

Figure 202: Edit IFB - Add „Mix Minus“- ports to the panel 

 

Attention: If you are using pure 4-Wires as “Mix Minus”, you have to configure a “listen to”- 

function for every “Mix Minus”- key. 

That is all you have to do to configure the „Edit IFB“- Function. 

If you want, you can now also configure other panels with the same functionality. 
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8.20.2 Operating the „Edit IFB“- Function  

To use now the „Edit IFB“- Function on a panel, you have to press the key “Edit IFB”. All 

available IFBs on this panel will show up with red markers (depending of the settings in the 

„9.8.7 Marker Definitions“).  

Now press the key with the IFB you want to edit. The marker will change to green. 

 

Figure 203: Edit IFB - Selecting an IFB 

 

After the IFB is selected, you can assign the Mix-Minus source to this IFB. Therefore press 

the key with the source configured. The key will show „Waiting“ for a short moment. Then 

the source-key changes to a green marker.  

You can always assign just one source to an IFB. If there was another source assigned to 

this IFB before, it will be deactivated and its marker changes back to red. 

 

Figure 204: Edit IFB - Assigning of an IFB „Mix Minus“ 

 

This example shows „IFB 0002“ with assigned source „Extern 2“. If you have the “Edit IFB”-

Function also configured and activated on other panels with the same sources, you can see 

the changes immediately on all these panels.  

 

After pressing the „Edit IFB“- Button, you can also press first a source button. When this 

source is already assigned to an IFB, the according IFB-key will show a green marker. By 

pressing now another IFB key, the allocation for this source changes to the selected IFB.  
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As soon as an IFB assignment has been changed on a panel, the IFB-table shows which port 

has been changed. 

The modified IFB entry will be shown with a  in the IFB-table. The name of the new source 

port is not yet shown.  

To display the latest source names assigned to the IFBs, you have to load the system-

configuration to your PC by pressing the - button. 

 

  

Figure 205: Edit IFB - Display IFB-changes in the IFB-table 

 

You can also modify the source assignment parallel on the IFB-table. When you send the 

changes to the system, all panels with the “Edit IFB”- Function enabled will show the latest 

assignment.  
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8.21 Creating and managing Scroll Lists 

A scroll list can consist of up to 1000 different entries. They can include most commands, 

for example, “Call to Port”, “Route Audio”, “Switch GPI” etc. A scroll list can be assigned to 

each panel. Using the scroll function of a key a user can select one of the commands from 

the scroll list directly from the panel. This provides access to a host of commands that 

might only be needed infrequently without using a large number of keys. It is also possible 

to assign individual functions a fixed ID number that can be used to activate them directly 

from a keypad. 

Each panel can only have a single scroll list assigned to it.  However, any number of panels 

can have access to the same list.  A maximum of 100 scroll lists can be created.   

Attention: 3000 and 5000 series control panels cannot use scroll lists. 

Scroll list details are found in the  tab of the Navigation Bar. 

 

8.21.1 Adding a new Scroll List 

To create a new scroll list, click on the  button in the   tab of the 

Navigation Bar. This automatically opens a new window where the functions and settings of 

the list can be defined. To edit an existing list, select the list and press the  

button, or double click on the list. Pressing the  button will delete the selected 

list. Please note that Director will not ask you to confirm before deleting a scroll list. 

A unique name for the scroll list can be entered in the “Long Name” field. 

 

Figure 206: Scroll Lists - tab and properties of a Scroll List 
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8.21.2 Editing Scroll List entries and functions 

Functions can be added to or deleted from the scroll list in the scroll list‟s properties. To add 

a new function click the  button and choose the desired function from the list. To 

delete an entry from the list select it and click the  button. 

 

Figure 207: Scroll Lists - Adding a new function 

 

Standard functions, such as “Call to Port”, “Call to Group”, “Logic” and “Switch GPIO” can 

also be dragged to the scroll list from the corresponding list in the Navigation Bar using 

Drag & Drop. 

 

To define or edit a function you have added, select the function and click the  

button.  Confirm your changes with the  button to return to the scroll list view. 
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Figure 208: Scroll Lists - example 

 

To adjust the order of the entries, mark an item in the list and click the  or 

 buttons. 

 

The corresponding key properties can be adjusted for every item in a scroll list. For example, 

key mode, key label and dim function can be separately set for each list entry. Select an 

entry in the scroll list and press the  button. 

 

Figure 209: Scroll Lists - Edit Scroll List entry    

 

 

In addition, each entry in the scroll list can be assigned a unique number (Keypad shortcut).  

This number allows the function to be selected by entering the number on a numeric 

keypad.  
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8.21.3 Assigning a Scroll List to a control panel 

Each control panel, except for the 3000 and 5000 series panels, can access a single scroll 

list. To assign a scroll list to a panel, open the panel and its properties, for example by 

double clicking on the gray area on the panel view. In the “General” tab you can choose a 

predefined scroll list that the panel should be able to access under “Scroll List”.  

 

Figure 210: Scroll Lists - Panel properties - choosing a scroll list 

 

Now individual keys on the control panel can be enabled to access the list. In order to do so, 

open the properties of a key. In the “General” tab the option “Scroll enable” must be 

selected.  Any number of keys on a control panel can be set in this way. 

Note: You should only activate the scroll function on empty keys, since after the first time 

something is selected from the scroll list the original functions on the key will be 

overwritten.  The last function chosen from the list will remain even after a node reset.   

 

Figure 211: Scroll Lists - Properties of a key - scroll enable 
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8.21.4 Scroll Lists – operation from a panel 

To show the keys on a panel that have scroll capabilities, press the master volume control.  

The displays of any keys that can scroll change to “SCRL KEY”. To select an entry from a 

scroll list, double click on the volume control next to the key where you want the function to 

be assigned.  Functions can be selected in different ways:  

 searching alphabetically by name 

 using a keypad 

 by type of function 

 

8.21.4.1 Alphabetical Search 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Activate the scroll function by double clicking on the volume control 

 

 

 

Turn the encoder until “Search” is displayed. Press the encoder 

once to confirm.   

 

 

The first position in the name blinks. Choose the first letter of the 

name by turning the encoder. Confirm by pressing the encoder 

once. 

 

The second letter in the name can now chosen by turning the 

encoder. Confirm your choice by pressing the encoder once.  

Repeat. 

 

 

A long press on the encoder selects the final name. 

 

 

 

 The function can now be used. 
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8.21.4.2 Selection via a keypad 

 

                    
 

 

 

 

 

 

8.21.4.3 Selection by function type 

 

 
 

 

 

      
     

 
 

 
 

 
 

 

 
 

 
Figure 212: Scroll Lists - selecting an entry on a panel 

 

 

 

On 2000 series control panels the click function of the encoder is activated with the “SCR” 

key.  To scroll in a list on these panels use the master volume control. The rest of the 

procedure is identical to that of the 1000 series panels. 

 

Activate the scroll function by double clicking on the volume 

control.  Turn the encoder until “Search” is displayed.  

 

 

Type an assigned “Keypad Shortcuts” number into the keypad (or 

on panel keys configured as a keypad).   

 

 

The number will be displayed directly on the scroll key. 

 

As soon as the number has been correctly identified, the 

corresponding function will be automatically assigned to the key. 

 

 

 

Activate the scroll function by double clicking on the volume 

control.   

Choose the function type by turning the encoder. 

 

 
“C2 Port” means “Call to Port” 

 
 

“L2 Port” means “Listen to Port” 

 
“C2 Group” means “Call to Group” 

 
“Logic“ means select a logic source. 

Confirm by pressing the encoder once. 

 
Choose an available function by turning the encoder.   

 
Confirm by pressing the encoder once. 
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8.22 Logic Functions 

Logic functions offer the possibility to implement and combine various functions system 

wide based on particular conditions. Each logic function can have up to 8 input variables 

that can be connected to one another by logic gates as required. These inputs lead to a logic 

output which can activate one or more system actions, for example GPI outputs, audio 

routes, signalizations, the activation of keys, further logic functions, etc. In a logic function, 

inputs (logic sources) and outputs (logic destinations) are differentiated according to 

Boolean logic definitions. The logic inputs of a function can be, for example, a GPI input, a 

Vox function, or a key press anywhere in the system.   

8.22.1 Logic workspace 

In order to add or edit a logic function, click on the  tab in the Navigation bar. Next, 

the inputs and outputs of the logic function must be defined. Click on  to add a 

logic output in which the actual logic function will be built. A window opens where you must 

select a node that will process the logic function. The logic function can also be given a 

unique name.   

 

Figure 213: Logic - Logic tab 

 

   

Figure 214: Logic - Selection of a node 

 

Since a node can only manage up to a maximum of 64 logic functions, the individual logic 

functions must be assigned to a specific node. It is not relevant whether or not the logic 

inputs and outputs are actually carried out on the node assigned. It is only being defined 

which CPU on the fiber ring makes the necessary calculations for the function.  
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Create the desired number of logic inputs using the  button. 

 

Figure 215: Logic - Properties of a Logic Source 

 

In the “Properties of Logic Source…” window you can give the entry a unique long name as 

well as a display name. The “Enable for Event use” is only for use in conjunction with the 

optional “Events” special feature.  See: 14.2.8 Event: Logic Source 

Double clicking on a destination will display a white piece of paper with a pink box in the 

Workspace. This box represents the output of the logic function. Using Drag & Drop, pull the 

desired logic sources from the table to the workspace. Later, you can create the actual logic 

function with the help of logic gates. 

 

Figure 216: Logic - Drag & Drop a logic source 

 



   

                                                                                                     DIRECTOR 6.20 Configuration Software, User Manual, Version 3.4 

 

 

Page 138 

8.22.2 Logic Gates 

The logic gates can be selected in the logic function Workspace.  The following functions are 

available: 

 
Pointer, to move items and lines 

 
Create a new connection 

 
Connection Splitter 

 
AND - gate 

 
NAND - gate 

 
OR - gate 

 
NOR – gate 

 
XOR - gate 

 
XNOR - gate 

 
NOT - gate 

 
D-Flip-flop 

 
Monoflop (from 100ms – 24h, optionally retriggerable) 

 
NOP – gate (No Operation) 

 
Clock –Generator  (adjustable from 125ms – 24h) 

Figure 217: Table - Logic - Available logic functions 

 

 

 

 

 

 

 

 

 

 

IN A 

 

IN B 
 

AND 
 

NAND 
 

OR 
 

NOR 

 

 
XOR 

 
XNOR 

 
NOT 

0 0 0 1 0 1 0 1 1 

0 1 0 1 1 0 1 0  

1 0 0 1 1 0 1 0 0 

1 1 1 0 1 0 0 1  

Figure 218: Table - Logic - Truth table for the logic functions 
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8.22.3 Building a logic function 

Click on one of the logic gate buttons. The selected gate will be highlighted. Move the 

mouse pointer to the workspace. The pointer changes to a crosshair cursor  . Click once on 

the workspace to place the gate in particular place. If you click again somewhere else, 

another gate will be placed there as well. If there is not enough room to place an object the 

mouse pointer will change to   . To select another kind of gate, click on it and place it on 

the workspace. 

To move a gate you placed earlier, choose the  button, click on the gate and hold the 

mouse button down. You can now move the element as you wish. Letting go of the mouse 

button places the gate in its new position. 

To delete an element, right click on it and choose “Delete Logic Gate”. 

 

 

Figure 219: Logic - Building a logic function 
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Select the  symbol to connect the various logic elements with one another. 

The word “From” appears on the mouse pointer in black. As soon as you place the pointer 

on an available output of a source or gate, the “From” changes to green .  Click with the 

mouse and a line will be docked to the output and the pointer label changes to “To”.  As 

soon as you place the pointer over an available input, the “To” becomes green. Another 

mouse click then creates the connection between the output and input. 

 

 

 

Figure 220: Logic - Creating a new connection 

 

 

 

Figure 221: Logic - Logic Workspace 

 

 

By selecting the  symbol you can select and move an element or connection. 
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Additional parameters can be set for the logic gates “Clock” und “Monoflop”. Right mouse 

click on the gate and choose “Properties”.   

 

Figure 222: Logic - Properties of a monoflop 

 

 

8.22.4 Assigning actions to a logic function 

After the logic function has been built it must still be defined what happens when the 

conditions are fulfilled. Functions are added to a logic destination with a right mouse click 

and selecting “Add Function” just like when programming a control panel key or Virtual 

Function.  You can add functions to a logic destination either in the logic list or on the 

Workspace.     

 

A maximum of 32 functions can be carried out by a single logic function. The configured 

function will be displayed in the “Function” column of the logic tab. 

                     

Figure 223: Logic - “Add Function” on a logic destination 

 

Note: The functions “Call to Port”, “Call to Conference” and “Listen to Port” are not available 

on logic functions since a logic function is not a physical port but rather a type of virtual 

function. 

In the properties of the 

monoflop you can set its 

hold time in ms.  In addition, 

with the „Retrigger extends 

time” you can extend the 

hold time by triggering the 

monoflop again. 
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8.22.5 Creating a macro 

Logic functions offer the possibility to quickly and easily create macros. Macros can be used 

if several functions need to be carried out for every key press on a control panel, for 

example switching a particular GPI, dimming a panel speaker and activating a particular 

signalization. All of these functions can be combined together in a single logic destination.  

This saves lots of time when configuring the system. Changes to the macro can also be 

made very quickly and only in one place.  

 Create a new logic destination with a unique name 

 Create a new logic source with the same name as the destination 

 Create a logic function by double clicking on the new destination in the logic list 

 Connect the output of the new source directly with the input of the destination 

 

Figure 224: Logic - Macro logic 

 

 At the destination add the functions that should be carried out using the “Add Function” 

command. 

 Open a panel that should carry out these functions and add the source for the macro 

function to the desired keys either by drag & drop or “Add Function” > “Logic”. 

 

 
Figure 225: Logic - Macro sources programmed to panel keys 
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8.23 Log System Activity 

Director allows all system activities to be logged. This can be accomplished visually in 

Director and can be saved to a hard drive, if desired. The log offers a rich overview of the 

current system status and records all system activity during normal operation. In the case of 

system problems, the log file offers a good way to localize the issue. System alarms are 

shown in red. 

 

 

Figure 226: Logging - Log tab 

 

 

 

8.23.1 Log settings 

 

Figure 227: Logging - Settings / Options / Logging 

 

 

Choose “Settings” >“Options” in 

Director.  The log settings can be 

accessed in the “Logging” tab.  You 

can set which information will be 

displayed in “Screen logging” and 

which information will be saved to 

disk in “Disk logging”.  
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Screen logging 

Log Errors Logs hardware errors 

Log Warnings Logs warnings  

Log Special Interfaces Logs the optional software special features 

Log Node Handler /Artist Config Update Logs configuration changes 

Log Commend Port Logs the Director connection to Artist 

Log Panel active/online Logs the port status (online/offline) 

Log Matrix Activity Logs matrix activities (every key press, GPI, etc.) 

Log Configuration changes Logs configuration changes  

Log MCR Panel Operation Engine Logs MCR panel operations (optional) 

Log Scheduler Engine Logs automatic times (optional) 

 

Disk logging 

Disabled The log file will not be saved 

Full log (recommended) Saves all log file details, independent of screen login settings 

Same as Screen logging Only saves the log details that are set in screen logging 

Split into number of rotating files Maximum number of log files (FIFO principle) (recommended: 6) 

Maximum Size of each log file 

 

Size of individual log files (recommended approx.  10000kB) 

Figure 228: Table - Logging - Screen/Disk logging functions 

 

The log-files are stored as “Director-Uxx.txt” files in the same folder, the Director is started 

from. 

 

 

Tip: When you want to open several instances of Director on the same Computer, the “Disk 

logging” needs to be disabled, or you have to copy and start the different Directors from 

different folders of your hard disk. 
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8.24 Node and Client logging 

In addition to the Director log, you can transfer the internal log files of individual system 

cards to the PC. Each CPU and every client card generates its own log information recording 

the condition and internal processes of the card. In the case of system errors this 

information is very important and is used to find the cause of the problem. Director must be 

connected to the system to access the files. 

Open the “Online View” with the  button or select “View” > “Artist Online View” in the 

menu. 

 

Figure 229: Logging - Artist Online View  

 

 Make sure that disk logging is activated (Settings/Options/Logging). 

 Make sure that the file size of the log file is large enough (recommended: 6 files at 

10MB). 

 Click the  button.  The system begins to read the log files of each individual 

card and saves them. 

 

Figure 230: Logging - Transfer of Log 

 

This process can take several minutes, depending on the size of the system. 

All log information will now be saved in the Director log file in the same directory as 

Director. 
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8.25 Resolving Configuration Errors 

During the configuration process small mistakes can occur, such as creating undefined 

functions. Since such errors could have unknown effects on the system, Director provides a 

central list of all configuration errors. 

Downloads and any changes to the current system are blocked if there are any unresolved 

configuration errors. Each error reported must be corrected and removed from the error list 

prior to the software allowing a download or update to take place.  

 

Figure 231: Cfg Errors - Navigation Bar - Configuration Errors tab 

 

Clicking on the Navigation bar “Cfg Errors”  tab displays any configuration 

errors that have been detected and are unresolved.  

The width of each column can be adjusted in order to read the complete error descriptions.  

Move the mouse pointer to the edge of a column. The pointer changes to a  .  Hold the 

left mouse key pressed and drag the column to the desired width. The table is divided into 

two columns. The first column describes the exact position of the configuration error and 

the second describes the problem.  

Double click on an entry to open the properties window of the misconfigured object directly.  

You can then correct the problem.  

As soon as the configuration error is corrected it disappears from the Cfg-Errors tab. 

Repeat this process for all further errors in the Cfg-Errors list. 

Only when all configuration errors have been corrected can the configuration be sent to the 

system.  
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8.26 Monitor „Live State„  

Director offers the possibility to monitor all panels connected to the system in real-time 

using “Live State”. For example, this feature gives an exact picture of current volume 

settings and key presses for control panels. Director only offers a visual monitoring of a 

port.  The audio to and from a port cannot be monitored. 

Communication and functions between ports are normally accompanied by a signalization 

on the panel. All incoming and outgoing calls plus other active functions can be monitored 

on the basis of their signalization. Even the current state of the function keys, like “Shift” or 

“HS”, is displayed in real-time. This allows problems to be quickly found, such as a pressed 

“HS” key when no headset is connected. The monitoring can be carried out from any PC that 

has Director and that is connected via Ethernet with the Artist system. There is no limit to 

the number of PCs that can monitor the same port at the same time.   

 

Panel Workspace 

 

The “Live State”   monitoring mode is accessible from the configuration view of a port. 

 

Figure 232: Panel live state - workspace with panel configuration 

 

Double click on the port you wish to open in the port or network lists found in the Navigation 

Bar. The port will be opened on the right side of Director and the configuration view shown. 

A second port can also be displayed below the first by selecting it from the drop down list or 

by dragging it to the list from the Navigation Bar using Drag & Drop. 
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Switching to Live State monitoring 

 

The control panel worksheet contains four tabs that are used for different modes of 

operation or programming. Depending on the user rights, fewer tabs may be available. If 

you cannot see all four tabs, please contact your Artist system administrator. 

Select the tab  to switch to the monitoring view. The panel opens in real-time 

view. As long as Director is connected to the system, you possess the necessary user rights, 

and the panel is online this tab will show the current state of the panel. If you have opened 

a second port in the Workspace its live state will be shown as well. 

The panel will now be displayed with all of its current actions, volume levels and 

signalizations. The status of the Virtual Functions and GPIOs will also be displayed. If one of 

these functions is active it will be indicated by a small red signal next to the function.  

In this mode the ports can only be visually monitored. In order to make changes to the 

configuration you must return to the configuration view by clicking the  tab.  

  

 

Figure 233: Panel live state - Live state monitoring 

 



 

DIRECTOR 6.20 Configuration Software, User Manual, Version 3.4          

 

  Page 149 

8.27 Remote Control a Panel 

Using Director and the  tab it is possible to monitor and remotely control 

every port in the system in real time. The panel can be operated completely online, as if you 

were sitting directly before it. However, only the panel hardware can be monitored and 

controlled. The audio to and from the control panel is not available in Director. 

Communication and functions between ports are normally accompanied by a signalization 

on the panel. All incoming and outgoing calls plus other active functions can be monitored 

on the basis of their signalization. Even the current state of the function keys, like  “Shift” or 

“HS”, is displayed in real-time. This allows problems to be quickly found, such as a pressed 

“HS” key when no headset is connected, or muted incoming audio. The monitoring can be 

carried out from any PC that has Director and that is connected via Ethernet with the Artist 

system. There is no limit to the number of PCs that can monitor the same port at the same 

time.   

 

Panel Workspace  

 

The  monitoring is accessible from the configuration view of a port. 

 

Figure 234: Remote Control - Panels tab with panel workspace 

 

Double click on the port you wish to open in the port or network lists found in the Navigation 

Bar. The port will be opened on the right side of Director and the configuration view shown. 

A second port can also be displayed below the first by selecting it from the drop down list or 

by dragging it to the list from the Navigation Bar using Drag & Drop. 
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Switching to Remote Control Mode 

 

The control panel worksheet contains four tabs that are used for different modes of 

operation or programming. Depending on the user rights, fewer tabs may be available. If 

you cannot see all four tabs, please contact your Artist system administrator. 

Select the tab  to switch to the remote control view. The panel opens in real-

time view. As long as Director is connected to the system, you possess the necessary user 

rights and the panel is online this tab will show the current state of the panel. In addition to 

the  view, you have the possibility to remote control the panel from Director. If 

you have opened a second port in the Workspace its live state will also be shown. 

The panel will now be displayed with all of its current actions, volume levels and 

signalizations. The status of the Virtual Functions and GPIOs will also be displayed.  If one of 

these functions is active it will be indicated by a small red signal next to the function. All key 

functions, volume controls, Virtual Functions, GPIOS and function keys can now be operated 

from Director  

All remote control actions will affect the control panel in real-time.  Make sure that you have 

the correct port open.   

If you press a panel key with the mouse this action will also take place at the panel. This will 

be visually signalled in Director in that you can see the key being pressed. It is also possible 

to activate GPIOs and Virtual Functions. Click on the small dot next to the Virtual Function or 

GPIO. 

                                            

Figure 235: Remote Control - operating remote control 
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You can also adjust all of the volume controls in real-time. Click on an encoder and hold the 

mouse button pressed. Begin to slowly move the mouse in a circle in the desired direction. 

A line labelled “Turn” will be displayed that can be moved to adjust the volume level. In 

addition, the level will be shown live in Director.  

 

 

Figure 236: Remote Control - Volume Control 

 

 

To use the function keys, for example “Beep Panel”, right mouse click on the “Beep” key 

and select “Hold Pressed”. The key will remain pressed. Now you can also press the desired 

destination key. When you are finished, you can deactivate the “Hold Pressed” by repeating 

the steps above.    

 

Figure 237: Remote Control - Hold pressed 

 

 

In this mode the ports can only be visually monitored. In order to make changes to the 

configuration you must return to the configuration view by clicking the  tab.  



   

                                                                                                     DIRECTOR 6.20 Configuration Software, User Manual, Version 3.4 

 

 

Page 152 

8.28 Crosspoint View 

The Crosspoint View allows you to monitor the live state of all crosspoints in the system. It is 

activated by clicking the  button or selecting “Crosspoint View” from the drop-down 

menu “View”. 

 

Figure 238: Crosspoint View - window before configuration 

 

In order to use the Crosspoint View, you must first set up the display window to indicate 

which ports should be displayed. There are several ways to do so: 

Drag ports from the port or network list directly into the Crosspoint View. All of the active 

audio connections to or from the port will be shown, depending on whether you drag the 

port to the “Scr” (source) column or “Dst” (destination) row. Groups and conferences can 

also be dragged into the crosspoint view to display all of their members‟ audio routes.  

To quickly add all ports in the system, click on the  button. All available 

members in the system will be shown in both the “Scr” and “Dst”.  It does not matter if the 

port is online or offline. The port will be shown as red (offline) or green (online). 

 

Figure 239: Crosspoint View - example 
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Depending on the system size, it can quickly become difficult to keep a clear overview of 

the system in the window. To make this easier, you can activate the option “Show only Ports 

having active crosspoints”. This option will dynamically change the display to only show 

ports that have active audio routes. 

 

Figure 240: Crosspoint View - Show only Ports having active Crosspoints 

 

 

If you drag a port to “Scr” or “Dst”, all other ports that are configured to have an audio 

connection with this port will be automatically added.   

 

 

Figure 241: Crosspoint View - Drag & Drop in the Crosspoint View 

 

 

 

To manually edit the Crosspoint View display, click the  button.  In the configuration 

window you can add ports either as sources or destinations using the  buttons.  
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Using the   and  buttons you can change the order of ports in the list. Ports, 

groups and conferences can also be dragged directly into this window using Drag & Drop. 

 

Figure 242: Crosspoint View - Configure crosspoint display window 

 

 

In addition, there is the possibility to save the current view. Click the button  and 

give the setup a unique name. To load a previously saved setup, click the  button.  

The presets are saved with the configuration in the nodes and in the configuration file. 

 

 

Figure 243: Crosspoint View - Load crosspoint setup window 
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The “Crosspoint View” displays all active crosspoints between the selected members using 

various symbols. Each symbol shows the type of audio connection and what caused it.  

 

Figure 244: Crosspoint View - legend 

 

If a crosspoint is active because of more than one function, the “Crosspoint View” will 

always display the highest order function (the order is the same as the order of functions 

under “Add Function”). 

As soon as you hold the mouse pointer over an active crosspoint in the Crosspoint View, a 

window opens with details about the crosspoint. Information includes the volume level, 

priority and the type of audio connection. In addition, the “Reason” explains exactly why this 

crosspoint is active. 

 

Figure 245: Crosspoint View - Crosspoint information 
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To get an overview of all active crosspoints related to a certain port, position the mouse 

pointer over the port. During so in the “Scr” column will show all audio coming from that 

source, while doing so in the “Dst” row will show all active audio going to that destination.  

After a brief delay, a popup window will show all active connections and their details.  

 

Figure 246: Crosspoint View - Popup window 

 

You can change a crosspoint directly by right mouse clicking on it in the Crosspoint View.  

The function “Kill Crosspoint” manually deactivates the crosspoint. Affected control panels 

will see “Ext.Off” in their display, but users can reactivate the crosspoint from the panel if 

necessary. “Force Crosspoint” manually forces a crosspoint between a particular source and 

destination without the crosspoint existing in the configuration. This can be used for test 

and commissioning purposes. The volume level of each crosspoint can also be adjusted 

between 3 levels.  

Note: Force Crosspoint, Kill Crosspoint and changes made to crosspoint levels are not 

intended for use in the normal configuration and control of the system. Any changes made 

to crosspoints with these features are not saved in the configuration and will not be 

available after a system reset. These options should only be used for testing and 

troubleshooting purposes.  

 

Figure 247: Crosspoint View - Manipulating a Crosspoint 
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8.29 Software Updates 

New software versions for Artist are periodically available and include new features and bug 

fixes. 

Note: Every software release comes with release notes and update instructions describing 

any special update procedures. Please read these documents carefully before updating your 

system.  

 

Each software release consists of at least 3 components. A new version of Director always 

requires the current firmware in the system cards. It is imperative to update all components 

to the latest version when performing a software update. 

Director Software PC configuration and control software 

Node Firmware CPU operating system 

Client Firmware Client card operating system 

Panel Firmware Control Panel operating system (an update is not always necessary) 

Figure 248: Table - Software update components 

 

 

 

 

 

 

 

 

 

Warning: Not following correct update procedures or using the wrong update files can 

damage the system and lead to a total system failure.  If this occurs, all matrix cards must 

be sent to the factory for service and the system cannot be used. Disregarding update 

instructions will also void any warranty and service agreements.   
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8.29.1 Before beginning the update: 

Check the software versions that are currently installed on your system. 

Director Version 

The version number of Director is found under “Help” -> “About” in Director. 

 

Figure 249: Software update - About Director 

 

Node and client version 

The version information for the CPU and client cards is found in the Online View. 

Press  or select “View” -> “Artist Online View”. 

 

Figure 250: Software update - Artist Online View 

 

Before beginning an update, save your original configuration with the old version of Director! 

Start the new version of Director and open a configuration from your hard drive. 

If you receive error messages such as “duplicate commands”, “missing calls”, “MCR..”, send 

your configuration file to customerservice@riedel.net and DO NOT UPDATE YOUR SYSTEM. 

 

 

mailto:customerservice@riedel.net
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8.29.2 Director update 

  

To update Director, simply copy the new Director.exe file to the directory of your choice. 

If you use Partial Files, XY-Matrix or the Partial Files Trigger you must also copy the files 

“Director.ETR” and “Director.RPS “ from the directory with the old version of Director to 

where the new version is located.  

WARNING: Director, CPU firmware and client firmware always come together as a package!  

Different versions are not compatible with one another. Please contact Riedel Customer 

Service if you are uncertain about compatibility issues. 

Old configuration files can be opened with the new Director, but older versions of Director 

cannot open configuration files written with a newer version. 

Therefore, always make a backup copy of your configuration files before performing an 

update. This will ensure that you can still open the files with the old version of Director in 

case of an emergency. 

 

8.29.3 Firmware update      

Open the “Artist – Online View” by clicking the .  Select one of the nodes and click the 

 button. 

 

Figure 251: Firmware update - Artist - Online View 

 

Select the correct firmware file in the open “Select Firmware File” window. Director 

automatically recognizes whether the firmware is for a node or for a client card. 
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8.29.3.1 Node Update 

 

  
Figure 252: Firmware update - Selecting a node 

  

 

 

Figure 253: Firmware update - Update progress 

 

 

Figure 254: Firmware update - Successful node update 

  

 

 

 

 

 

 

After selecting a node firmware file select the node 

to update.  You can choose to update nodes one at 

a time or update them all together over the fiber 

ring. After selecting a node, click the  button.  

The CPUs indicate that an update is taking place 

through the blinking of all of their LEDs. A progress 

bar in Director also displays the update process.  A 

message will appear after a successful update.   

 

Note: if there are 2 CPUs in a node, the redundant 

CPU automatically starts when the software is being 

updated.  Do not reset the node during this time. 
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8.29.3.2 Client Update 

 

 

  

Figure 255: Firmware update - Selecting the node and client cards 

 

 

Figure 256: Firmware update - Update progress 

 

 

Figure 257: Firmware update - Successful client card update 

 

If you have several nodes connected in a fiber ring and you did not select “All Nodes” during 

the update, repeat the process above for each node. The update can be carried out from 

any PC that is connected to the Artist system. 

After updating the firmware, open the previously saved configuration with the new version 

of Director and send it to the Artist system. Reset the system (“Extras”->”Reset all Nodes”).  

The system update has been completed successfully. 

After selecting a client firmware file, you can choose to 

either update all of the cards together over the fiber ring 

or to update cards individually.  After selecting a card, 

click the  button. The client cards signal that an 

update is taking place through the blinking of all of their 

LEDs.  A progress bar in Director also displays the update 

process. A message will appear after a successful 

update.   

Tip: If you have VoIP cards in your system, the client card 

update can take longer than an update without VoIP 

cards. 
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9 FUNCTIONS AND FEATURES IN DETAIL 

This part of the document provides supplementary information on the functions and 

features of the Director software. All functions and settings will be described in detail. 

9.1 Menu Bar 

The Menu bar provides the basic set of functions needed to manage the Director software.  

Many of these functions are identical to those in other Windows programs.  

There are six main menus that each contains further functions. 

 

Figure 258: Director - Menu bar 

 

 

9.1.1 File 

With the file menu you can open, save and manage configuration files. You can also send 

changes to the system and read out configurations. 

 

Figure 259: Menu bar - file options 
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Menu Bar - File Commands 

New 
Creates a new empty configuration 

(Keyboard shortcut: Ctrl + N) 

Open… 
Opens an existing configuration file 

(Keyboard shortcut: Ctrl + O) 

Import… 

Imports a configuration from a hard disk to the current configuration.  

The current configuration and the configuration imported will be 

merged 

Compare with… 
Compares the current configuration with an existing configuration on  

hard disk  

Save 

Saves the active Director configuration with its current file name to  

hard disk. 

(Keyboard shortcut: Ctrl + S) 

Save as… Saves the active configuration under a different file name, location 

Open Partial Configuration… 

Opens a partial configuration file *.PAR, which only makes partial 

changes to the existing configuration 

(Only available if the Partial File option is installed) 

Save Partial Configuration as … 

Saves only a part of the configuration as a *.PAR file.  The details to 

be saved can be manually selected. (Only available if the Partial File 

option is installed) 

Open from ARTIST 
Loads the current configuration from an online Artist system to 

Director 

Import from ARTIST 

Imports the current configuration in Artist to the configuration open 

in Director. The current configuration and the configuration imported 

will be merged 

Compare with ARTIST 
Compares the configuration in Director to the current system 

configuration in Artist 

Save to ARTIST (overwrite) Sends the complete configuration in Director to the Artist system 

Save Changes to Artist (merge) 
Sends only the changes in the configuration open in Director to the 

Artist system 

Print… Prints system information such as port lists, GPIs, etc. 

User Login Select user and password entry 

Exit Closes Director 

Figure 260: Table - Menu bar - File functions 
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9.1.2 Edit 

The “Edit” menu can adjust some basic settings in order to make changes in the 

configuration.  

 

Figure 261: Menu bar - Edit options 

 

9.1.2.1 Menu Bar - edit commands 

Cut Currently not available 

Copy Currently not available 

Paste Currently not available 

Special Interfaces 
Adds/removes Special Interfaces to/from the working 

configuration 

Marker definition… Opens the marker (signalization) properties for panels 

Copy panel… 
Copies a complete panel configuration or  Audiopatch to one or 

more panels 

Apply defaults to 

configuration objects… 

Globally applies NET properties to all ports in the configuration 

(See: NET Properties) 

Update Trunking key labels 
This function updates port names in a trunked system (See: 

Trunking)  

Figure 262: Table - Menu bar - Edit functions 

 

9.1.2.2 Special interfaces 

 

Figure 263: Menu bar - Edit - Add special features 

 

Using the menu selection “Add” you can add the “Audio/Video Router” or “Master Control 

Room” option software modules. Note that this will also require either a special USB dongle 

or an activation code. (See: 11 Special Features) 
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9.1.2.3 Marker definitions 

 

Figure 264: Menu bar - Edit - Marker definitions 

 

 

9.1.2.4 Copy Panel 

 

Figure 265: Menu bar - Edit - Copy Panel 

 

 

Choose the source panel that should be copied. 

Add destination panels using the  button or 

Drag & Drop. 

To delete panels from the list, select them and 

click the  button.  To remove all panels, 

click the  button.  

To only copy the Audio Patches from the source 

panel, choose the option “Copy Audiopatches 

only”.  None of the keys or other functions of the 

destination panels will be changed. 

To copy the panel, click . 

Note: All settings and keys will be overwritten at 

the destination panel. Panels can only be copied to 

other panels of the same type. 

In “Marker Definitions”, all panel 

signalizations can be changed for each 

panel type. 

 (See: 9.8.7 Marker definitions) 
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9.1.3 View 

 

Figure 266: Menu bar - View options 

 

Menu Bar View Commands 

Standard Toolbar Displays or hides the standard Toolbar 

Status Bar Displays or hides the Status Bar 

Artist Online View Opens the Artist Online View window 

Config Transfer Toolbar Displays or hides the Artist Update button 

Navigation Bar Displays or hides the Navigation Bar 

Crosspoint View Opens the Crosspoint View 

Alarms Opens the Alarm window 

MCR - Online View 
Opens the MCR Tool 

(Only available if this option is activated) 

Events – Online View 
Opens the “Events” window 

(Only available if this option is activated) 

Interruptible Foldback (IFB) Opens the IFB configuration table 

Scheduler – Online View 
Opens the Scheduler window 

(Only available if this option is activated) 

VOIP Statistics 
Opens the VoIP connection statistics window (if the system 

contains a VPIO 108 card) 
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Audio/ Video Router Interface 
Opens the Audio/ Video Router Interface window 

(Only available if this option is activated) 

Partial Files XY-Matrix 
Opens the XY-Matrix window 

(Only available if this option is activated) 

Partial Files Trigger 
Opens the Partial File Trigger window 

(Only available if this option is activated) 

Dock Navigation Bar left 
Docks the Navigation Bar to the left side of Director 

(Keyboard shortcut: <F9>) 

Dock Navigation Bar top 
Docks the Navigation Bar to the top of Director 

(Keyboard shortcut: <F10>) 

Figure 267: Table - Menu bar - View functions 

9.1.4 Settings 

 

Figure 268: Menu bar - Settings 

 

IP address of local Node… Opens the IP address entry window 

Connect (Network On/Off) 
Activates / deactivates the IP connection to the Artist or 

Performer system 

Options… Opens the Options window 

Colors Allows changes to be made to the port list‟s color scheme 

Figure 269: Table - Menu bar - Settings functions 

 
 

9.1.4.1 IP-Address of local Node 

 

Figure 270: Settings - ARTIST Node IP Address 

In Settings system parameters and user options can be defined.  

Manually set the IP address of the node you 

wish to connect to.  The drop down menu 

contains the last 10 IP addresses entered. 

If you are connecting to a node with 2 CPU 

cards, check the option “This is an Artist 

M/32/64/128 node with redundant 

controller card”.  This ensures that Director 

looks at both IP addresses and that it can 

switch to the 2nd CPU if necessary. 
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9.1.4.2 Options - Logging 

 

Figure 271: Menu bar - Settings - Options - Logging 

 

Screen logging 

Log Errors Logs hardware errors 

Log Warnings Logs warnings  

Log Special Interfaces Logs the optional software special features 

Log Node Handler /Artist Config Update Logs configuration changes 

Log Commend Port Logs the Director connection to Artist 

Log Panel active/online Logs the port status (online/offline) 

Log Matrix Activity Logs matrix activities (every key press, GPI, etc.) 

Log Configuration changes Logs configuration changes  

Log MCR Panel Operation Engine Logs MCR panel operations (optional) 

Log Scheduler Engine Logs automatic times (optional) 

 

Disk logging 

Disabled The log file will not be saved 

Full log (recommended) Saves all log file details, independent of screen logging settings 

Same as Screen logging Only saves the log details that are set in screen logging 

Split into number of rotating files Maximum number of log files (FIFO principle) (recommended: 6) 

Maximum Size of each log file 

 

Size of individual log files (recommended approx.  10000kB) 

Figure 272: Table - Logging functions 

 

The log-files are stored as “Director-Uxx.txt” files in the same folder, the Director is started 

from. 

 

Tip: When you want to open several instances of Director on the same Computer, the Disk 

logging needs to be disabled, or you have to copy and start the different Directors from 

different folders of your hard disk. 

The various log parameters can be 

set in the Logging tab. 
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9.1.4.3 Options - Partial Files  

Partial Files is a special software feature that allows certain parts of a configuration to be 

saved to a file and later opened. Partial Files must be activated with either an activation 

code or a special USB dongle before it can be used. For details see: 12.1 Partial Files 

 

Figure 273: Menu bar - Settings - Options - Partial Files 

 

Handle Partial Files Trigger 

operations initiated by  

Logic Sources 

By checking this box it is possible to load partial files with a Logic 

Source. Only one PC in a network should have this option activated.  

That PC must then be permanently connected to the Artist system.    

If a logic source triggers a partial file the PC will automatically 

manage the configuration changes. 

Restrict crosspoints 
Tick this box to use the XY-matrix in such a way that crosspoints will 

not be automatically released when a new one is activated.  

Standalone mode All partial files are located on the local PC. 

Server mode 

Only for use with Partial Files client/server. Activating server mode 

makes Partial Files available to other computers. The control of the 

files will be handled by the client PC. 

Client mode 

Only for use with Partial Files client/server. When client mode is 

activated, this PC takes control of the partial files on the server PC.  

This allows remotely controlling the partial files. 

Server IP to connect to 
Only for Partial Files client operation. Enter the IP address of the 

server PC here. 

Figure 274: Table - Partial file functions 
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9.1.4.4 Options - Autosave 

 

Figure 275: Menu bar - Settings - Options - Autosave 

 

Autosave the current Director configuration 

Autosave working configuration 

Activating this option saves the current Director configuration  

at predefined intervals. The files are saved in the directory 

where Director resides 

Time interval Defines how often the file is saved 

Number of rotating Sets the number of rotating backup files 

File name prefix Provides individual names for the backup files 

Set to Default Sets the names of the backup files to factory presets 

Open folder… 
Opens the folder where the backup files are stored  

(same directory as Director) 

 

Autosave the online configuration 

Autosave online configuration 

Activating this option saves the current configuration from the 

Artist system that the PC is connected to at predefined 

intervals. The files are saved in the directory where Director 

resides. 

Time interval Defines how often the file is saved. 

Number of rotating Sets the number of rotating backup files 

File name prefix Provides individual names for the backup files 

Set to Default Sets the names of the backup files to factory presets 

Open folder… 
Opens the folder where the backup files are stored  

(same directory as Director) 

Figure 276: Table - Autosave functions 
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9.1.4.5 Options - Miscellaneous 

 

Figure 277: Menu bar - Settings - Options - Miscellaneous 

 

Show live status in the panel and GPI 

lists 

Check this box to display the online status of ports and GPI 

activity 

Handle EditConf requests triggered 

from panel keys 

Tick this box to define this PC as the one handling the  

EditConf requests from the Artist system (only one PC in a 

network should have this option activated at a time) 

Handle MCR operations triggered by 

Panels / Logic Sources 

Tick this box to define this PC as the one handling MCR Tool 

requests (only one PC in a network should have this option 

activated at a time) 

Handle the Scheduler 

Tick this box to define this PC as the one handling scheduled 

events (only one PC in a network should have this option 

activated at a time) 

Ask for confirmation when saving the 

configuration to Artist with overwrite 

Tick this box to require a confirmation prompt before 

performing the "Save to Artist (overwrite)" command 

Auto Reverse Talk for 4-Wire 

Tick this box to activate this configuration tool.  When active,  

a return audio connection will be automatically programmed 

on 4-wire ports when a “Call to…” command to the port is 

programmed elsewhere 

The Alarms window should 

automatically pop up for new 

important alarms 

Tick this box to allow the Alarms window to open 

automatically when a new system alarm occurs 

Do not show the configuration transfer 

dialog for short, successful updates 

Tick this box to deactivate the transfer dialog for successful 

updates.  The window will only be shown if the configuration 

update was not successful 

Show panel key mode 

Tick this box to show key modes in the panel view 

(M: Momentary, L: Latching, A: Auto) 

 



   

                                                                                                     DIRECTOR 6.20 Configuration Software, User Manual, Version 3.4 

 

 

Page 172 

Automatically adjust speaker dim and 

key mode 

When this option is active, Director automatically deletes the 

dim panel speaker function for commands where the panel‟s 

microphone is not used. The key mode for special functions is 

also automatically set to latching  

Initial Tab in Panel View 
Defines the tab that is initially selected when opening a   

panel 

Show legacy Panels 

When this option is active, older panel types will also be 

displayed in the port type list when defining matrix ports (ex. 

xCP, 10xxB). This function is normally deactivated 

Figure 278: Table - Options - Miscellaneous functions 

 

 

Figure 279: Options - Miscellaneous - Show Panel Key Mode (Momentary, Auto, Latching) 

 

9.1.4.6 Colors 

Allows the display colors in the port list to be changed 

 

Figure 280: Menu bar - Settings - Colors 

 

 

 

9.1.5 Extras 

The Extras features provide the means to reset various aspects of the system and to register 

and activate special features.   

 

Figure 281: Menu bar - Extras 
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9.1.5.1 Set System-Time on all nodes  

Synchronizes the internal clocks on all nodes in the net to the PC‟s clock 

 

Figure 282: Menu bar - Extras - Set System Time on all nodes 

  

 

 

9.1.5.2 Reset all nodes 

Resets all available nodes on a fiber ring, as soon as the reset command is confirmed. A 

complete system reset takes approximately 20-40 seconds, depending on the system size. 

 

Figure 283: Menu bar - Extras - Reset all Nodes 
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9.1.5.3 Reset Tree … 

The reset tree allows panels, client cards or nodes to be reset individually, without affecting 

the rest of the system. 

 

Figure 284: Menu bar - Extras - Reset Tree … 

 

Select the item that you would like to reset. Depending on where you mark the reset tree 

( ), all components below that point will be reset. You can choose to reset a complete node, 

only a certain client card or a particular panel. 

 

9.1.5.4 Assign new Configuration ID 

This command is only used when merging two configurations that were originally created 

from the same configuration file (see also: 8.6.7 Merge). Please note that a new 

configuration ID makes any Partial Files incompatible to the merged configuration.  

 

Figure 285 Menu bar - Extras - Assign new Configuration ID 
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9.1.5.5 Register special features … 

Use this function to register any special features you have purchased. You will need an 

activation code from Riedel that is only valid for a single PC.  Special features include: 

 Partial Files 

 Audio Video Router 

 Master Control Room 

 Scheduler/Events 

For details see “11.1 Unlocking Software Add-ons” 

 

 

Figure 286: Menu bar - Extras - Register Special Features 
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9.1.6 Help  

Here you can find additional information about the Director software and Riedel support 

services. 

 

Figure 287: Menu bar - Help options 

 

Command line arguments… 
Allows an automatic start up of Director.  Changes the options for 

the Director.exe shortcut 

Limits… Describes the system limits of Artist 

Support… Displays the contact information for Riedel support 

About… 
Opens the Director start up window (splash window), which 

displays information such as the version number  

Figure 288: Table - Menu bar - Help functions 

 

 

Figure 290: Menu bar - Help - Command Line Arguments… 

 

 

 

Figure 292: Menu bar - Help - Limits… 

 
Figure 291: Menu bar - Help - About… 

 
 

 

 
Figure 289: Menu bar - Help - 

Support… 
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9.2 Toolbar 

The toolbar provides quick access to the most important and most often used functions. 

 

Figure 293: Director - Toolbar 

 

 
New Opens a new blank configuration file 

 
Open Opens an existing configuration file 

 
Save 

Saves the current configuration in Director under its 

current file name 

 
Print Prints selected information about the configuration 

 
User Login Select user and password entry 

 
Net Connect / disconnect the network connection to Artist 

 
Dock Navigation Bar left 

Docks the Navigation Bar to the left side of Director 

window (= F9) 

 
Dock Navigation Bar top 

Docks the Navigation Bar to the top of Director window  

(= F10) 

 
Audio/Video Router Interface Opens the Audio/Video Router Interface window 

 
Partial Files - XY Matrix Opens the Partial Files XY-Matrix 

 
Partial Files Trigger Opens the Partial Files Trigger window  

 
Master Control Room Opens the MCR user interface 

 
Events Opens the Events window 

 
IFB Opens the IFB table 

 
Scheduler Opens the Scheduler window 

 
Crosspoint View Opens the Crosspoint View window 

 
Online View Opens the Online View window 

 
Alarms Opens the Alarms window 

 
VoIP Statistics Opens the Statistics window for all VoIP connections 

Figure 294: Table - Director - Toolbar buttons 

 

The position of the toolbar can be moved both within and outside of the Director window. 
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9.3 Navigation Bar 

The Navigation Bar provides the basic functions for creating an Artist configuration. The 

individual tabs in the Navigation Bar allow the programming and editing of the system. 

 

Figure 295: Director - Navigation bar 

 

There are 10 different tabs on the Navigation Bar. Some are also associated with their own 

Workspace that is used for the programming and display certain features. Only one tab can 

be selected at time, but other tabs can be selected even if the workspace of a different tab 

is open.  

 

Network Set up the net and the hardware configuration of the node 

Ports Port and panel properties / view 

Scroll-Lists Creation and management of scroll lists for control panel keys 

Cfg Errors Displays configuration errors 

Log Displays log entries from Director 

Logic Program and edit logic functions 

Trunking Management of trunking assignments 

GPI View and edit central and panel GPIs 

Groups + Confs Create and edit groups and conferences 

Users Create and edit users and user rights 

Figure 296: Table - Director - Navigation bar tabs 

 

The Navigation Bar can be repositioned by dragging it with the mouse. It can also be moved 

outside of the Director window, for example to a second monitor. This provides the 

maximum viewing area in the Workspace.  
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9.4 Workspace 

The Workspace is used to program and view system functions in association with the 

Navigation Bar tabs. This includes, among other features, the configuration of the system, 

ports and control panels and creating logic functions.  

 

Figure 297: Director - Navigation bar - Workspace 

 

The corresponding Workspaces are normally accessed by double clicking on an entry in one 

of the tabs of the Navigation bar. 
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9.5 Update Bar 

The Update Bar manages the transfer of configuration data between Director and the Artist 

system. There are 3 ways to transfer configurations. They can only be used if there is a 

working IP connection to the system, there are no configuration errors, and the user has the 

necessary user rights.  

 

 

Figure 298: Director - Update Bar 

 

 
Open Online Configuration (from Artist) 

Loads the current configuration in Artist to  

Director (the existing configuration in Director can 

be saved beforehand) 

 
Save to ARTIST (overwrite) 

Sends the complete configuration from the PC to 

the Artist system 

 
Save Changes to ARTIST (merge) 

Sends only the changes made to the configuration 

to the Artist system  

Figure 299: Table - Director - functions update buttons 

 

 

 

 

Warning: If several Director PCs are connected to the same system at the same time, only 

the “Save Changes to Artist” button  should be used.  Otherwise, the changes made by 

one PC may be overwritten by another PC. 

It is strongly recommended to load the current system configuration to the PC with the  

 button before making any system changes. 

If you use “Partial Files”, do not save the configuration from Artist for use as a template for 

other configurations.  Any active partial configurations may have changed the file from its 

original settings. Before saving a file with “Partial Files”, make sure that no “Partial File” is 

active. 
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9.6 Status Bar 

The Status Bar shows detailed information about the configuration status and the status of 

the connection to Artist.  

 

 

Figure 300: Director - Status bar 

 

 

A Ethernet data bandwidth and connection status 

B Number of objects created in the configuration 

C User currently logged in 

D 

Network status and the number of nodes connected.  The IP address of the node  

Director is connected to is shown if the connection is active.   

A yellow background when Director is connected to a node means that the Artist system 

contains an active, functioning configuration. 

E Network connection and data traffic icons 

Figure 301: Table - Director - Status bar functions 

 

The Status Bar can be moved and placed outside of the Director window. 
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9.7 Online View  

Using the “Online View” window you can monitor nodes, change basic settings and update 

firmware in the cards in the mainframe. The Online View is normally only needed during 

initial system setup, for software updates, troubleshooting or when system parameters 

need to be changed. The current software version of individual cards in the system is also 

displayed.  For day-to-day use, the Online View is not relevant. 

You can open the „Online View“ in „View“>“Online View“ or with the button  

Note: The use of the Online View, changing system parameters and updating firmware 

should only be done by trained personnel.  Access to the “Online View” can be controlled 

using user rights.   

The “Node Frame EEPROM” and “Client Card EEPROM” buttons are only for use by Riedel 

service personnel.  

 

Figure 302: Director - Online View 

 

9.7.1 Node properties 

Basic settings for each individual node can be changed in the node properties window.  

Select a node in the Online View and click the  button. 

 

Figure 303: Online View - Node Properties 
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To change settings you must first tick the box next to the setting you would like to change. 

WARNING: Changes should only be made by trained personnel.. 

Set Node Address 
Set the node address here (addresses begin at 2).  See:8.6.6.1 Setting the 

Net and Node addresses 

Set Ethernet Address Shows the Ethernet MAC address. Changes are not possible 

Set IP Address Set the IP address of the node 

Set Subnet Mask Set the Subnet Mask 

Set Default Gateway Set the gateway (if needed) 

Set Ringclockmaster to 

Activates the node as ring clock master. This node will provide the audio 

clock to the fiber ring. The green LED on the CPU of the clock master will 

blink.  WARNING: Only one node in a fiber ring should be set as ring clock 

master. 

Set Synchronize to   

External Clock  

If a node is set to Ringclockmaster, it can also be set to synchronize to an 

external clock. This requires an optional sync module in the node 

Set Ethernet Hub feature   

to 

This function can tunnel an Ethernet signal over the fiber ring.  WARNING: 

Only use this option if the individual nodes are not running on the same  

IP network 

Set local Trunk Controller  

to 

If you want to use trunking, one node on the fiber ring must be defined as 

the Trunk Controller. This node then handles any trunking requirements 

Figure 304: Table - Online View - Node Properties functions 

 

After making changes, click the button “Send changes and reset the Node”.  The selected 

node then undergoes a reset. 

 

9.7.2 Write log data 

This button offers the possibility to read out the internal log files of all system cards in the 

mainframe. The information will be placed in the Director log files. For details see: 8.23 

Node und Client logging  

 

 

 

9.7.3 Update firmware 

This button is used to update the internal operating system, firmware and the individual 

system components. This includes the node, client and panel firmware. For trouble free 

operation, all system cards must have the same software version. The corresponding 

version numbers are found in the Online View. For further details on updating software see: 

8.28.3 Firmware Update 
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9.8 Net Properties 

The tabs of the Net Properties define the default settings that are applied to all nodes, 

panels and system wide settings. Of course, these settings can also be adjusted individually 

for each panel, if required. 

The properties window can be opened by right mouse clicking on the NET in the Navigation 

Bar.  Each tab of the net properties can change different parameters.  

9.8.1 General 

The “General” tab allows you to give a meaningful name to the NET. 

 

Figure 305: Net Properties - General tab 

 

Long Name 
The net can be given a meaningful name in Director. Up to 32 characters 

can be used 

Address 
The Address is a reference address assigned by the system;  

it cannot be changed by the user 

Figure 306: Table - Net Properties - General tab 



 

DIRECTOR 6.20 Configuration Software, User Manual, Version 3.4          

 

  Page 185 

9.8.2 Port Defaults 1 

Default volume level settings for control panels can be changed in the “Port Defaults 1” tab. 

 

Figure 307: Net Properties - Port Defaults 1 tab 

 

Min. Speaker Vol. Minimum speaker volume level on a control panel 

Min. Headset Minimum headset speaker volume level on a control panel 

Beep Volume Volume of the Beep tone 

Beep On Call Duration Duration of the initial beep tone prior to a call (if configured) 

Speaker Dim Level 
Level that the control panel loudspeaker is dimmed when a key is 

pressed 

Hardware 
Selection of hardware type for 1000 series panels (E = with encoder,    

B = no encoders) 

Fn-Key Assignment 
Allows assignment of the special function key layout for 1000 B-series 

panels 

Initial single volume Standard point-to-point volume 

Initial conference volume Standard conference call volume 

Figure 308: Table - Net Properties - Port Defaults 1 tab 

 

 

 

 

NOTE: If changes are made to these global default settings, the changes will only affect new 

ports defined after the changes were made. 

If changes to the defaults should apply retroactively to all previously configured ports, you 

must select “Edit” -> “Apply defaults to configuration objects”. This will also overwrite all 

previously made changes to individual port settings.  
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9.8.3 Port Defaults 2 

The “Ports Defaults 2” tab can change default settings for VOX sensitivity, LED brightness 

levels and busy signals. 

  

Figure 309: Net Properties - Port Defaults 2 tab 

 

Vox On-Threshold Signal level above which the Vox switch is activated 

Vox Off-Threshold Signal level below which the Vox switch is deactivated 

Vox Hold Time 
Duration a Vox switch remains active after the signal level falls 

below the Off-Threshold 

Brightness of LEDs / LCD Keys Brightness of the signalization LEDs/LCD keys 

Brightness of LED Keys / LCD Brightness of the 8 character LED / LCD panel key displays 

Enable In-Use Indication … 
Triggers a busy signalization on other panels when the panel is 

called or when it calls someone 

Enable Mute Function 
Activates the "Press to Mute" function on the panels' rotary 

encoders 

Enable for RRCS control Enables third party control of the system 

Response Timeout 

Internal system timeout for panel response. This value must be 

increased on remote panels connected via IP because of longer 

response times.  

Response Timeout Telephone 

Codec 

Internal system timeout for panel response. This value must be 

increased on remote panels connected via ISDN because of 

longer response times. 

Response Timeout VoIP Port 

Internal system timeout for panel response. This value must be 

increased on remote panels connected via VoIP because of 

longer response times. 

Figure 310: Table - Net Properties - Port Defaults 2 tab 
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NOTE: If changes are made to these global default settings, the changes will only affect new 

ports defined after the changes were made. If changes to the defaults should apply 

retroactively to all previously configured ports, you must select “Edit” -> “Apply defaults to 

configuration objects”. This will also overwrite all previously made changes to individual port 

settings.  

9.8.4 Port Settings 

The “Port Settings” tab manages the dim levels for the various call priorities and other 

miscellaneous port settings. 

 

Figure 311: Net Properties - Port Settings tab 

 

Dim lower Prios for "Standard" 
Volume level by which “Below Standard” calls are dimmed 

when a “Standard” priority call is received 

Dim lower Prios for "High" 

Volume level by which calls with “Standard” or “Below 

Standard” priorities are dimmed when a call with “High” priority 

is received 

Dim lower Prios for "Paging" 

Volume level by which calls with “High”, “Standard” or “Below 

Standard” priorities are dimmed when a call with “Paging” 

priority is received 

Dim lower Prios for "Emergency" 

Volume level by which calls with “Paging”, “High”, “Standard” or 

“Below Standard” priorities are dimmed when a call with 

“Emergency” priority is received  

Reply-Key Timeout 
Timeout after which the last call is no longer displayed on the 

“Reply” key 

Character set 
Enables Director to be switched to the Katakana character set 

(Japan) 

Minimum XP-Volume Currently not  available 

Figure 312: Table - Net Properties - Port Settings tab 
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9.8.5 Key Defaults 

The “Key Defaults” tab can change the default settings for control panel keys. 

 

Figure 313: Net Properties - Key Defaults tab 

 

Key Mode 
Specifies the key behaviour  

Auto (latch/non-latch), Momentary, Latching 

Latching Timeout: Defines the timeout for Auto and Latching mode keys 

Activate Speaker Dim 
Activates the “Speaker Dim” function as soon as a panel key  

is pressed 

Scroll Enable Allows the use of Scroll Lists on the keys 

Restore Volume Level 
When activated, dynamically assigned conferences return  

with their last volume level 

Action when muted key is pressed 
Determines the behaviour of a muted key when the key is 

pressed 

Figure 314: Table - Net Properties - Key Defaults tab 

 

 

 

NOTE: If changes are made to these global default settings, the changes will only affect new 

ports defined after the changes were made. 

If changes to the defaults should apply retroactively to all previously configured ports, you 

must select “Edit” -> “Apply defaults to configuration objects”. This will also overwrite all 

previously made changes to individual port settings.  
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9.8.6 Call Defaults  

In the “Call Defaults” tab the default priorities for the various audio functions can be set.  

 

Figure 315: Net Properties - Call Defaults tab 

 

Call Priority Below Standard Lowest Priority 

  Standard   

  High   

  Paging   

  Emergency Highest Priority 

Figure 316: Table - Net Properties - Call Defaults tab 

 

 

 

 

 

 

NOTE: If changes are made to these global default settings, the changes will only affect new 

ports defined after the changes were made. 

If changes to the defaults should apply retroactively to all previously configured ports, you 

must select “Edit” -> “Apply defaults to configuration objects”. This will also overwrite all 

previously made changes to individual port settings.  
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9.8.7 Marker Definition 

The signalizations on control panels can be managed in the “Marker Definition” tab. For 

every function available in Artist, the corresponding signalization can be edited.   

 

Figure 317: Net Properties - Marker Definition tab 

 

Set to defaults 
These buttons reset the markers for 1000 series, 2000 series and 

RIF-1032 / RIF-2064 panels back to factory default settings 

Preview level 

Shows how the markers will appear when the volume control on the 

panel is changed (only for 1000 series panels).  Move the slide with 

the mouse 

Edit definition… 
Opens the edit marker window (can also be reached by double 

clicking on a marker) 

Figure 318: Table - Net Properties - Marker Definition tab 
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9.8.7.1 Edit Marker  

Click the  button or double click on a marker to edit the marker. Each marker 

can be set separately for each control panel type. 

 

Figure 319: Net Properties - Marker definition tab - Edit Marker 

 

Persistence Timeout 
Defines how long a marker is displayed after the corresponding 

command has been terminated 

User-defined name 
Allows a marker name to be entered (only available for the user 

defined markers 0-17) 

Priority 
Defines the marker‟s priority (highest priority = 1). Used to define 

which marker is visible when several functions are on a single key 

Background color 

For 1000 series panels: color of the marker (except for possible 

volume level display). For each of the 8 LEDs one of 4 states can be 

chosen (off, red, yellow, green) 

Show crosspoint level in 

foreground 
Activates the display of the volume level in the foreground 

Crosspoint level color Color of the volume control indicator 

Muted crosspoint level color Color indicating the volume level is set to mute 

Flash Sets the marker to flash on and off 

Base color Defines the default color for 2000 and 3000 series control panels 

Flash to color 
Sets the marker on 2000 and 3000 series control panels to flash to 

another color 

LED state Defines the marker for a RIF-1032 / RIF-2064 

Figure 320: Table - Net Properties - Marker definition tab - Edit Marker 
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9.8.8 Rights 

The “Rights” tab manages the user rights of the net. A “Rights” tab is found in all 

“Properties” windows.  See: 9.22 User Rights  

 

Figure 321: Net Properties - Rights tab 
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9.9 Node - Properties 

In the “Properties of the Node” the default settings of the node are defined. The properties 

window can be opened with a right mouse click on the node in the Navigation Bar or by right 

clicking on the node in the net Workspace.  

 

Figure 322: Node Properties - Opening the Node Properties 

9.9.1 General 

The “General” tab manages the node identification details. 

 

Figure 323: Node Properties - General tab 

 

Long Name A unique description of the node (maximum 32 characters) 

Address 
Enter a valid node address (except 0 or 1).  The node address must 

correspond to the address of the connected node 

SOA Audio channels used.  Automatically assigned by the system 

NOA Audio channels used.  Automatically assigned by the system 

Figure 324: Table - Node Properties - General tab 
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9.9.2 Error mask  

The “Error mask” defines which system components can cause an alarm. The alarms are 

displayed red in a pop-up window in Director, when you are connected online. Choose the 

components that are included in your system.  

 

Figure 325: Node Properties - Error mask tab 

 

9.9.2.1 ALARMS 

When you are connected to the system, you might see the Alarm window. It will pop up, if 

there are any alarm-messages created by the system, like wrong firmware version of a card, 

a not working or present component, etc. You can also open this window by pressing       

  

There are two differentiated alarm categories: 

Message in red     =  Alarm (automatically pop up of the window) 

Message in black  =  just information (no automatically pop up of the window) 

In the Error mask tab of the Node properties, you can select which hardware component 

should be monitored and show up as a red alarm. 

 
Figure 326: Alarm - Window 
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By doing a double-click on an entry, you get detailed information. Helpful for long error 

descriptions. 

 

 
Figure 327: Alarm Details 

  

Also if there are errors shown, you still can up- and download configurations to/from the 

system. 

 

When all alarms are resolved, the Alarm-window stays open until you close it manually. So 

when a Alarm appears and disappears by itself, you can see that there was a problem, also 

when you are not sitting all the time in front of the Director. You can open the Director-Logs, 

to see what the problem was. 

 

In “Settings” > “Options” > Miscellaneous” you can also disable the automatically pop up of 

the alarm window. 

 

 

 

9.9.3 Relay 1 mask 

In addition to the alarms in Director, the alarm relays on the CPU rear cards can also be 

used to report errors. The “Relay 1” tab defines which errors should trigger Relay 1 to open 

(the relay is normally closed).  

 

 

Figure 328: Node Properties - Relay 1 mask tab 

 

The option “This relay should only be triggered by errors in the local node” means that the 

relay will only be activated by errors in the local node. If this option is not set, the relay will 

react to any of the defined errors in any node within the fiber ring.  
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9.9.4 Relay 2 mask 

The “Relay 2” tab defines which errors should trigger Relay 2 on the CPU rear card to open.  

 

Figure 329: Node Properties - Relay 2 mask tab 

 

The option “This relay should only be triggered by errors in the local node” means that the 

relay will only be activated by errors in the local node. If this option is not set, the relay will 

react to any of the defined errors in any node within the fiber ring.  

 

 

9.9.5 Rights 

Corresponding user rights can be managed in the “Rights” tab. A “Rights” tab is found in all 

“Properties” windows.  See: 9.22 User Rights  

 

Figure 330: Node Properties - Rights tab 
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9.10 MADI – Client Card Properties 

 
Each MADI card supports 8 MADI channels. The card can access any 8 channels from an 

established MADI data stream and bring them into the intercom system. Each card can also 

send 8 channels to an established MADI data stream. If more than 8 channels are required, 

individual MADI cards can be cascaded. The connection between cards is accomplished 

with either 2 coax cables or a duplex fiber optic cable.  

 

Figure 331: MADI - Cascading cards 

 

To add a MADI client card to the configuration, select the desired bay in the node 

configuration and choose the MADI-108 G2 client card. 

 

Figure 332: MADI - Adding a MADI card 

 

All available port types can be selected on the individual ports of a MADI card. 
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MADI cards will also appear in the network view in Director. Right mouse click on a MADI 

card to set its default properties. 

 

 

Figure 333: MADI - Opening MADI properties 

 

 

 

General 

In the “General” tab of each card you can set the frame length, which MADI channels are 

used, as well as the connection type to the next MADI card or device (“Electrical” or 

“Optical”).  

 

Figure 334: MADI - Properties of MADI Client Card - General tab 
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Frame length Defines whether a 56 or 64 channel MADI system is being used 

MADI Channels 
Selects which 8 audio channels this MADI client card uses (1-8, 9-16,   

17-24, 25-32, 33-40, 41-48, 49-56, 57-64*) 

MADI Up Interface Selects the uplink interface (COAX or fiber) 

MADI Down Interface Selects the downlink interface (COAX or fiber) 

Figure 335: Table - MADI - Properties functions 

 
 

9.11 VoIP  

VoIP 108 client cards are available for the Artist 32/64 and Artist 128. The VoIP card allows 

8 ports to be remoted via an Ethernet connection. You can choose whether you want to use 

the ports for 4-wires, 4-wire splits or control panels. Sending 4-wire ports over VoIP cards is 

an easy way to connect two Artist networks with one another. For example, using the “Trunk 

Navigator”, IP connections could function as “Trunklines”. (For trunking details, see: 16 

Trunking). 

An additional interface on the panel side is required to remote a control panel over a VoIP 

connection (for example, CONNECT IPx8, CONNECT IPx2). The interface converts the IP data 

to an Artist compatible AES signal. 

 

 

 

Figure 336: VoIP - Application example 
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9.11.1 VoIP - Client card properties 

To add a VoIP client card to the configuration, select the desired bay in the node 

configuration and choose the VoIP-108 G2 client card. 

 

Figure 337: VoIP - Adding a VoIP-108 G2 client card 

 

After adding the card, you can define the port types for the 8 available ports. All available 

port types can be selected on a VoIP card. 

Switch to the “Network” view to set the default settings of the VoIP card. Right mouse click 

on the card and choose “Properties”. 

 

Figure 338: VoIP - Opening the VoIP Properties 

 

In the “Properties” window you can enter the IP settings for the VoIP 108 card. 

 

Figure 339: VoIP - Properties of the VoIP-108 card 
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Enter the IP address that the card should use in your local network in the “IP-Address” field. 

The local IP range can be set in “Network mask”. 

To enable access to other IP networks (for example, internet access), enter the IP address of 

your router in the “Default Gateway” field.  Contact your network administrator for details. 

 

Figure 340: VoIP - IP settings 

 

9.11.1.1 VoIP - DNS 

DNS serves as a “phone book“ for the network by translating IP addresses into human-

friendly computer hostnames. DNS allows connecting to network members by entering the 

unique DNS-name. You can decide if you want to enter the IP-, or the DNS address to 

connect to a device. Also if the IP- address of a device has been changed in the same 

network, you can reach it always with the DNS name. 

If your network supports the DNS (Domain Name System) - functionality, you can enter the 

IP address of your DNS-Server into „Primary DNS server“. If you have also a secondary DNS 

Server, you can enter the IP in into „Secondary DNS Server“.    

You can enter the DNS host name of your VoIP card in „DNS hostname“. 

   

Figure 341: VoIP - DNS settings 

 

9.11.1.2 VoIP - SIP port 

If the standard SIP-port 5060 is already in use within your network by another SIP 

application, you can choose another SIP port for the Artist VoIP communication. Contact 

your network administrator to get a usable port. You can enter the new port setting in „SIP 

TCP/UDP Port“. 

ATTENTION: The Sip - port is related to all 8 matrix ports on this VoIP card. The settings of all 

devices connected to this card (Panels, VCP-10xx, SIP-Phone, etc.) needs to be modified to 

the same SIP - port setting. (For VCP10xx see: Setup VCP-1004/VCP-1012)  

 

Figure 342: VoIP - SIP Port 
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9.11.1.3 VoIP - QoS 

Quality of service is the ability to provide different priorities in your network to different 

applications, users, or data flows, or to guarantee a certain level of performance to a data 

flow. For example, a required bit rate, delay, jitter, packet dropping probability and/or bit 

error rate may be guaranteed. Quality of service guarantees are important if the network 

capacity is insufficient for applications such as voice over IP,  since these often require fixed 

bit rate and are delay sensitive, and in networks where the capacity is a limited resource, for 

example in cellular data communication. 

Please contact your network administrator if there is already a QoS code for VoIP 

application available in your network. You can enter this code in “Quality of Service”- 

“Differentiated Services Code Point (DSCP)” to prioritize the Artist VoIP packets. The default 

setting is “0”, so no QoS support. 

 

Figure 343: VoIP - QoS settings 

 

9.11.2 Creating VoIP Ports 

Create the port type you want to connect to the VoIP card in the hardware setup of a node. It 

is the same procedure then creating a port type on a standard digital client card. On a VoIP 

card you have 4 different possibilities. 

 4-Wire / 4 Wire-Split:  

VoIP-connection to another Artist system (also an installed VoIP card required) 

Only Audio is transmitted via VoIP. You can free route this audio in the destination 

system. 

 Any hardware Panel type:  

You can connect any panel or analogue/AES 4-Wires. A Riedel Connect IPx2/x8 is 

required on the opposite side.  

 Software-Panel  

Any PC with the VCP-1004/1012 Softpanel, soundcard and network connection 

installed can be connected to a VoIP card. You can use your PC as a full member of the 

intercom system.  Per VoIP port you can use one Softpanel. 

 SIP-Telephony (new in version 6.20) 

Allows to use IP-telephony by using the standard SIP-protocol. With this functionality 

you can call any SIP-phone connected to the network/Internet. 

 

You can completely free mix these possibilities within a VoIP card 
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Select the port type you want to use for every VoIP port in the hardware setup: 

 

Figure 344: VoIP - available port types 

 

Now you can set the IP parameters for the individual ports. Right mouse click on a port and 

select “Properties”. Choose the “VoIP” tab. 

 

Figure 345: VoIP - Properties of a VoIP port 

 

Remote Host Enter the destination IP address that this port should connect to 

Remote SIP-ID 
Enter the name of the destination port that should be connected to.  

VoIP cards usually use the name “Port „number x”  

Local SIP-ID 
Enter the name of the local port.  VoIP cards normally use the name 

“Port „number x” 

Audio Codec 

Select the desired audio codec. Depending on the quality of the codec, 

a larger bandwidth may be required.  The following codec‟s are 

currently available: PCM, G.711, G.722 PLC 

Audio Packet Size 
Enter the audio packet size. Many transmission failures can be resolved 

by choosing the smallest possible packet size 

Receive Buffer Size 

Set the receiving buffer size. The larger the value, the more information 

from the stream is temporarily saved. This will also increase the audio 

delay.  This value should be adjusted depending on the quality of your 

IP connection 

QoS 
Some network devices support “Quality of Service”. That means that 

certain data packets have priority over others, such as internet data  

Voice activity detection 

(VAD) 

This option reduces data transmission. Data will only be transmitted if 

it contains an audio signal 

Figure 346: VoIP - Properties functions 
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Enter the values required by the remote station to establish a connection.  

To connect two Artist systems via VoIP-108 G2 cards, select a 4wire/4wire split as port-type 

and set the parameters in the remote system using its Director software.  

If you want to remote one or more panels/4-wires over VoIP using a CONNECT IPx2 or x8, 

you must first set the parameters of the CONNECT IP and the individual ports using the 

corresponding web interface. For details, see the interface manuals. To remote a control 

panel over VoIP, a data rate of at least 80kB/s is required, depending on the audio codec. 

As soon as all of the parameters are correctly set up, the IP connection will be automatically 

established. If a destination port is connected, it will appear green in the Director port list.  

The individual VoIP ports can be configured and assigned functions like any other port in the 

system. 

 

 

 

 

 

 

 

9.11.3 Bandwidth calculation 

The VoIP transmission is based on two parts, control (signalization) data and audio 

data. The control data is very constant and can not be influenced by the user. The 

audio data depends on several factors:  

 

 Configured audio codec 

 Configured packet size 

 Network type 

 Jitter 

 Voice activity (if enabled) 

 

The bandwidth for the control data is quite constant: 20 kb/s. 
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9.11.3.1 Audio bitrates required by the codec‟s 

Each audio codec has different properties and one of it is the audio data bandwidth. 

This is the data which is used for the raw audio excluding any network protocol 

overhead. 

Codec Required 

audio 

bandwidth 

Audio- 

bandwidth 

Notes 

G711 U-law 8k 64kB/s 3,5kHz Mainly used in the USA 

G711 A-law 8k 64kB/s 3,5kHz Standard Codec 

G711 U-law 16k * 128kB/s 7kHz Mainly used in the USA 

G711 A-law 16k* 128kB/s 7kHz Standard Codec 

PCM 8k* 128kB/s 8kHz Uncompressed audio 

RARe U-law* 64kB/s 3,5kHz 
Riedel Codec. Similar to G711, but 

with better dynamics 

RARe A-law* 64kB/s 3,5kHz 
Riedel Codec. Similar to G711, but 

with better dynamics (for USA) 

G722 64kbps PLC* 64kB/s 7kHz 
PLC= Packet Loss Concealment 

(automatic error correction) 

G722 48kbps PLC* 48kB/s 7kHz 
PLC= Packet Loss Concealment 

(automatic error correction) 

* not available for VCP-1004 Softpanel 

Figure 347: Table VoIP - Audio codec bandwidth 

 

 

VoIP traffic is not streamed over the network. It is separated into packets.  

For each VoIP channel the user can individually select the size of the packets: 20ms, 40ms, 

80ms or 160ms. Default is 20ms. When the transmitter wants to send a packet, it has to 

wait until enough audio is available for sending, e.g. for a 40ms packet it has to wait 40ms. 

So the delay depends on the packet size. Small packets create less delay, but create more 

protocol overhead, because you need to send more packets for the same amount of audio. 

E.g. 20ms packets add 8 times the protocol overhead as 160ms packets. 

 

 

 

 

 

 

9.11.3.2 UDP Protocol 

The audio data is encapsulated into UDP datagrams which adds protocol 

overhead. 

Each packet UDP adds 64 Bits overhead resulting in additional bandwidth.  
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Audio packet size Packets/Second Bandwidth                    

bw UDP protocol 

20 ms 50 3,2 kb/s 

40 ms 25 1,6 kb/s 

80 ms 12,5 0,8 kb/s 

160 ms 6,25 0,4 kb/s 

Figure 348: Table - VoIP UDP Protocol bandwidth 

 

9.11.3.3 IP Protocol 

The UDP packets are encapsulated into IP datagrams.  

Each IP packet adds 160 Bits overhead.  

Audio packet size Packets/Second Bandwidth                         

bw IP protocol 

20 ms 50 8 kb/s 

40 ms 25 4 kb/s 

80 ms 12,5 2 kb/s 

160 ms 6,25 1 kb/s 

Figure 349: Table - VoIP IP Protocol bandwidth 

 

9.11.3.4 Ethernet Protocol 

The network protocol depends on the network type. E.g. Ethernet is using the Ethernet 

protocol. Wide area networks are based on DSL, Cable, E1, T1 etc. and use other protocols 

and therefore create different overhead. Thus the same IP traffic results in different network 

traffic between the LAN and the WAN. This example only handles Ethernet networks as an 

example.  

The Ethernet protocol adds 144 Bits overhead for each Ethernet packet. 

Audio packet size Packets/Second Bandwidth                    

bw Network protocol 

20 ms 50 7,2 kb/s 

40 ms 25 3,6 kb/s 

80 ms 12,5 1,8 kb/s 

160 ms 6,25 0,9 kb/s 

Figure 350: Table - VoIP Ethernet Protocol bandwidth 
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9.11.3.5 Jitter 

Jitter is the time variation of the VoIP packet transmission. It has an influence on 

the bandwidth, since the transmission is not constant when there is network 

jitter. Regarding a limited timeframe, it can happen that there are less packets 

transmitted, resulting in a lower bandwidth. Of course the opposite can also 

happen, resulting in a temporary higher bandwidth. Theoretically the temporary 

bandwidth could be infinite. It‟s nearly impossible to calculate the bandwidth 

variation caused by Jitter beforehand. As an advice it‟s a good idea to have 25% 

bandwidth reserve. The user should check the Jitter and the bandwidth variation 

when the system is installed. 

For more detailed information, please check the “VoIP Network Planning Guide”, 

available for download in the www.riedel.net member area. 

9.11.3.6 Calculation example for a VoIP SIP-Port: 

 

Audio Codec:         G.722, 64kps  

Audio Packetsize: 20ms 

Networktype:        Ethernet LAN 

   

Bandwidth Total     =  bw ControlData                               =>  20 kb/s 

                                  +  bw AudioCodec                               =>  64 kb/s 

                                  +  bw UDP Protocol Overhead           =>  3,2 kb/s 

                                  +  bw IP Protocol Overhead               =>  8    kb/s 

                                  +  bw Network Overhead                   =>  7,2 kb/s 

 

                                                                                                 102,4 kb/s 

 

Artist VoIP channels have a configurable Voice activity detection (VAD) flag. Per 

default it is enabled, which means that the audio transmission stops, when the 

audio drops below the Vox threshold. In this case the bandwidth is reduced to 

bwControlData (20kb/s). The network should always be designed to transmit the 

bandwidth for a permanent audio signal, but VAD is a nice feature to reduce the 

data volume in practice. 

 

ATTENTION: This calculation is just a theoretically example. It is not paying 

attention of any local network factors like Jitter, etc. So you have to add around 

+25% bandwidth overhead to be on the save side. 

 

 

 

 

 

 

 

 

 

 

http://www.riedel.net/
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9.11.4 Distribute a panel / 4-wire with CONNECT IPx2 / x8 

 

Figure 351: CONNECT IP x2 /x8 

 

With the Interfaces CONNECT IPx2 and CONNECT IPx8 you can distribute  2-, resp. 8 - Matrix 

ports via VoIP. By defining the hardware you can choose if you want to use digital Panel 

ports (AES) or analog audio ports as IO´s on the CONNECT IPxX. Every port can be 

connected to another VoIP-client card. This means, you can connect one CONNECT IPxX to 

different matrixes at the same time. The assignment of the ports is just done by the IP-

address and the SIP-ID´s in the different Systems.  

 

Figure 352: CONNECT IPx2/x8 - Application example 

 

To edit the basic setup of the CONNECT IPx2/x8 you have to connect the device via a LAN to 

a PC. Please note, that the PC and the CONNECT IPxX needs to be in the same IP range.  

The Default IP-address of a CONNECT IPxX is 192.168.42.160 

9.11.4.1 Configuration of the CONNECT IPx2 / x8 

Open any Internet-Browser on the PC and enter the IP-address of the CONNECT IPxX to get 

into the webinterface of the device. 

 

Figure 353: CONNECT IPxX - Open the webinterface 
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Login to the webinterface: 

 

Username:  Admin  

Password:            Admin 

 
Figure 354: CONNECT IPxX Login 

 

Now you have access to the webinterface. On the homepage you get general information 

about the device, like IP-address, software version and status. 

 

Figure 355: CONNECT IPxX - Webinterface - Info 

 

In „Network Configuration“ you can change the IP-address, Networkmask, Gateway and SIP-

Port, if needed. 

 

Figure 356: CONNECT IPxX - Webinterface - Network Configuration 

 

ATTENTION: Only change the default SIP-Port, if the default Port 5060 is already used by 

another application in your network. When you change the SIP-Port in the CONNECT IPxX, 

you also have to change the SIP-Port on the connected VoIP-cards. In this case, the new SIP-

Port is used for all 8 Ports of the VoIP-card. See 9.11.1.2 VoIP - SIP Port. 
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Press „Apply” to accept the new settings. In the following window press 

 to reboot the CONNECT IPxX with the new settings.  

If needed, you can also change the Device name, Username and password in „Device 

Configuration“.  

 

Figure 357: CONNECT IPxX - Webinterface - Device Configuration 

 

In „Port Configuration“ you can give different names (= SIP-ID) to the single ports of the 

Connect IPxX. The default-names for the ports in the CONNECT IPxX and the VoIP-card is 

“Port1 – Port8“. With the button „Apply“ you can accept the new SIP-ID´s per port. 

 

Figure 358: CONNECT IPxX - Webinterface - Port Configuration 

 

ATTENTION: Exactly the same names (SIP-ID´s) need to be used for the Director 

configuration of the ports. This is necessary, because the configured port on the VoIP-card 

and on the CONNECT IPxX uses this ID to connect. You can change the SIP-ID in the Director 

configuration in the “Properties” of the VoIP-Port. 

When you are using a Stereo AES 4-wire with separated channels (see 8.7.2.3 Configuring a 

2 channel 4-wire port), you have to activate the flag „Insert the audio of the next port…“ for 

the port in the webinterface. Then the audio of the following even port is routed to the 2.nd 

channel of the odd port. A 2-channel Panel or 4-wire (with 2nd channel flag active) will be 

detected and routed automatically. 

All further settings will be done in the Director configuration. 

For more detailed information about the CONNECT IPxX please read the „CONNECT IPx2-8 

Setup“ - guide, you can download from www.riedel.net as registered user. 

http://www.riedel.net/LinkClick.aspx?fileticket=oCEwUTnKmqs%3d&tabid=606&mid=1318&language=de-DE&forcedownload=true
http://www.riedel.net/LinkClick.aspx?fileticket=oCEwUTnKmqs%3d&tabid=606&mid=1318&language=de-DE&forcedownload=true
http://www.riedel.net/
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9.11.4.2 Configuration of the VoIP-Ports in Director 

When you have created a new port, for example a panel on a VoIP-card (see 9.11.2 Creating 

VoIP Ports), open the “Properties” of the port with a right click on the port. Open the “VoIP” 

–tab.  

Now enter the IP-address and the exact SIP-ID of the port on the CONNECT IPxX that should 

be used. 

 

Figure 359: CONNECT IPxX - Director - Port configuration 

 

Choose the audio codec, audio packet size and receive buffer size for this port you want to 

use (see 9.11.3 Bandwidth calculation). 

NOTE: These settings only need to be set in the Director configuration. When the CONNECT 

IPxX is connected, all settings are automatically set for this port in the CONNECT IPxX. 

When the CONNECT IPxX is connected, you can see the status of all ports in the VoIP 

Statistics of the Director or in the Webinterface -> “Status” of the CONNECT IPxX .  

 

Figure 360: CONNECT IPxX - Webinterface - Status 
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9.11.5 Softpanel VCP-1004/ VCP-1012 

Up from version 6.10 you can also use the free virtual Softpanel VCP-1004 and the fee 

required VCP-1012 to be connected to a VoIP card.  

With the VCP-10xx you can use any Windows® PC as a full intercom member. A soundcard 

and a connection to the VoIP network are required. For audio in- and output the sound 

device of your PC is used, that is set as default in your PC settings. 

There are 4/12 keys on 2 layers available. They can be configured like any other panel key 

by the Director. To operate the keys a PC-Mouse is required.  

 

 

Figure 361: VCP-1004 / VCP-1012 

 

Attention: For every Softpanel one port of the VoIP card is required. 

9.11.5.1 Installation of the VCP-1004/VCP-1012 Softpanel 

Download the VCP-1004 Softpanel from www.riedel.net. Unpack the file in any folder. 

A double click on „VCP-1004-Setup.msi“/„VCP-1012-Setup.msi“.will start the installation 

process. 

Attention: The VCP-1012 is fee required. Starting and using the panel is only possible, if you 

have a Riedel USB-Dongle installed and connected to your computer with this feature 

enabled. 

The required „NET Framework 2.0“ will be installed automatically if it is not yet installed on 

your PC. With „Setup.exe“ you can start the „Dotnetfx“ installation also manually. 

 

Figure 362: VCP-10xx - Softpanel Setup-Files in Explorer 

 

     ->     

Figure 363: VCP-10xx - Installing VCP-1004 

http://www.riedel.net/
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If you want you can select another folder to install the application. Select if this application 

should be installed for all PC users or only the actual one. 

    ->     

Figure 364: VCP-10xx - Installing VCP-1004 

 

When the VCP-1004/1012 is successfully installed, you can find the application in the 

program group “Riedel”. A shortcut on your Desktop will be automatically generated. 

        

Figure 365: VCP-10xx - starting VCP-1004 

 

9.11.5.2 Setup VCP-1004/VCP-1012 

To start the Softpanel, double click the icon  .  

If your PC is not yet connected to any network the VCP-10xx will show “No Link” in the 

Displays. 

 

Figure 366: VCP-10xx - VCP-1004 No Link 

 

Connect your network card with a LAN network. The VCP-1004 will show “Wait_for connect” 

automatically. 

 

Figure 367: VCP-10xx - VCP-1004 Wait for Connect 
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Press the  - button, to change to basic settings of your Softpanel. In the options window 

you can enter the SIP-Username of your panel.  

 

Figure 368: VCP-10xx - SIP Name 

 

Attention: The same SIP User name needs to be used later also in the Director 

configuration. 

In „IP-Address“ automatically the IP-Address of your PC network card is used. If you have 

more network cards installed, you can select, which IP (>network card) should be used for 

the VCP-1004. 

 

Figure 369: VCP-10xx - IP Address 

 

 

Figure 370: VCP-10xx - SIP Port  

 

In „Local SIP-Port“ you can change the network port for the SIP connection to be used. For 

example, if the default SIP-port 5060 is already used by another application on your PC  

Attention: The SIP-Port of the VCP-10xx and the Sip-Port of the VoIP-card the panel is 

connected to, needs to be identical. 

In the properties of the VoIP-card you can edit the SIP-Port of the VoIP-card. If you change 

the SIP-Port, all 8 Ports of the VoIP card are affected!  

See 9.11.1.2 VoIP – SIP port   
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9.11.5.3 Configuration VCP-10xx in Director 

Do a double click on a Node in the Network-Tab to open the hardware configuration. Select 

the port of the VoIP card you want to use for the new Softpanel. Create a new VCP-1004 

panel by selecting it from the drop-boxes „Miscellaneous“ -> „VCP-1004“. 

 

Figure 371: VCP-10xx - Creating a new VCP-10xx 

Afterwards the new panel will show up in the “Port”- and also in the “Network” tab of the 

Director 

Open the properties of the new VCP-10xx with a double click on the displayed panel or by 

doing a right click on the panel in the Network- or Port list. Select “Properties”.  

 

Figure 372: VCP-10xx - Director-View VCP-1004 

 

Select the tab „VoIP“ to configure the connection settings to the VCP-1004. All other tabs 

are nearly identical with standard panels. 

Enter the IP-address of the PC with the installed VCP-1004 into “Remote Host”.  

Also enter the SIP-ID of the Softpanel into “Remote SIP-ID” and “Local SIP-ID”. The ID needs 

to be identically with the ID given in the settings of the VCP-1004 application. 
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Figure 373: VCP-10xx - Properties of VCP-10xx - VoIP 

 

Depending of the quality of your network, you can now also adjust the audio-codec type and 

also the “Audio Packet Size” and “Receive Buffer Size” if it is necessary to get a stable 

connection to the Softpanel. 

Now you can configure the keys of the VCP-1004 in the Director like on all standard panels.  

Send the configuration changes to your Artist system.  

When all settings are correct and the Softpanel application is running and connected to the 

network, the VCP-1004 on your PC should now connect to the Artist. 

 

Figure 374: VCP-10xx - Connected VCP-1004 Panel 

 

The panel will now also show a green online status in the “Port” tab of the Director. 

You can now also monitor and control the VCP-1004 panel in „Live View“ and „Remote 

Control“ in the Director like every other hardware panel. 

 

9.11.5.4 Operate VCP-10xx on the PC 

The VCP-10xx Softpanel is using the standard sound device installed in your PC for incoming 

and outgoing audio. If you want to change the audio device (for example to an USB-Headset) 

you have to set the new device as default in your Windows settings. Restart the VCP-10xx 

application to use the new device for your Softpanel. 

To press a key on the Softpanel just move your mouse to the key and press the left mouse 

button.  
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Figure 375: VCP-10xx - Activating a key on VCP-1004 

 

To change the volume of a key, you have to click the rotary encoder and keep the mouse 

button pressed. Now move your mouse in circles to change the volume. If you just do a short 

click on a rotary encoder, you can mute/unmute the incoming audio of the key.  

 

Figure 376: VCP-10xx - Changing Volume on a VCP-1004 

Press  - button to switch to the 2nd page of the panel. When the Panel shows the 2nd 

page, the “Shift” button is marked yellow .  

Like on all other panels you can enter the option menus of the panel with the buttons  

and  + .  

On the “Opt” page the keys show on which Port of the Artist system this VCP-1004 is 

connected to and also the own name. 

The installed Client version and the used Roomcode for this panel is shown in the keys 

when you first press  and then . 

  

 

Figure 377: VCP-10xx - Option Display 

 

With the button  you can minimize the VCP-1004 to the Taskbar. Press the button  to 

minimize the application to the system tray . In both situations the application is 

still active and incoming audio is coming out of your speaker. 

When the VCP-1004 is losing the connection to the VoIP card, it will show also up in the 

symbol of the task bar. 

 > VCP-1004 not connected                          > VCP-1004 connected            
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9.11.6 SIP - Telephony (new in version 6.20) 

To use IP - telephony, an installed VoIP card and an available SIP-Server is necessary.  

Create a new port on a VoIP card in the node configuration table. Choose “Miscellaneous” > 

“Sip Phone Connection” to create a new SIP Phone. This SIP phone is now working like a 

standard telephone codec with a straightforward telephone number. 

 

Figure 378: SIP phone - creating a new SIP-Phone 

 

The new SIP-Phone shows up in the „Network“- tab with its own symbol. 

 

Figure 379: SIP Phone - SIP-Phone in the Network 

9.11.6.1 SIP-Phone Basic setup  

Before you can use IP-Telephony, you have to know the needed log-in information to your 

SIP-Server. These account information need to be entered into the Artist configuration.  

Open the „Properties“ of the SIP-Phone port and go to the „SIP Phone connection“ tab. 

 

Figure 380: SIP Phone - connecting to a  SIP-Server 

 

 

 

Following data‟s need to be entered, that the VoIP port is able to connect and log-in to a SIP-

server. Please contact your network administrator or phone provider to get all needed 

information. 
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Domain server (SIP PBX) 
Enter the DNS-Name or IP-address of your SIP Server (also called 

Registrar) the VoIP card need connect to. 

Username (SIP ID) Enter the SIP-ID or Username for your phone port.  

Display name 

Here you can enter a name, which should be displayed on other 

compatible phones, when this port is calling. Not all PBX are 

supporting this feature. 

Authentification username Login name for this telephone member on the PBX system 

Authentification password Login-password for this telephone member on the PBX system 

Reregister time(s) 
Enter the time, the port should reconnect and reregister to the PBX 

system. Depending on the used PBX 

SIP transport protocol 
Select if the UDP or TCP IP protocol is used for the communication 

with the PBX. Depending on the used PBX 

Figure 381: Table - SIP Phone - Settings 

 

 

When all settings are correct, the SIP port should connect to the PBX. The SIP port will show 

green in the “Ports” tab. Also you can see the connection status in the VoIP statistic window. 

(See 9.11.6 VoIP Statistic) 

 

Figure 382: SIP Phone - successful log in to SIP Server 

 

If your PBX is using a different SIP-Port, you can adjust it in the “Properties” of the VoIP 

card”. 

9.11.6.2 Creating of PoolPorts 

PoolPorts are the members that belong to a SIP Port. You can create several members with 

unique names, which can use the connection of a single SIP port. All are using the same 

outgoing number but can have different destination numbers configured. In „Phone No. 

Incoming“ in „Properties“ of the PoolPort you can add a fix allocation to designated 

incoming numbers. Only one PoolPort can use the Sip-Phone connection at the same time.  

To create new PoolPorts open the „Properties“ of the PoolPort and go to the tap „Port Pool“ 

 

Figure 383: SIP phone - Properties - PoolPorts 
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Press  to add a new PoolPort. Minimum one PoolPort is required per SIP 

Phone. The number of PoolPorts per Sip Phone is not limited.  

Select one of the PoolPorts and press  to define this Port as „Voice default“. 

This settings tells the system, which PoolPort should be used, when a caller with an 

unknown number is calling into the system. 

 

Figure 384: SIP Phone - creating PoolPorts and defining Voice defaults 

 

 

ATTENTION: Also if only one PoolPort is created, you have to define it as “voice  default“ to 

accept incoming calls with unknown or not configured numbers.  

If the PoolPort should only accept incoming calls of a defined number, you have to enter 

this number into „Incomimg number“ in the Properties des PoolPort. All other incoming 

calls will be blocked. 

 

You can see all created PoolPorts also in the „Network“ list of the Director underneath the 

SIP Phone port. 

 

Figure 385: SIP Phone - PoolPorts in the Network 
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9.11.6.3 Configuration of the PoolPorts 

Open the „Properties“ (right click->Properties) of a selected PoolPort to edit the basic 

settings. 

The tabs „General“, “Details 1+2“ etc. are identically to the settings of an ordinary 4-wire. To 

edit the telephony connection settings open the new tab „SIP phone connection, pool port“ 

 

Figure 386: SIP phone - connection, pool port 

 

In “Phone No. To dial“ you can enter a telephone number to call, when this port is activated 

with the “Dial” function. If you want to dial different numbers via a telephone keypad this 

field can also stay empty. 

In „Phone No. Incoming“ you can enter a number (or just a part of a number), that is allowed 

to call this PoolPort. Now only callers with this number (or part of the number) are accepted. 

All other callers will be blocked. 

In „Audio Codec“ you can select the audio codec and audio quality which should be used, 

when you are starting an outgoing call. You can select G711 or G722 with a bandwidth of 

64kBit/s each 

 

Figure 387: Sip Phone - Audio Codec‟s 

 

Depending of the quality of you network, you can adjust the size of the “Receive Buffer”. The 

size of these settings dedicate how many ms of the incoming audio should be buffered to 
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avoid audio drops. In a bad network this setting can improve the quality of the audio but 

also increase its delay. Default is 160ms. 

 

Figure 388: SIP Phone - Receive Buffer 

 

For details see: 9.11.3 Bandwidth calculation 

 

In “Invitation“ you can choose the mode of the outgoing call. 

If „Manual“ (default) is selected, the destination number will be dialled only manually by 

using the “Dial” function. 

If „Auto“ mode is chosen, the defined number will be dialled automatically as soon the VoIP 

card is started. So it establishes a permanent connection like a leased line. For example to 

use as a „Trunkline“. 

 

Figure 389: SIP Phone - Invitation 

 

The configuration to use SIP PortPools on panels is identically to the telephony with 

CONNECT SOLO/DUO.  

See: 9.23.9 Setting up a panel to use a CONNECT/SIP codec  
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9.11.7 VoIP statistics 

Using the “VoIP Statistics” window you can monitor all IP connections by various criteria.  

Click the   button in the tool bar to open the window. 

 
Figure 390: VoIP statistics 

 

All available IP connections for the card selected will be displayed under “Detected VoIP 

Cards” on the left. If you click on the Net symbol, all VoIP cards in the Artist network will be 

displayed. Ports with established connections will be green. 

If the option  is activated, only configured ports will be shown in 

the list. 

You can choose which statistics are displayed by clicking the  button. Press this 

button to customize the view. 

 

Figure 391: VoIP statistics - Statistics configuration 

  

Select the desired statistics from the overview window. By activating the  option, 

the statistics will also be saved in the “Director.log” file, which is saved in the same directory 

as the Director program. 

After you have selected a VoIP card, you can also generate an audio test signal to test the 

audio connection. Click the  button. 
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Figure 392: VoIP statistics - Signal generator  

 

This window allows you to set the test signal frequency that should be sent to or from the 

card. Also select the source of the test signal and the channel. 

To shut off the signal generator, click the  button. 

 
 
 

9.12 Panel - Properties 

The basic properties of an individual control panel are set in the panel‟s “Properties”. The 

properties can be accessed by right mouse clicking on either a port in the network or port 

list, or by right clicking on the panel. Double clicking on the panel in the Workspace also 

opens the properties. The properties vary slightly by port type (panel, 4-wire, ISDN, etc).    

 

 

9.12.1 General 

The “General” tab manages general settings like the port name, scroll lists, etc. 

 

Figure 393: Panel Properties - General tab 

 



 

DIRECTOR 6.20 Configuration Software, User Manual, Version 3.4          

 

  Page 225 

Long Name 
Unique name for the panel that is used in Director (maximum of 32 

characters) 

Local 
Display name (maximum 8 characters).  This name appears on control 

panel keys 

Alias 

Allows the entry of a temporary name for the port that is used in key 

displays system wide without changing the actual local name in the 

configuration 

Remote 

Additional display name for trunked systems.  The remote name is 

displayed on a remote system connected via trunking. (not currently 

supported) 

Room-Code 

Activates a room code for conferences.  Room codes are used when 

control panels in the same conference are physically near each other.  

This helps avoid feedback problems.  Ports in the same Roomcode  

mute the audio between them as soon as a conference is active. 

Roomcodes can be activated for both speaker and headset modes 

Scroll-List 
Selects a pre-defined scroll list that can be accessed by the panel.  

(maximum of one scroll list per panel) 

Enable 2nd audio channel 

Activates the 2nd audio channel of the control panel.  (This function is  

only available if the panel is connected to an odd numbered port and  

the next port is unused) 

Figure 394: Table - Panel Properties - General tab 

9.12.2 Details 1 

Default audio parameters and functions can be set in the “Details 1” tab of the panel 

properties. 

 

Figure 395: Panel Properties - Panel Details 1 tab 

 

Min. Speaker Vol. Minimum speaker volume level on a control panel 

Min. Headset Minimum headset speaker volume level on a control panel 

Beep Volume Volume of the Beep tone 

Beep On Call Duration Duration of the initial beep tone prior to a call (if configured) 
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Speaker Dim Level 
Level that the control panel loudspeaker is dimmed when a key is 

pressed 

Hardware 
Selection of hardware type for 1000 series panels (E = with encoder,    

B = no encoders) 

Fn-Key Assignment 

Allows assignment of the special function key layout for 1000 B-series 

panels.  In addition, the key functions of the Beep or Norm key can be 

switched to a monitoring function.  See details below 

Initial single volume Standard point-to-point volume 

Initial conference volume Standard conference call volume 

Figure 396: Table - Panel Properties - Panel Details 1 tab 

 

9.12.2.1 Monitoring Function   

Under “Fn-Key Assignment” there is the possibility to replace either the “Beep” or “Norm” 

function keys with a monitoring function. 

 

Figure 397: Monitoring - FN key assignment 

 

This makes it possible to monitor a selected port in the system.  That means that as soon as 

the monitored panel talks to a destination, the audio from the monitored panel will also be 

routed to the monitoring panel. 

To activate monitoring, either the “Norm” or “Beep” key is pressed, depending on how the 

function is configured.  The key has a latching timeout of around 2 seconds.  During this 

time, press a “Call to” key on your panel to monitor this port. 

It is not possible to monitor keys programmed with functions like “Call to 

Conference/Groups”, “Listen”, or other functions. 

Repeat the steps to deactivate the monitoring function. 

As soon as the monitoring function is activated on a port, it is signalled by the marker “Call 

to port not activated, monitoring activated”. The appearance of the signalization can of 

course be changed in “Marker Definition”. When the panel being monitored activates a call, 

it is signalled on the panel doing the monitoring with the normal “Call to port incoming call” 

marker. The audio from the monitored panel will be routed through and its volume can be 

adjusted or muted with the corresponding encoder. The monitored panel DOES NOT appear 

in the “Reply” key.  

 

Figure 398: Monitoring - marker definition 
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Example: 

1.) Change the “Norm” key to a monitoring key. 

 

Figure 399: Monitoring - Properties - Details 1 - FN-Key Assignment 

 

2.) Activate the monitor function on the panel 

 

Figure 400: Monitoring - Activating the monitor function on the panel 

 

The red marker indicates an active monitoring function. (You can monitor as many ports as 

you like at the same time). 

 

As soon as the port being monitored makes a call, the call is also routed to the monitoring 

panel and signalled on a key.  The key can also be used for calls to this port, as normal. 

 

 

To stop monitoring, repeat Step 2. 
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9.12.3 Details 2 

The “Details 2” tab of the panel properties sets the brightness, Vox sensitivity and other 

general functions. 

 

Figure 401: Panel Properties - Panel Details 2 tab 

 

Vox On-Threshold Signal level above which the Vox switch is activated 

Vox Off-Threshold Signal level below which the Vox switch is deactivated 

Vox Hold Time 
Duration a Vox switch remains active after the signal level falls 

below the Off-Threshold 

Brightness of LEDs 
Brightness of the signalization LEDs (1000 series) or LCD keys 

(2000/3000 series)  

Brightness of keys Brightness of the 8 character displays 

Font Rotation (only for 2000 

series available) 
Orientation of the displays in steps of 90° 

Enable In-Use Indication …, if 

Panel receives a call… 

Triggers a busy signalization on other panels when the panel 

receives a call  

Enable In-Use Indication …, if 

Panel makes a call… 

Triggers a busy signalization on other panels when the calls 

makes a call 

Enable Mute Function 
Allows incoming volume levels to be muted by pressing the 

corresponding encoder 

Enable for RRCS control Enables third party control of the system  (optional) 

Enable for Trunk call Allows the use of this panel in a trunked system; see Trunking 

Response Timeout 

Internal system timeout for the communication between the 

matrix and the control panel (must be increased for connections 

with large delays, such as ISDN, VoIP, etc.) 

Trunking address 
For the entry of a unique trunking address for this port.  The 

address is normally assigned automatically.  See:  Trunking 

Figure 402: Table - Panel Properties - Panel Details 2 functions 
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9.12.4 GPI 

The “GPIO” tab of the panel properties manages the panel‟s GPIOs. The behaviour of the 

individual GPIOs can be defined (GPI In: normal; inverted, GPI Out: normally open; normally 

closed) and the names of the GPIOs can be changed. 

 

Figure 403: Panel Properties - GPI tab 
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9.12.5 Virtual Keys 

The tab “Virt. Keys“ allows the creation of additional virtual keys for the panel. Click on the 

individual keys to activate them. The virtual keys will appear under the control panel.  

 

Figure 404: Panel Properties - Virtual Keys tab 

 

The example below shows a control panel with all 10 virtual keys activated. 

 

Figure 405: Panel - Virtual Keys 

 

The keys can be configured just like any other key and can be assigned up to 32 functions.  

These keys can be activated via the Remote Key command from any point in the system 

(for example, a Vox switch or GPI input). See: 9.16.11 Remote Key  
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9.12.6 Usage 

The “Usage” tab shows all of the sources that can talk to this panel or activate a function at 

the panel. 

The table is divided into 3 columns. The list can be sorted by column by clicking on a 

column label. A double click on an entry opens the corresponding function in the properties 

windows of the source‟s port.   

 

Figure 406: Panel Properties - Usage 

 

9.12.7 Rights 

Corresponding user rights can be managed in the “Rights” tab. A “Rights” tab is found in all 

“Properties” windows.  See: 9.22 User Rights  

 

Figure 407: Panel Properties - Rights 
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9.13 4-wire Properties 

The basic settings of a 4-wire port are defined in the port “Properties”. The properties of a 4-

wire can be opened with a right mouse click on either the port in the network list or in port 

list, as well as by right mouse clicking on a port in the Workspace. A double click on the port 

in the Workspace also opens the properties. 

 

9.13.1 General 

The “General” tab manages the port names and other settings. 

 

Figure 408: 4-Wire Properties - General tab 

 

Long Name 
Unique name for the port that is used in Director (maximum of 32 

characters) 

Local 
Display name (maximum 8 characters).  This name appears on control 

panel keys 

Alias 

Allows the entry of a temporary name that is used system wide in key 

displays where this port appears without changing the actual local name 

in the configuration 

Remote 

Additional display name for trunked systems.  The remote name is 

displayed on a remote system connected via trunking. (not currently 

supported) 

Room-Code 

Activates a room code for conferences.  Room codes are used when 

control panels or ports in the same conference are physically near each 

other.  This helps avoid feedback problems.  Ports in the same room 

code mute the audio between them as soon as a conference is active. 

Enable 2nd audio channel 

Activates the 2nd audio channel of a digital port.  (This function is  only 

available if the port is connected to an odd numbered port and the next 

port is unused) 

Figure 409: Table - 4Wire Properties - General functions 
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9.13.2 Details 1 

The “Details 1” tab allows the parameters of incoming audio to be set. 

 

Figure 410: 4Wire Properties - Details 1 tab 

 

Initial single volume Standard point-to-point and group call volume 

Initial conference volume Standard conference call volume 

Figure 411: Table - 4Wire Properties - Details 1 functions 
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9.13.3 Details 2 

The “Details 2” tab allows Vox settings, signalization options and some miscellaneous 

options to be set. 

 

Figure 412: 4Wire Properties - Details 2 tab 

 

 

Vox On-Threshold Signal level above which the Vox switch is activated 

Vox Off-Threshold Signal level below which the Vox switch is deactivated 

Vox Hold Time 
Duration a Vox switch remains active after the signal level falls 

below the Off-Threshold 

Enable In-Use Indication …, if 

Panel receives a call… 

Triggers a busy signalization on other panels when the port 

receives a call  

Enable In-Use Indication …, if 

Panel makes a call… 

Triggers a busy signalization on other panels when the port  

makes a call 

Enable for RRCS control Enables third party control of the system  (optional) 

Used as trunkline Uses this port as a trunkline to another system 

Enable for Trunk call 
Allows the use of this port in a trunked system;  only available if  

“Used as Trunkline” is not activated See: Trunking 

Trunking address 
For the entry of a unique trunking address for this port.  The 

address is normally assigned automatically.  See:  Trunking 

Figure 413: Table - 4Wire Properties - Details 2 functions 
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9.13.4 Gain 

The “Gain” tab allows the input and output gain levels to be set for the port. In addition, you 

can select whether the gains for this port can be controlled by a panel using the “Set 

Input/Output Gain” function. See:“7.16.20 Set Input/Output Gain” 

 

Figure 414: 4Wire Properties - Gain tab 

 

 

… the “Set Input/Output Gain” 

function from a panel… 

Allows control of the gain settings by a 1000 series control panel.  

See:“9.16.20 Set Input/Output Gain”.  The settings in the tab then 

serve as default settings. 

… the configuration … The gain settings are exclusively set in the Director configuration 

Input Gain Set the input gain level (coming into the matrix) 

Output Gain Set the output gain level (going from the matrix) 

Reset Resets the selected gain parameter back to 0dB 

Figure 415: Table - 4Wire Properties - Gain functions 
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9.13.5 Beep 

Since a 4-wire cannot generate a beep tone, it is possible to instead activate a GPI output 

when the port is beeped. 

The selected GPI contact will be activated as soon as the 4-wire is beeped by a control 

panel. 

 

Figure 416: 4Wire Properties - Beep tab 
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9.13.6 Virtual Keys 

The tab “Virt. Keys“ allows the creation of additional virtual keys for the port. Click on the 

individual keys to activate them. The virtual keys will appear next to the 4-wire.  

 

Figure 417: 4Wire Properties - Virtual Keys tab 

 

The example below shows a 4-wire port with 2 virtual keys activated.   

 

Figure 418: 4Wire Port - Virtual Keys 

 

The keys can be configured just like any other key and can be assigned up to 32 functions.  

These keys can be activated via the Remote Key command from any point in the system 

(for example, a Vox switch or GPI input). See: 9.16.11 Remote Key  
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9.13.7 Usage 

The “Usage” tab shows all of the sources that can talk to this port or activate another 

function at the port. 

The table is divided into 3 columns. The list can be sorted by column by clicking on a 

column label. A double click on an entry opens the corresponding function properties 

windows of the sources port.   

 

Figure 419: 4Wire Properties - Usage tab 

 

9.13.8 Rights 

Corresponding user rights can be managed in the “Rights” tab. A “Rights” tab is found in all 

“Properties” windows. See: 9.22 User Rights  

 

Figure 420: 4Wire Properties - Rights Tab 
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9.14 Key Properties 

The “Properties” of a key can set basic key parameters for each individual key on a control 

panel. To open the “Properties”, right mouse click on a key and choose “Properties”, or 

double click on a key. There will be one tab for every function the key has been assigned.  

The tabs “General” and “Rights” are also always present. 

The “General” tab can set the key label, key mode, whether a key press causes the 

loudspeaker to dim, etc. 

 

Figure 421: Key Properties - General tab 

 

Key Label 

If the option "Define automatically" is activated, the pre-assigned  

display name for the programmed function will be used.  Uncheck  

this box if you want to manually assign the display text for the key  

Key Mode 

Specifies the key behaviour: 

Momentary (PTT), Latching (switch); Auto (momentary or latching, 

depending on how long the key is pressed. >350ms: Momentary,  

<350ms Latching) 

Latching Timeout 
If the key mode is set to “Latching” or “Auto”, the key can be set to 

automatically deactivate after a specified period 

Radio Button 

Places the key in one of 4 available groups.  Each key on the panel 

in  the same group is deactivated as soon as another key in the 

group is pressed.  That means that only one key from each group 

can be active  at the same time.  Radio buttons groups only 

function on a single  control panel 

Action when muted key is 

pressed: 

Describes what happens when a key that was previously muted by 

pressing its corresponding encoder is pressed  

No unmute when activated, no 

mute when deactivated 

The volume level does not change when the key is pressed.  It 

remains muted 

Unmute when activated,  no 

mute when deactivated 

If the key is pressed, the volume control jumps back to its last 

position.  The volume remains to mute after the key is released. 

Unmute when activated, mute 

again when deactivated 

If the key is pressed, the volume control jumps back to its last 

position.  The volume is muted again as soon as the key is no 

longer active 
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Scroll enable 

Allows the key to access the panel‟s scroll list (a scroll list must 

have been previously defined and assigned to the panel).  See:  

8.20 Scroll Lists 

Dim the panel speaker … 
Dims the panel loudspeaker as soon as the key is pressed (NOTE: 

not recommended for latching keys) 

Restore volume level 
When activated, dynamically assigned conferences on this key are 

always shown with their last stored volume level 

Figure 422: Table - Key Properties - General functions 

9.14.1 Key Modes: 

Auto 

If the key is tapped quickly (>350ms) it acts like a latching key.          

If the key is held pressed for longer than 350ms, it acts like a 

momentary key 

Momentary (PTT) The functions on the key are only active as long as the key is pressed 

Latching The functions on the key are turned on and off by pressing the key 

Figure 423: Table - Key properties - Key modes 

 

9.14.2 Rights 

Corresponding user rights can be managed in the “Rights” tab. A “Rights” tab is found in all 

“Properties” windows. See: 9.22 User Rights  

 

Figure 424: Key Properties - Rights tab 
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9.15 Virtual Function Properties 

The properties of the Virtual Functions can be opened by right mouse clicking on the Virtual 

Functions of a control panel or 4-wire port. Only the user rights can be changed in the 

properties window. To change other settings, such as the Vox parameters, open the 

properties of the port and select tab “Details 2”. 

 

9.15.1 Rights 

Corresponding user rights can be managed in the “Rights” tab. A “Rights” tab is found in all 

“Properties” windows. See: 9.22 User Rights  

 

Figure 425: Key Properties - Rights tab 
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9.16 Overview of Functions (Commands) 

Functions (commands) are the actions that are triggered by key presses, virtual functions, 

logics functions and GPIs. Each function receives its own tab in the properties of the object 

that activates it where further options of the function can be defined.   

This chapter describes in detail each function and its available options. 

 

Available commands: 

Keys                             Virtual Functions        Logic Outputs           GPI Inputs/Outputs 

                                  

Figure 426: Add function - function overview depending of the activator 

 

 only available on 1000 series control panels 

 only available on 1000- and 2000 series control panels 
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9.16.1 Call to Port 

The “Call to Port” function is a point-to-point call from a caller (source) to a target 

(destination). It is the standard function for communication between two individuals.  

 

Figure 427: Call to port - Call tab 

 

Destination Defines the target port to be called 

Local Port Selection of a port of the local system 

Trunking address 
Possibility to enter a trunking address, to configure a trunkcall offline 

(see 16.4.5 Offline-configuration of trunkcalls  (new in Director 6.20)  

To 2nd channel 
Defines whether the call should target the 2nd audio channel of the 

destination port (if available) 

Trunking net address Only available in trunked systems; (See: Trunking) 

Trunking port address Only available in trunked systems; (See: Trunking) 

Priority 
Defines the priority level for this call;  

See: 9.8.4 Net Properties -> Port Settings 

Trunkcall priority Only available in trunked systems; (See: Trunking) 

Isolate 

Blocks all other calls to the destination port as long as this call is 

active.  When calling a control panel, the microphone at the 

destination will automatically be activated and the audio routed to 

the calling port 

Isolate self Blocks all other calls to the local port while this call is active 

Disable Crosspoint volume 

adjust at Destination 

The destination panel is not allowed to change the volume level of  

the incoming call.  The crosspoint will be set to 0dB, regardless of 

other volume settings or priorities 

Use 2nd channel on this port 

as the audio source 

Selects the 2nd audio channel of the port as the audio source for the 

call (if a 2nd channel is available) 

Beep destination on Call 
Triggers a short beep tone at the destination panel before the  source 

microphone is activated 
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Autolisten from Destination 
Activates the “Autolisten” function for this call; 

see below: Autolisten 

Allow the “Set Input/Output 

Gain” function to adjust the 

source port from this panel 

Enables the use of the I/O gain control on this panel for the selected 

port (only for 2 and 4-wires).  The function “Set Input/Output Gain” is 

required on another panel key.  See: “9.16.23 Set Input/Output Gain” 

Figure 428: Table - Call to port - Call functions 

 

 

 

9.16.1.1 Autolisten 

The Autolisten function allows hands-free operation at the destination port. When called by 

an Autolisten call, the return path is activated automatically and stays open until 

deactivated with the “Autolisten OFF” command from either side (See: “9.16.22 Autolisten 

OFF”).  If the destination port makes an autolisten call to the source, the automatic return 

path is reversed.  This means that the audio from the original source is automatically routed 

to the destination.  

Activate the Autolisten-function, by activating this function for the „Call to…” command, you 

want to use it  

If the Autolisten function is used on a 4-wire port, a permanent “Listen” to the destination 

command will be triggered as soon as the 4-wire‟s Vox is activated.  This listen function can 

only be deactivated from a control panel using the “Autolisten Off” command. Therefore, it 

is imperative that the panel also has an Autolisten command to the 4-wire port.  
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9.16.2 Call to Conference 

A “Call to Conference” is a multipoint-to-multipoint function between the multiple members 

of a conference. Every member can talk into the conference at the same time and hear the 

sum of all active members (if they have the necessary privileges).  

 

Figure 429: Call to conference - Conference tab 

 

 

Destination 
Select the conference to speak to (Conference must be   

defined  in advance, see 8.17 Add Conference) 

Priority 
Sets the priority for the call (see 9.8.4 Net Properties -> Port 

Settings) 

Trunkcall priority Only available in trunked systems (see Trunking) 

Talk privilege Allows the member to speak into the conference 

Listen privilege Allows the member to hear the conference 

Use 2nd audio channel on this port 

(instead of the 1st) 

Sets the 2nd audio channel of the port as the audio source  

(can only be selected if a 2nd audio channel is available)  

Use this command to select the 

destination conference during an Edit 

Conference operation 

Allows the Edit Conference command to change the members    

of this conference.  The command “Edit Conference” is also  

required on the control panel.  See: 9.16.13 Edit Conference)  

The destination conference on this 

command can be changed by Edit 

Conference 

Allows the edit conference panel to dynamically add or delete  

this member to a conference 

Figure 430: Table - Call to conference - Conference functions 
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9.16.3 Call to Group 

The “Call to Group” function is a point-to-multipoint call. A single port calls several ports at 

the same time. This method of communication always goes in only one direction. Any 

answers to the call from group members are always point-to-point calls back to the source. 

 

Figure 431: Call to group - Group tab 

 

Destination 
Selects the group to be called (the group must have been previously 

created).  (See: 8.17 Add Group) 

Priority 
Defines the priority level for this group call (see: 9.8.4 Net Properties - 

>Port Settings) 

Trunkcall priority Only available in trunked systems (see Trunking) 

Disable Crosspoint volume 

adjust at Destination 

The destination panel is not allowed to change the volume level of the 

incoming call.  The crosspoint will be set to 0dB, regardless of other 

volume settings or priorities 

Show incoming Marker / 

Enable volume adjust 

Activates the incoming marker and the incoming volume control when 

a group member answers the call.  This option should not be used if 

group members are also programmed on the same panel as  

individual calls. Doing so would link together their incoming level 

controls and thus prevent individual volume control for calls coming 

from these ports. 

Use 2nd channel on this port 

(instead of the 1st) as the 

audio source 

Selects the 2nd audio channel of the port as the audio source for the 

call (if a 2nd channel is available) 

Figure 432: Table - Call to group - Group functions 
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9.16.4 Call to IFB 

The “Call to IFB” function allows IFBs to be quickly configured using the IFB table. To use an 

IFB it must have been previously defined in the IFB table. (See: 8.15.1.3 Using the IFB 

table). 

To program IFBs, select a previously defined IFB from the list or drag an IFB from the IFB 

table to a key or Virtual Function. 

 

Figure 433: Call to IFB - Call to IFB tab 

 

Destination IFB Selects a predefined IFB from the IFB table 

Disable Crosspoint volume 

adjust at Destination 

The destination panel is not allowed to change the volume level of the 

incoming call.  The crosspoint will be set to 0dB, regardless of other 

volume settings or priorities.  (This function is only available when a 

control panel is the destination) 

Use 2nd channel on this port 

as the audio source 

Selects the 2nd audio channel of the port as the audio source for the 

call (if a 2nd channel is available) 

Beep destination on call 
Triggers a short beep tone at the IFB (only available when the 

destination is a control panel)  

Figure 434: Call to IFB - Call to IFB functions 
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9.16.5 Listen to Port 

The “Listen to Port” command is a point-to-point function. It routes the audio from the target 

port (Source) to the port activating the command.  

 

Figure 435: Listen to port - Listen tab 

 

Source Select the port that should be listened to 

Local Port Selection of a port of the local system 

Trunking address 

Possibility to enter a trunking address, to configure a listen to trunkport 

offline (see 16.4.5 Offline-configuration of trunkcalls  (new in Director 

6.20) 

From 2nd channel (instead    

of  1st) 

Listens to the 2nd audio channel of the target port (only available if a 

second audio channel is available) 

Priority 
Sets the priority level for the listen command  

(see: 9.8.4 Net Properties -> Port Settings) 

Disable Crosspoint volume 

adjust 

The incoming volume level from the port being listened to cannot be 

changed.  The crosspoint will be set to 0dB, regardless of other  volume 

settings or priorities.   

Use 2nd channel on this port 

(instead of the 1st) as the 

audio destination 

Sets the 2nd channel of the port as the destination for the audio being 

listened to (only available if a second audio channel is available) 

Allow the “Set Input/Output 

Gain” function to adjust the 

source port from this panel 

Enables the use of the I/O gain control on this panel for the selected port 

(only for 2 and 4-wires).  The function “Set Input/Output Gain” is required 

on another panel key. See: “9.16.23 Set Input/Output Gain” 

Figure 436: Table - Listen to port - Listen functions 
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9.16.6 Route Audio 

The “Route Audio” function can route audio from a source to a destination within the 

system. If the command is programmed on a control panel the panel can also adjust the 

volume level and mute the audio route. Route Audio is also a point-to-point function. 

If different panels have the same route audio command configured on any key, the volume 

indicator is synchronized on all panels if the volume is changed on one key (new in Version 6.10) 

 

Figure 437: Route Audio - Route tab 

 

Source Defines the source port 

From 2nd channel (instead  

of 1st) 

Routes the audio from the 2nd channel of the source port. (only 

available if a second audio channel is available) 

Destination Defines the destination port (output) 

To 2nd channel  

(instead of 1st) 

Routes the audio to the 2nd audio channel of the destination port  

(only available if a second audio channel is available) 

Priority 
Sets the priority level of the audio route  

(see: 9.8.4 Net Properties -> Port Settings) 

Disable Crosspoint volume 

adjust 

Deactivates the crosspoint level control. The crosspoint will be set to 

0dB, regardless of other volume settings or priorities.   

Attention: Also in this software version the volume indication on a   

key still shows a volume change when this option is enabled, but the 

volume is fixed to 0dB 

Figure 438: Table - Route Audio - Route functions 
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9.16.7 Switch GPI Out 

The “Switch GPI Out” function can activate any GPI output in the system, whether on a GPI 

card or a control panel. 

 

Figure 439: GPI Out tab 

 

GPI-Out Sets which GPI output will be triggered 
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9.16.8 Select Audiopatch 

The “Select Audiopatch” allows a predefined Audiopatch to be activated on a control panel, 

For information on creating audio patches, see: Chapter 8.13  Audiopatches                            

 

Figure 440: Select Audiopatch tab 

 

Panel Selects the panel where the Audiopatch should be changed 

Audiopatch Selects which predefined Audiopatch on the panel should be activated 

Figure 441: Table - Select Audiopatch functions 
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9.16.9 Control Audiopatch  

The function “Control Audiopatch” allows particular crosspoints or amp gain settings in an 

audio patch to be adjusted from a control panel key. 

Note: This function is not available on 3000 and 5000 series control panels. 

Before an audio patch crosspoint is available for control with the “Control Audiopatch” 

function, it must first be unlocked in the audio patch. Open the audio patch of a panel.  

Select the crosspoint or the amplifier that you like to adjust and check the option 

.   The crosspoint or amplifier will turn blue    /  and is now 

available for control with the “Control Audiopatch” function. 

Warning: Elements that are unlocked for use with the “Control Audiopatch” function are 

permanently activated, regardless of the settings in the current Audiopatch. 

On a control panel key, under “Add Function” select the command “Control Audiopatch.”  

(This command is not available for use on virtual keys or Virtual Functions.) 

A new window opens where you can select the Audiopatch element that you would like to 

control. 

First, choose a control panel from the drop down menu, or drag one to the menu from the 

port or network lists using Drag & Drop.   

Note: Only panels that have an Audiopatch element unlocked will be available for selection 

or can be dragged into the menu. 

 

Figure 442: Control Audiopatch - panel choice 

 

 

 

 

 

 



 

DIRECTOR 6.20 Configuration Software, User Manual, Version 3.4          

 

  Page 253 

Select the type of element that should be adjusted from the panel. Choose  for an 

input amplifier, or chose  for an output amplifier. To adjust a crosspoint gain in 

the Audiopatch matrix, select . Next, choose the exact element that you would 

like to adjust. Only unlocked elements will be shown in the list.  

 

Figure 443: Control Audiopatch - element selection 

 

The panel key will display .  You can also change the display name on the 

key in the key‟s properties. 

 

To adjust the gain level, turn the corresponding encoder. On 1000 series control panels the 

level can also be reduced by pressing on the left side of the key and increased by pressing 

on the right side of the key. As soon as the gain level is adjusted it will be displayed in “dB” 

on the key display. After a timeout of approximately 3 seconds the display will return to the 

original display name.  

.  

On 2000 series control panels the level is adjusted using the “XP” function key. Press the 

“XP” key and select the key with the Audiopatch gain you would like to adjust. The gain can 

now be changed using the panel‟s master volume control. 

Note: If the ability to adjust a particular crosspoint is available from several keys or on 

several panels, the gain displays will not be synchronized.  A change in the gain made from 

one position will only be displayed at other locations when the gain is changed from these 

locations.   

It is strongly recommended not to add any additional functions to the key. 
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9.16.10 Remote Key 

The “Remote Key” function can influence or remote control any key in the system. 

 

Figure 444: Remote Key tab 

 

Destination Selects the panel with the key to be controlled 

Expansion Panel 
Selects whether or not the key is on the main panel or an 

expansion panel 

Key Page Selects whether the key is on the main page or the shift page 

Key 

Selects the key to be controlled by key number and current 

display name.  (Key numbers are counted from left to right and 

from top to bottom) 

Press the Key Activates the selected key (the key will be remotely controlled) 

Lock the Key (so that the local 

operator cannot press it) 
Locks the selected key on the panel 

Set the Signalling Marker 
Displays the selected marker above the key 

(Standard or user defined markers.  See: 9.8.7 Marker Definition) 

Set key text 

Displays the entered text in the selected key, as long the Remote 

Key function is active. The existing text on the key will be  

overwritten temporary.  

Figure 445: Table - Remote Key functions 
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9.16.11 Reply 

The “Reply” command offers an easy-to-use call-back function for control panels. The last 

incoming call is automatically displayed in the reply key. “Call to Conference” calls do not 

normally appear in the reply key. The duration that calls are displayed can be adjusted (see: 

9.8.4 Net Properties –> Port Settings). Pressing the reply key always calls back the last 

destination that called, even if the key has switched back to displaying “Reply”. If the 

destination that called is already programmed on another panel key, the reply key will 

reflect the volume level previously set. 

If in the “Net-Properties”-> “Port Settings” the “Reply-Key Timeout” is set to 24 hours, the 

last caller will remain displayed on the key until the call is answered. Afterwards, the key 

will revert to “Reply” in its display. 

If the reply key is also set to “Scroll enable” (key properties, general tab), the last 20 calls 

can be accessed in chronological order by using the scroll function.  (See: 8.20.4 Scroll Lists 

– operation from a panel) 

 

Figure 446: Reply tab 

 

Priority 
Sets the priority for reply calls; 

See: 9.8.4 Net Properties -> Port Settings 

Enable Reply for calls from 

conference 

If this option is activated, ports that call using conference calls will 

also be displayed in the reply key 

Figure 447: Table - Reply tab 
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9.16.12 Edit Conference 

This function is only available on 1000 series control panels. The “Edit Conference” function 

allows the user to add and remove members to and from a conference, as well as assigning 

talk and listen privileges to these members. All conferences and members to be assigned 

must be available as keys on the user‟s panel. See: 8.18 Configuring “Edit Conference”  

 

Figure 448: Edit Conference tab 

 

The “General Properties” of the “Edit Conference” key should be set to “Latching” (with a 

short timeout) and without the “Dim the panel speaker …” option activated. 

9.16.13 Edit IFB  

The „Edit IFB“- Function is only for panels of the 1000- and 2000series available. With the 

„Edit IFB“ - Function you can easily assign IFB-sources to IFBs directly on panels without 

using the Director software. 

For further details about configuration and operation see 8.19 Configuration and Operation 

the „Edit IFB“– Function 

To use this function on a panel, you need to add the “Edit IFB”- function to an empty key of 

your panel. There are no further parameters to set up.  

 

Figure 449: Edit IFB tab 
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9.16.14 Dim Panel Speaker 

The “Dim Speaker” function allows the volume level of a particular control panel speaker to 

be reduced. 

 

Figure 450: Dim Speaker tab 

 

Destination Selects the panel where the loudspeaker should be dimmed 

Dim speaker by Defines the dim value (in dB) 

Figure 451: Table - Dim Speaker tab 
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9.16.15 Dim XP Level 

The “Dim XP-Level” function allows a particular crosspoint in the matrix to be dimmed by a 

certain amount or muted. 

 

Figure 452: Dim Level tab 

 

Source Selects the crosspoint source  

Destination Selects the crosspoint destination 

Dim by Defines the amount of dimming (in dB) 

Figure 453: Table - Dim Level tab 
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9.16.16 Beep Panel 

The “Beep Panel” generates a beep tone at the destination panel or triggers a GPI contact 

for 4-wires. The function is identical to the “Beep” function key + destination on a panel. 

 

Figure 454: Beep tab 

 

Destination Select the port to be beeped 
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9.16.17 Telephone Dial Keypad / Display 

The “Keypad” function allows the creation of a telephone keypad on a control panel without 

a dedicated hardware keypad and also provides other telephone functions. For further 

details, see: 9.23.9 Setting up a panel to use a CONNECT/SIP codec 

 

Figure 455: Keypad tab 

 

The key function can be selected in the drop-down menu. 

0 – # 
Selects a keypad digit to assign.  Only one number can be assigned per 

key  

CL Clear – each key press deletes the previous digit  

DisplayH 

Displays the telephone number entered. The digits “scroll” on to the key 

as they are dialled.  If the telephone number has more than 8 digits,   

they “scroll” on to the Display H key  

DisplayL 

Displays the telephone number entered. The digits “scroll” on to the key 

as they are dialled. The Display L key shows the last 8 digits of the 

number dialled 

Numbers can also be entered manually by pressing the corresponding 

level control and scrolling 

Pressing the display key dials the number entered (comparable to 

Dial/Off). Any preset telephone numbers will be temporarily ignored   

and the manually entered telephone number will be dialled 

ReplyH Shows the first 8 digits of an incoming telephone number (if available) 

ReplyL 

Shows the last 8 digits of an incoming telephone number (if available).  

The number of the last caller will always be displayed. 

Pressing the key dials the last incoming telephone number (Dial/Off) 

Phone No 

Allows the entry of a telephone number that is dialled when the key is 

pressed.  (This function is perfect for multiple use in scroll lists to create   

a telephone book)  

Figure 456: Table - Keypad tab 
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9.16.18 Telephone Dial / Hang up 

The “Dial” function is used in conjunction with CONNECT SOLO or CONNECT DUO. It enables 

a control panel to call a preset telephone number from the configuration. 

 

Figure 457: Dial tab 

 

Dial only 

With this function it is possible to dial a preset telephone number. The 

command can only be used in combination with a separate “Call to” key 

that is set to a telephone port   

Hang up only 

It is possible to end a telephone connection with this function. The 

command can only be used in combination with a separate “Call to” key 

that is set to a telephone port   

Dial and Hang up 

Combines the functions “Dial only” and “ Hang Up only” in one key. The 

command can only be used in combination with a separate “Call to” key 

that is set to a telephone port   

Stop Connection 

Allows a remote panel connected via ISDN to break the connection.    

This command is only available on remote panels that are connected 

using a CONNECT DUO.  

Figure 458: Table - Dial functions 
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9.16.19 Logic 

The “Logic” function assigns a Logic Source to a key, Vox or GPI. A logic source can be 

assigned any number of times within the system.  See: 8.21 Logic Functions. 

 

Figure 459: Logic tab 
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9.16.20 Kill Partyline Mic 

The “Kill Partyline Mic” offers a way to shut off the microphones on a connected Performer 

partyline system. The function only works if the partyline is a member of a conference and 

the conference key is also programmed on the control panel. For example, to kill the mikes 

on active C3 beltpacks the “Kill Mic” key and the key for the corresponding conference must 

be pressed at the same time. 

 

Figure 460: Kill Partyline Mic tab 

 

To operate this function with only one finger, it is useful to set the „Kill Mic“ - key as 

“Latching” with a  Timeout. 

When you now activate the „Mic Kill“ - key, all keys with an active “Call to Conference”- 

function will show a flashing marker as long the timeout is set. Now press the key you want 

to switch off all microphones. All mikes of the Partyline(s) in this conference will be 

switched off. 

Attention: Always all mikes for both cannels of the complete Partyline will be switched off. It 

is not possible to just switch of the mic for only one channel of the Partyline. 

 

 

 

Figure 461: Kill Partyline Mic - Panel operation 
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9.16.21 Autolisten Off 

The “Autolisten Off” function turns an active Autolisten off. The “AL OFF”- key and the 

corresponding “Call to…“- key that has “Autolisten” activated must be pressed at the same 

time. 

 

Figure 462: AL Off tab 

 

 

 

To operate this function with only one finger, it is useful to set the „AL Off“ - key as 

“Latching” with a  Timeout. 

When you now activate the „AL Off“ - key, all keys with an active  Autolisten function will 

show a flashing marker as long the timeout is set. Now press the key that should stop the 

Autolisten function. 

 

 

 

 

 
Figure 463: Autolisten Off - Panel operation 
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9.16.22 Set Input/Output Gain 

For every 4-wire in the system you have the choice of how you would like to control the I/O 

gains (Properties> Gain). You can choose whether the gain should only be set in the Director 

configuration or whether it can also be adjusted from a control panel. To adjust the input 

and output gains from a control panel, select “Set the Input/Output Gain function from a 

panel…” on the 4-wire port that the panel should control. 

 

Figure 464: Set Input/Output Gain of a port to Panel control / RRCS control 

 

Attention: The Set Input/Output Gain function is only available on 1000 series control 

panels because the function requires keys with separate left and right contacts. This key 

type is currently only available on 1000 series control panels. 

The “Set Input/Output Gain” function can be configured in two different ways. 

Version 1: Set Input/Output Gain of a particular port 

 

Figure 465: Set Input/Output Gain - “Adjust following Port” 

 

In this version, the key is assigned to a specific port. The key display will show the name of 

the port, but with a different marker. It is recommended to set the key to “Latching“ 

(possibly with a timeout) and to deactivate the “Dim” option. 

To adjust the input gain of the 4-wire, press the left side of the key. The key will now show 

“In Gain” and the volume LED will begin to flash. As soon as the encoder next to the key is 

turned, the gain level will change with the current gain displayed in dB. To adjust the output 

gain, press on the right side of the key. The display will change to “Out Gain”. The volume 

LED will likewise correspond to the approximate gain level.       

   ->    ->   

   ->    ->   

Figure 466: Operating “Set In/Output Gain” on the panel (direct access) 
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Version 2: Another way to program this command uses a special function key.   

Pressing the “I GAIN O” key switches all “Call to” and “Listen to” 4-wire keys, that are 

available for gain control, to gain adjust mode. 

 

Figure 467: Set I/O gain - Set Input/Output Gain with a dedicated function key 

 

Either the input or output gain can be changed, depending on whether the “I GAIN O” key 

was pressed on the left or right side. The respective gain levels will be displayed both in dB 

and by the position of the volume control LED. To enable one handed operation, set the Set 

Input/Output Gain key to “Latching” with a short timeout. 

Adjust the following port 
Defines this key as the I/O-Gain control key for the selected  

4-wire port (Key mode Latching, short Timeout, no Dim). 

Select the destination port(s)  

with another panel key 

Defines the key as a function key that toggles 4-wire ports between 

Call/Listen and Gain Adjust (Key label: “I Gain O”). 

Suggested key behaviour: Latching with a short timeout, no Dim. 

If the key is pressed on the left side (input) or right side (output), the 

volume LEDs of all of the 4-wire keys on the panel that are available 

for gain adjust will begin to flash. The key displays will show their  

port names.  Turning the corresponding encoders will adjust the gain 

with the current gain shown in dB (range: mute, -18dB to +18dB).  

Pressing the encoder toggles between mute and the last gain level 

set.  If you double click on the master volume control when in Gain 

Adjust Mode, all of the 4-wire gains on the panel will be set to the 

norm level (independent of whether the input or output gain had 

been selected).  A second press on the “I Gain O” key returns the 4-

wire keys to their original “Call”  or “Listen”- function. 

Figure 468: Table - Set I/O gain functions 

 

 

 

  ->  ->  

Figure 469: Operating I/O gain on a panel (indirect access) 
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9.16.23 Sidetone 

This function key is used to activate the “Sidetone” feature on a panel and to control the 

sidetone level. “Sidetone” is the volume level at which users hear themselves (useful in 

headset mode). Once the command has been placed on a panel key and the microphone is 

active, the panel‟s audio will also be routed back to its own output. The level can be 

controlled using the rotary encoder next to the “Sidetone” key. Pressing the “Sidetone” key 

allows users to talk to themselves so that they can adjust their own “Sidetone” levels. 

 

 

Figure 470: Sidetone tab 

 

Enable for speaker mode 
Activates sidetone in speaker mode (only useful if the speaker 

mode has been routed to the headset in the Audio Patch) 

Enable for headset mode Activates sidetone in headset mode 

Norm sidetone level Initial sidetone level when the command is placed on a key 

Applies to 2nd audio channel 
Activates the sidetone on the 2nd audio channel of the panel (if 

available) 

Figure 471: Table - Sidetone functions 
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9.16.24 Send String 

This function key is used to send a data string of up to 256 characters to RRCS (Riedel 

Router Control Software). When activated, the command sends the data string to a third 

party control system to activate a particular function. For more information, please refer to 

the RRCS documentation. 

 

Figure 472: Send String tab 
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9.17 Group Properties 

The “properties” of a group contains all of the group settings and information. To create a 

new group, click the  button in the  tab of the Navigation Bar. 

9.17.1 Group “General” tab 

The “General” tab sets basic parameters such as names and GPIOs assignments to the 

group. 

 

Figure 473: Group Properties - General tab 

 

Long Name Unique group name used in Director (up to 32 characters) 

8-char Label Group name that appears on key displays (max. 8 characters) 

Assigned GPI Out 
Allows the assignment of a GPIO that is always triggered when this group call 

is activated 

Enable for trunk call Allows the group to be used between trunked systems; see Trunking  

Trunking address 
Entry of a unique trunking address.  To use a group in a trunked system, the 

groups in the systems must have the same trunking address; see Trunking 

Figure 474: Table - Group Properties - General functions 
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9.17.2 Group “Members” tab 

The “Member” tab manages the list of members that makes up the group. 

Group members can be added by clicking the “Add Port…” button and then selecting 

members from a drop down menu. Members can also be dragged into the group from either 

the network list or the port list using Drag & Drop.  By default, this will add the 1st audio 

channel of the port to the group. If you want to add the 2nd audio channel of a port, the 

member must be added using the  button and selecting the “2nd Channel” option.  

Selected members can be deleted from the group using the  button. 

 

Figure 475: Group Properties - Members tab 

 

 

Figure 476: Group Properties - “Add Port…” window 
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9.17.3 Group “Usage” tab 

The “Usage” tab lists detailed information on all locations that have a “Call to Group” 

command to this group. The port name and the exact location of the group call are shown.  

If you double click on an entry in the list, it will open the corresponding properties of the 

command on that port so that you can make adjustments. 

 

Figure 477: Group Properties - Usage tab 
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9.17.4 Group “Rights” tab 

Corresponding user rights can be managed in the “Rights” tab. A “Rights” tab is found in all 

“Properties” windows. See: 9.22 User Rights  

 

Figure 478: Group Properties - Rights tab 
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9.18 Conference Properties 

In the properties of a conference you can define basic conference parameters as well as see 

a list of all conference members.  

9.18.1 Conference “General” tab 

The name of the conference is entered in the “General” tab. The conference can also be 

assigned a GPIO contact. In addition, this tab can be used to unlock the conference for use 

in trunked systems or with the “MCR” or “Events” software add-ons. 

 

Figure 479: Conference Properties - General tab 

 

Long Name Unique conference name used in Director (up to 32 characters) 

8-char Label Local conference name that is displayed on keys (max. 8 characters) 

Alias 

As soon as it is entered, this 8 character display name temporarily 

overrides the ”8-char Label”.  If the Alias name is deleted, the “8-char 

Label” will again be displayed on panel keys 

Assigned GPI Out 
Allows a GPIO to be assigned to a conference.  The GPIO will always  

be triggered as soon as a member speaks into the conference  

Enable for trunk call Activates the conference for use in trunked systems. See: “Trunking” 

Trunking address 

Assigns a unique trunking address.  To use a conference in a trunked 

system, the conferences in the systems must have the same trunking 

address; see Trunking 

Enable for Master Control 

Room use 

Allows the conference to be used in the “MCR” software add-on.  

See:“13 Master Control Room Software” 

Create an associated logic 

source for MCR use 

A logic source will be automatically created for this conference. This  is 

required to control the “MCR” software add-on from a control panel 

Figure 480: Table - Conference Properties - General functions 
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9.18.2 Conference “Usage” tab 

The “Usage” tab lists detailed information on all locations that have a “Call to Conference” 

command to this conference and who are thereby conference members. The port name, the 

exact location of the conference call, and conference privileges (talk, listen) are shown. If 

you double click on an entry in the list, it will open the corresponding properties of the 

command on that port so that you can make adjustments. 

 

Figure 481: Conference Properties - Usage tab 

 

9.18.3 Conference “Rights” tab 

Corresponding user rights can be managed in the “Rights” tab. A “Rights” tab is found in all 

“Properties” windows. See: 9.22 User Rights  

 

 

Figure 482: Conference Properties - Rights tab 
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9.19 Scroll List Properties 

The properties of a scroll list allow individual functions to be added to the list as well as 

offering an overview of who can use the list. Double click on a scroll list in the “Scroll List” 

tab of the Navigation Bar to open the list‟s properties. 

9.19.1 Scroll List “General” tab 

The “General” tab allows all scroll list functions and their options to be defined and 

changed. The list can also be given a unique name. For details on creating a scroll list see: 

“8.20 Creating and Managing Scroll Lists” 

 

Figure 483: Scroll List Properties - General tab 

           

Long Name Unique scroll list name used in Director (up to 32 characters) 

Members All scroll list functions and details are defined in this window 

Move up 

Changes the order of scroll list entries. Select an entry from the list and 

click the “Move up” button to move the entry one position higher with 

each mouse click 

Move down 

Changes the order of scroll list entries. Select an entry from the list and 

click the “Move down” button to move the entry one position lower with 

each mouse click 

Add… 
Adds a new function. The same functions are available that can   normally 

be used on control panels 

Edit Scroll List Entry… 
Allows a scroll list entry to be edited. This includes changing the name, 

key mode, etc. (see details below)  

Edit function… 

This button allows the selected function to be customized. The available 

options for functions are identical with those that are normally available 

when the function is programmed to a panel key  

Delete Deletes the selected entry from the Scroll List 

Figure 484: Table - Scroll List Properties - General functions 
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Figure 485: Scroll List Properties - Edit Scroll List entry 

 

Key Mode 
Defines the key mode that the function should use: 

“Auto”, “Momentary” or “Latching” 

Latching Timeout 

If the key mode is set to “Auto” or “Latching”, an additional timeout can 

be added. After the timeout period, the key will automatically be 

deactivated   

Dim the panel speaker … 
Defines whether the control panel loudspeaker should be dimmed when 

the function is active 

Key Label 

If the "Define automatically" option is activated, the default name for  

the function will be used on the key.  When deactivated, a custom   

name of up to 8 characters can be assigned.  

Keypad shortcut 
A unique ID number can be assigned for each scroll list entry.              

This allows the entry to be retrieved by using a telephone keypad  

Figure 486: Table - Scroll List Properties - Edit Scroll List functions 
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9.19.2 Scroll List “Usage” tab 

All the panels that can access this scroll list can be seen the “Usage” tab. Double clicking on 

an entry opens the properties of the selected control to allow a different list to be assigned. 

 

Figure 487: Scroll List Properties - Usage tab 

 

9.19.3 Scroll List “Rights” tab 

Corresponding user rights can be managed in the “Rights” tab. A “Rights” tab is found in all 

“Properties” windows. See: 9.22 User Rights  

 

Figure 488: Scroll List Properties - Rights tab 
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9.20 GPI In Properties 

The default parameters for the GPI Input can be set in the properties tab. Choose a GPI 

Input from the “GPIO” tab in the Navigation Bar. Double click on the GPI or right mouse click 

and select “Properties”. 

9.20.1 GPI In “General” tab 

The name and type of GPI Input are entered in the “General” tab. 

 

Figure 489: GPI In Properties - General tab 

 

Long Name Unique name used in Director (up to 32 characters) 

Type 

Defines the behaviour of the input. 

Select whether an incoming external signal switches the input to active 

(normal) or inactive (inverted)  

Figure 490: Table - GPI In Properties - General functions 

 

The “Usage” tab is always empty for GPI Inputs, because no member of the system can 

activate an input. 
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9.20.2 GPI In “Rights” tab 

Corresponding user rights can be managed in the “Rights” tab. A “Rights” tab is found in all 

“Properties” windows. See: 9.22 User Rights  

 

 

Figure 491: GPI In Properties - Rights tab 
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9.21 GPI Out - Properties 

The default parameters for the GPI Output can be set in the properties tab. Choose a GPI 

Output from the “GPIO” tab in the Navigation Bar. Double click on the GPI or right mouse 

click and select “Properties”. 

9.21.1 GPI Out “General" tab 

The name and type of GPI Output are entered in the “General” tab. 

 

Figure 492: GPI Out Properties - General tab 

 

Long Name Unique name used in Director (up to 32 characters) 

8-char Label Local 8 character name for the GPI out used on key displays 

8-char Label Remote 
8 character name for the GPI out for use in trunked system (not supported   

at  this time)  

Type 
Type of GPI output (when not activated). You can choose between normally  

open and normally closed 

Off Delay 
The relay can be assigned a release delay time. Enter the amount of time the 

output should remain active after the GPIO function is turned off   

Figure 493: Table - GPI Out Properties - General functions 
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9.21.2 GPI Out “Usage” tab 

The “Usage” tab lists all ports, groups and conferences that can activate this GPI. 

Double click on an entry to edit the function directly. 

 

Figure 494: GPI Out Properties - Usage tab 

 

9.21.3 GPI Out “Rights” tab 

Corresponding user rights can be managed in the “Rights” tab. A “Rights” tab is found in all 

“Properties” windows. See: 9.22 User Rights  

 

Figure 495: GPI Out Properties - Rights tab 
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9.22 User Rights 

The “Users” tab, found on the Navigation Bar, allows Director Users to the created and 

managed. 

 

Figure 496: Users tab 

 

New users can be added using the  button.  However, this is only possible if the 

current user is the administrator or has “Account Manager” rights. Double click on a user or 

press the  button to open the properties of the user. 

 

9.22.1 User “General” tab 

The “General” tab of the User Properties manages the name, password and basic rights for 

the user. 

 

Figure 497: User - General tab 
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Long Name Unique name used in Director 

Description Additional field to enter a user description 

Password Enter a password for the user 

Repeat Password Re-enter the password 

 

Users can be assigned the following general rights: 

Allow Save to ARTIST (overwrite) Allows the use of the “Save to Artist” button 

Allow Save Changes to ARTIST (merge) Allows changes to be sent to the Artist system 

Allow Save Configuration to Disk Allows the configuration in Director to be saved to the PC 

Allow Open File from Disk 
Permits configuration files to be opened from the hard 

disk 

Restrict Properties for AV-Router 
Restricts access to the AV-Router properties (if the AV-

Router has been added) 

Scheduler Manager 
Allows the user to create and edit entries in Scheduler/  

Events (if available in Director) 

User Account Manager 

Allows this user to create new users.  New users can have  

up to the same rights as the user that created them.  The 

“Acc Mgr” field in the “Users” tab will display “Yes”  

Allow System Resets Allows the user, to reset the system 

Enable Partial Files 
Allows partial configuration to be loaded (if Partial Files 

has been added to Director)  

Allow Update 
Activates the "Update" button in the Partial Files Tools XY 

Matrix (if Partial Files has been added to Director) 

Allow Update All 
Activates the "Update All" button in the Partial Files Tools  

XY Matrix (if Partial Files has been added to Director) 

Allow Load Offline 

Activates the "Load Offline" button in the Partial Files 

Tools  XY Matrix (if Partial Files has been added to 

Director)  

Allow Load All Offline 
Activates the "Load All Offline" button in the Partial Files  

Tools XY Matrix (if Partial Files has been added to Director) 

Allow Save Partial File to Disk Allows Partial Files to be saved to the PC  

Allow PF Configuration Allows the configuration of Partial File Event Triggers 

Figure 498: Table – User restrictions 

 

In addition, each “Properties” window in Director has a “Rights” tab where individual user 

rights can be assigned for that object. 
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User rights are organized hierarchically. This means that the user rights apply as well to all 

lower level objects on the system configuration tree. Individual objects in the configuration 

can of course have access rights to them later removed.    

Normally, rights are only present that were previously given at a higher level unless they are 

manually added at the lower level. 

The user rights hierarchy levels are: 

 Web 

 Net 

 Node 

 Port 

 Key / Virtual Function 

 

For example, you can give another user rights to a complete node, only certain panels or 

particular keys. This is dependent on which hierarchy level you assign rights to the user.  

Rights to levels below that level are automatically granted.  

 

To change user rights, open the Properties window at the desired hierarchy level. Rights can 

be managed in the  tab. 

 

Only the administrator cannot have rights taken away. The administrator always has 

unlimited access to all functions and objects in the configuration. 

 

Figure 499: Panel Properties - Rights 
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The following columns are available in the Rights window 

Owner 

Displays the user who “owns” or created the object.  The current user can 

change the owner of an object if he/she has the necessary rights.  The new 

owner is automatically   granted the same rights in regards to the object 

USER List of available users 

Create children * 
Allows the current user to assign user rights to the marked users up to the 

amount of rights that he/she possesses  

Delete children * Allows the current user to remove rights from the marked users 

Edit 
Allows the marked users to edit the function (including all lower objects in   

the rights hierarchy)  

Live 
Allows the marked users to open the Live States tab  (including for all lower 

objects in the rights hierarchy. For example, all ports on Node 2)  

Remote 
Allows the marked users to open the Remote Control tab (including for all 

lower objects in the rights hierarchy. For example, all ports on Node 2) 

* These options are not available in the lowest hierarchy levels, for example at the key level  

Figure 500: Table - Panel Properties - Rights functions 

 

If rights are changed then the changes will be marked with a “*”. This shows that the 

changes have not yet taken effect. As soon as either the  or the  button is 

pressed the “*” disappears. 

Previously assigned rights are marked with a . 

 

If users attempt to configure objects without the necessary user rights they will see the 

following error message: 

 

Figure 501: User rights error message 
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9.22.2 User “Usage” tab 

The “Usage” tab on a user shows which special functions, such as “Master Control Room”, 

the user can use. 

 

 

Figure 502: User Properties - Usage 
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9.23 Setting up CONNECT Codecs and Remote Panels 

The Artist product range currently offers 4 types of codec interfaces: 

 CONNECT DUO 

 CONNECT SOLO 

 CONNECT IP 

 CONNECT IPx2 / CONNECT IPx8 

 

All codec‟s are delivered with their own configuration software for basic setup and stand 

alone use. The individual software packages are not described in this manual. Further 

information can be found on the installation CD that was delivered with the codec.   

The use of the CONNECT IP codec is completely transparent. This means that no 

configuration in Director is required. 

Attention: Do not mix up the Connect IP with the new Riedel CONNECT IPx2 and x8. This 

Interfaces need to be configured via the Director. For details see the corresponding manual 

for this product. 

The configuration procedure for CONNECT DUO and CONNECT SOLO is identical. The only 

difference is that CONNECT DUO offers the possibility to remote a control panel over ISDN.  

In the configuration instructions below, CONNECT DUO is used as an example since the 

operation of CONNECT DUO and CONNECT SOLO from a panel is identical. 

The following instructions apply only to when a codec is connected digitally to a CAT5 or an 

AES card. This type of connection allows the codec‟s to be used and configured by Artist. 

If a codec is connected analog to an AIO card, the codec functions like a normal 4-wire port.  

An intelligent connection to the matrix is not possible in this case. The codec must be 

controlled directly on the device itself. 
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9.23.1 Adding a codec to the configuration 

To add a new codec to a configuration, open the configuration view of a node. To do so, 

double click on the node or select the node in the “Network” tab of the Navigation Bar. 

Select the CAT5 or AES card that the codec will be connected to. 

Click on a port and choose the device type “Telephone codec” from the list. 

If possible, you should connect the codec to an odd numbered port. If the next port is 

unassigned, it will be automatically reserved for the codec‟s 2nd audio channel. This allows 

both of the available telephone lines on the codec to be used at the same time. 

 

Figure 503: CONNECT Solo/Duo - Adding a codec 

 

For details on setting up the codec for connection to an Artist system please refer to the 

codec‟s instruction manual. 

After the codec has been added to the node configuration, it appears in the network list with 

a  symbol. It also appears in the port list.  

 

Figure 504: CONNECT Solo/Duo - Codec in the node configuration 
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9.23.2 General tab 

To adjust the codec‟s properties, right click on the codec in the port list or network list and 

select “Properties”. 

 

Figure 505: CONNECT Solo/Duo - Properties of Telephone Codec – General tab 

 

Long Name Unique name used in Director (up to 32 characters) 

Room-Code 
Allows a Room Code to be assigned to avoid feedback when using 

conferences on ports that are physically near each other 

Enable 2nd audio channel 

Activates the 2nd audio channel 

(This function is only available, if an odd numbered port is used and the 

next port is free.  As of Director 5.90, this option is automatically 

selected when possible) 

Figure 506: Table - CONNECT Solo/Duo - Properties of Telephone Codec - General functions 
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9.23.3 Details tab 

The “Details” tab allows the basic setup of the port. Normally, no changes need to be made 

here. 

 

Figure 507: CONNECT Solo/Duo - Properties of Telephone Codec - Details tab 

 

Response Timeout Internal system timeout for panel response 

Enable for Trunk call Enables this port for trunking calls; see Trunking  

Trunking address Unique trunking address for the port; see Trunking 

Figure 508: Table - CONNECT Solo/Duo - Properties of Telephone Codec - Details functions 
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9.23.4 Port Pool tab 

This tab sets up the codec destinations. Each telephone destination, whether it is a control 

panel or a 4-wire, becomes a so called “PoolPort”. There is no limit to the number of pool 

ports that can be added. However, a maximum of 2 members can be connected to a single 

codec at the same time. Each pool port could, for example, be a predefined telephone 

destination with a fixed telephone number. 

 

Figure 509: CONNECT Solo/Duo - Properties of Telephone Codec - Port Pool tab 

 

Click the  button to add a new pool port. 

Choose the destination type in the pop up window. If a CONNECT SOLO is being used, only 

“4-Wire” should be selected because CONNECT SOLO does not support remote panels. 

 

Figure 510: CONNECT Solo/Duo - Add Port to Pool 

 

To create a connection to a telephone or a simple audio connection to another codec, select 

“4-wire”. Repeat these steps until you have created all of your virtual pool members. 
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Figure 511: CONNECT Solo/Duo - 4Wires in Port Pool 

 

Select a 4-wire port and click the   button.  All incoming calls without CLIP 

(Calling Line Identification Presentation) or with CLIR (Calling Line Identification Restriction) 

will be switched to this port. If you only have a single 4-wire pool port, it must be set as the 

“Voice Default”.   

If no “Voice Default” is defined, audio from incoming calls will not be routed into the system. 

Both CONNECT SOLO and CONNECT DUO support the CLIP function. However, it is only used 

by CONNECT DUO in ISDN mode. 

To add a control panel as a pool port, click the  button and select the panel type 

that is to be connected to the remote CONNECT DUO.   

Note: Remote panels only work with a connection between 2 CONNECT DUOs 

 

Figure 512: CONNECT Solo/Duo - 4Wires and panels in a port pool 

  

It is also imperative to define a panel as the “Panel Default” for the port pool. Select a panel 

and click the  button.  In the “Default” column the word “Panel” will appear.  This 

signals that incoming panel calls without a recognizable telephone number will be routed to 

this panel. Even if there is only 1 panel in the port pool, it must be defined as the “Panel 

Default”. 
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All virtual 4-wire and panel ports appear in the network list and the port list. 

 

Figure 513: CONNECT Solo/Duo - Pool Panels in the network view 

 

9.23.5 Telephone Number tab 

The “Telephone Number” tab is used for entering the MSN telephone number of your own 

telephone connection. If you are using an ISDN connection, it is very important to enter 

these numbers. The MSN numbers will then be transferred to the codec. 

 

Figure 514: CONNECT Solo/Duo - Properties of a telephone codec - Telephone number tab 

 

Telephone number  1st Channel MSN number for the 1st channel, or Pots Line 1 

Telephone number  2nd Channel MSN number for the 2nd channel, or Pots Line 2 

Figure 515: Table - CONNECT Solo/Duo - Properties of a telephone codec - Telephone number functions 
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9.23.6 Rights tab 

Corresponding user rights can be managed in the “Rights” tab. A “Rights” tab is found in all 

“Properties” windows. See: 9.22 User Rights  

 

Figure 516: CONNECT Solo/Duo - Properties of Telephone Codec - Rights Tab 
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9.23.7 Pool Panel – 4-wire properties 

Right mouse click on a pool port and select “Properties” to open the properties of the pool 

port. 

All of the tabs and settings of a pool port are identical to a normal 4-wire port. The only 

difference is that a pool port also has an additional “Telephone Codec” tab where the 

number to be dialled by the pool port can be entered. 

 

Figure 517: CONNECT Solo/Duo - Properties of Pool Port - 4Wire Telephone Codec tab 

 

Phone No. to dial 
Enter the telephone number to be dialled.  If no number is entered, it is 

also possible to manually dial a number later from a control panel  

Phone No. incoming 

Enter the incoming telephone number. This is normally identical to the 

telephone number to be dialled. It enables the caller to be assigned to  

the correct panel keys. If no telephone number is entered, the Voice 

Default port will be used for incoming calls 

Hang up timeout Automatic hang up after a certain time has passed (10s – 4h) 

Protocol 

Select the type used by the destination codec. For 4-wire connections 

with a CONNECT DUO using an ISDN connection either the G.711 codec 

(normal telephone codec, 3,5kHz) or G.722 codec (digital codec for 

connection to another codec, 7kHz) can be used. The G722/Artist Code  

is only used for the connection of panels over ISDN. CONNECT SOLO    

only supports the G.711 codec. 

Codec-Channel Select the channel that the port should use to dial 

Figure 518: Table - CONNECT Solo/Duo - Properties of Pool Port - 4Wire Telephone Codec functions 
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9.23.8 Pool Panel – Panel properties 

Right mouse click on a pool port and select “Properties” to open the properties of the pool 

panel. 

All of the tabs and settings of a pool panel are identical to a normal panel port. The only 

difference is that a pool panel also has an additional “Telephone Codec” tab where the 

number to be dialled by the pool panel can be entered. 

 

Figure 519: CONNECT Solo/Duo - Properties of Pool Port - Panel Telephone Codec tab 

 

Phone No. to dial 
Enter the telephone number to be dialled. If no number is entered, it is 

also possible to manually dial number later from a control panel 

Phone No. incoming 

Enter the incoming telephone number. This is normally identical to the 

telephone number to be dialled. It enables the caller to be assigned to  

the correct panel keys. If no telephone number is entered, the Panel 

Default panel will be used for incoming calls 

Hang up timeout Automatic hang up after a certain time has passed (10s – 4h) 

Protocol To remote a panel over ISDN select the G722/Artist Codec 

Codec-Channel Select the channel that the port should use to dial 

Figure 520: Table - CONNECT Solo/Duo - Properties of Pool Port - Panel Telephone Codec functions 
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9.23.9 Setting up a panel to use a CONNECT/SIP codec 

The following examples show the various ways to operate a codec from a control panel. 

9.23.9.1 Dialling a connection with a fixed number 

This is the easiest way to dial a number from a control panel. It requires that all pool ports 

have a fixed telephone number assigned to them in their “Properties”.   

Choose a key to handle dialling functions. Right mouse click on the key and select the 

“Dial/HangUp” function under “Add Function” -> ”Telephone Dial/HangUp”. Set the key 

mode to latching with a short timeout and without a dim function. If this is not done, the 

dial and destination keys must always be pressed together. 

Pull pool ports to panel keys using Drag & Drop. They will automatically be added with the 

standard “Call to port” function. 

 

Figure 521: Dialling - Assigning a dial function 

 

To create a connection, press the “Dial/Off” key. The markers above all available telephone 

destinations (pool ports) will begin to flash. 

 

Figure 522: Connect - Panel - Dialling with a PoolPanel 

 

While the “Dial/Off” key is still active, press the key of the pool port that you would like to 

call. The marker above the pool port indicates that it is dialling. As soon as a connection has 

been established, the marker changes to the normal “Call to Port” marker. As long as the 

connection is active the key functions like a normal “Call to Port” key. You can adjust the 

incoming volume level and talk to the destination by pressing the key. If you call a voice 

port pool, make sure that the 4-wire has a Vox connection back to your control panel. 

 

Figure 523: Connect - Panel - Number is dialled 

 

To break the connection, press the “Dial/Off” key and key of connection you would like to 

end. The pool port will then revert to displaying the standard “Pool Port Offline” marker.  

See: “9.8.7 Marker Definitions” 
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9.23.9.2 Manually dialing a telephone number without a built-in keypad 

With the help of the “Telephone Dial Keypad” function it is possible to create a keypad on 

any panel. Add a function to a key by selecting “Add function” -> “Telephone Dial Keypad”.  

In the properties of the function you can select the exact digit or function to add to the key. 

 

Figure 524: Connect - Telephone Dial Keypad - Keypad tab 

 

The key functions can be selected from the drop down menu. 

0 – # 
Selects a keypad digit to assign.  Only one number can be assigned per 

key  

CL Clear - each key press deletes the previous digit  

DisplayH 

Displays the telephone number entered. The digits “scroll” on to the key 

as they are dialled.  If the telephone number has more than 8 digits, they 

“scroll” on to the Display H key  

DisplayL 

Displays the telephone number entered. The digits “scroll” on to the key 

as they are dialled. The Display L key shows the last 8 digits of the 

number dialled 

Numbers can also be entered manually by pressing the corresponding 

level control and scrolling 

Pressing the display key dials the number entered (comparable to 

Dial/Off). Any preset telephone numbers will be temporarily ignored and 

the manually entered telephone number will be dialled 

ReplyH Shows the first 8 digits of an incoming telephone number (if available) 

ReplyL 

Shows the last 8 digits of an incoming telephone number (if available).  

The number of the last caller will always be displayed. 

Pressing the key dials the last incoming telephone number (Dial/Off) 

Phone No 

Allows the entry of a telephone number that is dialled when the key is 

pressed. (This function is perfect for multiple use in scroll lists to create   

a telephone book)  

Figure 525: Table - Connect - Telephone Dial Keypad - Keypad functions 
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Figure 526: Connect - Panel - Example of a keypad configuration 

 

Press the digits to enter the telephone number. The number dialled will be displayed in the 

“DisplayL” (digits 1-8) and the “DisplayH” (digits 9-16) keys. The normal display text in the 

keys may be temporarily overwritten.  

 

Pressing the “CL” key will delete the previous digit. 

 

To dial a number that was entered manually, press the number in the “DisplayH”- or  

“DisplayL”- keys. The markers of all available pool ports on the panel will start to flash.  

Press the pool port that you wish to dial the number. This will temporarily override any pre-

assigned number on the port. From this point on the panel functions just like it did when 

using the “Dial/Off” key. 

 

Figure 527: Connect - Panel - Dialling of a manually entered number 

 

To break the connection, press either the “DisplayL” or “DisplayH” key and the key of the 

connection you would like to end. 

 

 

If the panel receives an external call from someone who transmits their telephone number, 

it will appear in the “DisplayL” or “DisplayH” keys. In any case, these keys will display the 

number of the last caller. Press the “ReplyL” key + an available pool panel to call the 

number back. 
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The “DisplayL” key offers another way to dial a telephone number without a built-in keypad.  

Telephone numbers can be entered by pressing and turning the encoder next to the key. 

Press the encoder once. The digit “0” will appear in the display. Turn the encoder until it 

displays the number you wish to enter.  The next number can now be entered by pressing 

the encoder again. 

 >  > > > >  

Figure 528: Connect - Panel - Entering a number by using the volume encoder 

 

The number entered in this way is dialled exactly like a number entered on a keypad. 

 

You can also use the “Telephone Keypad” function to assign a phone number to a key. In 

this case the “Phone No.” key behaves exactly like a “DisplayL” key. This means that 

pressing the key along with a pool port will dial the number. This will temporarily override 

any previously assigned number the pool port was assigned. It is recommended to manually 

define the key‟s display. 

 

Figure 529: Connect - Telephone Keypad - Phone No. function 

 

To dial, press the telephone number key + the pool port to be used. 

 

 

Figure 530: Connect - Panel - Dialling of a preset number 
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9.23.9.3 Manually dialling a telephone number with a built-in keypad 

Expansion panels with built-in keypads are available for 1000 and 2000 series control 

panels. These expansion panels allow telephone numbers to be dialled quickly. Some of the 

keys on the expansion panel keypad do not currently have functions assigned (“M” keys, 

plus “P”,”R” and “S” keys) 

The “C” key deletes the last digit entered. It works just like the “Clear” command from the 

keypad function. 

 

To use the keypad, you must still program the “DisplayL” and “DisplayH” keys to the panel, 

as well as the pool ports to be used. 

 

 

Figure 531: Connect - Keypad panel setup 

 

The number entered on the keypad will appear in the “DisplayL/H” keys. To dial the number 

press the “DisplayL” + a pool port key. The rest of the procedure is the same as that for a 

panel without a built-in keypad. 
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9.23.10 Setting up a Remote Panel using CONNECT DUO 

To remote a control panel with CONNECT DUO, create at least one pool port panel in the 

properties of the codec. The control panel will appear in the network list and the port list as 

a normal panel. Open the panel‟s properties to enter the telephone settings. 

In the “Telephone Codec” tab of the pool panel select the G.722/Artist protocol. You can 

also optionally assign the ISDN channel to be used, a hang up timeout and a fixed 

telephone number for the panel.  

 

 

Figure 532: CONNECT Solo/Duo - Properties of an ISDN panel - Telephone Codec tab 

 

 

Make sure that the “Response Timeout” for the ISDN panel is at least 200ms (“Details 2” 

tab of the panel properties). This increases the stability of the data connection between the 

matrix and the control panel, which can be disrupted by the longer delays on ISDN lines. 

 

Figure 533: CONNECT Solo/Duo - Properties of an ISDN panel - Details 2 - Response Timeout 

 

 

You can now configure the ISDN panel just like any other control panel. All of the functions 

are available that are available for panels connected directly to the matrix.  
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However, the panel requires a special key to terminate a standing ISDN connection from the 

remote panel. 

Select the option “Stop Connection” from the “Telephone Dial/Hang up” function and add it 

to a key. 

 

Figure 534: Connect - Dial Function - Stop Connection 

 

 

Figure 535: CONNECT Duo - ISDN panel 

 

To establish a connection to the matrix from an ISDN panel, you must dial the telephone 

number directly on the CONNECT DUO. 

As long as there is not an active ISDN connection, the remote panel will remain in “waiting 

mode”. The display will show “Wait for CAT5/Coax”. As soon as a connection is established, 

the panel will boot and receive its configuration from the Artist matrix. When the keys show 

their function the system is connected and ready for use.  

 

Director does not currently support the 2 channel mode for remote panels. However, 

experienced users can configure a work around: 

It is possible to create an additional 4-wire connection to the 2nd ISDN channel of the 

remote panel. If the audio patch in the ISDN panel is configured properly, and the extra 4-

wire connection is active, the 2nd audio channel on the control panel can be used. 
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10 SYSTEM PARAMETERS 

10.1 Default Settings 

Parameter Minimum Maximum Default 

Min. Speaker Vol. -45dB 0dB -45dB 

Min. Headset Vol. -45dB 0dB -45dB 

Beep Volume mute 0dB -30dB 

Beep On Call Duration 0ms 1000ms 250ms 

Speaker Dim Level mute 0dB -18dB 

Initial single volume mute +6dB 0dB 

Initial conference volume mute +6dB 0dB 

Vox On Threshold permanent +12dBu -24dBu 

Vox Off Threshold -69dBu +9dBu -27dBu 

Vox Hold Time no delay 6400ms 800ms 

Brightness of LEDs / LCD Keys 10% 100% 50% 

Brightness of LED Keys / LCD 10% 100% 30% 

Response Timeout 0ms 1000ms 32ms 

Response Timeout ISDN 0ms 1000ms 200ms 

Dim lower Prios for "Standard" mute 0dB -12dB 

Dim lower Prios for "High" mute 0dB -18dB 

Dim lower Prios for "Paging" mute 0dB -24dB 

Dim lower Prios for "Emergency" mute 0dB mute 

Reply Key Timeout 0s 24hrs 3s 

Minimum XP Volume mute 0dB mute 

Input Gain *) -18dB +18dB 0dB 

Output Gain *) -18dB +18dB 0dB 

GPIO Out Off Delay no delay 5s no delay 

Figure 536: Table - System parameters 

 

*) When controlling the I/O gain of a port using a panel, the gain can also be muted. 
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Parameter Minimum Maximum Default 

Audiopatch Input Mic Pre-Amplifier Gain 0dB +20dB 0dB 

Audiopatch Input Amplifier Gain mute, 0dB +18,5dB +3dB 

Audiopatch Input High Pass Filter Cut-Off off, 40Hz 640Hz off 

Audiopatch Input Low Pass Filter Cut-Off off, 1kHz 16kHz off 

Audiopatch Input Compressor Threshold -48dB +12dB -15dB 

Audiopatch Input Compressor Ratio 1:1 8:1 2.5:1 

Audiopatch Input Compressor Attack 100μs 100ms 20ms 

Audiopatch Input Compressor Release 10ms 1s 500ms 

Audiopatch Input Limiter Out-Level -33dBU +12dBU +9dBU 

Audiopatch Input Limiter Threshold -6dBr +6dBr -3dBr 

Audiopatch Input Limiter Attack 100μs 100ms 200μs 

Audiopatch Input Limiter Release 10ms 1s 200ms 

Audiopatch Crosspoint Level -60dB +12dB 0dB 

Audiopatch Output High Pass Filter Cut-Off off, 40Hz 640Hz off 

Audiopatch Output Low Pass Filter Cut-Off off, 1kHz 16kHz off 

Audiopatch Output Compressor Threshold -48dB +12dB +12dB 

Audiopatch Output Compressor Ratio 1:1 8:1 1:1 

Audiopatch Output Compressor Attack 100μs 100ms 50ms 

Audiopatch Output Compressor Release 10ms 1s 500ms 

Audiopatch Output Limiter Out-Level -33dBU +12dBU +6dBU 

Audiopatch Output Limiter Threshold -6dBr +6dBr +6dBr 

Audiopatch Output Limiter Attack 100μs 100ms 100μs 

Audiopatch Output Limiter Release 10ms 1s 100ms 

Audiopatch Output Amplifier Gain -27,6dB 0dB 0dB 

Figure 537: Table - System parameters 
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10.2 Specifications / System Limits 

Parameter Node Net Notes 

Nodes - 128   

Ports 128 1024 Any combination of 4-wires and panels is possible 

Groups 350  

Group members 64  

Conferences 350  

Conference members 64  

Keys per control panel 124 RCP-1028 with 6 x ECP-1016 

Functions per key or Virtual 

Function 
32   

Reply key entries 20 Lists the last incoming calls to the panel 

GPI inputs 1000  

GPI output 1000  

Logic functions 64 8192   

Logic inputs no limit   

Logic inputs per function 8   

Scroll lists 100   

Entries per scroll list 1000   

Scroll Lists per panel 1   

Users per configuration 50   

Available user rights per user  255   

Maximum volume level +18dB   

Figure 538: Table - Specifications / System Limits 

 

 

 

 

Figure 539: Director limits 
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11 SPECIAL FEATURES (SOFTWARE ADD-ONS) 

11.1 Unlocking Software Add-ons 

This part of the manual describes the four optional software add-ons that are currently 

available in Director. Generally, all functions and add-ons are implemented in Director.  

However, in order to use the add-ons they must be first unlocked. The unlocking process 

always takes place only on the local PC. If several configuration PCs are used on an Artist 

system, each PC must be unlocked separately in order to use the add-ons. 

There are two ways to unlock special features: 

 Manual activation key 

 USB dongle 

You must be logged in as the Administrator in order to activate special features. 

 

11.1.1 Manual activation key 

On the basis of various PC components, such as the hard drive ID and MAC address, 

Director generates a unique code for each software add-on. To unlock one of the special 

features, the code must be given to a Riedel dealer who will then be able to give you the 

corresponding activation key. 

Note: This code is only valid for a particular software add-on used on a particular PC. If you 

change PCs or replace your hard drive the code will no longer be valid. In that case, you 

must request a new code from your Riedel dealer. 

To unlock a special feature select “Register special features from the “Extras” menu”. 

 

Figure 540: Registration - Extras - Register special features … 

 

 

Figure 541: Registration - Register Special Features 
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Click on the  button of the feature you would like to add. A pop up window opens 

where the registration key is given. 

 
Figure 542: Registration - Registration dialog 

 

Using the  button, you can copy the code to the Windows clipboard in order to 

paste it into a Word document or an email. Send the code to Riedel Communications GmbH 

& Co. KG or your local dealer. 

As soon as you have received the activation key, repeat the steps above and enter the key 

in the registration dialog window. Click the  button to activate the special 

feature. 

You only have to activate a special feature on a PC once because the code is saved in the 

Windows registry. Upgrading to a new version of Director does not require a new 

registration. 

 

11.1.2 USB DONGLE 

As an alternative to manually entering an activation code, you can activate special features 

using a USB dongle. The dongle automatically activates all special features that you have 

ordered as long as it is connected to the PC. This activation method has the advantage that 

you can quickly change the configuration PC without causing any problems with the 

software registration, for example in an emergency situation. 

Depending on your operating system, you may have to first install the corresponding USB 

driver. The driver is delivered along with the USB dongle. After the installation, restart 

Director. 

It is not necessary to activate the dongle in Director. Director automatically recognizes 

whether the dongle is installed or not. All special features that you have ordered will be 

immediately available for use.  Registration using the “Extras”… menu is not necessary. 

If features in Director were already manually unlocked this does not present any problem.  

The dongle has priority. If the dongle is removed the manual registration remains active.  

 

mailto:customerservice@riedel.net?subject=Request%20of%20Director%20Special%20Feature%20Registration%20Code
mailto:customerservice@riedel.net?subject=Request%20of%20Director%20Special%20Feature%20Registration%20Code
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12 PARTIAL FILES 

12.1 Purpose 

The special feature “Partial Files” enables you to save and load only a certain part of a 

configuration. For example, you can switch back and forth between different assignments 

for specific keys or complete configurations for panels. When needed, these partial 

configurations can be sent to the system to change the functionality of one or more control 

panels. These partial configurations only affect certain objects, such as particular panels, 

and can be loaded to the system without changing the entire configuration. The partial 

configuration files are saved on a hard disk and called up as needed. The use of a base 

configuration in conjunction with partial files, that are either manually or automatically 

loaded, offers maximum flexibility in the use of the system. 

Partial files can be loaded in various ways. They can be manually opened from a hard disk 

and sent to the system. Partial files can also be loaded using a XY-Matrix in Director.  

Activating a crosspoint in this matrix automatically loads a corresponding partial file into 

the system. The easiest way to load a partial file is with the “Partial File Trigger”. Using this 

tool a partial file can be loaded via a logic function placed on a panel key or GPI. In this 

case, it is necessary that the PC where the saved partial files are located is permanently 

online and connected to the system. 

12.2 Creating Partial Files 

When using partial files, you should always create a pair of files - an “ON” file and an “OFF” 

file. This means that before you begin to make changes on a panel to save as a partial file, 

you should first save the current status of the panel as its own partial file. This allows a 

return to the original configuration state. The “ON” file represents the temporary 

configuration change, and the “OFF” file allows the return to the basic configuration. 

A partial file may be assigned any element or function that is available in Director, from a 

complete node to individual keys, conferences, groups, logics users, scroll lists, etc. 

In the File menu, select “Save Partial Configuration as …” to save a certain part of the base 

configuration as a partial file. 

 

Figure 543: Partial Files - File - Save Partial Configuration as … 
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A window opens in which all nodes, users and functions in the base configuration are 

displayed in a tree structure. 

 

Figure 544: Partial Files - Define Partial Configuration selection 

 

Director automatically marks items that were changed since the configuration was last 

saved. 

A box filled red   indicates something that was changed. A box that only has a red dash 

 means that the change took place in a level below that point. Click the  symbol to 

expand. 

To select an item manually, click on the box next to it. If the box is filled in red, the item will 

be included in the partial file. 

All of the items marked with the red box can then be saved as a partial file. Click 

 to save. 

If you are working with a system that already has existing partial files, it is imperative to 

create any partial files from the base configuration. If you were to simply load the current 

configuration from the matrix to create a new partial file, it could be that an existing partial 

file was already active within the Artist system. This would result in it no longer being 

possible to remove all of the partial files to return to the original configuration. 

 

Before creating a new partial file it is therefore necessary to deactivate all existing partial 

files by loading their corresponding “Off Files” to the system. Afterwards, the configuration 

can be read out of the system or you can load the base configuration from a hard disk to 

create a new partial file.  

Please take note that when you load a configuration from the system to the PC in order to 

save it, it may contain an active partial file. If this configuration were then to be saved as a 

complete configuration file, any active partial files would also become part of the 

configuration.  The base configuration would then be unusable. Before saving the 

configuration make sure that all partial files have been deactivated. 



   

                                                                                                     DIRECTOR 6.20 Configuration Software, User Manual, Version 3.4 

 

 

Page 312 

12.3 Downloading a Partial Configuration file 

“Partial” configuration files only include a part of a complete configuration. These partial 

files only affect, for example, a single panel and can be loaded into the system without 

changing the rest of the configuration. The partial files are saved to a hard disk and opened 

as needed. The use of a base configuration in conjunction with partial files, that are either 

manually or automatically loaded, offers maximum flexibility in the use of the system.  

A partial file may be assigned any element or function that is available in Director, from a 

complete node to individual keys, conferences, groups, logics users, scroll lists, etc. See: 

12.2 Creating Partial Files 

To manually load a partial file, select „Open Partial Configuration…„ in the File menu. A 

window opens where you can open previously saved partial files ending with “*.Par”.    

 

Figure 545: Partial Files - Opening a partial configuration file 

 

Using the  button, the partial file can now be loaded into the system. 

Note: Director does not ask for confirmation before loading the file. Make sure that the 

corresponding base configuration is already open in Director. 

 

Warning:  Partial Files do not support the “Auto Reverse Talk for 4-wire” function which 

automatically programs a return audio path from a 4-wire to a control panel. If 

you add a call from a panel to a 4-wire in a partial file, you must manually 

configure the return audio route to the panel as a part of the partial file. 

 

  

 

  

Select the partial file you wish to 

load and click “Open”, or simply 

double click on the file. The file will 

be opened and added to the base 

configuration.  
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12.4 Opening Partial Files 

There are three different ways to open partial files. The easiest way is to load the partial file 

via the “File” menu, as described above. To open complex combinations of partial files, for 

example to automatically load files for particular studio assignments, the “Partial XY-Matrix” 

can be used. It allows pre-defined partial files to be loaded or deactivated by setting a 

crosspoint in the matrix. Another possibility to open partial files is with the “Partial File 

Trigger” function. This function allows partial files to be connected to a logic source. When 

the source is activated, for example by a key press or GPI input, the partial file is loaded 

automatically. 

 

 

Figure 546: Partial Files - File - Open Partial Configuration … 

 

 

The “XY-Matrix” and the “Partial File Trigger” require Director to be permanently connected 

to the system. Director must be open and the files required should be saved locally on the 

hard drive of the PC. Only one Director PC in a network can have this option active. 
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These options can be set in the “Partial Files” tab found under “Settings” > “Options”. With 

the XY matrix it is possible to only use the local Director as a server while the setting of the 

actual crosspoints in the XY-matrix takes place on another “Client” PC. This has the 

advantage that the PC with the partial files can be located in a machine room while the 

control of the partial files can be carried out at a regular workspace. In this case, the partial 

files remain on the server. 

 

 

Figure 547: Partial Files - Settings / Options / Partial Files 

 

Handle Partial File 

Trigger… 

Selects whether Director will load partial files that were triggered by a 

logic source. 

WARNING! The partial files must be saved on the local PC. Only one 

Director PC in the system can have this option active at a time 

Restrict  crosspoints 

When this is selected only one crosspoint is allowed to be active in each 

row or column.  In order to set a new crosspoint, previous crosspoints  

must first be removed. If this option is not activated, only one crosspoint 

may be set in each row, but multiple crosspoints can be set in a column  

Standalone mode The XY-Matrix is controlled from the local PC 

Server mode 

This PC acts as a server. The partial files are controlled by the client PC 

Note: All partial files must be saved locally on the hard drive of the sever 

PC 

Client mode 
This PC acts as a client and controls the server PC. The individual partial 

files should not be located on this client PC  

Server IP to connect to 
If your PC is set to be a client, you must enter the IP address of the server 

PC where the partial files are located 

Figure 548: Table - Partial Files - Settings / Options / Partial Files functions 
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12.4.1 XY-Matrix 

The “XY-Matrix” is a convenient tool for handling partial files in a variety of production 

settings. Each row and column of the matrix can be customized.  This is useful, for example 

when a number of control rooms must be dynamically assigned to several different studios.  

Depending on the situation, crosspoints in the XY-Matrix are set and the necessary 

configuration is automatically loaded into the system. 

You can open the XY-Matrix by selecting “View” > “Partial Files XY-Matrix” or by clicking on 

the  button in the toolbar. 

 

Figure 549: Partial Files - XY Matrix - “View” > “Partial Files XY-Matrix”  

 

The XY-Matrix window will be empty the first time you open it. 

 

Figure 550: Partial Files - XY-Matrix (not yet configured) 

 

 

 



   

                                                                                                     DIRECTOR 6.20 Configuration Software, User Manual, Version 3.4 

 

 

Page 316 

Update Loads the required partial files and sends them to the Artist system 

Update All 
First loads all of the “Off Files” and the required “On Files” from the   

hard disk and sends them to the Artist system  

Load Offline 
Loads the required partial files locally in the configuration without  

sending the changes to Artist  

Load All Offline 

Loads all of the “Off Files” and the required “On Files” from the hard disk 

without sending the changes to Artist.  This option can be used to test 

whether the partial files load correctly 

Edit XY-Matrix setup… Opens the edit window for editing the XY-Matrix 

Close Closes the XY window 

Figure 551: Table - Partial Files - XY-Matrix functions 

 

Click the  button to customize the XY-Matrix according to your 

requirements. It is only necessary to set up the XY-Matrix on the server if running in client-

server mode. The view from the server will be shown in the XY-Matrix on the clients as soon 

as there is a connection. 

 

Figure 552: Partial Files - XY Matrix - XY-Matrix setup 

 

You can create entries on both the X and Y axes by clicking the corresponding  

button. 

 

Figure 553: Partial Files - XY Matrix - Adding an entry in XY matrix 

 

Assign the row or column a name. For each entry you can assign 2 GPI inputs that will 

trigger a signal next to its name in Director. These signals can be used to indicate “On Air” 

or rehearsal status in a studio. This way you can see in the XY-Matrix if certain studios are 

being used, and thus avoid changing their configuration. Create all of the entries necessary 

on the X and Y axes.   
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You can change the order of items by selecting them and using the  and 

 buttons. 

 

Figure 554: Partial Files - XY Matrix - Example XY-Matrix setup 

 

Close the configuration window by clicking “OK” to see the updated XY view. 

 

Figure 555: Partial Files - XY-Matrix 

 

After the basic matrix layout has been created, you must assign partial files to the individual 

crosspoints. Right mouse click on a crosspoint and select the corresponding partial file. The 

files should have already been created.   

 

Figure 556: Partial Files - XY Matrix - Selecting Partial Files in XY matrix 
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Select “Select new On-File for…” the crosspoint. A window opens where you can select the 

corresponding “.Par” file. Repeat for the respective off file and all other crosspoints in the 

XY-Matrix.  

 

Figure 557: Partial Files - XY Matrix - Selecting the Partial Files 

 

All XY-Matrix settings, including the assignment of partial files to crosspoints, is saved in the 

same directory that Director is located in. A file called “Director_RPS.xml” is automatically 

created which contains this information. The XY-Matrix setup is not a part of the standard 

configuration file. If you move Director to another directory or to another PC, you must also 

move the “Director_RPS” file.  

 

To make an assignment in the XY-Matrix, click on the corresponding crosspoint. The 

crosspoint will be highlighted yellow. (If you are running the XY-Matrix in server-client mode, 

you must first click the  button to connect to the server. The XY-Matrix settings 

will then be directly displayed on the client PCs). 

 

Figure 558: Partial Files - XY Matrix - Switching Crosspoints 

 

The corresponding partial files will be loaded to the Artist system by clicking on the  

or  buttons. The yellow highlighting will then disappear. This indicates that the 

crosspoints are currently active in the system. 

 

Figure 559: Partial Files - XY Matrix - active crosspoints 
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12.4.2 Partial Files Trigger 

The “Partial File Trigger” offers a completely different approach to handling partial files.  

This tool allows partial files to be assigned a logic source. As soon as this logic source is 

activated anywhere in the system, for example by a key press or GPI input, the 

corresponding partial file is loaded to the matrix. This allows configuration changes to be 

made quickly from any point in the system.  

To use this option, first activate it under “Settings” > “Options” > “Partial Files”. 

Attention: Only 1 PC in an Artist system should have this option activated. This PC must 

permanently have Director open and always be connected to the system. All partial files 

required must also be located on this PC. 

 

Figure 560: Partial Files - Partial File Trigger - Settings > Options > Partial Files 

 

First, create the necessary logic functions. A logic source will be needed for each partial file.  

In the “Logic” tab of the Navigation Bar, click the  button to create a new logic 

source. Give the source a distinct name. 

 

Figure 561: Partial Files - Partial File Trigger - Logic Sources 
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Figure 562: Partial Files - Partial File Trigger - Properties of a Logic Source 

 

Next, open the “Partial File Trigger” via “View” > “Partial File Trigger” or click the  button 

in the toolbar. 

 

Figure 563: Partial Files - View - Recall Partial Files - Partial File Trigger 

 

The “Partial File Trigger” window will open. 

 

Figure 564: Partial Files - Partial File Trigger 
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To create a new connection between a logic source and a partial file, click the  

button.  The “Add/ Change Partial File Trigger” window will open. 

In the field “Logic Source”, select the logic source that should trigger the partial file. 

 

Figure 565: Partial Files - Partial File Trigger - Add or Change Partial File Trigger 

 

In the field “Panel which triggers the Logic Source” you can define which panels are allowed 

to trigger the partial file. You can assign this privilege to a certain port by selecting it from 

the drop down menu. If multiple ports should be able to load the file, check the  

box. 

Select the partial file that should be loaded when the logic source is activated. Click the  

 button. 

 

Figure 566: Partial Files - Partial File Trigger - Selecting the Partial Files 

 

Choose the corresponding “.Par” file and click the open button. 

 

The “Add/Change Partial File Trigger” window will now display the logic source and partial 

file assignment. Click  to close the window and confirm the changes. 

 

Figure 567: Partial Files - Partial File Trigger - Add or Change Partial File Trigger 
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An entry will now be displayed in the “Partial File Trigger” window. Repeat the steps above 

to make further assignments. 

 

Figure 568: Partial Files - Partial File Trigger 

 

To edit an assignment, double click on the entry or select it and click the  button.  

To delete a selected entry, click  . All assignments can be deleted by clicking the 

 button. Note: the entries will be deleted without asking for confirmation. 

 

These logic source / partial file assignments will be automatically saved in the 

“Director_ERT.xml” file located in the same directory as Director. The assignments are not a 

part of the standard configuration file. If you change the location of Director on your PC, you 

must also manually move this file to the same directory. 

 

You can now assign the logic sources as usual to keys, Vox, GPI inputs, etc. When the logic 

source is activated, the corresponding partial file will be automatically loaded to the system. 

 

Figure 569: Partial Files - Partial File Trigger - Assigning a Logic Source 
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13 MASTER CONTROL ROOM (MCR)  

Overview 

The “MCR” software add-on provides a convenient way to manage conferences and their 

members. It is normally used in a master control room to dynamically assign various 

members to individual conferences. The “MCR” offers an overview window where 

conferences can be easily monitored and changed. Individual members can be added to 

conferences using Drag & Drop. The interface also shows which members are currently 

speaking into a conference and what conferences are being spoken into. It can directly 

adjust 4-wire gain levels and use presets to mange member assignments. The “MCR” can 

also be used by multiple users on different PCs and changes will be synchronized between 

the PCs. The activation of “MCR” features from multiple control panels is also possible.   

 

Figure 570: MCR - Typical MCR view 

 

A comprehensive system of user rights allows different parts of the “MCR” to be accessible 

to different users, as well as the creation of multiple user specific views. All settings and 

user rights are a part of the standard configuration and are therefore independent of any 

specific PCs.   
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13.1 Adding the MCR 

To use the MCR, the special feature must first be unlocked on all of the Director PCs. (See: 

“11.1 Unlocking Software Add-ons“). Afterwards, the MCR must be added to the current 

configuration. Select “Edit” > “Special Interfaces” > “Add” > “Master Control Room”. 

 

Figure 571: MCR - Adding the MCR 

 

The  symbol will appear in the network view.  The MCR can now be configured and used. 

 

Figure 572: MCR - MCR in the Network View 

 

13.2 Creating MCR Conferences 

When setting up the MCR, there are a few prerequisites that must be taken care of first. It is 

necessary to create new conferences that are to be used in the MCR. Open the 

 tab in the Navigation Bar. 

Click on the  button to create a new conference. Give the conference a unique 

name. In order to use the conference in the MCR, you must select the option “Enable for 

Master Control Room use”. 

 

Figure 573: MCR - Creating a MCR conference 

 

If you also intend to control the MCR interface using a control panel, you must select the 

option “Create an associated logic source for MCR use”. This will automatically create a 
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logic source for this conference, which is necessary for controlling the interface from a 

control panel. If you only intend to use the MCR interface on the PC, this option is not 

required. 

Repeat the steps above for all the conferences that should be used in the MCR. 

 

 

13.3 Configuring the MCR 

 
The MCR must be set up in advance before you use it. Right mouse click on the MCR in the 

Network View and select “Properties”. 

 

Figure 574: MCR - MCR Properties 

 

You can also open the MCR by clicking on the  button in the toolbar and right clicking on 

the MCR window and selecting “MCR Properties”. Since the MCR is an online tool, the user 

interface will only be shown when there is an active connection to an Artist system.  

 

Figure 575: MCR - Properties of the MCR 
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A properties window will open where all of the basic settings can be made.  

 

Figure 576: MCR - MCR Properties window 

 

13.3.1 Creating MCR members 

 

All members to be used in the MCR tool must be added and defined in advance. On control 

panels, this reserves an empty key for MCR use. Each element of an MCR member 

corresponds to a fixed key. Each MCR member can consist of several elements spanning 

multiple ports. For example, an MCR member could include different ports or just two 

identical MCR keys located on the main page and shift page of a particular control panel.  

Because an MCR member element corresponds to a specific key, it provides a way for a 

panel to be assigned to different conferences on different keys at the same time. In this 

case, each key would be a separate element for the MCR member. In the members tab, 

click on the  button. 

 

Figure 577: MCR - Edit MCR Member 

 

In the field “8-char Label”, give each member a unique name. Using the “Alias” field, you 

can later assign each member a temporary name. If you want to later remote control the 

MCR from a control panel, you must also activate the “Create an associated logic source for 

MCR use” option. This will automatically create a new logic source for this member in 

Director. 

 

You can now add elements to this member.  Press the  button. Select a port from 

the “Destination” list. 
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Figure 578: MCR - Add new element 

               

If you select a control panel as a port, you must specify the exact position of the key that 

should later serve as a place holder for conferences. To do so, the physical location of the 

key has to be defined. Under “Expansion Panel” select whether the key is located on the 

main control panel or on an expansion panel. Under “Key Page”, select the page where the 

key is located. Under “Key”, the actual key is selected. All of the key labels are shown in the 

drop down list. This allows an empty key to be selected easily. If you are adding a 4-wire or 

2-wire port, you do not need to specify a key. In that case, the conferences will be 

programmed on the VOX function of the port.       

 

Figure 579: MCR - Choosing the MCR key 

     

Assign whether the member element should be able to listen and/or talk into the 

conference.  To do so, select the corresponding options  and . 

If you want to use the 2nd audio channel of a panel in the MCR, select this option on 

. This is only available if the panel was previously 

configured for 2 channel use.   

Using the  option, you can select whether the MCR 

user interface should indicate when audio from this panel is active. 
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You can edit a selected entry using the  button.  Using the  button deletes the 

selected entry.  

Repeat the steps above for each member and for each member element required in the 

MCR tool. 

 

Figure 580: MCR - Add new MCR Member – example 

 

13.3.1.1 Using 4-wires in multiple conferences  

 
Up from Director Version 6.0 you can choose, if you want to use a 4-wire (or 4-wire split) 

member in different conferences at the same time or not.  

Up to Version 5.91 all MCR 4-wire members always could be used simultaneously in 

different conferences. If you now open an older configuration with Director 6.x this function 

is now deactivated for all 4-wires. If you want to use a 4-wire simultaneously in different 

conferences, you have to enable this function for every member individually. 

If you want to allow using a 4-wire simultaneous in different conference, you have to enable  

 in the „Edit MCR Member” window. 

A panel-port is always used in max. one conference at the time. If you are trying to enable 

the panel to be used in multiple conferences, you get an error-window. 

 

Figure 581: MCR - Error message when trying to use a panel in multiple conferences 
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If you want to have the possibility to use all new 4-wires as default in multiple conferences, 

you can enable this functionality in the  tab for all 4-wires. 

This setting has only an effect, when you add new 4-wire members to the MCR. Already 

existing members you have to modify manually.  

 

Figure 582: MCR - Misc - Default settings for new 4-wires 

 

All 4-wire/4-wire split, that are enabled to be used in multiple conferences are shown with 

„yes“ in the column „MultiConf“ of the Member list. 

 

Figure 583: MCR - Members-table - Multiconf 
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13.3.2 MCR setup – layouts 

Open the “Conf.Layout” tab in the MCR properties to setup the MCR layout for each user. 

 

Figure 584: MCR - Layout - Add new Port 

 

Select the user whose view you would like to define in the “Layout for user” drop down list.  

Note: you must be logged in as the Administrator. 

 

Create pages for conferences that should appear in the MCR user interface in the 

“Conference Pages” field. 

Up to 20 pages of conferences can be added per user with a maximum of 48 conferences 

per page.  However, each conference can be assigned its own page. 

Click on the  button to add a new page. 

 

 

Figure 585: MCR - Layout - Add page 

 

Enter a unique name for the page (max. 32 characters). Define the number of rows (“Row 

count) and the number of columns (“Column count) for the page. There can be a maximum 

of 4 rows and 12 columns per page. 

 

You can edit a previously created page by selecting it and pressing the  button.  

A page can be deleted by selecting it and clicking . 
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Repeat these steps until all of the pages you need have been created for each user. 

 

Figure 586: MCR - Layout - Create MCR pages 

 

Conferences must now be assigned to the pages. Click the  button. Select a 

conference from the drop down list. The list only shows conferences that are setup for use 

with the MCR interface. (See: “13.2 Creating MCR Conferences”) You can also change the 

position of the conference on the page, if needed. To do so, manually change the “Row” and 

“Column” number. Otherwise, Director will automatically choose the next free cell for the 

conference. 

 

Figure 587: MCR - Layout - Assign a conference to a page 

 

Distribute the available conferences as you like by repeating the steps above. 
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Figure 588: MCR - MCR Properties - Layout 

 

You can also add conferences to this window by dragging them from the “Groups+Confs” 

tab directly using Drag & Drop. 

Selected conferences can be edited or deleted by using the  and 

 buttons. 

Close the properties window by clicking . If you are online with Artist, press <F5> or 

the  button to send the changes to the system. Since MCR is an online tool, the user 

interface will only be shown when you are online with the system. After sending the changes 

to Artist, the new MCR interface setup is available to all PCs connected to the system.  
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13.3.3 Monitoring set up 

The MCR allows certain ports in the system to be used as monitor ports. This enables you to 

monitor individual MCR members or conferences and to speak to them directly, if 

necessary. 

The monitor view can also be configured separately for each user. The monitor ports are 

always available for their users independent of which MCR page is being viewed. 

First, the monitor ports must be defined. Open the MCR properties by right mouse clicking 

anywhere on the MCR window and selecting “Properties”. 

Select the “Monitors” tab in the properties window. 

 

Figure 589: MCR - MCR Monitor - MCR Properties > Monitors 

 

Click on the  button to add a new monitor port. 

 

Figure 590: MCR - MCR Monitor - Adding a new monitor port 

 

Next, the monitor port must be given a unique display name. Enter a name up to 8 

characters long. 

If you later want to access the monitor ports from a control panel, select the 

 option. 
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A port can now be defined as a listen port. The individual members and conferences can be 

monitored from this port. 

Select the port from the drop down list. It can be a 4-wire, 2-wire or panel port. If the 

monitor port should be the 2nd channel of a port, select the option   (if 

the port has a 2nd channel available). 

 

Figure 591: MCR - MCR Monitor - Add new MCR Monitor - Listen Port 

 

If you talk to a monitor destination via a monitor port, you can add an additional “Talk Port”.  

This port does not have to be the same as the “Listen Port” and can be any port in the 

system. To add a new “Talk Port”, press the   button. 

 

Figure 592: MCR - MCR Monitor - Adding a Talk Port 

 

Select the desired port from the “Port” list. Depending on whether the port is a 4-wire, 2-

wire input or a control panel, you can define how the talk command is triggered. On a panel 

the exact position of the talk key must be defined. On a 4-wire port the function will be 

automatically programmed on the VOX function of the port. 
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Confirm your selections with the  button. You can add further members to this 

monitor setup, if needed. Otherwise, you can return to the properties window by clicking 

 and add further monitor setups, if required. 

 

Figure 593: MCR - Monitor example 

 

Now these newly created monitors must be added to the MCR layout. Open the tab “Monitor 

Layout”. 

 

Figure 594: MCR - Monitor Layout 

 

Choose the user who should use the monitor functions.  Click the button  to 

assign the monitor ports. 

 

Figure 595: MCR - MCR Monitor - Add a monitor 

 

Repeat these steps for all monitor ports that the selected user should have access to. 

Afterwards, send the changes to the matrix with the <F5> key or the  button.  When 

Director is connected to the system, the configured monitor ports will be displayed, 

depending on which user is logged on. 
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13.3.4 Creating MCR presets 

The MCR feature lets you to create presets. This provides a way to pull a group of members 

into a conference at the same time. 

Select the “Presets” tab from the MCR “Properties” window. 

 

Figure 596: MCR - MCR Presets - Properties of the MCR > Presets 

 

Press the  button to create a new preset. Give the preset a unique name. 

 

Figure 597: MCR - MCR Presets - Creating a new preset 

 

Choose the members for this preset group by selecting them in the member list. Members 

who are not currently online will be marked red. They can still be added to the preset. 

 

Figure 598: MCR - MCR Presets - Selecting the preset members  

 

As soon as the changes are sent to Artist, the preset is available for all PCs connected to the 

system. 
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13.3.5 Other settings (Misc) 

Other general settings can be defined in the “Misc” tab of the MCR “Properties”. 

 

Figure 599: MCR - MCR Properties > Misc 

 

With the option  you can activate a place holder that appears 

on MCR keys in the system when they are not assigned to a conference. This lets the MCR 

keys be identified quickly and helps prevent accidentally adding additional functions to 

these keys. 

You can choose the place holder.  Enter up to 8 characters. As a default the name “MCR- - -“ 

is used.   

 

If you want to later use the MCR interface from a control panel, you can have the necessary 

logic sources created automatically by making the appropriate selections under “Create 

logic sources for…”. This would allow, for example, a panel to send MCR changes to the 

system directly via an “Update” key. It is also possible to control the monitor functions 

entirely from a control panel. The corresponding logic sources are simply pulled to keys to 

make their functions available on the panel.   

You can also change the standard key mode for these keys on the panels to operate the 

MCR. You can choose between “Latching” and “Momentary”. Depending if you first press a 

conference- or a member key on the panel, the key mode is using the setting made here. 

(see 13.5.2 Using the MCR from a control panel for Details)  

 

 

Figure 600: MCR - MCR Misc - Keymode 
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If you choose „Momentary“ a two hand operation is necessary. You have to press the 

selected conference- or member button as long you select the corresponding members / 

conferences.  The key mode configured in the single “Properties of Key” will be ignored. 

 

 

Figure 601: MCR - MCR Misc - Scheduled Tasks 

 

If you also using the „Scheduler“ to activate conferences controlled by a timer, you can set 

time periods when to show a special clock symbol. 

You can set the time in minutes to show a  -symbol on the affected conferences and 

members before an automatic conference activation starts and before the event will be 

deactivated automatically.  

Prerequisite for using this functionality is the activated “Events/Scheduler” tool of the 

Director and an existing event “MCR Conference”. For Details see 13.4.9 Display of time 

controlled conferences and 14.2.2 Event: MCR Conference 

 

 

 

Figure 602: MCR - MCR Misc - Multiple usage of 4-wires 

 

With the option „Default for all new MCR members“ you can set the behaviour for new 

added 4-wires, if you want to use 4-wires in multiple conferences simultaneous. See Details 

13.3.1.1 Using 4-wires in multiple conferences  
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13.4 Using the MCR 

After all of the settings are configured and sent to the system, the MCR interface can be 

used in Director from all of the PCs that are connected to Artist. Because the MCR is an 

online tool, its user interface is only available when Director is connected online with an 

Artist system. 

As soon as you have connected to the system using the  button and obtained the online 

configuration using the  button, you must log on with your username and password.  

To open the MCR interface, click the  button in the toolbar. The MCR window 

corresponding to the current user will appear.  

 

Figure 603: MCR handling - Active MCR tool (example) 
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13.4.1 MCR – overview  

 

 

Figure 604: MCR handling - function overview (example) 
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13.4.2 Assigning members to a conference 

To add a MCR member to a conference, simply pull the member into the conference using 

Drag & Drop. Select the MCR page with the conference you want to use and pull the 

member into it. 

                 

Figure 605: MCR handling - Members Drag & Drop 

 

Control panel members are only allowed to be in one conference at a time. If the member is 

currently available, it will be marked by a  in the member list. As soon as the member has 

been assigned to a conference the symbol will change to a  . If you attempt to pull the 

panel into another conference, an error message will appear. 

4-wires and 2-wire splits work slightly differently. These port types can be in multiple 

conferences at the same time. 

Since an “MCR Member” can consist of several member elements, the elements that make 

up a member are listed in the “Member Ports” field when you click on a member. The 

“Member Ports” cannot be dragged directly into a conference. 

 

Figure 606: MCR handling - Members with corresponding Member Ports 

As soon as any changes have been made, the update button  turns red and flashes.  

This means that the changes have not yet been sent to the system. If you press this button, 

the changes will be sent to Artist and reflected on all of the other MCR interfaces connected 

over other copies of Director. 

 

Figure 607: MCR handling - Sending changes 
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If a member is assigned to one or more conferences (4-wires only) you can see an overview 

of the assignments in a small pop-up window. Place the mouse pointer over a member in 

the MCR member list. After a short delay, an info window will automatically appear showing 

the conferences that the port is a member of and how many members are in each 

conference.  

 

Figure 608: MCR handling - Assignment information. Example 4-wire port 

 

You can also drag individual members from one conference directly into another 

conference. Click on a member in a conference and pull the member to another conference.  

Send the changes to the system with the  button. 

 

Figure 609: MCR handling - Moving a member 

 

As soon as a member sends any active audio, this will be indicated either by a red  or  

in the port list and in the conference. If someone is actively speaking into a conference, the 

name of the conference will be highlighted red.   

 

Figure 610: MCR handling - Active audio in a conference.  Source is “N-1” 
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13.4.3 Using presets 

A preset is a predefined group of members. A preset allows the group to be assigned to a 

conference together using Drag & Drop. If you hold the mouse pointer on a preset all of the 

members in the preset will be displayed.   

 

Figure 611: MCR handling - Presets- Member Info 

 

Pull a preset from the “MCR Presets” list into a conference. Send the changes to the system 

using the  button. 

 

Figure 612: MCR handling - Drag & Drop- presets 

 

The individual members will now be listed in the conference. 

 

Figure 613: MCR handling - Preset members in a conference 

 

Note: If you want to remove the members of a preset from a conference, you must remove 

the individual members separately.  
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13.4.4 Removing a member from a conference 

There are two ways to remove a member from a conference. 

 

Method 1: 

Pull the member from the conference back into the “MCR Member” list. The hand  

symbol changes back to a green dot  (for 4-wires, it only changes if the member has been 

removed from all conferences). Send the changes to the system using the . 

   ->  

Figure 614: MCR handling - Removing a member from a conference 

 

 

Method 2 

Right mouse click on a member to remove the member from one or more conferences. You 

have different options depending on whether you right click in the active conference or in 

the “Member List”. If you right click on a member in a conference, you can select the entry 

“Remove from conference”. You can also select “Remove all members” to remove all 

members from the conference with a single click.   

 

Figure 615: MCR handling - Remove a member with a right click in the conference 
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If you right mouse click on a member in the “MCR- Members” list you can automatically 

remove the member from all conferences by selecting ”Remove from all Conferences”. For 

control panel members method 1 and 2 are identical. However, 4-wire ports can be in more 

than one conference at a time, and method 2 can remove them from all conferences at 

once.  Transfer the changes to the system using the  button. 

 

Figure 616: MCR handling - Remove from all conferences 

 

 

13.4.5 Using an alias name 

All conferences and members normally have a fixed name. However, in many situations it is 

useful to assign a temporary name to a member or conference to provide a better overview 

and your workflow easier. For these applications a so-called “alias” name can be used. The 

alias temporarily overrides the normal name of the port or conference without having to 

change the basic configuration of the MCR. As soon as the alias is deleted, the original 

name is used again.  

To assign an alias, right mouse click on a conference or member in the “MCR Members” list.  

Select “Set Alias” in the popup menu that appears. Enter an alias name with up to 8 

characters. 

              

Figure 617: MCR handling - Select and enter an alias for a conference 
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Figure 618: MCR handling - Select and enter an alias for a MCR member 

 

As soon as you click the  button, the alias name will be applied and also immediately 

sent to the system. The new alias will also appear on all other MCR interfaces running on 

other copies of Director. It is not necessary to manually press the update  button. 

All conferences and members in the MCR interface with an active alias will be highlighted 

green. This indicates that the normal name has been changed. 

 

Figure 619: MCR handling - Display of alias names 

 

If you wish to change an assigned alias, right mouse click on a member or conference.  

Select “Rename alias” to change the name. The change will be automatically sent to the 

system. 

To delete an alias and return to the original name, right mouse click on a conference or 

member. Select “Remove alias”. The name will change back to the original name and will 

be automatically sent to the system. The green highlighting will disappear.  

 

Figure 620: MCR handling - Rename or remove an alias 
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13.4.6 Changing a 4-wire I/O gain level 

The MCR interface offers a way to graphically display the input and output gain of a 4-wire 

port and change the gain, if necessary. A small arrow symbol  is displayed next to 4-wire 

members in the “MCR Members” list and in the “Member Ports”. This indicates that the 

input and output gains can be manually changed.  

To change the gain settings of a 4-wire port in the MCR interface, first select the port in the 

“MCR Members” list. The “Members Port” list will display that member‟s corresponding 

ports. Right mouse click on a member port and select “Set Input/Output Gain…”   

 

Figure 621: MCR handling - Opening the I/O gain function 

 

The gain control must be assigned to Director.  Set the desired input and output levels for 

the port. Afterwards, press the   button. The changes will be sent to the 

system. 

 

Figure 622: MCR handling - Setting the input and output gain levels 

 

The changed gain settings will be indicated by the green arrow in the “Member Ports” and 

“MCR Members” lists. 

 

Figure 623: MCR handling - display of changed input and output gain levels 
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13.4.7 Using the Monitor function 

The MCR offers a way to monitor selected conferences or members using ports assigned as 

monitoring ports (see: “13.3.3 Monitoring set up”). It is also possible to talk to the 

conference or port being monitored from a monitor port. 

To monitor a conference, simply pull the conference to the monitor port. To monitor a port, 

drag it from either from a conference or from the “MCR Members” list to the monitor port.  

This change will be immediately sent to the system. You do not have to press the update 

 button. 

           

Figure 624: MCR handling - Monitoring a conference (red= audio currently active in the conference) 

 

                 

Figure 625: MCR handling - Monitoring a member 

 

Pressing the  button temporarily mutes the monitor audio to the port. The 

changes are immediately sent to the system. If “Mute” is active, it will be indicated by a red 

mute button . 
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The  button indicates that the monitor is currently listening to a port. This 

means that the input of the port is routed to the monitor output. As soon as the button is 

pressed, it changes to . The change will be immediately sent to the system.  

Now the audio that is routed from an MCR conference to the output of the port can be heard 

at the monitor output. This button is only available if a single port with an input and output 

is being monitored. This function is not available for conferences or 4-wire splits. 

 

To stop monitoring, right click on the monitor and select “Cancel monitoring”. The change 

will be immediately sent to the system. 

 

Figure 626: MCR handling - Ending the monitoring function 

 

 

You can also set the input and output gain level of the monitoring port in this menu. 

 

13.4.8 Undo changes 

Changes to the conference or port assignments in the user interface are only visible locally 

until the  is pressed. The MCR interface documents all changes since the last update 

was sent. 

Open the “Status” tab from the MCR interface.  

 

Figure 627: MCR handling - Master Control Room - Status 
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The “Local MCR Status” list shows all changes that have been made since the last transfer 

of changes to the Artist system (with the exception of gain changes and the monitor 

function). Click the  button to undo all of these changes. You will 

be asked to confirm your choice. This option can also be reached from a MCR page with a 

right mouse click. 

 

Figure 628: MCR handling - Discarding changes 

 

If you wish to reset all MCR assignments and end any monitoring, press the  

button in the “Status” tab. After being asked to confirm, the MCR will be reset. 

Note: the reset also affects all other online MCR interfaces. 

This option is also available in the network view of Director. Right mouse click on the  

symbol. 

 

Figure 629: MCR handling - Network tab - Reset MCR 

 

The “Reset (Online)” function will reset the complete MCR system. That means that all 

currently active conferences and monitor functions will be emptied. 

If you save a configuration with an MCR interface to a hard disk, a snapshot of the current 

MCR assignments will also be saved. If this configuration is read out from a system or 

opened from a hard drive, you can locally reset these saved assignments with the command 

“Reset (working configuration only)”.  The online system will not be affected. 
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13.4.9 Display of time controlled conferences  

Starting in version 6.10 it is possible to highlight timer controlled Conferences and 

Members in the MCR which will be switched by the “Scheduler”.  

To use this functionality „Events/Scheduler“ must be registered and enabled in the Director. 

First create a new Event „MCR Conference“ in the properties of Events  . See 14.2.2 

Event: MCR Conference for Details 

Now open the „Scheduler“  and select the new „MCR Conference“-Event created before. 

Select the time and dates when this Event should be activated/deactivated automatically. 

See 14.4.2 Configuring the Scheduler  for Details. 

Open the „Properties“ of the „MCR“ by a right click in the MCR-window and select   to 

adjust the display settings for timer controlled conferences.  

 

Figure 630: MCR Scheduler - Properties des MCR > Misc 

 

Here you can set up the time to see a  - symbol on affected conferences and members 

before a timer controlled conference will start.  

The same symbol will show up, before an activated timer will be deactivated. You can set up 

both settings individually 

Following symbols are used for timer controlled conferences. These symbols show up on 

affected conferences and also on the affected members: 

 

Member / Conference will soon be used for Scheduler controlled conference.  

If the timer is already running, the symbol shows up before the scheduled conference will be 

stopped automatically. (Depending of the settings in “Misc”). 

 
Member / Conference is used in a running scheduled conference 

 

Member / Conference should now be used in a scheduled conference, but it is not. 

Causes:  

- The start time of a new generated timer was in the past 

- The event was stopped manually in the Events - tool   

   

Figure 631: Table - MCR Scheduler Icons 
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View 13.4.1 MCR – Overview to get an overview of the displays for scheduled conferences 

A short tool-tip window will show up, when you show with the mouse over a conference or a 

member with a clock-symbol. It will show the actual status and which timer is or will be 

used: 

Member will soon be used for a scheduled event.  

 

Figure 632: MCR Scheduler - Member will be used soon 

 

Member is part of an actual running scheduled conference.  

 

Figure 633: MCR Scheduler - Member is used in a scheduled conference 

 

The running scheduled conference will be stopped soon 

 

Figure 634: MCR Scheduler - Scheduled conference ends soon 

 

Scheduled timer could not be started 

 

Figure 635: MCR Scheduler - Scheduled task could not be started 
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13.5 Setting Up and Using the MCR Interface from a Control Panel 

The MCR tool can be controlled from multiple PCs as well as from control panels. Any 

control panel type can be used. 

 

13.5.1 Setting up the MCR and panels 

You must assign an online Director PC to handle MCR requests in order to use the MCR 

interface from one or more control panels. 

Go to “Settings” > “Options” and then select the tab “Miscellaneous”. Activate the option 

“Handle MCR operations triggered by Panels / Logic Sources“. 

 

 

Figure 636: MCR - Panel control - Settings > Options 

 

Warning: only 1 Director PC in the network should have this option activated. The control of 

the MCR interface by control panels only works when this copy of Director is online with the 

system. 

 

To enable the MCR interface to be controlled from a panel, every function, member, monitor 

and conference is assigned a logic source. This means that control panels are only sending 

logic commands to the Director PC which then converts these to MCR commands. 

It is therefore necessary when creating conferences and MCR members that the 

 option has been set in the “MCR Properties”. (See: “13.2 

Creating MCR Conferences“ , “13.3 Configuring the MCR“ and “13.3.5 Other settings 

(Misc)“). 
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Open the  tab in Director. The MCR sources generated automatically will be listed 

with their automatically generated names “MCR…”.  

 

Figure 637: MCR - Panel control - Logic Sources 

 

Double click on a port in the port list or network list to open a control panel that should be 

used to control the MCR interface. Pull the logic sources onto unused keys. Repeat for each 

panel that should control the MCR. 

 

Figure 638: MCR - Panel control - Adding MCR logic sources to a control panel 

 

After you have sent these changes to the system the MCR can be controlled from both the 

software interface and control panels. 
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13.5.2 Using the MCR from a control panel 

To assign a member to a conference, first press the conference key. All available members 

will be indicated by a red marker. 

 

Figure 639: MCR - Panel control - Selecting the conference 

 

Select the members to add. Newly selected or already existing members will be indicated by 

a green marker. Press the “MCR Upd” key. The changes will be sent to the system and also 

reflected in all MCR software interfaces. 

 

Figure 640: MCR - Panel control - Selecting members 

 

If you press a conference key again, the panel returns to the display mode. Conferences 

that are being spoken into are highlighted with several red LEDs. 

 

Figure 641: MCR - Panel control - Marker signalisation of an active conference 

 

You can also press a conference key to display all of the members assigned to the 

conference. Members that have green markers are assigned to the conference, members 

with red markers are not assigned to the conference.   
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You can also first select the member to assign it to a conference. Press the member and 

then press the conference that the member should be added to. 

 

Figure 642: MCR - Panel control - Selecting a member 

 

Assign the member to conferences by pressing conference keys (Note: only 4-wire ports can 

be assigned to more than one conference). Confirm your changes by pressing the “MCR 

Upd” button. 

 

Figure 643: MCR - Panel control - Assigning members to conferences 

 

You can also press a member key to display all of the conferences that the member is a 

part of (displayed with a green marker). 

 

The monitor function is operated in the same way. Select the monitor and then the member 

or conference to monitor.  The assignment will be immediately sent to the system. It is not 

necessary to press the “MCR Upd” key.  

 

If several control panels are controlling the MCR, each key press will be simultaneously 

shown on the other control panels. All panel users have the same user rights. 
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14 EVENTS / SCHEDULER 

The software add-on “Events/Scheduler” is a versatile tool that can trigger pre-defined 

events or configuration changes automatically according to a schedule or with a simple 

mouse click.  For example, functions on a key can be easily changed or MCR conferences 

can be automatically activated at certain times. 

 

 
Figure 644: Scheduler / Events - example 

 
 

14.1 Adding the Events / Scheduler add-On 

The Events/Scheduler software add-on is already present when a new configuration is 

created. It appears as the  symbol in the network view of the Navigation Bar. 

 

Figure 645: Scheduler / Events - Events in the network view 

 

However, the feature must be unlocked before it can be used. Follow the directions in 

chapter “11.1 Unlocking the Software Add-ons”. 
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14.2 Creating events 

You must open the “Events-Online View” in order to create events. Click the  button in the 

tool bar or double click on the  symbol in the network view of the Navigation Bar. The 

window can also be opened via “View” > “Events – Online View”. The “Events-Online View” 

window is also used to start and stop individual events.  

 
 
Figure 646: Events - Online View window 

 

 

 

 

 

14.2.1 Event Properties 

To create a new event or to edit an existing event, click the  button. The “Event 

Management” window will open. 

 

Figure 647: Events - Event Management  window 
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Next, create a new event using the  button found in the “Event List” area on the left 

side of the window. The event list will display the new event and assign an automatically 

generated name “Event #001”. Enter a new name for the event in the “Name” field found on 

the right side of the window under “Properties of the selected Event”. The name can be as 

long as you like. 

 

Figure 648: Events - Enter a name for the event 

 

Now you can begin to set up what the event will actually do. On the right hand side of the 

window, click the  button and select the type of function that should later be triggered 

by the event. 

The maximum number of functions that can be carried out at the same time in an event is 

100.  

 

Figure 649: Events - Adding a new event 
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14.2.2 Event: MCR Conference 

If you also use the “Master Control Room” add-on and have already configured it, you can 

create an event that will automatically add members to a conference. The event can then 

be later triggered by a key press or set to be automatically activated at a certain time.   

Select the function “MCR Conference”. The “Event Action: MCR Conference” window will 

open. 

 

Figure 650: Events - Event Action: MCR Conference 

 

All MCR members will be displayed in this window along with their online status and any 

current aliases being used. 

Select a conference from the “Conference” drop down menu. Then select the members that 

should be placed into the conference when the event is activated.  

 

Figure 651: Events - Selecting a conference and its members 

 

Confirm your choices with the  button.  The new event now appears as “Modified: 

new” in the “Event Management” window. As soon as the change you made to the 

configuration has been sent to the system using the  button, the word “new” 

disappears from the list and the event is available for use. 

 

Figure 652: Events - New MCR Conference - event 
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14.2.3 Event: Call to Conference 

This function places a “Call to Conference” command on the keys of selected ports when 

the event is active.  Create a new event in the “Event Management” window, as described 

above, or add this function to an existing event. 

Click the  button on the right-hand side of the window and select the function “Call to 

Conference”. A new window will open where you can specify the details of the function. 

 

Figure 653: Events - Event Action: Call to Conference 

 

First, choose the conference that should be used by the event. You can also select a 

conference from a shortlist, if any are defined. Select the conference privileges for the 

member. 

  

Next, choose the conference member.  Click on the  button. 

 

Figure 654: Events - Call2Conf - Function location 

 

Decide who can trigger this “Call to Conference” function and whether it should be activated 

from a port or a GPI.  

If you choose , select the port and the exact location where the function should appear.  

If you selected a control panel, you can choose between placing the call on the  

or on a  .  If you selected a 4-wire port, only the  will be available.   
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Figure 655: Events - Call2Conf - Choosing a panel key 

 

Note: If you selected “Panel Key”, you must specify the exact key where the function will 

appear.  If the key that you chose already has a function assigned, this other function will 

not be removed. The command triggered by the event will be added as an additional 

function to the key. 

 

After you confirm your selection with the  button, the key or Virtual Function will 

appear in the “Event Action” window. 

 

Figure 656: Events - Call2Conf - Event Action 

 

You can use the 2nd audio channel of a port as the source of the call, if available, by 

selecting  the  option. 

After closing the window with the  button, the new function will be listed in the 

“Event Management” window. 

Repeat the steps above if you want to add additional functions to the event. 

 

Figure 657: Events - Event Management window - Call to Conference Event 

 

Send the changes to the matrix with the <F5> key or the  button in Director. 
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14.2.4 Event: Call to Group 

This function places a “Call to Group” command on the keys of selected ports when the 

event is active. Create a new event in the “Event Management” window, as described above, 

or add this function to an existing event. 

Click the  button on the right-hand side of the window and select the function “Call to 

Group”. A new window will open where you can specify the details of the function. 

 

 

Figure 658: Events - Event Action - Call to Group 

 

Select the group and then specify the exact location where the “Call to Group” command 

should appear with the   button. 

 
For a description of how to select a panel key or Virtual Function please see: “14.2.3 Event: 

Call to Conference”. 

 

Figure 659: Events - Event Action - Call to Group 

 

The new function is now available in the event list. 

 

Figure 660: Events - Event Management window - Call to Group Event 

 

Send the changes to the matrix with the <F5> key or the  button in Director. 
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14.2.5 Event: Port to Port 

When this function is activated it places a “Call to Port” command on the keys of two 

control panels. Create a new event in the “Event Management” window, as described above, 

or add this function to an existing event. 

Click the  button on the right-hand side of the window and select the function “Port to 

Port”. A new window will open where you can specify the details of the function. 

 
Figure 661: Events - Event Action: Port to Port 

 

You can manually enter a display name for the ports that will appear on the panels after the 

event has been activated. If you leave this field empty, the default name for the ports will be 

used. 

Press the  button to set up which ports will be used for the event and the exact 

position of the key or Virtual Function where the command will appear. 

For a description of how to select a panel key or Virtual Function please see: “14.2.3 Event: 

Call to Conference”. 

 

Figure 662: Events - Event Action: Port to Port 

 

The new function is now available in the event list. 

 

Figure 663: Events - Event Management window - Port to Port Event 

 

Send the changes to the matrix with the <F5> key or the  button in Director. 
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14.2.6 Event: Call to Port 

This function places a “Call to Port” command on the key of a selected port when the event 

is active. Create a new event in the “Event Management” window, as described above, or 

add this function to an existing event. 

In contrast to the “Port to Port” function, this command only sets up communication in one 

direction. 

Click the  button on the right-hand side of the window and select the function “Call to 

Port”. A new window will open where you can specify the details of the function. 

 

Figure 664: Events - Event Action: Call to Port 

 

You can manually enter a display name for the port that will appear on the panel after the 

event has been activated. If you leave this field empty, the default name for the port will be 

used. 

Select the port to be called from the “Destination” list. 

Press the  button to set up which port will be used for the event and the exact 

position of the key or Virtual Function where the command will appear. 

For a description of how to select a panel key or Virtual Function please see: “14.2.3 Event: 

Call to Conference”. 

 

The new function is now available in the event list. 

 

Figure 665: Events - Event Management window - Call to Port Event 

 

Send the changes to the matrix with the <F5> key or the  button in Director. 
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14.2.7 Event: Listen to Port 

This function places a “Listen to Port” command on a key of a selected port when the event 

is active. Create a new event in the “Event Management” window, as described above, or 

add this function to an existing event. 

Click the  button on the right-hand side of the window and select the function “Listen 

to Port”. A new window will open where you can specify the details of the function. 

 

Figure 666: Events - Event Action - Listen to Port 

 

Select under “Source” the port that you would like to listen to. 

Press the  button to set up which port will be used for the event and the exact 

position of the key or Virtual Function where the “Listen to Port” command will appear. 

For a description of how to select a panel key or Virtual Function please see: “14.2.3 Event: 

Call to Conference”. 

Note: When using the event function “Listen to Port” on a panel, it is recommended to set 

the properties of the key you select to “Latching” and deactivate the “Speaker Dim” 

function. 

 

The new function is now available in the event list. 

 

Figure 667: Events - Event Management window - Listen to Port Event 

 

Send the changes to the matrix with the <F5> key or the  button in Director. 
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14.2.8 Event: Logic Source 

This function places a “Logic Source” on a key of a selected port when the event is active.  

Create a new event in the “Event Management” window, as described above, or add this 

function to an existing event. 

To allow a logic source to be used in events, open the properties of the logic source in the 

 tab with a double click. Check the box for the “Enable for Event use” option. 

 

Figure 668: Events - Properties of a Logic Source 

 

Click the  button on the right-hand side of the “Event Management” window and select 

the function “Logic Source”.   new window will open where you can specify the details of the 

function. 

Select the logic source you would like to use. Only the logic sources that were unlocked for 

use with the event add-on will be shown.  

 
Figure 669: Events - Event Action - Logic Source 

 

Press the  button to set up which port will be used for the event and the exact 

position of the key or Virtual Function, where the “Logic Source” function will appear. 

For a description of how to select a panel key or Virtual Function please see: “14.2.3 Event: 

Call to Conference”. 

The new function is now available in the event list. 

 

Figure 670: Events - Event Management window - Logic Source Event 

 

Send the changes to the matrix with the <F5> key or the  button in Director. 
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14.2.9 Configuration using Drag & Drop 

You can also set up most event functions using Drag & Drop. Create a new function, for 

example a “Port to Port”. Click on the  button on the right-hand side of the window 

and select the “Port to Port” function. A new “Event Action” window will open where you can 

specify the details of the function.  Close the window by clicking the  button without 

finishing the function setup. 

 

Figure 671: Events - Event Action 

 

 

Figure 672: Events - Undefined function 

 

Open the two ports in the Workspace that you wish to use and drag the command to keys 

directly from the “Event Management” window. 

 

Figure 673: Events - Drag & Drop to keys 

 

The keys will be added to the function. 

 

Figure 674: Events - Configured function 
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You can also use the same process when setting up all of the other functions. 

For example, when programming a “Call to Conference”, you can drag the conference 

directly from the  tab to the event window. Then you can drag the event 

command from the event window to a panel or 4-wire port. 

 

Figure 675: Events - Drag & Drop a conference to a port 

 

 

Figure 676: Events - Configured function 

 

If you need to add a number of different events with the same source but with different 

destinations, we recommend using the copy function. Create an event with the source you 

want to use and then press the   button. Every time you press this button a new copy 

of the original event will be created. Simply drag these copies to the destinations you need.  

The original destination will be replaced with the new one you chose. 

 

       

Figure 677: Events - Creating and modifying using the copy command 
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14.3 Starting and Stopping Events 

 
After you have created and configured the events they can be started and stopped directly 

from Director. 

Open the “Events – Online View” window by clicking on the  button in the toolbar. 

 

Figure 678: Events - Online View 

 

All events that you have created will be listed in this window. 

 

Note: Because the events function is an online tool, only the events that have been sent to 

the system with a configuration update will be shown. This requires an active connection to 

the matrix.  If you are running Director in offline mode, no events will be shown in the 

“Events - Online View”. 

 

If you have created a large number of events, you can use the filter function to search for 

specific events. 

 

Figure 679: Events - Events with a filter active 

 

To start an event, select the event and press the  button or simply double click on 

the event.  

You do not have to manually send the configuration to the system. As soon as an event is 

started or stopped, the configuration change is automatically sent directly to the system. 
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Active events will be highlighted green and their status will be listed as “active”. 

 

Figure 680: Events - Active events 

 

The functions defined by the event will then appear on the corresponding panels and keys. 

 

Events can be stopped by double clicking on an active event or by selecting the event and 

clicking the  button. 

 

Pressing the  button will end all events that are currently active. A pop up window 

will ask you to confirm that you wish to end all events. 

 

Figure 681: Events - “Stop all“ confirmation 

 

 

 

Note: Multiple PCs can be online with Director at the same time and still use the Events / 

Scheduler. Each PC shows the current status of all of the events.  However, be sure to read 

the current configuration from the matrix before checking the event status.  
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14.4 Scheduler 

The scheduler is an extension of the event function. It allows events to be automatically 

triggered at specific times. 

Scheduling events by time is controlled by the internal clock of a configuration PC. For this 

reason, a copy of Director needs to be running and connected to the system to control 

scheduled events.  

To ensure that the clock in the PC is accurate, it is recommended to use an auxiliary DCF 

card or regularly synchronize the PC clock via the internet. 

 

 

14.4.1 Activating Director for the Scheduler 

Choose which PC running Director will control the scheduled events. This PC must always 

remain online with the system. 

Open the Options window in Director.  Select “Settings” > “Options”. 

 

Figure 682: Scheduler - Opening the options window 

 

In the “Options” window, select the  tab and activate the function 

. 

 

Figure 683: Scheduler - Activating the Scheduler function in Director 
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14.4.2 Configuring the Scheduler 

To configure the Scheduler, click on the  button in the toolbar. This will open the 

“Scheduler - Online View” window. 

 

Figure 684: Scheduler - Scheduler Online View 

 

Press the  button to add a new timer. A new entry will appear with a pre-assigned 

name. Enter a new unique name for the timer in the “Name” field.  

 

Figure 685: Scheduler - Naming a timer 

 

Select the event in the “Event” field that should be activated by the timer. The event must 

have been previously configured. 

 

Figure 686: Scheduler - Selecting an event 

 

If you would like to change the event, you can access the event‟s configuration window 

directly by clicking the  button. 
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Enter the time when the event should start and how long it should last. If the event should 

end at a specific time, select   and enter the time when the event should end. 

The scheduler automatically calculates how long the event will last. 

 

Figure 687: Scheduler - Enter the start time of the event 

 

Select if and how often the timer should repeat this event. You can either select a single 

date for the event or set up a reoccurring event by selecting the days of the week when the 

event should be active. 

 

    or      

Figure 688: Scheduler - Entering a date 

 

All timers and their details are listed in the “Scheduled Tasks” area of the “Scheduler – 

Online View” window. 

 

Figure 689: Scheduler - Timer 

 

As soon as the PC‟s internal clock reaches the activation time for an event, the event will be 

automatically started. Active events will be indicated by the word “active” in the “Status” 

column.   

You can also open the “Events - Online View” window to show all active events by pressing 

the  button. 
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Figure 690: Scheduler - Active Timer 

 

If the timer, for example, starts a timed conference in the “Master Control Room” interface, 

the members will be placed into the conference in the MCR window. 

 

Figure 691: Scheduler - Automatic MCR conference 
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15 AUDIO VIDEO ROUTER 

15.1 General 

This special feature can monitor up to two external routing switchers and make changes to 

conferences in the Artist system based on the routers‟ status. 

The monitoring of the external lines is handled by a specially developed software interface 

that can assign communication paths to the same locations as the routers send their audio 

and video.  

The routers are connected over a serial COM port to a computer that runs the “DMX Driver” 

software. The software is supplied by Riedel Communications GmbH. 

The Audio Video Router (AVR) feature requires a computer to be permanently connected to 

both systems. 

15.2 DMX Driver 

The “DMX Driver” software is used to interface between the router and the Artist system. 

The router is connected to a serial COM port of the computer. 

To start the software, double click on the “dmxdrv_com1.exe” file. The software will open 

and initialize COM 1 port on the computer, to which the router should be connected. 

Alternatively, COM ports 1 – 4 can also be used. 

Please note that if you use a different COM port, you must also open a different file on your 

PC.   

The file “dmxdrv_com1“ is used for COM port 1. 

The file “dmxdrv_com2“ is used for COM port 2.  And so on… 

 

 

Figure 692: AV Router - DMX Driver 

 

After starting the DMX Driver the software reads out all of the information required from 

your system. You do not need to do anything further at this point.  

The DMX Driver will then display a list of all available sources and destinations. 
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15.3 Adding the Audio/Video Router (AVR) to Director 

To add the AVR in Director, right mouse click on the Web in the network view and select 

“Add Audio/Video Router Interface”. You can also add the AVR to the configuration under 

“Edit” > “Special Features” > “Add”. 

 
Figure 693: AV Router - Adding the AVR 

 

The AVR appears in the network view as a green icon with the letters “AV”. 

 
Figure 694: AV Router - AVR in the configuration 

 

To configure the AVR, the current user must have the necessary user rights. Open the 

 tab.  Select a user and click the  button. 

 

Figure 695: AV Router - Properties of a user 

 

Deactivate the option “Restrict Properties for AV-Router”. 
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15.4 Connecting Director to the DMX Driver 

The following steps will make the information from the “DMX Driver” available in Director: 

Open the AVR interface in Director by double clicking on the AVR  icon. First, activate the 

option “Enable Audio/Video Router Interface“. Next, choose the option “Enable DMX Driver“  

to establish the connection to the “DMX Driver”. 

   >   

Figure 696: AV Router - AVR Online View 

 

As long as there is an active connection between the “DMX Driver” and your router system, 

the individual sources and destinations will appear in the “Active Crosspoints” list. 

The option “Enable ZMX” is for a special feature developed for a specific customer and is 

not normally used (it stands for Zentrale [central] Video Matrix and would be activated 

instead of the “DMX Driver”, which stands for Dezentrale [decentralized] Video Matrix).   

The option “Force Configuration Updates periodically” is only used for debugging purposes. 

 

 

 

 

 

 

 

 

 



 

DIRECTOR 6.20 Configuration Software, User Manual, Version 3.4          

 

  Page 379 

15.5 AVR Configuration 

To configure the AVR, press the <F8> key or click the    button in the AVR 

online view. This opens the AVR configuration window. 

15.5.1 Router-IF objects 

 

Figure 697: AV Router - Properties of the AVR 

 

The AVR allows you to automatically add members to a conference depending on the status 

of the external router. 

You will need at least one conference and one group that were previously created in the 

Director configuration. Create as many groups and conferences as you will need.  (see:  8.17 

Create and Manage Groups and Conferences). 

Add the panels that should later be added to a particular conference to the members list of 

a group. 

Next, using Drag & Drop pull the conferences from the “Groups + Confs” tab to the AVR field 

“Router-IF Objects → Conferences”.  Drag the groups to the “Router-IF Objects → Groups” 

field. 

 

Figure 698: AV Router - Adding groups and conferences to the AVR 

 

WARNING: After you have added the groups and conferences, you must confirm the 

additions with the  key. Failure to do so will result in the changes not being saved.  
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15.5.2 Router-IF source 

You have now assigned a conference and a group of members to the AVR. The next step is 

to configure the “Router-IF Src” sources  and the “Router-IF Dst” destinations.  

 

Figure 699: AV Router - Router-IF Scr 

 

If you make a change to the router, the conferences in the intercom system should also be 

changed to reflect the new status of the router. You must configure the AVR so that a router 

change assigns a certain group of members to a conference.   

The tabs “Router-IF Src” and “Router-IF Dst” refer to the sources and destinations of the 

external router. 

Example: If the router assigns Source 1 to Destination 2, the Artist system should 

automatically assign a group of panels to a predefined conference. To achieve 

this, the AVR needs to be configured accordingly. 

Add a source by clicking the  button. This will open a new window where you can 

enter the source‟s details. 

 

Figure 700: AV Router - Adding a new router source 

 

In the “Matrix” drop down menu you can choose between “ZMX” and “DMX”. Always select 

“DMX”. 

As in our example, we will configure the Input Port 1. 

Now tell the AVR which conference should be activated by this action and confirm with the 

OK button. 

WARNING: After you have finished making changes to a tab always confirm by clicking the 

 button in the AVR “Properties” window. Failure to do so will result in the changes 

not being saved. 
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15.5.3 Router-IF destination 

After you have assigned the sources in the system you must also configure the destinations.  

Select the tab “Router-IF Dst”. 

 

Figure 701: AV Router - Router- IF Dst 

 

To add a new destination click the  button. A new window will open where the 

destination can be configured. 

 

Figure 702: AV Router - Adding a new destination 

 

In the “Matrix” drop down menu you can choose between “ZMX” and “DMX”.  Always select 

“DMX”. As in our example, we will configure the Output Port to 2. 

Assign a predefined group of members to the destination using the  button. 

Select a group and assign which key will be reserved on all of the panels of the group,  Enter 

the exact key number to be used on the panels in the group. 

 

Figure 703: AV Router - Editing a panel group 

 

“Key-Nr“ designates the panel key to be used. 

NOTE: Make sure that this key is unused on all of the panels in the group before assigning it 

to the AVR. 
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When the group is assigned to a conference, the conference will appear on the designated 

panel key.  

“Shift Page” refers to the shift page of the panel.  This option determines whether the key is 

on the first or second page.  

In our example, all panels in the AVR GRP group will be assigned the conference key on the 

main panel, main page, Key # 1. 

If a panel group is not assigned to a source, a place holder will appear on the keys. 

 

Figure 704: AV Router – Placeholder panel key 

 

Confirm the settings by clicking . 

The new entry will be listed in the “Router-IF Dst” tab. 

 

Figure 705: AV Router - Entry in the Router-IF Dst tab 

 

WARNING: After you have finished making changes to a tab always confirm by clicking the 

 button in the AVR “Properties” window. Failure to do so will result in the changes 

not being saved. 

 

To complete our example: If you now routed Source 1 to Destination 2 on the router, then all 

members of the group “AAVR GRP 1” would be assigned the conference “AVR CONF 1” on 

their main panel, standard page, Key # 1.  
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15.5.4 Router-IF ext. Lines 

The tab “Router IF.ext.Lines” is not for assigning groups of panels to a conference, as 

described above, but rather for assigning a 4-wire. 

Drag a 4-wire from the port list into the “Router-IF Objects > Panels” field in the AVR 

window. 

 

Figure 706: AV Router - Adding a 4-wire 

 

This will assign a 4-wire to the AVR.  

 

WARNING: After you have finished making changes to a tab always confirm by clicking the 

 button in the AVR “Properties” window. Failure to do so will result in the changes 

not being saved. 

 

In the “AVR Properties” window open the “Router-IF Src” tab. 

 

Figure 707: AV Router - Router-IF Scr tab 
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Click the  button to assign a new 4-wire as an AVR source. Select “DMX” under 

matrix and enter the input port number of the router. Activate the option “Allow External 

Line”. Enter a name for the 4-wire in the “Description” field. 

 

Figure 708: AV Router - Add new Router-IF Source 

 

If you added a conference in “Router-IF Objects” and it was not assigned to a group of 

control panels, it will be available under “Router-IF ext Lines”. 

Select which 4-wire should be used for the conference by double clicking on the conference 

or selecting the conference and clicking the  button.  Confirm with OK. 

 

Figure 709: AV Router - Settings for the External Lines 

 

The tab “Router-IF ext. Lines” lists the external 4-wire‟s conference with the corresponding 

port and display text. Send the configuration to the Artist by clicking the  button. 

 

Figure 710: AV Router - Router-IF ext. Lines 

 

The 4-wire can now be assigned a group of members. In our example, this is done by 

assigning router input port 10 a destination.   

After this assignment there will be a command on the Vox function of the 4-wire.  
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15.5.5 Router-IF external Lines Defaults 

In the “Router-IF ext. Lines defaults” tab you can create a default setting for each 

conference that is used for external lines. Double click on a conference or select the 

conference and press the  button. The “Def. Settings for „Conference Name‟” window 

will open. 

 

Figure 711: AV Router -  Def. Settings for „AVR Conference‟ 

 

In this window you can select the source responsible for the switching as well as the default 

4-Wire for this conference. You can also edit the display text. When finished confirm with 

“OK”. 

 

Figure 712: AV Router - Router-IF ext. Lines defaults 

 

The defaults can be applied to selected conferences in the “Router-IF ext. Lines” tab by 

clicking the  button or pressing <F6> on the keyboard. 

Repeat the steps above for all of the inputs and outputs on your router. Afterwards, send the 

configuration to the system using the  button. 
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15.5.6 Testing the AVR 

The intercom system will be automatically reconfigured according to the AVR settings as 

soon as the AVR and DMX drivers are active and connected to the router. 

All paths currently active in the router are listed in the “Audio/Video Router Interface – 

Online View” under “Active Crosspoints”. 

 

Figure 713: AV Router - Online View 

 

It is possible to undo an active AVR connection in Artist.  Select an item from the list and 

click the  button. All changes will be periodically sent to the system. 

 

To test the AVR configuration or to manually force a connection, you can click the  

button. 

 

Figure 714: AV Router - Add Crosspoint 

 

Enter a source and destination.“DMX” should always be selected under “Matrix”. As soon as 

you have made the changes, confirm with “OK” and this manually activated crosspoint will 

be listed in the AVR online view. Press the  to send the new crosspoint to the system.  

All of the corresponding control panels of the selected group should now display the 

conference name for that route on their pre-defined key. 
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In this way the AVR can be tested without having an active connection to an external router.  

Deactivate the option “Enable DMX Driver” and select the option “Force Configuration 

Updates periodically (DEBUG)”. 

 

Figure 715: AV Router - Online View 

 

Manually force a crosspoint, as described above. The new crosspoint will be periodically 

automatically sent to the system. This allows you to simulate any particular router 

crosspoint selection and test the Artist configuration.   

 

NOTE: Do not forget to reactivate the option “Enable DMX Driver” as soon as the external 

router is reconnected. 
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16 TRUNKING 

In certain applications it is not possible to connect individual Artist mainframes over fiber.  

For example, fiber connection is not an option when the distance between two frames is too 

far, or if the maximum number of ports within the fiber ring would exceed 1,024. In this 

case, two or more systems can be intelligently connected together via trunking. Up to 50 

Artist systems can be trunked together. The control of the system and its dynamic routing is 

handled by the Trunk Navigator software. 

Note: To start the Trunk Navigator, a RIEDEL USB dongle must be connected to the trunking 

PC to unlock the software. 

 

Figure 716: Trunking - Example trunking network (Soccer World Cup 2006) 

16.1 Requirements 

Trunking requires the Riedel Trunk Navigator software, a RIEDEL USB-Dongle and a few 

additional configuration changes in Director on systems to be trunked together. The Trunk 

Navigator can be installed parallel on two PCs for redundancy. The PCs should be connected 

to one another over an IP network. The Trunk Navigator can run without any problems on 

the same PC as the Director used for local configurations. However, please note that the 

Trunk Navigator must be permanently online with the system in order to manage the 

trunking feature.   

Always make sure that the software version of the Trunk Navigator is compatible with the 

firmware and Director versions used in the trunked system. The firmware in all of the 

systems to be trunked must be the same version. 

The Trunk Navigator normally has the same version number as Director. 

For example:  Director 6.20Dxx       compatible with     Trunk Navigator 6.20TNxx 
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In addition, there are a few hardware requirements for trunking. There must be at least one 

audio connection between the systems to be trunked. The number of audio connections 

later determines the possible number of simultaneous trunk calls. These connections may 

be analogue, AES, ISDN, VoIP or other audio formats. 

The other requirement is an IP connection from the Trunk Navigator PC to each trunked 

system in order to dynamically manage the trunk line assignments. A bandwidth of at least 

64kB/s is adequate.  

 

Figure 717: Trunking - Building a trunked network 
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16.2 Setup in Director 

16.2.1 General 

Before activating the Trunk Navigator software some preparations need to be made in each 

of the systems which are to be trunked together, otherwise the Trunk Navigator cannot 

dynamically assign trunk lines. In addition, all of the ports of each system (both panels and 

4-Wires) which will be allowed to use trunking need to be set up for this feature. 

16.2.2 Preparing the Artist systems 

In each system one of the nodes must be defined as the “Local Trunk Controller”. This node 

carries out commands from the Trunk Navigator. The “Local Trunk Controller” capability is 

already integrated into CPUs‟ firmware and must simply be activated. However, only one 

node on a fiber ring should be defined as the “Local Trunk Controller”. It does not matter 

whether or not this node is also defined as the Ring Clock Master. 

The node that is set to be the “Trunk Controller” must be connected to an IP network, 

preferably over a switch or hub.  The IP address must be reachable by the Trunk Navigator 

PC. Make a note of the IP addresses of the “Trunk Controller” node in each system for use 

in configuring the Trunk Navigator. 

 

To define a node as the “Trunk Controller”, open the “Online View” by clicking the  button 

in the toolbar. Select the node you wish to define and open its “Properties”. 

 

Figure 718: Trunking - Director - Artist Online View  

 

 

Figure 719: Trunking - Director - Online Bar - Set local trunk controller to enabled 

 

Activate the option “Set Local Trunk Controller to enabled” and click the  

button. The node will be defined as the “local trunk controller” as soon as the reset is 

complete. 
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The trunk controller will be indicated in the “Artist Online View” with the entry: “Trunk 

Controller” - “YES”.  There may only be one trunk controller within an Artist fiber ring. 

 

Figure 720: Trunking - Director - Artist Online View with active Trunk Controller 

 

Repeat the steps above for each Artist network that should be enabled for trunking. 

 

16.2.3 Preparing the configuration 

In order to later identify the individual systems in the Trunk Navigator, a unique “Web” 

name should be given to each of their configurations. 

Select the  tab, right mouse click on the  and select “Properties”.  

You can also change the name by selecting the Web and pressing <F2> on the keyboard. 

 

Figure 721: Trunking - Director - Web icon 

 

In the properties of the “Web” you must also assign a unique Trunking Address. The 

Trunking-Web-Address must be different in each system to be trunked. The Trunking-Web-

Address is similar to a postal code for the system. 

 

 

Figure 722: Trunking - Director - Properties of the Web 
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16.2.4 Defining trunklines 

So called “Trunklines” are used for the audio connections between the trunked systems. A 

trunkline is always a 4-wire. Either an analogue or AES 4-wire (for example, ISDN, VoIP) can 

be used. The more trunklines there are per system the more simultaneous calls can be 

carried out between the systems at the same time. 

Define at least one 4-wire in your system as a trunkline. Open the properties of the port by 

double clicking on it in the Workspace. Or select the port in the port list or network list, right 

mouse click and select “Properties”. It is also recommended to name the port as a 

trunkline. 

Note: if you use an AES 4-wire as a trunkline, remember that 2 ports must be used in 

Director although the physical connection is only to the odd numbered port. Both ports are 

defined as mono ports. See: “8.7.2.3 Configuring a 2 channel 4-wire port“ 

 

 

Open the “Properties” of the individual trunk ports and select the option , 

located in the  tab. The rest of the parameters of the 4-wire will be greyed out. A 

unique trunking address will appear in the “Trunking Address” field. This address can only 

be used once in the local system. However, the address may be used in one of the other 

trunked systems, since the trunking address always corresponds to a particular Web-Trunk-

Address. 

The trunking address is normally assigned by Director and increases by 1 for each 

additional trunk port. 

 

Figure 723: Trunking - Director - Properties of a trunkline 

 

Repeat these steps for all ports that should be used as trunklines. 

Note: Make sure that there are no audio functions programmed on the Virtual Functions of 

the trunklines.  Delete all functions if necessary. The dynamic assignments for the port will 

be handled by the Trunk Navigator and the Local Trunk Controller. 
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16.2.5 Preparing individual ports for trunking 

All ports (panels or 4-wires), that should be able to communicate to a trunked system must 

first be defined in the configuration. Only these ports will be listed in the Trunk Navigator 

and be available as destinations to the trunked systems.    

Open the properties of the port by double clicking on it in the Workspace. Or select the port 

in the port list or network list, right mouse click and select “Properties”. Select the  

tab. 

Activate the option .  A trunking address will automatically be assigned 

by Director and appear in the “Trunking Address” field. 

 

Figure 724: Trunking - Director - Enabling a port for a Trunk Call 

 

 

Repeat the steps above for all of the ports that should later be allowed to use trunking. The 

procedure is identical for 4-wires and control panels. Remember to define ports for trunking 

in the other trunking systems as well. 
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16.2.6 Preparing groups and conferences for trunking 

Groups and conferences can also be enabled for trunking and can be shared throughout the 

trunked systems. For example, if 3 Artist networks use the same conference each can 

speak into the conference and listen to the replies. This creates a large group or conference 

that spans all of the trunked systems and uses the same trunk address.   

To use a group or a conference in a trunked system, open the “Properties” of the 

group/conference in the  tab by double clicking on an entry. 

In the  tab, activate the option . The “Trunking address” will be 

assigned automatically. 

Note: Groups and conferences must use the same trunking address in all trunked systems.  

It may be necessary to manually assign the trunk addresses for groups and conferences.  

 

 

Figure 725: Trunking - Director - enabling conferences 

 

 

Figure 726: Trunking - Director - enabling groups 

 

Repeat the steps above for all groups/conferences that should use trunking. Remember to 

enable the corresponding groups/conferences in the trunked systems and to match their 

trunking addresses. 



 

DIRECTOR 6.20 Configuration Software, User Manual, Version 3.4          

 

  Page 395 

16.3 Trunk Navigator Software 

The Trunk Navigator software is required to network all of the predefined trunklines and 

trunk ports with each other and dynamically manage call requests. In order for trunking to 

function, the Trunk Navigator must be permanently online and connected to the individual 

trunked systems over an IP connection. 

The Trunk Navigator does not need to be installed in Windows. It simply consists of an .exe 

file that should be copied to the directory of your choice. From there it can be started with a 

double click on the  icon or via a shortcut. A Riedel USB dongle is required to use the 

software. 

After the software is started an empty Trunk Navigator window opens. 

 

Figure 727: Trunk Navigator (not configured) 

 

 

Figure 728: Trunk Navigator -  example 
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16.3.1 Changing the background image 

To better customize the Trunk Navigator to reflect where it is being used, the background 

image can be changed. For example, it could be set to display a map of your choice. Any 

*.bmp, *.jpg, or *.gif file can be used. For optimal appearance, a resolution of 760 x 900 

pixels is recommended. 

To change the background image, select the function “Select Background…” in the “Admin” 

menu. Choose the directory where the file is saved and pick the file type in the “Files of 

Type:” drop down menu. Select the file and click the “Open” button. 

      >          

Figure 729: Trunk Navigator - Selecting a new background image 

 

The new image is now linked to the Trunk Navigator background. It will be displayed each 

time the program is started.   

 

Figure 730: Trunk Navigator - with a custom background 
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16.3.2 Connecting Trunk Navigator to an Artist system 

Once a network connection to all trunked Artist systems is established, you need to connect 

the Trunk Navigator to the systems.  

Note: Make sure that you know the IP addresses of all nodes that are set as a “Trunk 

Controller” before proceeding. 

 

In the Menu “Admin” select the function “Connect to Artist System…”. Enter the IP address 

of the first Artist system in the window and confirm by clicking . 

>     >   

Figure 731: Trunk Navigator - Connect to Artist 

The first trunked system will appear on the map as a green icon  labelled with its Web 

name. When newly added, systems normally appear first in the upper left corner of the 

background image. You may have to scroll in order to see the icon. However, you can move 

the icon to any location on the background image. 

Successful connections will be logged in the log area of the software. The previously created 

trunk configuration will be displayed in the configuration area. 

 

Figure 732: Trunk Navigator - Successful connection to a trunked system 

Repeat these steps for all additional trunked systems. 
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If a red icon  is shown, this means that the Trunk Navigator cannot establish a connection 

to the IP address entered for this Web. Check the IP address and contact your network 

administrator to see whether or not the address is being routed correctly. The corresponding 

error messages will be shown in the log field. 

 

 

Figure 733: Trunk Navigator - No connection to the trunked system 

If a connection icon is light yellow  , this means that a connection was established to the 

system, but the node with that IP address is not defined as a Trunk Controller. Change the 

IP address to the address of the system‟s Local Trunk Controller. An error message will be 

displayed in the log area. 

 

 

Figure 734: Trunk Navigator - The connected node is not a Local Trunk Controller 
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Once all systems have been connected to the Trunk Navigator, all of their available ports 

will be displayed in the configuration area. 

The trunk address will be displayed in parentheses (  ) after the Port/Group/Conference 

name. 

 

Figure 735: Trunk Navigator - Ports shown in the Trunk Navigator 

16.3.3 Setting up trunklines 

Once all of the systems have been connected to the Trunk Navigator, the trunklines 

between the individual systems must be assigned. In the “Admin” menu, select “Trunkline 

Setup”. The “Trunkline Setup” window will open. 

 

Figure 736: Trunk Navigator - Trunkline setup, no trunk lines available 

 

To create a new trunkline, click the  button. A new window will open where all of the 

systems are listed. 

Click on the  symbol to show all available trunklines in a system. 
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Figure 737: Trunk Navigator - Trunkline setup 

 

 

Select a trunkline from both a system on the right and a system on the left to create a 

connection between them. Confirm your selections with  . 

 

 

Figure 738: Trunk Navigator - Select trunk ports 

 

The new trunkline will be listed in the “Trunkline Setup” window. Continue adding trunklines 

with the  button to connect the rest of the trunklines with each other. Trunklines that 

are already configured will no longer be available for selection. 

 

 

Figure 739: Trunk Navigator - Configured trunkline connection 
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After you have connected all of the trunklines with each other they will all be listed in the 

“Trunkline Setup” window. 

 

Figure 740: Trunk Navigator - Trunkline setup 

 

The  and  buttons can be used to delete a single trunkline or all trunklines. 

To save this trunkline setup, click the  button. The trunkline assignments can be 

saved to a file on the hard drive ending with “.tls” and opened later using the  

button. 

As soon as a setup has been saved, the last setup used will always be loaded when the 

Trunk Navigator is started. The name of the file that is being automatically loaded is shown 

in the “Setup file…” line.  

 

Figure 741: Trunk Navigator - Load trunkline setup 

 

As soon as the “Trunkline Setup” window is closed using the  button, all of its 

settings will be implemented and the configured trunkline will be displayed along with its 

capacity. All of the details of the trunklines are displayed in the trunkline area of the 

software. A green background to the line indicates that the trunk ports are online. 

Note: Only the trunk ports of the systems are monitored.  The correct physical connection 

between the trunk ports is not monitored. 

 

Figure 742: Trunk Navigator - Successful trunkline connection 

 

The configuration of the Trunk Navigator is now completed. 
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16.3.4 Trunk Navigator details 

The following buttons in Trunk Navigator can hide or show different areas in the software: 

 Log area 

 Configuration area 

 Trunkline area 

 (Trunk) Calls area 

 

The software also features the following menus for configuring the software: 

File 

 

Figure 743: Trunk Navigator - drop-down menu “File” 

 

Exit Closes Trunk Navigator 

 

View 

 

Figure 744: Trunk Navigator - drop-down menu “View” 

 

Toolbar Activates/ deactivates the toolbar in the Trunk Navigator window 

Status bar Activates/ deactivates the status bar in the Trunk Navigator window 

Figure 745: Table - Trunk Navigator - “View” functions 
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Admin 

 

Figure 746: Trunk Navigator - drop-down menu “Admin” 

 

Connect to Artist system … Allows a new Artist system to be connected 

Remove system Removes an existing Artist system 

Trunkline setup… Opens the trunkline setup window 

Select Background… Selects a different background image 

Protection Mode… Activates the redundancy mode 

Stop Protection Ends the redundancy mode 

Cancel all trunk requests Ends all active trunk calls 

Dump routing core Requests the internal trunkline information 

Figure 747: Table - Trunk Navigator - “Admin” functions 

 

Help 

 

Figure 748: Trunk Navigator - drop-down menu “Help” 

 

About Trunk Navigator … Displays the software version of Trunk Navigator 

 

 

Figure 749: Trunk Navigator - About Trunk Navigator 
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16.3.5 Protection mode of the Trunk Navigator 

Since Trunk Navigator requires a permanent connection for trunking to function, there is the 

option to start a second “standby” Trunk Navigator. 

This means that another copy of Trunk Navigator that runs on a second PC seamlessly takes 

over the routing management if the primary PC is no longer online. The only requirement is 

that the second PC with Trunk Navigator must be in the same IP network as the Artist 

systems and the active Trunk Navigator. 

Start Trunk Navigator on the second PC. In the “Admin” menu, select the function 

“Protection Mode…”.  No further configuration is necessary for the back-up Trunk Navigator. 

          >             

Figure 750: Trunk Navigator - Enter the IP address of the active Trunk Navigator 

 

As soon as you confirm the IP address of the primary Trunk Navigator by clicking , 

the second copy attempts to connect with the IP address. Once it is successful, it downloads 

all of the necessary information directly and goes into standby mode. 

 

Figure 751: Trunk Navigator - in Standby mode 

 

If the active Trunk Navigator located at the IP address entered does not answer (for 

example, because the program was closed or the PC crashed), the standby Trunk Navigator 

seamlessly takes over all routing functions. 

This will be indicated in the status bar:  
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After a successful handover, turn off the “Protection Mode”. This will allow the originally 

active Trunk Navigator to start in “Standby” mode.  Select “Stop Protection” in the “Admin” 

menu. 

 

Figure 752: Trunk Navigator - Stop Protection 

 

The status bar of the previous “Standby” Trunk Navigator will display “Standalone”. 
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16.4 Configuring Trunking Calls in Director 

As soon as the Trunk Navigator is set up and online with the system, the individual trunking 

calls in each system can be configured. 

“Call to Port”, “Call to Group” and “Call to Conference” - commands can be configured to 

trunking destinations. Up from Director version 6.20 it is now possible also to create a 

“Listen to” command to a trunked port  

Open the  tab in each Director configuration. All of the available destinations in 

the trunked systems will be listed. 

 

Note:  Normally Trunking calls are configured online. Both, Director and the Trunk Navigator 

must be connected. The  tab is empty in offline mode. If only the Trunk 

Navigator is inactive, the list will only show the local trunk ports.  

Up from version 6.20, it is also possible to configure trunk calls offline, if you know the 

destination trunk addresses. For details see 16.4.5 Offline-Configuration of Trunkcalls  

 

 

 

16.4.1 Trunking: Call to Port 

To create a “Call to Port” command to a trunking destination, the Navigation Bar in Director 

must be open to the  tab. 

 

 

Figure 753: Trunking - Director 
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Clicking the  symbol shows all trunking destinations in all of the systems. The trunk 

addresses of all trunking objects are shown in (  ). 

 

Figure 754: Trunking - Director - Viewing all trunk ports 

 

Open a local port in the Workspace and drag the trunking destination to a key or Virtual 

Function using drag & drop. 

 

Figure 755: Trunking - Director - Drag & Drop “Call to Port“ to trunking destinations 
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16.4.2 Trunking: Listen to Port 

To configure a „Listen to“ to a trunkport it is not possible to use the drag&drop method. To 

use “listen to” for a trunk member, you have to know the trunking address of the 

destination port you want to listen to.  

 

Create a standard „listen to“ - function on a local key or virtual function. The „Properties“ 

window of this function will open automatically. Now select „Trunking address“ as „Source“ . 

Enter the NET and Port-address of the trunkport you want to listen to. 

 

You can find the trunking address of the trunked port in the  tab. The address 

is shown in ( ) behind the portname.  

 

 
Figure 756: Trunking – Creating a „Listen to“ Trunkport function 

 
This method is identically to the offline-configuration of trunkcalls. See 16.4.5 Offline-

configuration of Trunkcalls (new in Director 6.20). 

 

Because an automatic takeover of the trunkport-labels is not yet working in this version, the 

key will show „LstnTR ?“ in the display. 

To label the key, you can disable the function “define automatically“ in the  tab of 

the key properties and enter a name manually. You can also use the function „Edit“ -> 

„Update Trunking key labels“ once when you finished all listen to configurations and when 

the Trunk Navigator and Director is online. Then the labels will be updated. (See 16.4.4 

Trunking: Changing port names) 

 

 ->  
Figure 757: Trunking - “Listen to Port“ key text 
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16.4.3 Trunking: Call to Group / Call to Conference 

To use groups or conferences via trunking, you need to configure a group resp. a conference 

in all trunked systems you want to use for this functionality. The group resp. conference in 

the different systems has to use the same trunking address. Then the Trunk Navigator 

knows, which groups/conferences are linked together.  

 

Create a new group resp. conference in the local system (see 8.17 Create and manage 

Groups and Conferences) and open the properties of the new group/conference. 

Enter any trunking address for this conference/group. 

  

Tip: The trunking address for groups and conferences is independent of the trunk addresses 

of single ports. So a trunk address of a group/conference can be the same then the address 

of a single port.  

 

 
Figure 758: Trunking - Call to Group/Conference - Trunking address 

 

Now create also a group resp. a conference in the configurations of the trunked systems 

and set the same trunking address for the group/conference like in your local system.  

The  long-, and. 8-char labels of the  group/conference can be different in every system.  

 

To now configure calls to a trunked groups resp. conferences to local ports, you have to 

drag&drop the needed groups/conferences from the  - list to local keys or virtual 

functions.  

Therefore the - tab and the local port needs to be opened. 
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Figure 759: Trunking - Drag&Drop of groups and conferences 

 

 
Note: Groups and conferences can only be programmed via Drag & Drop if the local 

configuration also contains a group or conference with the same trunk address.  The groups 

and conferences of the various systems are connected to another via this trunk address. 

 

16.4.4 Trunking: Changing portnames 

If you change Net-, Port- or Display names of trunk enabled ports in your local configuration, 

send these changes with   to the local system. The Trunk Navigator will take over these 

changes and forward them to all connected Directors. After a while, the Trunkinglist in the 

-tabs will be updated with all new names in all Directors. It can take up to 1 

minute until all lists are up to date. To overtake all new labels to the other local 

configurations, activate the function “Update Trunking key labels” in the “Edit” menu in all 

other connected Directors. All local keylabels, configured with a trunking function that have 

been changed, will be updated to the latest. An Info-window will show the numbers of 

changed labels in the local configuration. Now send the configuration with  to the local 

systems. 

->  

Figure 760: Trunking - Director - Update Trunking key labels 
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16.4.5 Offline configuration of Trunkcalls (new in Director 6.20) 

Up from Director version 6.20 it is possible, to configure Trunkcalls also in offline mode.  

That means, no Trunk Navigator or Artist needs to be connected. Therefore you need to 

know the trunk addresses of the called trunkport and also the trunk-address of the trunked 

system. You can figure out these addresses for example by opening the configuration of the 

trunked system in another Director instance (writing Log files need to be disabled in 

Director to open another instance on the same computer. See 9.1.4.2 Options - Logging). 

You can figure out the “Trunking Net address” in the properties of the web of the 

configuration. Open “Properties” of the „WEB“ in the  -tab 

 

 

Figure 761: Trunking - Director - Properties of the NET 

 

 

 

Figure 762: Trunking - Director - Trunking NET address 
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To find out the Trunk address of a single port, you have to open the „Properties“ of the port 

and go to the  - tab. In „Trunking address“ you can figure out the Trunk address of 

the port. 

 

Figure 763: Trunking - Director - Trunk address of a Ports 

 

To configure offline a trunkcall to a local port, just add with „Add function“ a new „Call to 

Port“ or „Listen to Port“ command on a key or a virtual function. Now open the “Properties” 

of this function and select   instead of „local Port“ and enter the Net-, and 

Trunkaddress of the trunked destination port. 

 

Figure 764: Trunking - Director - Call to Port - Trunking address 

 

Use the same procedure also for a “Listen to Port” command. 
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Because an automatic takeover of the trunkport-labels is not yet working in this version, the 

key will show „LstnTR ?“ resp. ”CallTR ?” in the display. 

To label the key, you can disable the function “define automatically“ in the  tab of 

the key properties and enter a name manually. You can also use the function „Edit“ -> 

„Update Trunking key labels“ once when you finished all listen to configurations and when 

the Trunk Navigator and Director is online. Then the labels will be updated. (See 16.4.4 

Trunking: Changing portnames) 

 

 ->  
Figure 765: Trunking - Offline configuration - key display 
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16.4.6 Trunking priorities 

Each trunking call can be assigned one of 3 different trunking priority levels. The priorities 

allow the most important calls to be given a higher priority in the face of limited trunkline 

capacity. The three priorities are: “Low”, “Standard”, and “High”. 

All new trunk calls are first created with the priority “Standard” by default. To change the 

priority of a trunking call, open the properties of the trunking call and change the priority 

under “Trunkcall priority”.  

Right mouse click on the key or Virtual Function and select the “Edit”. Select the desired 

trunking call. 

 

Figure 766: Trunking - Director - Editing a trunking call 

Change the priority of the call under “Trunkcall priority”. 

 

Figure 767: Trunking - Director - Selecting the trunk call priority 

 

The maximum number of simultaneous calls in a trunked system is dependent on the 

number of trunklines available. 

For example, as soon as the trunkline capacity is used up by calls with a “Standard” priority 

and a call with a “High” priority is activated, one of the standard calls will be terminated. If 

calls with priorities “Standard” and “Low” are active at the same time, the call with the 

lowest priority will be ended to allow the higher priority call to use the trunkline. 

As soon as an active trunking call is ended by a call with a higher priority, this will be 

indicated on the affected control panel keys. 

Active Trunking Call:               Trunking call ended by a call with a higher priority: 

                           

Figure 768: Trunking - Markers Panel key 
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16.5 Displaying trunking calls 

The Trunk Navigator software displays the current status of the trunkline capacity in % for 

each direction. 

 

Figure 769: Trunk Navigator - Capacity used on the trunkline 

 

In addition, the trunkline area of the Trunk Navigator software lists which trunklines are 

being used and in which direction. 

 

Figure 770: Trunk Navigator - Active trunk lines 

 

 

The exact details of which trunk port of a system activated a certain call and the destination 

for the call are listed in the trunk call area.  

 

Figure 771: Trunk Navigator - Active source and destination ports 

 

 

All trunk call connections are also listed in the log area along with the exact time they took 

place. The log file is saved as a .txt file in the same directory as the Trunk Navigator. 

 

Figure 772: Trunk Navigator - Log entries of an active trunk call 

 

Note: Since the trunkline capacity is dependent on the source being used, multiple direct 

calls can be activated at the same time from a single source. The distribution to the ports in 

the destination system is handled by the CPU in the remote system.   
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As soon as a trunkline has reached its maximum capacity, this will be indicated by “100%“ 

being displayed in red. 

 

Figure 773: Trunk Navigator - 100% use of a trunkline 

 

If another trunk member tries to activate a trunk call with the same priority, this person will 

see a busy signal on the corresponding control panel key when they press it. 

 

Figure 774: Trunking - Panel key display Trunkline busy 

 

If a trunkline or an entire trunked system is offline, it will be displayed red in the Trunk 

Navigator. 

 

Figure 775: Trunk Navigator - Trunkline offline 

 

If a user tries to make a call, the caller will see an error message when the key is pressed. 

 

Figure 776: Trunking - Panel key display Trunkline or trunk system not available 
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17 TROUBLESHOOTING 

Problem Possible Cause Potential Solution 

Director cannot connect to 

Artist 
Network is not activated Press the network button in Director 

 Incorrect IP address in Director Enter the correct IP address 

 Network cable is not connected 
Connect the network cable to the 

10BaseT port on the CPU rear card 

 
Ethernet is only connected to   

the redundant PC 

Connect the Ethernet cable to the 

active CPU, or use a switch or 

Ethernet hub to connect to both 

CPUs at the same time 

 Wrong Ethernet cable 
Direct connection PC->Artist: 

10BaseT X-Over ; Hub/Switch : 1:1 

 

IP address of the PC is not in  

the same subnet mask as 

Director 

Make sure that the PC is in the  

same subnet as Artist  

(Ex. 192.168.42.x) 

 
A firewall is blocking the   

network connection 

Deactivate the firewall or unlock  

port 8192 

 

Windows Network ARP cache 

problem after changing the IP 

address 

Execute the DOS command 

“arp –d *” : Reset the ARP cache 

Unstable IP-connection 

(interruptions during 

firmware update or 

downloading configurations) 

Wrong speed setup of your PC 

network-card  

Set the speed of your network-card 

in your Windows device manager    

to “Auto detection” or “10Mbit 

halfduplex” 

2 or more nodes are 

connected via fiber, but only  

1 node is visible in the online 

bar 

Fiber connection is not working 
Clean the fiber connectors, check  

the cable (see CPU LEDs)  

 
Fiber is not connected correctly 

 

Make sure that the node 1 

downstream TX is connected to the 

upstream RX of the next node, and 

vice versa 

 Node addresses are the same Change the node address of a node 

 
The systems are running  

different software versions 

Update/downgrade all systems to 

the same software version 

 
Wrong fiber cable type or fiber 

transceiver installed 

Check the hardware for which fiber 

type should be used 

It is not possible to read out 

the configuration from the 

system 

Network is not active 
Press the network button in   

Director 

 

The Director version is newer / 

older than the firmware in the 

system 

Open the version of Director that 

matches the firmware installed 

 

The system was not used for a 

long period .The CPU has 

therefore lost the configuration 

Open the configuration from the 

hard drive and send it to the system 

(afterwards reset the system) 
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You do not have the user rights  

to read out the configuration 

from the system 

Contact your system administrator 

It is not possible to send a 

configuration to the system 
Network is not active Press the network button 

 Configuration contains an error 
Check the “Cfg errors” tab in  

Director for undefined entries 

 

The version of Director is 

newer/older than the Artist 

firmware 

Use the correct version of Director 

that matches your firmware 

 

The node address in the 

configuration is not the same 

address as the system 

Adjust the node addresses, either in 

the configuration or on the node 

itself 

 

You do not have the necessary 

user rights or have clicked 

“Cancel” in the Log-in window 

Contact your system administrator, 

or click “Ok” when logging in 

Panel / Port does not boot The connection to Artist is faulty Check the cabling 

 
The Artist CAT5 cable is con-

nected to the “Expansion”port 

Connect the CAT5 cable to the 

“Matrix” connector 

 The panel has no power Check the power cable 

 

The yellow LED on the 

corresponding client card is 

active, -> all 8 ports are not 

working 

The client card is not configured or   

it has the wrong firmware 

 

The panel is connected to the 

2nd channel of a stereo port / 

an AES signal is not working 

Always connect a panel or AES 

signal to the even numbered port    

of a stereo port 

 Cable is too long 

Check whether the maximum cable 

length of approx. 300m has been 

reached  

 The panel crashed 
Reset the panel by cycling the  

power or with a software reset 

ECP 10xx/20xx does not 

work 
The ECP‟s address is incorrect 

Check the address in Director and  

on the dip switch on the ECP 

GPI card does not work 
The jumper setting on the GPI 

card is incorrect 

Check the bay and jumper setting  

on the GPI card (see the sticker on 

the GPI card) 

The complete system has 

crashed or does not boot. The 

CPUs make a clicking noise 

The HDLC cable on the CPU rear 

cards is defective or not present 

Connect the HDLC cable to the 

“HDLC” connector on both CPU     

rear cards  

Clicks in the digital 4-wire 

audio 

There is no Ring Clock Master in 

the Artist ring / the Ring Clock 

Master is set for external sync,  

but no sync signal  is present 

Set a node in the ring as the Ring 

Clock Master ( -> Online bar -> Node 

properties) / connect a valid sync 

signal to the sync module 

No audio, incorrect signaling, 

no reply function on certain 

panels, N/A display for 

working ports 

A hardware configuration 

change was made in the 

software or a new configuration 

was sent to the system without 

a system reset 

Reset all nodes (Director->Extras-

>Reset all Nodes)    

Figure 777: Table - FAQ 
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20 SERVICE 

We offer comprehensive customer service options for this product, if you have further 

questions or suggestions.  Service includes: 

Telephone service 

E-mail service 

Skype service 

Fax service 

Configuration support 

Trainings 

Repairs 

 

Your first contact should always be your local distributor / dealer. 

In addition, Riedel Customerservice in Wuppertal, Germany is always available to help you. 

 

Telephone: +49 (0) 202 292 9400 

(Monday - Friday, 8:00 – 17:00 Central European Time) 

 

Fax: +49 (0) 202 292 9419 

 

Skype: riedel.communications.service 

 

Or use the contact form on our website:  

www.riedel.net 

 

For repairs, please contact your local distributor.  Your distributor will help you with the 

repair process and with securing replacement parts. 

The address for sending repairs directly to Riedel Communications GmbH & Co. KG is: 

Riedel Communications GmbH & Co. KG 

- Repairs - 

Uellendahler Str. 353 

D-42109 Wuppertal 

Germany 

 
 

file://192.168.0.2/Application%20Data/Microsoft/Word/Original%20Files/www.riedel.net


 

 

 

 

Headquarter 

Riedel Communications GmbH & Co. KG • Uellendahler Str. 353 • 42109 Wuppertal • Germany 

Phone: +49 (0) 202 292-90 • Fax: +49 (0) 202 292-99 99 • sales-international@riedel.net  
 

Sales Germany 

Riedel Communications GmbH & Co. KG • Ernst-Augustin-Str. 12 • 12489 Berlin • Germany 

Phone: +49 (0) 30 67 82 61-0 • Fax: +49 (0) 30 67 82 61-59 • sales-germany@riedel.net  
 

Sales Austria 

Riedel Austria Communications GmbH • Dörfelstr. 6-8• 1120 Vienna • Austria 

Phone: +43 1 523 66 85-0 • Fax: +43 1 523 66 85-50 • sales-austria@riedel.net 

 

NEW: Sales Switzerland 

Riedel Communications Switzerland AG 

Käshaldenstrasse 40 • 8052 Zürich • Switzerland 

Phone: +41 (0) 44 307 10 30 

Fax: +41 (0) 44 307 10 39 
 

Sales USA 

Riedel Communications Inc. • 1721 VictoryBlvd • Glendale, CA 91201 • USA • 

East Coast Phone +1 (914) 819-0495 • East Coast Fax +1 (914) 816-4033 • sales-us@riedel.net 

West Coast Phone + 1 (818) 241 4696 •West Coast Fax + 1 (818) 241 5927 • sales-us@riedel.net 
 

Sales Asia 

Riedel Communications International GmbH (Sales Asia) 

19 Loyang Way • #02-03 Changi Logistic Centre • Singapore 508724 

Phone +65 6546 7128 • Fax +65 6234 1573• sales-asia-pacific@riedel.net  
 

Sales China 

Riedel Communications International GmbH •Rm 706, Blok A, Huibin Office Building, • 

8 Beichendong Rd • Chao Yang District Riedel Communications Australia Pty.Ltd. 

South Sydney Technology Park 

68/45-51 Huntley Street 

Alexandria 2015, Australia 

Phone +61 (0) 2 9550 4537 Beijing 100101 • P.R. China 

Phone +86 10 8498 1197 • Fax +86 10 8497 1987 

 

Sales Australia 

Riedel Communications Australia Pty.Ltd. • South Sydney Technology Park • 68/45-51 Huntley Street 

Alexandria 2015, Australia • Phone +61 (0) 2 9550 4537 

 

www.riedel.net  
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